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Introduction      1

Introduction

T
he only thing standing between you and your writing is your word proces-

sor. Yeah, I know: It’s supposed to be helpful. Well, it tries. Computers can 

do only so much. But you, as a smart person, are capable of so much more, 

which is why I’m guessing you opened this book.

Welcome to Word For Dummies, which removes the pain from using Microsoft’s 

greatest and most confusing word processing software ever! This book is your 

friendly, informative, and entertaining guide to getting the most from Word.

Be warned: I’m not out to force you to love Word. This book won’t make you enjoy 

the­program.­Use­it,­yes.­Tolerate­it,­of­course.­The­only­promise­I’m­offering­is­to­
ease the pain that most people feel from using Microsoft Word. Along the way, I 

kick Word in the butt, and I hope you enjoy reading about it.

About This Book

I don’t intend for you to read this book from cover to cover. It’s not a novel, and if 

it­were,­it­would­be­a­political­space­opera­with­an­antihero­and­a­princess­fighting­
corrupt­elected­ofÏcials­who­are­in­cahoots­with­an­evil­intergalactic­urban­renewal­
development corporation. The ending would be extremely satisfying.

This­ book­ is­ a­ reference.­ Each­ chapter­ covers­ a­ specific­ topic­ or­ task­ you­ can­
accomplish­by­using­Word.­Within­each­chapter,­you­find­self-contained­sections,­
each­of­which­describes­how­to­perform­a­specific­task­or­get­something­done.­
Here are some sample topics you encounter in this book:

 » Moving a block

 » Check your spelling

 » Save your stuff!

 » Text-formatting techniques



 » Working with tables in Word

 » Plopping down a picture

 » Mail merge, ho!

I give you no codes to memorize, no secret incantations, no tricks, no presenta-

tions to sleep through, and no wall charts. Instead, each section explains a topic 

as­though­it’s­the­first­thing­you­read­in­this­book.­Nothing­is­assumed,­and­every-

thing is cross-referenced. Technical terms and topics, when they come up, are 

neatly shoved to the side, where you can easily avoid reading them. The idea here 

isn’t for you to master anything. This book’s philosophy is to help you look it up, 

figure­it­out,­and­get­back­to­work.

How to Use This Book

You hold in your hands an active book. The topics between this book’s  

yellow-and-black covers are all geared toward getting things done in Word. All 

you­need­to­do­is­find­the­topic­that­interests­you­and­then­read.

Word uses the mouse and keyboard to get things done, but mostly the keyboard.

I use the word click to describe the action of clicking the mouse’s main (left) button.

This is a keyboard shortcut: Ctrl+P. Press­and­hold­down­the­Ctrl­(Control)­key­and­
type the letter P, just as you would press Shift+P to create a capital P.

Sometimes, you must press more than two keys at the same time, such as 

Ctrl+Shift+T. Press­Ctrl­and­Shift­together­and­then­press­the­T­key.­Release­all­
three keys.

Commands in Word exist as command buttons­on­the­Ribbon­interface.­I­may­refer­
to the tab, the command group, and then the button itself to help you locate that 

command button.

Menu commands are listed like this: Table ➪    Insert Table. This direction tells you 

to click the Table command button and then choose the Insert Table item from the 

menu that appears.

Some of Word’s key commands dwell on the File screen. To access that screen, 

click­the­File­tab­on­the­Ribbon.­To­return­to­the­document,­click­the­Back­button,­
found in the upper left corner of the File screen and shown in the margin. Or you 

can press the Esc key.
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When I describe a message or some text you see onscreen, it looks like this:

Why should I bother to love Evelyn, when robots will

eventually destroy the human race?

If you need further help with operating your computer, I can recommend my book 

PCs For Dummies (Wiley). It contains lots of useful information to supplement what 

you­find­in­this­book.

Foolish Assumptions

This book was written with a few assumptions. Foremost, I assume that you’re a 

human being, though you might also be an alien visiting from another planet. If 

so, welcome to Earth. Try the tacos. When you conquer our planet, please destroy 

Idaho last. Thanks.

Another foolish assumption I make is that you use Windows as the computer’s 

operating system. Windows 10 is current, though Windows 11 is on the horizon 

and­may­be­current­by­the­time­you­read­this­introduction —­assuming­that­you’re­
still reading this Introduction. This book doesn’t cover Windows.

This­book­covers­several­versions­of­Microsoft­Word.­Specifically,­it’s­written­to­
Word 2021, the Microsoft 365 version of Word, and the online version of Word. 

Most versions of Word 2013 forward are similar, so you should be covered here. 

Any­differences­between­the­various­Word­versions­are­covered­in­this­text.

One version of Word not covered here is the Macintosh version of Word. Sorry, 

Mac­users,­but­the­Mac­version­of­Word­is­too­different­to­present­along­with­the­
Windows versions covered in this text.

What’s Not Here

This book covers using Word for anyone from a bare beginner to a modestly 

sophisticated scrivener. More advanced material is covered in its companion book, 

Word 2016 For Professionals For Dummies, which I wrote and Wiley published. I rec-

ommend this book if you want to dig into advanced topics such as manuscript 

preparation,­Word­use­in­a­legal­ofÏce,­macro­programming,­and­other­“profes-
sional”­word­processing­duties.­The­title­covers­Word­2016­specifically,­but­nearly­
all of it also applies to the current version of Word.
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Icons Used in This Book

This­icon­flags­useful,­helpful­tips,­or­shortcuts.

This icon marks a friendly reminder to do something.

This icon marks a friendly reminder not to do something.

This icon alerts you to overly nerdy information and technical discussions of the 

topic at hand. The information is optional reading, but it may enhance your rep-

utation at cocktail parties if you repeat it.

Where to Go from Here

Start­reading!­Behold­the­table­of­contents­and­find­something­that­interests­you.­
Or look up your puzzle in the index.

Read!­Write!­Let­your­brilliance­shine!

My email address is dgookin@wambooli.com. Yes, this is my real address. I reply 

to all email I receive, and you get a quick reply if you keep your question short and 

specific­to­this­book­or­to­Word­itself.­Although­I­enjoy­saying­hi,­I­cannot­answer­
technical support questions or help you troubleshoot your computer. Thanks for 

understanding.

You can also visit my web page for more information or as a diversion: 

www. wambooli.com.­ This­ book’s­ specific­ support­ page­ can­ be­ found­ at 
www. wambooli.com/help/word. I place errata and updates on that page as well as 

write frequent blog posts with Word information, tips, and tricks.

My YouTube channel contains hundreds of videos about Word, including tips, 

tricks, and tutorials. Check it out at youtube.com/dangookin

To­find­this­book’s­online­Cheat­Sheet,­simply­go­to­www.dummies.com and search 

for Word For Dummies Cheat Sheet in the Search box.

Enjoy this book. And enjoy Word. Or at least tolerate it.
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IN THIS PART . . .

See how to start Word and decipher the Word screen.

Explore differences between Word the program and 
Word online.

Get to know the computer keyboard and the 
touchscreen.

Learn how to read the status bar and discover special 
symbols representing secret characters in your text.



CHAPTER 1  Hello, Word!      7

Chapter 1

Hello, Word!

A
ccording to the popular book Pencils For Dummies, the pencil is the ultimate 
word processing tool. It’s easy to use, it’s wireless, and it features the 
original Undo command, in the form of an eraser. And that’s all the hilar-

ity­you’ll­find­packed­into­Pencils For Dummies.

As­a­writing­tool,­the­pencil­remains­popular­and­relatively­easy­to­figure­out,­but­
it’s not that technologically advanced. Your typical Ticonderoga #2 lacks many of 
the­ powerful­ capabilities­ you­find­ in­ a­ sophisticated­ application­ like­Microsoft­
Word, which is why Word requires a more formal introduction.

Start Your Word Day

Word the program dwells as a digital resident of your PC, a loyal subject of the 
king of the computer realm, Windows. It also exists in the ethereal realm on the 
Internet,­which­you­can­access­if­you­have­the­Microsoft­365­subscription.­Rous-
ing­ the­ program­ into­ a­ state­ of­ useful­ consciousness­ depends­ on­which­flavor­
you use.

IN THIS CHAPTER

 » Starting Word

 » Deciphering the Word screen

 » Understanding the Ribbon

 » Zooming in and out

 » Quitting Word

 » Minimizing Word
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 » Ensure that you sport a proper posture as you write. Your wrists should be 

even with your elbows. Your head should tilt down only slightly, though it’s 

best to look straight ahead. Keep your shoulders back and relaxed. Have a 

minion gently massage your feet.

 » Obviously, you can’t use Word unless your computer is on and toasty.

 » The online version of Word can’t be used unless you have Internet access.

 » Other nerdy terms for starting a program: Run. Launch. Open. Fire up. Beg. 

Thrash. Whimper.

Starting Word the program

Word can be started like any old boring program on a computer. I’ll be quick:

1. Press the Windows key on the keyboard.

The Windows key is adorned with the Windows logo icon, which I won’t 

illustrate here, because it changes more frequently than teenage fashion. 

The key is nestled between the Ctrl and Alt keys to the left of the spacebar. 
A duplicate is found on the right side of the spacebar on desktop computers. 
Use either key.

2. Look for Microsoft Word on the Start menu.

The item might be titled Word and followed by the year or OfÏce release.

If you don’t find Word right away, start typing its name: word. Eventually you 

see matching programs with word in their name: sword, crossword, and 

eventually Microsoft Word.

Sometimes Word is found on a Microsoft OfÏce submenu.

3. Click the Word icon to start the program.

Watch in amazement as the program unfurls on the screen.

Starting Word online

The web-based version of Word is available at this address:

office.com/launch/word

You­must­be­signed­in­to­Microsoft­365­for­this­link­to­successfully­lead­you­to­the­
online version of Word. Fret not: If you’re not signed in, the web page prompts you.

https://www.office.com/launch/word
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 » The online version of Word is limited from the full power of the Word 

program. Differences are noted throughout this book.

 » You need a Microsoft 365 account to use the online version of Word.

 » Word online grants you access to the documents saved to your OneDrive 

folder. OneDrive is Microsoft’s cloud application, providing access to your files 
over the Internet.

Opening a document to start Word

You use Word to create documents. These are stored on a computer along with all 
that other junk you keep but don’t know why. Documents are also found on the 
cloud in your OneDrive account, which allows you to use the online version of 
Word to edit and otherwise mess with them.

To open a document and start Word, follow these steps:

1. Locate the document icon.

Use your Windows kung fu to open the proper folders and hunt down a Word 

document icon, similar to the one shown in the margin.

Online, browse your OneDrive folder for Word document icons, though the 

icon image is often replaced with a thumbnail image showing the document’s 

teeny-tiny contents.

2. Double-click the icon.

On OneDrive, a single click is all you need.

PINNING WORD TO THE TASKBAR

The best way to start Word, and the way I do it every day, is to click the Word icon on the 

taskbar. Word starts simply, quickly, and with a minimum of pain.

The issue, of course, is how to get the Word icon on the taskbar — if the icon doesn’t 
already appear on the taskbar. To add it, first find the Word icon on the Start menu, as 
described in the nearby section “Starting Word the program.” When you find it, right-
click the Word icon and choose More, Pin to Taskbar.

The Word icon is pinned (permanently added) to the taskbar. From there, you need click 

it only once to start the program.
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The document is opened and presented on the screen, ready for whatever.

 » You use Word to create documents. They’re saved to storage on your 

computer or on the cloud. Details are offered in Chapter 8.

 » Documents you create on the cloud stay there — unless you have the 
OneDrive program installed on your computer. In this setup, the cloud files 
are also available on your computer. Likewise, files you save to your OneDrive 
folder (or one of its subfolders) on your computer are also available on the 

cloud, and you can use the online version of Word to edit them.

 » The document name is assigned when it’s first saved. Use the name to 
determine the document’s contents — providing that it was properly named 
when first saved.

 » Documents are files. As such, they are managed by Windows. If you need to 
find a lost document or rename it or organize your documents into a folder, 
you use Windows, not Word.

Behold the Word Program

I believe that the Word program in Windows is the prototype, the golden Apollo 
from which the lesser-yet-valiant Word on the Internet gains its inspiration. 
Between the two versions, many things look and work the same. But no, it’s that 
Word program in Windows that I use as the ideal.

Working the Word Start screen

After­ starting­Word,­ you­may­first­ see­ something­ called­ the­Word­ Start screen, 
shown­in­Figure 1-1.­I­admit­that­the­Start­screen­is­friendlier­than­that­ominous,­
empty page that has intimidated writers since the dawn of paper.

You­can­use­the­Start­screen­to­open­a­previously­opened­document,­start­a­new­
document­based­on­a­template,­or­start­with­a­blank­document.­So,­ if­the­Start­
screen­annoys­you,­click­the­New­button­(refer­to­Figure 1-1)­and­get­writing!

Once­you’ve­made­your­choice —­to­start­a­new­document,­open­one­shown­in­the­
list,­ or­ use­ a­ template —­Word­ is­ ready­ for­ you­ to­ start­writing.­Word­ is­ also­
equally content if you just stare at the screen and await inspiration.
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 » A template is a document that contains preset elements, such as formatting, 

styles, text, and possibly graphics. You use a template to help you start a 

common type of document, such as a résumé, a report, or an angry letter to 

the editor. See Chapter 16.

 » You can pin your favorite documents to the Start screen so that they’re always 

ready when Word presents itself. Choose Pinned documents to see the list. 

Refer to Chapter 8 for details on pinning a document.

 » The pinned document list isn’t shared between Word the program and Word 

on the web.

 » The Word Start screen doesn’t appear when you open a document to start 

Word. Refer to the earlier section “Opening a document to start Word.”

 » You can disable the Start screen so that Word always opens with a blank 

document. (See Chapter 33.) This feature isn’t available on the Internet.

FIGURE 1-1: 
The Word Start 

screen.



12      PART 1  Your Introduction to Word

 » The Word Start screen appears only when you first start the Word program. It 
doesn’t appear when you start a new document while the Word program 

window is already open.

Examining Word’s main screen

Writing­is­scary­enough­when­you­first­see­that­blank­page.­With­a­computer,­the­
level of terror increases because Word festoons its program window with all kinds 
of­controls­and­doodads.­I­recommend­that­you­refer­to­Figure 1-2­to­gain­an­idea­
about the meaning of some basic terms. Ignore them at your peril.

The details of how all these gizmos work, and the terms to describe them, are 
covered throughout this book. The good news is that the basic task of typing text 
is­straightforward.­See­Chapter 2­to­get­started.

FIGURE 1-2: 
Word’s visage.
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 » The view buttons (in the lower right in Figure 1-2: Read Mode, Print Layout, 
and Web Layout) are missing from the online version of Word.

 » To get the most from Word’s window, adjust its size: Use the mouse to drag 
the window’s edges outward. You can also click the window’s Maximize button 
(refer to Figure 1-2) to have the window fill the screen.

 » The largest portion of Word’s screen is used for composing text. It looks like a 

fresh sheet of paper, but it doesn’t smell the same. If you choose to use a 

template to start a new document, this area may contain some preset text.

Working the Ribbon

An­ important­ part­ of­Word’s­ interface­ is­ the­ Ribbon.­ It’s­ where­ a­majority­ of­
Word’s commands dwell and where settings are made. These items appear as but-
tons, input boxes, and menus.

The­Ribbon­is­divided­into­tabs,­as­shown­in­Figure 1-3.­Each­tab­holds­separate­
groups.­Within­the­groups,­you­find­the­command­buttons­and­doodads­that­carry­
out various word processing duties.

The­online­version­of­Word­features­a­different­Ribbon,­more­abbreviated­than­the­
Word­program.­To­view­the­Ribbon­as­shown­in­Figure 1-3,­click­the­chevron­at­the­
far­right­end­of­the­Ribbon­and­choose­the­Classic­Ribbon­command.­Even­then,­
the­Ribbon­may­not­look­the­same­as­for­the­program­version­of­Word.

To­use­the­Ribbon,­first­click­a­tab.­Then­scan­the­group­names­to­locate­the­com-
mand you need. Finally, click the button to activate the command or to display a 
menu­from­which­you­can­choose­a­command.­This­book­describes­finding­com-
mands­on­the­Ribbon­in­exactly­this­manner:­tab, group, command button.

FIGURE 1-3: 
The Ribbon.



14      PART 1  Your Introduction to Word

 » Some items on the Ribbon are controls that let you input text or values or 

adjust other settings.

 » Buttons with menus attached appear with a downward-pointing triangle to 

the right of the icon, as illustrated in Figure 1-3.

 » Galleries on the Ribbon display a smattering of tiles. To see them all, click the 

Show Gallery button in the gallery’s lower right corner, also shown in 

Figure 1-3.

 » Use the Dialog Box Launcher icon in the lower right corner of a group to open 

a dialog box that’s relevant to the group’s function. Not every group features a 

dialog box launcher.

 » The amazingly frustrating thing about the Ribbon is that it can change. Some 
tabs may appear and disappear, depending on what you’re doing in Word.

 » To ensure that you always see all command buttons, adjust the program’s 

window as wide as is practical.

 » Clicking the File tab replaces the contents of the Word window with a screen 

full of commands and other information. To return to the Word window, click 

the Back button (shown in the margin) or press the Esc key.

Showing and hiding the Ribbon

Microsoft­may­believe­that­showing­and­hiding­the­Ribbon­is­a­feature,­one­that­
you­control­according­to­your­preferences.­I­find­that­this­option­frustrates­most­
people,­especially­when­you­unintentionally­hide­the­Ribbon.

To­resolve­Ribbon­frustrations,­use­the­Ribbon­Display­Options­menu,­located­in­
the­upper­right­area­of­the­Word­window­and­illustrated­in­Figure 1-3.­Choose­an­
item­to­determine­how­to­display­the­Ribbon.­Your­choices­are

Auto-Hide Ribbon: The most annoying choice, the Ribbon appears only when you 

hover the mouse pointer near the top of the document.

Show Tabs: With this choice, only the Ribbon’s tabs appear. Click a tab to show the 

bulk of the Ribbon, which disappears again after you’ve chosen a command.

Show Tabs and Commands: This option shows the entire Ribbon — tabs and 
commands — as illustrated in Figures 1-2 and 1-3. This is probably the choice you 
want.
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To­temporarily­hide­the­Ribbon,­click­the­Collapse­the­Ribbon­button,­labeled­in­
Figure 1-3.­To­bring­back­the­Ribbon,­click­a­tab,­and­then­at­the­spot­where­the­
Hide­the­Ribbon­button­originally­appeared,­click­the­pushpin­icon,­shown­in­the­
margin.­The­Ribbon­stays­open.

 » I recommend that you keep the Ribbon visible as you discover the won-

ders of Word.

 » The online version of Word has only two options for Ribbon visibility: Always 

Show and Automatically Hide.

Working with Word on a tablet

If you’re using Word on a tablet or another touchscreen device, you can adjust the 
spacing­between­buttons­on­the­Ribbon­by­activating­Touch­mode.­This­spacing­
feature­makes­the­Ribbon­more­useful­to­your­stubby­fingers.­Follow­these­steps:

1. Click or touch the Customize Quick Access Toolbar button.

The button appears to the right of the Quick Access toolbar buttons. (Refer to 

Figure 1-2.)

2. Choose Touch/Mouse Mode.

The Touch Mode button appears on the Quick Access toolbar, shown in the 

margin.

Tap­the­button­to­switch­the­Ribbon­between­Mouse­and­Touch­modes.­In­Mouse­
mode,­ the­buttons­on­the­Ribbon­appear­closer­ together.­ In­Touch­mode,­more­
space­is­added­between­the­buttons,­which­makes­it­easier­for­your­stubby­fingers­
to tap the proper command.

Changing the document view

Just­to­keep­you­on­your­toes,­Word­offers­multiple­ways­to­view­a­document­in­its­
window. The blank area where you write, which should be full of text by now, can 
be­altered­to­present­information­in­different­ways.­Why­would­you­want­to­do­
that?­You­don’t!­But­ it­helps­ to­know­about­ the­different­ways­so­ that­you­can­
change them back.

The standard way to view a document is called Print Layout view. This view is 
shown in this book, and it’s how Word typically presents a document. A virtual 
page appears on the screen, with four sides, like a sheet of paper with text in the 
middle.­What­you­see­on­the­screen­ is­pretty­much­what­you’ll­see­ in­the­final­
results, whether printed or published as an electronic document.
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The other views are

Read Mode: Use this view to read a document like an eBook. The Ribbon and 

pretty much the rest of Word is hidden while in Read mode.

Web Layout: This view presents a document as a web page. It’s available should 

you use Word’s dubious potential as a web page editor.

Focus: The briefest of presentations — only the document and your text appear, 
no controls or other whatnot.

Immersive Reader: A funky presentation where Word reads your document 

to you.

Outline: This mode helps you organize your thoughts, as covered in Chapter 25.

Draft: Draft view presents only basic text, not all the formatting and fancy features, 

such as graphics.

To­switch­between­Read­Mode,­Print­Layout,­and­Web­Layout­views,­click­a­View­
button,­found­in­the­lower­right­corner­of­the­Word­program­window.­(Refer­to­
Figure 1-2.)­These­buttons­are­absent­in­the­online­version­of­Word.

To­get­to­Outline­and­Draft­views,­as­well­as­to­see­all­View­modes­in­one­location,­
click­the­View­tab­and­choose­the­appropriate­command­button­from­the­Views­
group. And, again, these view modes are absent in the online version of Word.

When your document looks weird in the Word program window, switch back to 
Print­Layout­view­to­fix­the­problem.­Click­the­Print­Layout­button­on­the­status­
bar,­or­click­the­View­tab­and­choose­Print­Layout­in­the­Views­group.

Making text look larger or smaller

When the information in Word’s window just isn’t big enough, don’t increase the 
font­size!­Instead,­whip­out­the­equivalent­of­a­digital­magnifying­glass,­the­Zoom­
command. It helps you enlarge or reduce your document’s presentation, making 
it easier to see or giving you the Big Picture look.

Several­methods­are­available­to­zoom­text­in­Word.­The­most­obvious­is­to­use­the­
Zoom­control,­found­in­the­lower­right­corner­of­the­Word­window,­on­the­status­
bar. Adjust the slider right or left to make the text larger or smaller, respectively.

To­set­specific­zoom­sizes,­click­the­100%­button­on­the­status­bar.­Use­the­Zoom­
dialog box to set a size based on percentage, page width, or even multiple pages.
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 » Zooming doesn’t affect how a document prints — only how it looks on 
the screen.

 » For more specific zoom control, click the View tab and use the commands 
found in the Zoom group.

 » If the computer’s mouse has a wheel button, you can zoom by holding the Ctrl 
key on the keyboard and rolling the mouse wheel up or down. Rolling up 

zooms in; rolling down zooms out.

 » If you find that the document zoom has changed accidentally, it’s probably 
because of the Ctrl+mouse wheel trick described in the preceding bullet.

 » Word has plenty of document viewing tools that work similarly to the Zoom 

command, including side-by-side page presentation and tools for viewing 

multiple documents. See Chapter 24 for details.

End Your Word Day

It’s the pinnacle of etiquette to know when and how to excuse oneself. For exam-
ple,­the­phrase­“Well,­I­must­be­off”­works­a­lot­better­than­growling,­“I­wish­you­
all­would­rot”­before­leaving­a­family­dinner.­The­good­news­for­Word­is­that’s­
completely acceptable to quit the program without hurting its feelings.

HELP ME, WORD!

As in most Windows programs, a Help system is available in Word. In addition to the 

Help tab on the Ribbon, press the F1 key to summon this support, which displays the 

Word Help pane on the side of the document window. There you can type a topic, a 

command name, or even a question in the box to search for help.

The F1 key also works anytime, and the information displayed tends to be specific to 
whatever you’re doing in Word.

Little buttons that look like question marks appear in various places in the program. 

Click one of these buttons to also summon Word Help.

Alas, the F1 key doesn’t work for the online version of Word. Instead, use the Help tab to 

summon help when working online.
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Quitting Word

When­you’ve­finished­word­processing­and­you­don’t­expect­to­return­to­it­any-
time soon, quit the Word program. Click the X button in the upper right corner of 
the­Word­program­window.­(Refer­to­Figure 1-2.)

The catch? You have to close each and every Word document window that’s open 
before you can proclaim that you’ve completely quit Word.

The other catch? Word won’t quit during that shameful circumstance when you’ve 
neglected­to­save­a­document.­If­so,­you’re­urged­to­save,­as­shown­in­Figure 1-4.­
My­advice­is­to­click­the­Save­button­to­save­your­work;­see­Chapter 8­for­specific­
document-saving directions.

If­you­click­the­Don’t­Save­button,­your­work­isn’t­saved­and­Word­quits.­If­you­
click the Cancel button, Word doesn’t quit and you can continue working.

 » You don’t have to quit Word just to start editing another document. Refer to 

the next couple of sections for helpful, time-saving information.

 » After quitting Word, you can continue to use Windows to accomplish whatever 

task comes next. Or, you can choose to do something relaxing, like playing 

Ninja Sniper Aliens III.

Closing a document without quitting Word

You don’t always have to quit Word. For example, if you’re merely stopping work 
on one document to work on another, quitting Word is a waste of time. Instead, 
you close­the­first­document.­Follow­these­steps:

FIGURE 1-4: 
Better click that 

Save button.
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1. Click the File tab.

The File screen appears. Various commands line the left side of the screen.

2. Choose the Close command.

The Close command for the online version of Word doesn’t close the docu-

ment. Only the Close command for the Word program closes the open 

document.

3. Save the document, if you’re prompted to do so.

The shame! Always save before closing. Tsk-tsk.

After the document has closed, you return to the main Word window. You don’t 
see­a­document­in­the­window,­and­many­of­the­Ribbon’s­command­buttons­are­
dimmed­(unavailable).­At­ this­point,­you­can­create­a­new­document­or­open­a­
document you previously saved.

Bottom line: There’s no point in quitting Word when all you want to do is start 
editing a new document.

 » There’s no urgency to close a document. I keep mine open all day, saving 

often. Occasionally, I wander off to do something not work related, like play a 
game or see who’s being obnoxious on Facebook. To return to the document 

at any time, click its button on the Windows taskbar.

 » The keyboard shortcut for the Close command is Ctrl+W. This command may 
seem weird, but it’s a standard keyboard shortcut used to close documents in 

many programs.

 » To swiftly start a new, blank document in Word, press Ctrl+N.

Setting Word aside

Don’t quit Word when you know that you’ll use it again soon. In fact, I’ve been 
known to keep Word open and running on my computer for weeks at a time. The 
secret­is­to­use­the­Minimize­button,­found­in­the­upper­right­corner­of­the­screen.­
(Refer­to­Figure 1-2.)

Click­the­Minimize­button­to­shrink­the­Word­window­to­a­button­on­the­taskbar.­
With the Word window out of the way, you can do other things with your com-
puter. Then when you’re ready to word-process again, click the Word button on 
the taskbar to restore the Word window to the desktop.
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Chapter 2

The Typing Chapter

W
ord processing is about using a keyboard. It’s like typing on a type-
writer­but­without­the­“Ding!”­at­the­end­of­each­line —­oh,­and­other­
improvements as well. But I digress.

Microsoft Word and typing go together like social media and bickering about poli-
tics.­Long­before­the­mouse­and­all­the­fancy­graphics­became­popular,­typing­was­
how­you­processed­words.­Yep —­ask­a­grizzled­old-timer­and­you’ll­hear­tales­of­
unpleasant text screens and mysterious keyboard commands that would tie your 
fingers­ in­knots.­Things­today­aren’t­ that­bad­(well,­ if­you­stay­far­from­social­
media).

Input Devices Galore

When­you­process­words,­you­type:­clickity-clack-clack.­You­use­your­fingers­and­
one­thumb­to­manipulate­the­computer­keyboard.­Typing­is­an­important­part­of­
getting­text­on­a­page,­but­also­important­is­the­mouse.­No,­you­don’t­type­with­
the­ mouse,­ but­ you­ do­ some­ pointing­ and­ clicking­ in­ addition­ to­ clickity- 
clack-clacking.

IN THIS CHAPTER

 » Knowing the keyboard and mouse

 » Using the spacebar

 » Using the Enter key

 » Observing the status bar

 » Minding the space between pages

 » Showing and hiding hidden 

characters

 » Dealing with weird underlines
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Using the PC keyboard

I’m­sure­you­can­easily­recognize­a­computer­keyboard,­but­do­you­know­the­tech-
nical terms that refer to its various keys?

Relax:­No­one­does.

Rather than look at all 100+­keys­as­a­single,­marauding­horde,­consider­how­the­
keys­are­clustered­into­groups,­as­illustrated­in­Figure 2-1.­To­best­use­Word­and­
understand­how­the­keyboard­is­referenced­in­this­book,­it­helps­to­know­the­gen-
eral­keyboard­areas­illustrated­in­the­figure.

Of­all­the­keys,­a­few­play­important­roles­in­the­word­processing­task:

Enter: Marked with the word Enter and sometimes a cryptic, bent-arrow thing, 

this key is used to end a paragraph of text. See the later section “Pressing the 
Enter key.”

Spacebar: The only key with no symbol on it, it inserts a space between words and 
sentences. Yes, just one space. See the later section “Whacking the spacebar.”

Tab: This key inserts the Tab character, which shoves the next text you type over to 
the next tab stop. The Tab key is also used to complete a predictive text suggestion; 
see the later section, “Using text predictions.”

Backspace and Delete: Use these keys to back up and erase text. Read more 
about these keys in Chapter 4.

Every character key you press on the keyboard produces a character in your Word 
document,­on­the­blank­part­where­you­write.­Typing­those­character­keys­over­
and­over­is­how­you­create­text­in­a­word­processor.­That’s­how­Shakespeare­did­it.

FIGURE 2-1: 
A typical PC 

keyboard.
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 » Understanding how the Tab key functions requires heavy medication. 
Chapter 12 is dedicated to typing tabs and setting tab stops.

 » A laptop keyboard’s layout is different from the desktop keyboard layout, as 
shown earlier, in Figure 2-1. For example, most laptop keyboards lack a 
numeric keypad. The cursor keys are clustered tightly around the typewriter 
keys in unusual and creative patterns. The function keys might be accessed by 
pressing special key combinations.

 » Keys on the numeric keypad can be number keys or cursor keys. The split 
personality is evident on each key cap, which displays two symbols. When the 
Num Lock key’s lamp is on, the keys generate numbers. When the lamp is off, 
the keys serve as duplicate cursor keys.

 » Cursor keys control the cursor, which is ofÏcially known as the insertion pointer 

in Microsoft Word. The cursor keys include the four arrow keys (up, down, left, 
right) and also the keys Home, End, PgUp (or Page Up), PgDn (or Page Down), 
Insert, and Delete.

 » Ctrl is pronounced “control.” It’s the Control key.

 » The Delete key may also be labeled Del on the keyboard.

 » The modifier keys — Shift, Ctrl, and Alt — work in combination with 
other keys.

Working an onscreen keyboard

Two-in-one­ laptops,­ tablets,­ and­ other­ touchscreen­ devices­ sport­ an­ onscreen­
keyboard,­which­you­can­use­to­type­text­in­Word.­You­can­also­draw­text,­scribble,­
and­perform­a­host­of­other­options.­For­email­or­short­missives,­ the­onscreen­
keyboard­is­tolerable.­And­you­look­so­high-tech­when­you­use­it.­For­true­word­
processing,­however,­don’t­torture­yourself —­instead,­use­a­real­keyboard.

When­using­a­real­keyboard­isn’t­possible,­here­are­my­onscreen­keyboard­thoughts­
and­suggestions:

 » The onscreen keyboard’s operation works basically the same as a real 
keyboard: You type text using your fingers, albeit probably not as fast as on a 
physical keyboard.

 » Accessing some of the specialized keys (function keys, cursor keys, and others) 
is problematic. Sometimes they’re available by choosing a different touch-

screen keyboard layout, but often they’re unavailable.
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 » Using the Ctrl key on the onscreen keyboard is a two-step process: Tap the 
Ctrl key and then touch another key — for example, Ctrl and then the S key, 
for Ctrl+S.

 » Not all Ctrl-key combinations in Word can be replicated by using the onscreen 
keyboard.

 » Refer to Chapter 1 for information on activating Touch mode, which makes it 
easier to use Word on a tablet.

Understanding the mouse pointer

Though­word­processing­is­a­keyboardy­thing,­you­inevitably­lift­your­hand­from­
the­keyboard­to­fondle­the­computer­mouse.­Use­the­mouse­to­choose­commands,­
select­text,­and­move­around­the­document.­Specific­information­on­these­tasks­is­
found­ throughout­ this­ book.­ For­ now,­ it­ helps­ to­ understand­ how­ the­ mouse­
pointer­changes­its­appearance­as­you­work­in­Word:

For­editing­text,­the­mouse­pointer­becomes­the­I-beam.

For­choosing­items,­the­standard­11­o’clock­mouse­pointer­is­used.

For­selecting­lines­of­text,­a­1­o’clock­mouse­pointer­is­used.

The­ mouse­ pointer­ changes­ its­ appearance­ when­ the­ click-and-type feature is 
active:­Teensy­lines­appear­below­and­to­the­left­and­right­of­the­I-beam­mouse­
pointer.­Refer­to­Chapter 32­to­read­why­no­one­uses­click-and-type.

When­you­point­the­mouse­at­a­command­button­or­any­icon­on­the­Word­screen,­
you­see­a­pop-up­information­bubble.­The­text­in­the­bubble­describes­the­com-
mand­and­perhaps­offers­a­hint­on­how­the­command­is­used.

Keyboard Do’s and Don’ts

You don’t need to be a 70-words-per-minute touch typist to use a word proces-
sor.­And­if­you­don’t­know­how­to­type,­see­the­nearby­sidebar,­“Do­I­need­to­learn­
to­type?” —­although­I­can­tell­you­that­the­answer­is­“Yes,­you­need­to­learn­to­
type.” It also helps to know a few typing do’s and don’ts that are particular to 
word processing.
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Following the insertion pointer

Text­you­compose­in­Word­appears­at­the­insertion pointer’s­location.­The­insertion­
pointer­looks­like­a­flashing­vertical­bar:

|

Open and close your eyes as you look at this insertion pointer to form an idea of 
how it looks on the screen.

Characters appear before­ the­ insertion­pointer,­ one­at­ a­ time.­After­ a­ character­
appears,­the­insertion­pointer­advances­to­the­right,­making­room­for­more­text.

 » The insertion pointer moves as you type, but its location can be set to any 
location in the document’s text. Chapter 3 covers moving the inser-

tion pointer.

 » Some documentation refers to the insertion pointer as the cursor. The mouse 
pointer might also be referred to as the cursor. For clarity, this book refers to 
the insertion pointer and mouse pointer without using the term cursor.

Whacking the spacebar

Pressing the spacebar inserts a space character­into­the­text.­Spaces­are­important­
between­words­and­sentences.­WithoutthemreadingwouldbedifÏcult.

The­most­ important­ thing­to­remember­about­ the­spacebar­ is­ that­you­need­to­
whack it only once when word processing. Only one space appears between words 
and­after­punctuation.­That’s­it!

“DO I NEED TO LEARN TO TYPE?”

No one needs to learn to type to use a word processor, but you do yourself a favor 
when you learn. My advice is to find a computer program that teaches you to type. I can 
recommend the Mavis Beacon Teaches Typing program, even though I receive no money 
from her and none of her children resembles me. I just like the name Mavis, I suppose.

The program Typing Instructor Platinum is also recommended.

No matter which software you choose, knowing how to type makes the word process-

ing chore a wee bit more enjoyable.
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 » I’m serious! Back in the dark ages, typing instructors directed students to use 
two spaces between sentences. That extra space was necessary for readability 
because typewriters used monospaced characters. On a computer, however, 
the extra space adds little to the text and potentially leads to formatting woes 
down the road.

 » Word flags double-spaces between words as a grammatical error. See 
Chapter 7.

 » Anytime you feel like using two or more spaces in a document, use a tab 
instead. Tabs are best for indenting text as well as for lining up text in 
columns. See Chapter 12 for details.

Backing up and erasing

When­you­make­a­typo­or­another­type­of­typing­error,­press­the­Backspace­key­on­
the­keyboard.­The­Backspace­key­moves­the­insertion­pointer­back­one­character­
and­erases­that­character.­The­Delete­key­also­erases­text,­though­it­gobbles­up­
characters to the right of the insertion pointer.

See­Chapter 4­for­more­information­on­obliterating­text.

Pressing the Enter key

In­word­processing,­you­press­the­Enter­key­only­when­you­reach­the­end­of­a­par-
agraph. Do not press the Enter key at the end of a line.

When­your­text­wanders­precariously­close­to­the­right­margin,­Word­automati-
cally­wraps­the­last­word­on­the­line­down­to­the­next­line.­This­word wrap feature 
eliminates the need to press Enter at the end of a line.

 » Don’t use the Enter key to double-space your text. Double-spacing is a 
paragraph format in Word. See Chapter 11 for more information.

 » Don’t press the Enter key twice to add extra space between paragraphs. Space 
between paragraphs is added automatically, provided it’s part of the para-

graph format, also covered in Chapter 11.

 » If you want to indent a paragraph, press the Tab key after pressing Enter. 
As with other word processing rules and regulations, paragraphs can be 
indented automatically, provided that format is applied, as covered in 
(you guessed it) Chapter 11.
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Stuff That Happens While You Type
As­you­madly­compose­text,­fingers­energetically­jabbing­the­buttons­on­the­key-
board,­you­may­notice­a­few­things­happening­on­the­screen.­You­might­see­spots.­
You­might­see­lines­and­boxes.­You­may­even­see­lightning!­All­are­side­effects­of­
typing­in­Word.­They’re­normal,­and­they’re­presented­to­help­you.

Using text predictions

Relax:­Your­computer­isn’t­possessed.­That­ghostly­text­you­see,­accurately­guess-
ing­what­you’re­about­to­type­next,­is­Word’s­text­prediction­feature­in­action.­In­
Figure 2-2,­the­ghost­in­the­machine­guesses­what­I­might­type­next.­If­the­sug-
gested­text­is­what­you­want,­press­the­Tab­key­to­insert­it­(refer­to­Figure 2-2).­
Otherwise,­keep­typing­to­foil­the­computer’s­feeble­physic­capabilities.

To­disable­text­predictions,­right-click­the­Status­bar­and­choose­Text­Predictions­
from the pop-up menu. Press Esc to dismiss the pop-up menu.

Watching the status bar

The­reason­it’s­called­the­status bar is that it shows you the status of your docu-
ment,­updating­information­as­you­type.­A­barrage­of­information­appears,­start-
ing­at­the­left­end­of­the­status­bar­and­marching­right,­as­shown­in­Figure 2-3.

FIGURE 2-2: 
Text predictions 

in action.

FIGURE 2-3: 
Stuff that lurks on 

the status bar.
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Use­the­status­bar’s­ information­to­see­which­page­and­line­you’re­editing,­the­
word­count,­and­other­details.

The­details­that­appear­on­the­status­bar­are­customizable.­Chapter 29­explains­
how to control what shows up and what’s hidden on the status bar.

Observing page breaks

As­your­document­gains­length,­Word­shows­you­where­one­page­ends­and­another­
page­begins.­This­visual­assistance­helps­you­keep­elements­on­the­same­page,­but­
also­shows­you­how­text­flows­between­pages.

The­visual­clue­for­a­new­page­is­shown­in­Figure 2-4.­In­Print­Layout­view,­the­
page­break­appears­graphically.­Text­above­the­ethereal­void­is­on­one­page,­and­
text below the void is on the next page.

In­Draft­view,­the­page­break­appears­as­a­line­of­dots­marching­from­left­to­right­
across­the­document.­In­other­views,­the­page­break­may­not­show­up,­in­which­
case­you­use­the­status­bar­to­determine­the­current­page.­For­example,­when­the­
page-number­indicator­changes­from­6­to­7,­you’ve­started­a­new­page.

 » To control the gap between pages in Print Layout view, point the mouse at the 
gap. When the mouse pointer changes, as shown in the margin, double-click 
to either close or open the gap.

 » Don’t force a page break by pressing the Enter key a gazillion times! Instead, 
see Chapter 13 for information on inserting page breaks (new pages) in Word.

FIGURE 2-4: 
The page break in 

Print Layout view.
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 » The topic of page breaks brings up the concept of widows and orphans, which 
is otherwise tremendously sad but not in this case. Widow and orphan refer to 
a single line of text at the page’s top or bottom, respectively. Word automati-
cally moves such text to the next or previous page to prevent widows and 
orphans from appearing. It’s cruel but effective.

Working collapsible headers

You­may­see­a­tiny­triangle­to­the­left­of­various­headings­in­your­documents,­as­
shown­in­the­margin.­These­triangles­allow­you­to­expand­or­collapse­all­text­in­
the header’s section. Click the icon once to collapse the text; click again to 
expand it.

 » The collapsible header icons appear in Print Layout view when the insertion 
pointer is in the header or when the mouse pointer is hovered over 
the header.

 » See Chapter 25 for a longer discussion of collapsible headers, as well as 
information on Word’s Outline view.

Dealing with spots and clutter in the text

There’s­no­cause­for­alarm­if­you­see­spots —­or­dots —­amid­the­text­you­type,­
such as

This•can•be•very•annoying.¶

What you’re seeing are nonprinting characters. Word uses various symbols to rep-
resent­characters­you­normally­don’t­see:­spaces,­tabs,­the­Enter­key,­and­more.­
These­jots­and­tittles­appear­when­the­Show/Hide­feature­is­activated:

1. Click the Home tab.

2. In the Paragraph group, click the Show/Hide command button.

The button features the Paragraph symbol as its icon, shown in the margin.

To­hide­the­dots­and­clutter­again,­click­the­Show/Hide­command­button­a­second­
time.

 » Why bother with showing these goobers? Sometimes it’s useful to check out 
what’s up with formatting, find stray tabs visually, or locate empty paragraphs, 
for example.
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 » WordPerfect users: The Show/Hide command is as close as you can get to 
your beloved Reveal Codes command.

 » The keyboard shortcut for the Show/Hide command is Ctrl+Shift+8. Use the 8 
on the typewriter area of the keyboard, not the numeric keypad.

 » The Paragraph symbol is called the pilcrow.

Understanding colorful underlines

When­Word­underlines­your­text­without­permission,­it’s­drawing­your­attention­
to­something­amiss.­These­special­underlines­are­not­text­formats.­Here­are­a­few­
of­the­underlines­you­may­witness­from­time­to­time:

Red zigzag: Spelling errors in Word are underlined with red zigzags. See Chapter 7.

Blue single or double-underline: Grammatical and word choice errors are flagged 
with a blue single or double underline, depending on the offense. Again, see 
Chapter 7.

DICTATE THY PROSE

An option for some versions of Word is using dictation instead of typing to generate 
text. To confirm that your edition of Word sports this feature, look for the Voice group 
on the Home tab, which features the Dictation button, shown nearby. If you’re 
prompted, activate the feature, which requires your computer to have a microphone 
attached and configured.

To dictate text, start talking. Word translates your utterances into text. Whatever you 
say appears in the document, almost immediately and with fair accuracy. You can  
dictate some punctuation, such as “period,” “comma,” and “new line” to start a new 
paragraph.

Click the Dictate button again to disable this feature.
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Blue single underline: Word courteously highlights web page addresses by using 
a single, blue, underline. You can Ctrl+click the blue underlined text to visit the web 
page.

Red lines: You may see red lines in the margin, underneath text, or through text. If 
so, it means that you’re using Word’s Track Changes feature. See Chapter 26.

Beyond­these­automatic­underlines,­you­can­apply­the­underline­format­to­your­
text,­choosing­the­type­of­underline­and­its­color.­See­Chapter 10.
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IN THIS PART . . .

Discover how to use the scroll bars, move the insertion 

pointer, and get around with keyboard shortcuts.

Find out how to delete characters, lines, sentences, 

paragraphs, and pages. You’re also introduced to the 

lifesaving Undo command.

Learn how to find and replace text in your documents.

Work with blocks of text and see how you can mark, 
select, copy, move, and paste blocks.

Customize the spell checker and AutoCorrect settings.

Become familiar with how to preview and print 

documents, both on paper and electronically.
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Chapter 3

To and Fro in a 
Document

C
omputer screens today are larger than those doinky, hot-and-heavy, 

14-inch CRT monitors from ages back. A modern monitor is nice and roomy, 

wide­as­the­wild­west —­but­not­really­that­tall.

Despite its ample real estate, the computer screen can never capture the true 

depth of a Word document. You could orient the monitor vertically, providing you 

have­good­neck­muscles.­Still,­your­written­efforts­most­likely­extend­across­mul-
tiple pages. No, it’s best to employ Word’s various techniques that let you hop, 

skip, and jump around your document hither, thither, and yon.

Document Scrolling

It’s ironic that the word scroll is used when referring to an electronic document. 

The­scroll­was­the­first­form­of­portable­recorded­text,­existing­long­before­bound­
books. On a computer, scrolling is the process by which you view a little bit of a big 

document in a tiny window.

IN THIS CHAPTER

 » Using the scroll bars

 » Moving the insertion pointer

 » Getting around with keyboard 

shortcuts

 » Getting lost and getting back

 » Using the Go To command
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Working the vertical scroll bar

The document portion of the Word program window features a vertical scroll bar, 

illustrated­in­Figure 3-1.­The­scroll­bar’s­operation­is­similar­to­the­scroll­bar­in­
any­Windows­program.­For­a­review,­the­figure­illustrates­the­mouse’s­effect­on­
parts of the scroll bar.

A­key­feature­on­the­scroll­bar­is­the­elevator­button.­(Refer­to­Figure 3-1.)­Use­the­
mouse to drag this button up or down to scroll the document. Its position on the 

scroll­bar­reflects­the­location­of­the­text­you­see.­For­example,­when­the­elevator­
button­is­at­the­top­of­the­scroll­bar,­the­window­shows­text­at­the­start­of­the­
document.

FIGURE 3-1: 
The vertical 

scroll bar.
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 » As you drag the elevator button up or down, you see a page number dis-

played, as shown in Figure 3-1. When a document is formatted with heading 
styles, you also see the heading title below the page number, as shown in 

the figure.

 » The vertical scroll bar may disappear at times; move the mouse pointer over 

the text, and it shows up again.

 » When the elevator button doesn’t show up, or is dimmed, the whole docu-

ment appears in the window.

 » Because the elevator button’s size reflects how much of the document 
appears in the window, the button grows smaller as the document grows 

longer.

 » Using the scroll bar to scroll the document doesn’t move the insertion pointer. 
If you start typing, don’t be surprised when Word jumps back to where the 
insertion pointer lurks.

Using the horizontal scroll bar

When the document is wider than can be displayed in the window, a horizontal 

scroll bar appears. It shows up at the bottom of the document part of the window, 

just­above­the­status­bar.­Use­the­horizontal­scroll­bar­to­shift­the­page­back­and­
forth, left and right.

 » Word automatically slides the document left and right as you type, but this 
movement can be jarring. Instead, try to adjust the horizontal scroll bar to 
display as much of the text as possible. You can also enlarge the document 
window to make it wider on the screen.

 » When the horizontal (left-to-right) shifting bugs you, consider using Word’s 
Zoom tool to adjust the size of the document on the screen. See Chapter 1.

Using the mouse wheel to scroll

The computer mouse’s wheel button scrolls the Word document as it scrolls any 

other window, such as a web page. Roll the wheel to scroll up or down. The direc-

tion the document moves is set in Windows, so I can’t for certain tell you whether 

rolling the wheel up scrolls the document up or down. Just try it to see how it 

works.
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Some mice let you press the wheel button or tilt it from side to side. If so, press 

and hold down the wheel button and drag the mouse forward or backward to 

slowly scroll the document up or down. Tilt the wheel button from side to side to 

pan the document left and right.

 » Unlike using the scroll bars, when you use the mouse wheel to scroll the 
document, the insertion pointer moves with your view. Use the Shift+F5 

keyboard shortcut to return the insertion pointer to the spot where you last 
edited text. See the later section “Return to the Previous Edit.”

 » Be careful not to press the Ctrl key as you use the mouse wheel to scroll. The 
Ctrl+wheel trick zooms a document in and out.

Move the Insertion Pointer

In Word, you can edit any part of the document; you don’t always have to work at 

“the­end.”­The­key­to­pulling­off­this­trick­is­to­know­how­to­move­the­insertion­
pointer­to­the­exact­spot­you­want.

 » Moving the insertion pointer is important! Scientific studies have shown that 
merely looking at the computer screen does no good.

 » New text appears only at the insertion pointer. Text is deleted at the insertion 

pointer’s location. Text is pasted at the insertion pointer. Formatting com-

mands affect text where the insertion pointer lies blinking.

Commanding the insertion pointer

The­easiest­way­to­put­the­insertion­pointer­exactly­where­you­want­it­is­to­click­
the­mouse­at­that­spot­in­the­text.­Point.­Click.­The­insertion­pointer­moves.

If­your­computer­or­laptop­features­a­touchscreen,­tap­the­screen­with­your­finger­
to relocate the insertion pointer.
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Moving in small increments

For short hops, nothing beats using the keyboard’s cursor keys to quickly move 

the­ insertion­ pointer­ around­ a­ document.­ Pressing­ one­ of­ the­ four­ arrow­keys­
moves the insertion pointer up, down, right, or left:

Press This Key To Move the Insertion Pointer

↑ Up to the preceding line of text

↓ Down to the next line of text

→ Right to the next character

← Left to the preceding character

Moving­ the­ cursor­ doesn’t­ erase­ characters.­ See­ Chapter  4­ for­ information­ on­
deleting­stuff.

If­you­press­and­hold­down­the­Ctrl­(Control)­key­and­then­press­an­arrow­key,­the­
insertion pointer moves in larger increments. The invigorated insertion pointer 

leaps desperately one of these four directions:

Press This Key Combo To Move the Insertion Pointer

Ctrl+↑ Up to the start of the previous paragraph

Ctrl+↓ Down to the start of the next paragraph

Ctrl+→ Right to the start (first letter) of the next word

Ctrl+← Left to the start (first letter) of the previous word

You can use either set of arrow keys on the computer keyboard, but when using 

the­numeric­keypad,­ensure­that­the­Num­Lock­light­is­off.­(If­it’s­on,­press­the­
Num­Lock­key.)­If­you­don’t,­you­see­numbers­in­the­text­rather­than­the­insertion­
pointer­dancing­all­over —­like444this.

Moving from beginning to end

The insertion pointer also bows to pressure from those cursor keys without arrows 

on­them.­The­first­couple­consists­of­Home­and­End,­which­move­the­insertion­
pointer­to­the­start­or­end­of­something,­depending­on­how­Home­and­End­are­
used:
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Press This Key or Combination To Whisk the Insertion Pointer

Home To the start of a line of text

End To the end of a line of text

Ctrl+Home To the tippy-top of the document

Ctrl+End To the end of the document

The­remaining­cursor­keys­are­the­Page­Up,­or­PgUp,­key­and­the­Page­Down,­or­
PgDn,­key.­As­you­might­suspect,­pressing­these­keys­doesn’t­move­up­or­down­a­
page in the document. Nope. Instead, they slide you through the document based 

on­the­amount­of­text­visible­in­the­window.­Here’s­the­round-up:

Press This Key 
or Combination To Whisk the Insertion Pointer

PgUp Up one window full of text or to the tippy-top of the document if 
you’re near there

PgDn Down one window full of text or to the end of the document if 
you’re near there

Ctrl+Alt+PgUp To the top of the current window’s text

Ctrl+Alt+PgDn To the bottom of the current window’s text

The­key­combinations­to­move­to­the­top­or­bottom­of­the­current­window’s­text­
are Ctrl+Alt+PgUp­and­Ctrl+Alt+PgDn,­ respectively.­That’s­Ctrl+Alt, not just the 

Ctrl key. And yes, few people know or use these commands.

WHAT ABOUT CTRL+PgUp AND 
CTRL+PgDn?

The Ctrl+PgUp and Ctrl+PgDn key combinations are shortcuts to the Browse Previous 
and Browse Next commands, respectively. Their function changes based on what you’ve 
recently done in Word.

For example, the Ctrl+PgDn keyboard shortcut repeats the Find Next command. It might 
also repeat the Go To command, or a number of other Word commands that move the 
insertion pointer.

Because of their changing behavior, I don’t recommend using Ctrl+PgUp or Ctrl+PgDn 

as a consistent way to move the insertion pointer.
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Return to the Previous Edit

Considering all the various commands for moving the insertion pointer, it’s quite 

possible­ to­make­ a­mistake­ and­not­ know­where­ you­ are­ in­ a­ document —­or­
where you were. Yea, verily, the insertion pointer has boldly gone where no inser-

tion pointer has gone before.

Rather than click your heels together three times, just remember this keyboard 

combination:

Shift+F5

Pressing­the­Shift+F5 keyboard shortcut forces Word to return you to the last spot 

you edited. You can use this keyboard shortcut three times before the cycle repeats. 

The­first­time­should­get­you­back­to­where­you­were­before­you­got­lost.

Sadly, the Shift+F5 keyboard shortcut works only in Word; you can’t use this com-

mand in real life.

Go to Wherever with the Go To Command

Word’s­Go­To­command­allows­you­to­send­the­insertion­pointer­to­a­specific­page­
or line, or to the location of a number of interesting items that Word can poten-

tially cram into a document. The Go To command is your word processing tele-

porter to anywhere.

To use the Go To command, follow these steps:

1. Click the Home tab.

2. In the Editing group, click the Find button and choose Go To.

The Find and Replace dialog box appears with the Go To tab forward, as shown 
in Figure 3-2.

And­now,­the­shortcut:­Press­Ctrl+G to quickly summon the Find and Replace dia-

log­box’s­Go­To­tab.

To­zip­the­insertion­pointer­to­a­specific­location,­choose­it­from­the­Go­to­What­
list.­For­example,­choose­Page­to­visit­a­specific­page.­Type­the­page­number­in­the­
Enter­Page­Number­box,­and­then­click­the­Go­To­button­to­go­to­that­page­in­your­
document.
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 » The Go To command is unavailable in the online version of Word.

 » The Enter Page Number box also accepts relative pages as input. For example, 

to go three pages forward, type +3. To go 12 pages backward, type –12 in 

the box.

 » The last item you chose from the Go to What list affects the behavior of the 
Ctrl+PgUp and Ctrl+PgDn keyboard shortcuts. For example, if you choose 
Page and click the Go To button, the Ctrl+PgUp and Ctrl+PgDn keyboard 
shortcuts navigate through your document a page at a time.

FIGURE 3-2: 
Telling Word  

to Go To 

you-know-where.
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Chapter 4

Text Editing

T
hey­say­that­the­author­Isaac­Asimov­wrote­final­drafts­the­first­time.­If­only­
your­and­my­scrivening­were­perfect­as­the­electronic­words­hit­the­digital­
page.­Word­ processing­ involves­ creating­ text,­ but­ the­ task­ also­ involves­

reviewing­and­editing­your­words.­Yes,­unlike­Asimov,­eventually­you­must­edit­
something­you­wrote.

To­accommodate­text­editing­requirements,­Word­comes­with­a­host­of­commands­
to­chop,­slice,­stitch,­and­otherwise­reassemble­your­text.­These­commands­are­a­
necessary­part­of­word­processing,­and­they­work­best­when­you­have­oodles­of­
text­to­edit.­Therefore,­my­advice­is­to­concentrate­first­on­writing —­then­edit.

One­of­the­reasons­budding­writers­get­stuck­is­that­they­spend­more­time­editing­
than­writing.

Remove Text You Don’t Want

Credit­the­guy­who­put­the­eraser­on­the­end­of­the­pencil:­It’s­a­given­that­human­
beings­make­mistakes.­The­round,­soft­eraser­counterbalances­the­sharp­point­of­
the­pencil­in­many­ways.

IN THIS CHAPTER

 » Deleting characters

 » Deleting lines, sentences, and more

 » Splitting and joining paragraphs

 » Understanding hard and soft returns

 » Undoing your mistakes

 » Using the Redo (Undo-Undo) 

command
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In­Word,­you­use­the­keyboard­to­both­create­and­destroy­text.­The­majority­of­
keys­create­text.­Only­two­keys­destroy:­Backspace­and­Delete.­These­keys­gain­
more­power­when­used­with­other­keys —­and­even­the­mouse —­that­help­them­
to­banish­great­swaths­of­text.

 » As text is deleted, the remaining text on the line, in the paragraph, or on  

the page scoots up to fill the void. Deleting text doesn’t leave a hole in 
the document.

 » Document fields are not deleted like regular text. When you attempt to 
remove a field, Word highlights the field’s text as a warning. To continue and 
remove the field, press either the Delete or Backspace key. See Chapter 23 for 
more information on fields.

Deleting single characters

Press­either­the­Backspace­or­Delete­key­to­delete­single­characters:

 » Backspace deletes the character to the left of the insertion pointer.

 » Delete deletes the character to the right of the insertion pointer.

In­the­following­example,­the­insertion­pointer­is­flashing­(okay,­it­would­be­flash-

ing­on­a­computer­screen)­between­the­v­and­the­i­in­inevitably.­Pressing­the­Back-

space­key­deletes­the­v;­pressing­the­Delete­key­deletes­the­i:

It is inev|itably the duty of people who are in a

hurry to be stuck behind those who are not.

You­can­press­and­hold­down­Backspace­or­Delete­to­machine-gun-delete­charac-
ters.­Release­the­key­to­halt­such­wanton­destruction,­though­I­recommend­that­
you­use­other­delete­commands­(covered­in­this­chapter)­rather­than­ratta-tat-tat 

your­text.

Deleting a word

To­gobble­up­an­entire­word,­press­the­Ctrl­key­with­the­Backspace­or­Delete­key:

 » Ctrl+Backspace deletes the word to the left of the insertion pointer.

 » Ctrl+Delete deletes the word to the right of the insertion pointer.
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These­keyboard­shortcuts­work­best­when­the­insertion­pointer­is­at­the­start­or­
end­of­a­word.­When­the­pointer­is­in­the­middle­of­the­word,­these­commands­
delete­only­from­that­middle­point­to­the­start­or­end­of­the­word.

When­you­use­Ctrl+Backspace­to­delete­a­word­to­the­left,­the­insertion­pointer­sits­
at­ the­ end­ of­ the­ preceding­word­ (or­ paragraph).­When­ you­use­Ctrl+Delete­ to­
remove­a­word,­the­cursor­sits­at­the­start­of­the­next­word.­This­positioning­is­
done­to­facilitate­the­rapid­deletion­of­several­words­in­a­row.

No­mere­pencil­eraser­can­match­Ctrl+Delete­or­Ctrl+Backspace­for­sheer­speed­
and­terror!

Deleting more than a word

To­remove­chunks­of­text­larger­than­a­character­or­a­word,­the­keyboard­must­pal­
up­with­the­mouse.­The­process­involves­selecting­a­chunk­of­text­and­then­delet-
ing­the­chunk.­See­Chapter 6­for­more­information­on­selecting­text.

Be­aware­that­these­text­destruction­methods­do­not­work­in­the­online­version­of­
Word.

Delete a line of text

A­line­of­text­starts­at­one­side­of­the­page­and­moves­to­the­other.­It’s­not­really­
a­sentence­or­a­paragraph,­but­the­line­can­be­removed­easily:

1. Move the mouse pointer into the left margin, next to the line of text.

You know you’ve found the sweet spot when the mouse pointer changes into a 
northeast-pointing arrow.

2. Click the mouse.

The line of text is selected and appears highlighted on the screen.

3. Press the Delete key to send the line into oblivion.

Delete a sentence

A­sentence­is­a­grammatical­thing.­You­know:­Start­with­a­capital­letter­and­end­
with­a­period,­a­question­mark,­or­an­exclamation­point.­You­probably­mastered­
this­grammatical­concept­in­grammar­school,­which­is­why­they­call­it­grammar­
school­anyway.
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Making­a­sentence­go­bye-bye­is­cinchy:

1. Position the mouse pointer at the offending sentence.

2. Press and hold down the Ctrl key and click the mouse.

The Ctrl and mouse-click combination (Ctrl+click) selects a sentence of text.

You can release the Ctrl key.

3. Press the Delete key.

Delete a paragraph

A­paragraph­is­one­or­more­sentences,­or­a­document­heading,­ending­with­a­press­
of­the­Enter­key.­Here’s­the­fastest­way­to­delete­a­full­paragraph:

1. Click the mouse button thrice.

Thrice means “three times.” The triple-click selects a complete paragraph of 
text.

2. Press the Delete key.

Another­way­to­select­a­paragraph­is­to­click­the­mouse­twice­in­the­left­margin,­
next­to­the­paragraph.

Delete a page

A­page­of­text­includes­everything­on­a­page,­top­to­bottom.­This­document-chunk­
isn’t­ something­Word­directly­ addresses­with­ specific­keyboard­ commands.­To­
remove­a­page­full­of­text­requires­some­legerdemain.­Follow­these­steps:

1. Press Ctrl+G.

The Find and Replace dialog box appears, with the Go To tab forward.

2. From the Go to What list, click to select Page.

3. Type the number of the page you want to delete.

For example, type 2 to delete Page 2.

4. Click the Go To button and then click the Close button.

The insertion pointer is positioned at the top of the page.

5. Press the F8 key.

Word enters Extended Selection mode. Now you must send the insertion 
pointer to the top of the next page.

6. Press Ctrl+G to view the Find and Replace dialog box again.
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7. Type the next page number.

For example, type 3 to delete page 2, which you entered in Step 3.

8. Press the Delete key.

All­text­is­removed­from­the­page.

 » If the page remains but it’s blank, you might be dealing with a hard page 
break. See Chapter 13.

 » If you’re trying to delete a blank page at the end of a document, see the 
sidebar in Chapter 9.

 » Chapter 3 offers more information on the Go To command.

 » The F8 key activates Extended Selection mode. See Chapter 6 for more F8 key 
tricks.

Delete an odd-size chunk of text

Word­lets­you­delete­any­old­odd-size­chunk­of­text­anywhere­in­a­document.­The­
key­is­to­select­that­text­as­a­block.­After­the­block­is­marked,­press­the­Delete­key­
to­zap­it­to­kingdom­come.­Refer­to­Chapter 6­for­more­information­on­selecting­
blocks­of­text.

Split and Join Paragraphs

A­paragraph­is­both­an­English­grammatical­entity­and­a­Word­formatting­con-

cept.­ In­English,­ a­ paragraph­ is­ a­ basket­ of­ sentences­ that­ collectively­ express­
some­thought,­idea,­or­theme.­In­Word,­a­paragraph­is­a­chunk­of­text­that­ends­
when­you­press­the­Enter­key.­While­grammarians­and­software­engineers­duke­it­
out­over­the­different­meanings,­you­can­redefine­a­paragraph­in­a­document­by­
splitting­or­joining­text.

Making two paragraphs from one

To­split­a­single­paragraph­in­twain,­follow­these­steps:

1. Click the mouse at the point where you want the new paragraph to 

begin.

Ideally, that point is at the start of a sentence.
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2. Press the Enter key.

Word splits the paragraph in two; the text above the insertion pointer becomes 
its own paragraph, and the text following it then becomes the next paragraph.

Depending­on­how­the­paragraph­was­torn­asunder,­you­may­need­to­delete­an­
extra­space­lingering­at­the­end­of­the­first­paragraph­or­dawdling­at­the­start­of­
the­next.

Making one paragraph from two

To­join­two­paragraphs­and­turn­them­into­one,­follow­these­steps:

1. Place the insertion pointer at the start of the second paragraph.

Use the keyboard to position the insertion pointer, or click the mouse.

2. Press the Backspace key.

The Enter character from the preceding paragraph is removed, which joins two 
paragraphs into one.

Depending­ on­ how­neatly­ the­ paragraphs­were­ joined,­ you­may­need­ to­ add­ a­
space­between­the­sentences­at­the­spot­where­the­paragraphs­are­thrust­together.

Soft and Hard Returns

Word­defines­a­paragraph­as­a­chunk­of­text­ending­with­a­hard­return­character.­
You­press­the­Enter­key­to­generate­this­character.­The­paragraph­ends,­and­then­
a­new­paragraph­starts.­And­so­it­goes­throughout­the­document.

You­can­end­a­line­of­text­without­ending­the­paragraph­by­typing­a­soft return,­also­
known­as­a­manual­line­break.­To­do­so,­press­Shift+Enter.­The­current­line­of­text­
stops­and­the­insertion­pointer­hops­to­the­start­of­the­next­line.­Keep­typing­at­
that­point­and,­eventually,­press­Enter­to­end­the­paragraph.

The­soft­return­is­best­used­to­split­titles­and­headings.­Using­a­soft­return­is­also­
the­secret­behind­ typing­an­address.­By­ending­each­ line­with­Shift+Enter,­you­
keep­the­address­text­together­as­a­single­paragraph.­For­example,­the­following­
address­is­a­single­paragraph­with­soft­returns­separating­each­line:
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Mr. President

1600 Pennsylvania Ave.

Washington, DC 20500

To­help­you­identify­hard­returns­and­soft­returns,­use­the­Show/Hide­command:­
Click­the­Home­tab­and,­in­the­Paragraph­group,­click­the­Show/Hide­command­
button.­The­button­is­adorned­with­the­Paragraph­symbol­(¶).

When­the­Show/Hide­command­is­active,­the­soft­return­appears­as­a­right-angle­
arrow,­which­looks­like­the­symbol­found­on­the­keyboard’s­Enter­key:­↲

The­hard­return­appears­as­the­paragraph­mark:­¶

Here­is­how­the­same­address­appears­with­the­Show/Hide­command­active:

Mr. President

1600 Pennsylvania Ave.

Washington, DC 20500¶

The­ Show/Hide­ command­ can­ also­ help­ identify­ weird­ formatting­ in­ the­ text.­
Refer­to­Chapter 2­for­more­details.

Though­soft­returns­keep­text­close,­the­text­is­still­affected­by­the­paragraph’s­
line­spacing.­See­Chapter 11­for­more­information­on­paragraph­formatting.

Undo Mistakes with Undo Haste

That quafÏng and drinking will undo you.
—­RICHARD­II,­WILLIAM­SHAKESPEARE

The­Undo­command­undoes­anything­you­do­in­Word,­which­includes­formatting­
text,­moving­blocks,­typing­and­deleting­text —­the­whole­enchilada.­You­have­
two­handy­ways­to­unleash­the­Undo­command:

 » Press Ctrl+Z.

 » Click the Undo command button on the Quick Access toolbar.
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I­prefer­using­the­Ctrl+Z­key­combination,­but­an­advantage­of­the­Undo­command­
button­is­that­it­sports­a­drop-down­menu­that­helps­you­review­the­past­several­
actions­you’ve­taken,­which­can­be­undone.

 » Regrettably, you cannot pick and choose from the Undo command  
button’s drop-down menu; you can merely undo multiple actions with a 
single command.

 » Word warns you should you attempt an action that cannot be undone. For 
example, you see a message such as “There is not enough memory to undo 
this operation.” Proceed at your own peril.

 » The Undo command doesn’t work when you have nothing to undo or 
something simply cannot be undone. For example, you cannot undo a 
document save.

Undoing the Undo command with Redo

If­you­undo­something­and —­whoops! —­you­didn’t­mean­it,­use­the­Redo­com-

mand­to­set­things­back­to­the­way­they­were.­For­example,­you­may­type­some­
text­and­then­use­Undo­to­“untype”­the­text.­You­can­then­use­the­Redo­command­
to­restore­the­typing.­You­have­two­choices:

 » Press Ctrl+Y.

 » Click the Redo command button on the Quick Access toolbar.

The­Redo­ command­does­ exactly­ the­opposite­ of­whatever­ the­Undo­ command­
does.­So,­if­you­type­text,­Undo­untypes­the­text­and­Redo­recovers­the­text.­If­you­
use­Undo­to­recover­deleted­text,­Redo­deletes­the­text­again.

Using the Repeat command

When­ the­ Redo­ command­ has­ nothing­ left­ to­ redo,­ it­ changes­ functions­ and­
becomes­the­Repeat­command.­On­the­Quick­Access­toolbar,­the­command­button­
changes­as­shown­in­the­margin.­The­Repeat­command’s­duty­is­to­repeat­the­last­
thing­you­did­in­Word,­whether­it’s­typing­text,­applying­a­format,­or­carrying­out­
a­variety­of­other­activities.

Lamentably,­you­can’t­use­the­Repeat­command­to­ease­your­typing­chores.­That’s­
because­it­repeats­only­the­last­single­character­you­typed.

The­keyboard­shortcut­for­the­Repeat­command­is­Ctrl+Y,­the­same­as­the­Redo­
command.
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Chapter 5

Search for This, Replace 
It with That

L
ittle Bo Peep has lost her sheep. Too bad she doesn’t know about Word’s Find 
and­Replace­commands.­She­could­find­the­misplaced­ruminants­in­a­matter­
of nanoseconds. Not only that, she could use search-and-replace to, say, 

replace all the sheep with real estate. It’s all cinchy after you understand and use 
the various Find and Replace commands. Sadly, it’s only words that are replaced. 
True, if Word could search-and-replace real things, there’d be fewer sheep in the 
world.

Text Happily Found

Finding text is one of the most basic and ancient tools available in a word proces-
sor. The only issue has been whether the command is called Find or Search. The 
terms Relentlessly Hunt Down and Fiendishly Locate were never considered.

IN THIS CHAPTER

 » Finding text in a document

 » Using special text-finding options

 » Locating entire words

 » Searching for text that cannot be 

typed at the keyboard

 » Hunting down formatting codes

 » Replacing found text with other text
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 » In Word, finding duties are split between the traditional Find dialog box and 
the navigation pane.

 » The online version of Word has only a single Find command, which is far more 
limited than the protgram version. Press the Ctrl+F key to activate it.

Finding a tidbit o’ text

Don’t­bother­with­the­Ribbon!­To­find­text­in­a­document,­press­Ctrl+F, the mem-
orable keyboard shortcut for the Find command. You see the navigation pane, 
similar­to­what’s­shown­in­Figure 5-1.

In the Search Document box, type the text you want to locate. As you type, instances 
of the text are highlighted in the document. In-context chunks of text appear in 
the­navigation­pane­under­ the­Results­heading,­ as­ illustrated­ in­ ­Figure 5-1.­To­
peruse found text, use the up and down arrows in the navigation pane or click a 
snippet to view that particular part of the document.

FIGURE 5-1: 
The navigation 

pane.
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When­text­can’t­be­found,­the­navigation­pane­explains­that­it­can’t­find­the­text.­
And if too many tidbits of text are found, previews don’t appear in the navigation 
pane,­which­I­find­disappointing.

 » To clear text from the Search Document box, click the X button found at the 
right end of the box.

 » Do not end the text with a period unless you want to find the period, too. 
Word’s Find command is persnickety.

 » Word finds text only in the current document (the one you see in the window). 
To find text in another document, switch to that document’s window and try 
searching again. Or, you can use the Find command in Windows, which is too 
messy to cover in this book.

Scouring your document with 
Advanced Find

The navigation pane is a handy tool for locating text. In fact, I keep it open for all 
my documents. When it comes to exercising some Find command muscle, however, 
you­must­turn­to­a­more­specific­tool,­the­traditional­Find­dialog­box.­It’s­now­called­
the­Find­and­Replace­dialog­box,­and­its­enlarged­view­is­illustrated­in­Figure 5-2.

FIGURE 5-2: 
The Find and 

Replace 
dialog box.



54      PART 2  Your Basic Word

Follow these steps to conjure forth the Find and Replace dialog box:

1. Click the Home tab.

2. In the Editing group, choose Find ➪   Advanced Find.

The Find and Replace dialog box appears, with the Find tab forward. You may 
see only the top part of the dialog box. So:

3. Click the More button to reveal the dialog box’s powerful bits.

What you see now appears just like Figure 5-2.

4. Type the search text in the Find What text box.

5. Use the dialog box’s controls to make further adjustments.

Examples for using the various controls are found throughout this chapter.

6. Click the Find Next button to locate the text.

Once the text is found, you can do whatever to it: Edit it, change it, or click the 
Find Next button to continue looking for text.

After the Find command has scoured the entire document, you see an info box 
explaining­that­the­search­is­finished.­Click­OK,­and­then­click­the­Cancel­button­
to dismiss the Find and Replace dialog box.

Options set in the Find and Replace dialog box remain set until deactivated. When 
you can’t seem to locate text that you know is in a document, review the dialog 
box’s­settings.­Turn­off­the­settings­you­no­longer­need.

Find case-sensitive text

When­you­want­to­find­Pat­in­your­document,­the­Find­command­must­know­the­
difference­between­Pat and pat. One is a name, and the other is to lightly touch 
something. To locate one and not the other, use the Find and Replace dialog box. 
(Refer­to­Figure 5-2.)­Select­the­Match­Case­option­under­Search­Options.­That­
way, Pat matches only words that start with an uppercase P.

Find a whole word

Word’s Advanced Find command can locate Pat and not pat,­but­it­might­also­flag­
the word Pattern at the start of a sentence. To avoid that situation, select the Find 
Whole Words Only option.
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Find word variations

Two­options­in­the­Find­and­Replace­dialog­box­assist­you­with­finding­words­that­
may not be exactly what you’re looking for.

The­Sounds­Like­(English)­option­allows­you­to­search­for­homonyms, or words 
that sound the same as the search word. These words include their and there, deer 
and dear, and hear and here. The command doesn’t, however, locate rhyming 
words.

The­Find­All­Word­Forms­(English)­option­expands­the­search­to­include­different­
forms of the same word. With this option set, you can search for the word hop and 
also­find­matches­with­hops, hopped, and hopping.

Search this way or that

The Find command searches from the insertion pointer’s position to the end of a 
document and then back ’round the top again. To override its sense of direction, 
use­the­Search­drop-down­list,­as­illustrated­earlier,­in­Figure 5-2.­You­see­these­
three options:

 » Down: The Find command searches from the insertion pointer’s location to 
the end of the document, and then it stops.

 » Up: The Find command searches from the insertion pointer’s location to the 
start of the document. Then it stops.

 » All: The Find command searches the entire document, from the insertion 
pointer’s location down to the end of the document and back up to the 
beginning, and then stops at the point where the search began.

You­can­use­keyboard­shortcuts­to­search­up­or­down.­The­Ctrl+PgDn key combi-
nation­repeats­the­last­search­downward;­the­Ctrl+PgUp key combination repeats 
the most recent search upward. These keyboard shortcuts can change the func-
tion, so keep in mind that they only repeat a search immediately after you’ve 
initiated a search.

Finding stuff you can’t type
The Find command is brilliant enough to locate items in your document such as 
tab characters or text colored red. The puzzle is how to input this type of informa-
tion in the Find and Replace dialog box. Seriously, try it: Type text that is colored 
red in the Find What box. You can’t!
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The secret is to use the Format and Special buttons, lurking near the bottom of the 
dialog­box.­(Refer­to­Figure 5-2.)

Find special characters

To hunt down special characters in a document, such as a tab or Enter key press, 
click the Special button in the Advanced Find dialog box. Up pops a list of 22 items 
that Word can search for but that you would have a dickens of a time typing in the 
Find and Replace dialog box.

Despite­the­exhaustive­list,­here­are­the­few­items­you­may­find­handy:

 » Any Character, Any Digit, and Any Letter are options that represent, well, 
just about anything. These items can be used as wildcards for matching 
lots of stuff.

 » Caret Character allows you to search for a caret (^) symbol, which may not 
seem like a big deal, but it is: Word uses the ^ symbol in a way to find special 
text. See the Technical Stuff paragraph at the end of this section.

 » Paragraph Mark (¶) is a special character that’s the same as the Enter 
character — the one you press to end a paragraph.

 » Tab Character moves the insertion pointer to the next tab stop.

 » White Space is any number of blank characters: one or more spaces, tabs, 
empty lines, or a combination thereof.

Choose­an­item­from­the­list­to­search­for­that­special­character.­When­you­do,­a­
special, funky shorthand representation of that character appears. The shorthand 
involves the ^ character and then another character, such as ^t to search for the 
tab character.

If you’re a nerd, you can quickly type special characters manually. Popular options 
are­^p­for­the­paragraph­mark­(Enter­key­press),­^t­for­a­tab,­^w­for­white­space,­
and ^? for any character. These symbols may not make much sense, but if you’re 
a nerd, you won’t care.

Find formatting

In its most powerful superhero mode, the Find command can scour a document 
for text and formatting. You can search for the formatting information itself or 
use­it­with­text­to­locate­specifically­formatted­text.

The secret to hunting down text formats is to use the Format button, found at the 
bottom­of­the­Find­and­Replace­dialog­box,­as­shown­earlier,­in­Figure 5-2.­Click­
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this button to view a menu full of formatting categories, such as Font, Paragraph, 
and­Tabs.­Choose­a­category­to­pluck­out­a­specific­format.

Suppose­that­you­want­to­find­the­text­red herring in your document. The text is 
italicized and colored red. Follow these steps:

1. Click the Home tab.

2. In the Editing group, choose Find ➪   Advanced Find.

The Find and Replace dialog box appears.

3. Type the text you’re searching for.

In this example, that would be red herring.

4. Ensure that the dialog box details are displayed; click the More button, if 

necessary.

5. Click the No Formatting button to remove any previously applied 

formatting.

The No Formatting button is available when you’ve previously searched for 
format attributes.

6. Click the Format button and choose Font from the pop-up list.

The Find Font dialog box appears

7. Choose Italic as the font style.

8. Select Red from the Font Color menu.

Yes, many shades of red dwell on the menu.

9. Click OK.

The Find Font dialog box goes away and you return to the Find and Replace 
dialog box. Below the Find What text box appears the search format. It lists 
which attributes the Advanced Find command is looking for.

10. Click the Find Next button to locate the formatted text.

If you want to search only for a format, leave the Find What text box blank. (Refer 
to­Step­3.)­This­way,­you­can­search­for­formatting­attributes­without­regard­to­
text.
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 » The Find command remembers your formatting options! The next time you 
want to search for plain text, click the No Formatting button. (Refer to Step 5.) 
Doing so removes the formatting attributes and allows you to search for text 
in any format.

 » Word’s Find and Replace command is powerful enough that it can find and 
replace text formats. Details on performing this magic are found in my book 
Word 2016 For Professionals For Dummies (Wiley).

Replace Found Text

When­you­want­to­find­text­and­replace­it­with­new­text,­summon­the­Find­com-
mand’s powerful companion, Find and Replace. This is the command Little Bo 
Peep uses to establish her real estate empire, transforming all those useless sheep 
into vast land holdings.

To globally change all instances of text throughout the document, follow these 
steps:

1. Click the Home tab.

2. In the Editing group, click the Replace command button.

If you don’t see the Replace command button directly, click the Editing button 
to find it.

Choosing the Replace command button summons the Find and Replace dialog 
box with the Replace tab forward, shown in Figure 5-3.

3. In the Find What box, type text you want to replace.

For example, if you’re finding coffee and replacing it with tea, type coffee.

FIGURE 5-3: 
The Replace tab 
in the Find and 

Replace 
dialog box.
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4. In the Replace With box, type the replacement text.

To continue from the example in Step 3, you type tea here.

5. Click the Find Next button.

At this step, the Replace command works just like the Find command: Word 
scours your document for the text you typed in the Find What box. If the text is 
found, it’s selected on the screen; proceed with Step 6. If nothing is found, start 
over again with Step 3 — or just abandon your efforts and close the dialog box.

6. Click the Replace button.

The found text (selected) is replaced.

7. Repeat Steps 5 and 6 until all the text is replaced.

Or you can click the Replace All button to search-and-replace the text through-
out the document in a single step.

Just­as­you­can­search­for­specific­text­and­formatting,­you­can­find­and­replace­it.­
The­secret­is­to­use­the­More­button,­shown­in­Figure 5-3.­For­example,­you­can­
choose­to­find­an­entire­word,­which­avoids­finding­use in causes. Refer to the sec-
tion “Scouring your document with Advanced Find,” earlier in this chapter. The 
options are set individually to either the Find What or Replace With text boxes.

 » If you don’t type anything in the Replace With box, Word replaces your text 
with nothing! It’s wanton destruction! Still, it may be something you need. For 
example, to search for extra tabs in a document and remove them: Search for 
two tabs (^t^t) and replace them with a single tab (^t). Refer to the earlier 
section “Find special characters” for details on typing the tab character into 
the Find What and Replace With text boxes.

 » Speaking of wanton destruction, the Undo command restores the document 
to its preceding condition if you foul up the Replace operation. See Chapter 4 
for more information.

 » For a large document, Word may inform you that it cannot undo a document-
wide Replace All operation.

 » The keyboard shortcut for the Replace command is Ctrl+H. The only way I can 
figure that one out is that Ctrl+F is the Find command and Ctrl+G is the Go To 
command. F, G, and H are found together on the computer keyboard, and 
Find, Replace, and Go To are found together in the Find and Replace dialog 
box. Go figure.

 » The Find and Replace command can also locate specific text formatting and 
remove it or replace it with new formatting. This advanced topic is covered in 
my book Word 2016 For Professionals For Dummies (Wiley).
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Chapter 6

Blocks o’ Text

W
riting is about blocks, from the moveable printing blocks used by the 
ancient Chinese to the universal writer’s block. In word processing, the 
word blocks refers to selected chunks of text in a document, which  

I­believe­you’ll­find­more­useful­to­your­productivity­than­the­other­types­of­blocks.

Meet Mr. Block

“Hello, Mr. Block! What do you do?”

“Well! I’m a block of text. I have a beginning and an end. I can be any size, from a 
single character to the entire document.”

To create Mr. Block in a document, you select text. You can use the keyboard. You 
can use the mouse. You can use both at once or employ some of Word’s more eso-
teric text-selection commands.

A block of selected text appears highlighted in a document, similar to what’s 
shown­in­Figure 6-1.

IN THIS CHAPTER

 » Understanding blocks of text

 » Marking a block with the keyboard

 » Selecting text with the mouse

 » Using the F8 key to mark text

 » Unblocking text

 » Copying and moving blocks of text

 » Pasting text in various ways
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Once­a­block­of­text­is­selected,­you­can­perform­certain­actions­that­affect­only­
the text within the block. You can format, copy, move, or delete the block.

To help format a selected block of text, the mini toolbar appears. This pop-up 
thingie hosts popular commands found on the Ribbon, allowing you to quickly 
format­the­block­of­text.­The­mini­toolbar­on­the­left­in­Figure 6-2­appears­any-
time text is selected. The mini toolbar on the right is summoned anytime you 
right-click in the document.

 » A block of text in Word includes text and text formatting.

 » Graphics and other non-text elements can also be selected as a block. In fact, 

you can select graphics along with text in the same block.

 » When the status bar is displaying word-count statistics, the number of words 

selected in the block of text is displayed next to the total number of words in 

the document. (Refer to Figure 6-1.)

 » When the Find command locates text, the found text is selected as a block. 

Refer to Chapter 5 for more information on the Find command.

 » The mini toolbar disappears after a few moments of neglect. Refer to 

Chapter 33 for information on disabling the mini toolbar.

 » Selecting text also means selecting invisible characters such as the tab or the 

Enter character, which marks the end of a paragraph. Word shows the Enter 

character as an extra blank space at the end of a paragraph. When you select 

this blank, you select the entire paragraph as a block. To avoid selecting the 

Enter character, don’t select the blank space at the end of a paragraph.

FIGURE 6-1: 
A block of text is 

selected.
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Mark a Block of Text

Before you can work with a block of text, you must tell Word where the block starts 
and where it ends. The process is known as marking or selecting a block of text.

Using the keyboard to select text

You can use the keyboard’s cursor keys to select text, but only when you know the 
secret: Press and hold down the Shift key as you move the cursor. While the Shift 
key is down, Word’s standard cursor-key commands not only move the insertion 
pointer­but­also­select­chunks­of­text.­Table 6-1­lists­common­key­combinations.

FIGURE 6-2: 
The mini toolbar 

and the block 

pop-up menu.

TABLE 6-1 Keyboard Selection Wizardry

To Select This Press This

A character at a time to the left of the insertion pointer Shift+←

A character at a time to the right of the insertion pointer Shift+→

A block of text from the insertion pointer to the beginning of the line Shift+Home

A block of text from the insertion pointer to the end of the line Shift+End

A block of text from the insertion pointer to a line above Shift+↑

A block of text from the insertion pointer to a line below Shift+↓
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Though you can use any keyboard cursor-movement command, including some 
that move the insertion pointer a great distance, I recommend using this Shift key 
technique for selecting only small chunks of text. Otherwise, you may end up 
tying­your­fingers­into­knots.

 » See Chapter 3 for the full list of Word’s cursor key commands.

 » Either Shift key works, although I prefer to use the left Shift key and then work 

the arrow keys on the right side of the keyboard.

Marking a block with the mouse

Mickey may rule a kingdom, but your computer’s mouse rules over text selection 
in your computer.

Drag over text to select it

Position the mouse pointer at the start of the text block, and then drag the mouse 
over the text you want to select. As you drag, the text becomes highlighted or 
selected.

 » This technique works best when you use the mouse to drag over only the text 

you can see on the screen. When you try to select text beyond what you see 

on the screen, you have to select and scroll, which can be unwieldy.

 » Using the mouse to select text in a table is funky. See Chapter 19.

 » Also see Chapter 33, which covers how to adjust Word so that you can use the 
mouse to select individual letters as opposed to entire words at a time.

Click the mouse to select text

A­speedy­way­to­select­specific­sizes­of­chunks­of­text­is­to­match­the­power­of­the­
mouse­ with­ the­ dexterity­ of­ your­ index­ finger.­ Table  6-2­ explains­ some­ 
clicking-and-selecting techniques worth noting.
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Select text with the old poke-and-point

Here’s the best way to select a chunk of text of any size, especially when that 
chunk of text is larger than what you can see on the screen at one time:

1. Click the mouse to set the insertion pointer wherever you want the block 

to start.

I call this location the anchor point.

2. Scroll the document.

You must use the scroll bar or the mouse wheel to scroll the document. If you 

use the cursor-movement keys, you reposition the insertion pointer, which isn’t 

what you want.

3. Hold down the Shift key and click the mouse wherever you want the 

block to end.

The text from the insertion pointer to wherever you clicked the mouse is 

selected as a block.

Using the F8 key to mark a block

A relic from the old days, the F8 key activates Word’s Extend Selection command. 
Press this key to “drop anchor” at the insertion pointer’s location. Then use either 
the mouse or the cursor keys to select text. In fact, you cannot do anything but 
select text when Extend Selection mode is active.

TABLE 6-2 Mouse Selection Arcana

To Select This 
Chunk of Text Click the Mouse Thusly

A single word Double-click the word.

A line Move the mouse pointer into the left margin beside the line you want to select. The 
mouse pointer changes to an arrow pointing northeastward. Click the mouse to 
select a line of text. Drag the mouse up or down to select several lines.

A sentence Position the insertion pointer over the sentence and Ctrl+click. (Press the Ctrl key and 
click the mouse.)

A paragraph Point the mouse somewhere in the paragraph’s midst and click thrice (triple-click).
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To exit Extend Selection mode, you can either do something with the block of text 
or press the Esc key to cancel.

 » To help you with the F8 key and Extend Selection mode, right-click the status 

bar and choose the Selection Mode item. The text Extend Selection appears on 

the status bar whenever this mode is active.

 » Not only can you use the cursor keys while in Extend Selection mode — any of 
the character keys works as well. Text is selected from the anchor point to the 

character you type. Type an N, for example, and all text between the insertion 

pointer and the next letter N is selected.

 » You can also use the Find command to locate a specific bit of text in Extend 
Selection mode. Word marks all text between the anchor and the text that the 

Find command locates.

 » Press the F8 key twice to select the current word.

 » Press the F8 key thrice (three times) to select the current sentence.

 » Press the F8 key four times to select the current paragraph as a block of text.

 » Press the F8 key five times to select the entire document, from top to bottom.

 » No matter how many times you press F8, be aware that it always drops 

anchor. Whether you press F8 once or five times, Word is still in Extend 
Selection mode. Do something with the block or press Esc to cancel this 

mode.

Blocking the whole dang-doodle document

The­biggest­block­you­can­mark­is­an­entire­document.­Word­has­a­specific­com-
mand to do it. Follow these steps:

1. Click the Home tab.

2. In the Editing group, choose Select ➪ Select All.

The entire document is marked as a single block o’ text.

And now, the keyboard shortcut: Press Ctrl+A to select an entire document as a 
block.
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Deselecting a block

When you mark a block of text and change your mind, you must unmark, or dese-
lect, the text. Here are a few handy ways to do it:

 » Move the insertion pointer. It doesn’t matter how you move the insertion 

pointer, with the keyboard or with the mouse, but doing so deselects the 

block. (This trick doesn’t work when you use the F8, Extend Selection, key to 

select text.)

 » Press the Esc key and then the @@la. This method works to end Extend 

Selection mode.

 » Press Shift+F5. The Shift+F5 key combo (refer to Chapter 3) is the “go back” 
command, but it also deselects a block of text and returns you to the text you 

were editing before making the selection.

Manipulate a Block of Text

You can block punches, block hats, block and tackle, play with building blocks and 
engine­blocks,­take­nerve­blocks,­suffer­from­mental­blocks,­jog­for­blocks,­and,­
naturally, block text. But what can you do with those marked blocks of text?

Why, plenty of things! You can apply a format to all text in the block, copy a block, 
move a block, search for text in a block, proof a block, print a block, and even 
delete a block. The information in this section explains a few of those tricks.

 » Blocks must be selected before you can manipulate them. See the first half of 
this chapter.

 » When a block of text is marked, various Word commands affect only the text 
in that block.

 » To replace a block, type some text. The new text (specifically, the initial 
character) replaces the entire block.

 » To delete a block, press the Delete or Backspace key. Thwoop! The block 

is gone.

 » Formatting commands can be applied to any marked block of text —   
specifically, character and paragraph formatting. See Part 3 of this book.

 » Also see Chapter 32 for information on Word’s bizarre yet potentially useful 
Collect and Paste feature.
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Copying a block

After a block is marked, you can copy it to another part of the document. The 
original block remains untouched by this operation. Follow these steps to copy a 
block of text from one place to another:

1. Mark the block.

Detailed instructions for completing this task are offered in the first half of this 
chapter.

2. Click the Home tab.

3. In the Clipboard group, click the Copy command button.

You get no visual clue that the text has been copied; it remains selected.

4. Click to set the insertion pointer at the position where you want to place 

the block’s copy.

Don’t worry if it looks like the text won’t fit! Word inserts the block into the text.

5. Click the Paste command button.

The block of text is inserted into your text just as though you had typed it there 
by yourself.

The keyboard shortcuts for the copy and paste actions are Ctrl+C and Ctrl+V, 
respectively. You’ll probably use these keyboard shortcuts more than the com-
mand buttons in the Home tab’s Clipboard group.

 » See the later section “Setting the pasted text format” to discover various ways 
you can paste text into a document.

 » The Paste command continues to paste the copied text, over and over — that 
is, until new text is selected and copied (or cut). Pasting text again simply 
pastes down a second copy of the block, spit-spot (as Mary Poppins would 

say).

 » You can paste a copied block into another open Word document or even into 

another application. This is a Windows trick that works in any program that 

accepts text as input.

Moving a block

To move a block of text, you select the text and then cut and paste. This process is 
almost the same as copying a block, described in the preceding section, although 
in Step 3 you choose the Cut command button (shown in the margin) or press 
Ctrl+X on the keyboard. Otherwise, all steps are the same.
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Don’t be alarmed when the selected block of text vanishes! This result is cutting 
in action; the block of text is being moved, not copied. You see the block of text 
again when you paste it.

If you screw up, the Ctrl+Z Undo shortcut undoes a block move.

Setting the pasted text format

When you paste text in Word, you may see the Paste Options icon appear, as shown 
in the margin. This button allows you to select formatting to apply to the pasted 
block. For example, you can choose to retain the formatting as pasted, choose to 
paste in the text plain and unformatted, or choose to have the pasted text match 
the style of the text around it.

To work the Paste Options button, click it with the mouse or press and release the 
Ctrl­key­on­the­keyboard.­You­see­a­menu­of­options,­illustrated­in­Figure 6-3.

Table 6-3­summarizes­some­of­the­common­paste­options.

For example, to keep only text with a copied or cut block (no formatting), press 
the Ctrl key and then tap the T key after pasting. These are two separate keys, not 
Ctrl+T.

Using the Paste Options icon is utterly optional. In fact, you can continue typing 
or working in Word and the icon bows out, fading away like some nebbish who 
boldly asked a power blonde to go out with him and she utterly failed to recognize 
his existence. Like that.

FIGURE 6-3: 
Pasting options.
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 » Click the Set Default Paste text to direct Word to permanently deal with 

pasted text. It’s a handy trick, especially when you find yourself repeatedly 
choosing the same Paste Options format.

 » The items on the Paste Options icon — and more — are also found on the 
Paste button menu, located on the Home tab in the Clipboard group.

 » You can control whether the Paste Options icon appears after pasting text: 

Click the File tab and choose Options to summon the Word Options dialog 

box. Choose Advanced. In the Cut, Copy, and Paste area, add or remove the 

check mark by the option Show Paste Options Button When Content Is Pasted 

to show or hide the icon, respectively.

Using the mouse to copy or move a block

When you need to move a block only a short distance, you can use the mouse to 
drag-move or drag-copy the block.

To move any selected block of text, hover the mouse pointer anywhere in the 
blocked text and then drag the block to its new location. As you drag the block, the 
mouse­pointer­changes,­as­shown­in­the­margin.­This­mouse­pointer­modification­
means that you’re moving a block of text.

TABLE 6-3 Paste Option Options

Icon Keyboard Shortcut Name Description

K Keep Source Formatting The formatting is okay; don’t do a thing.

M Merge Formatting Reformat the pasted block so that it 
matches the text it’s being pasted into.

U Paste Picture Paste in a graphical image of the text.

T Keep Text Only Just paste in the text — no formatting.
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To­copy­a­block­of­text,­point­the­mouse­pointer­at­the­block —­just­as­though­you­
were­going­to­move­the­block —­but­press­and­hold­down­the­Ctrl­key­as­you­drag.­
When you drag the block, the mouse pointer changes to resemble the icon shown 
in­the­margin.­This­change­is­your­clue­that­the­block­is­being­copied­and­not­just­
moved.

The mouse move/copy trick works best when you’re moving or copying a block to 
a location you can see right on the screen. Otherwise, you’re scrolling the docu-
ment with the mouse while you’re playing with blocks, which is like trying to grab 
an angry snake.

 » When you drag a block of text with the mouse, you’re not copying or cutting it 

to the Clipboard. You cannot use the Paste (Ctrl+V) command to paste the 
dragged block again.

 » To create a linked copy of the block, drag the mouse and hold down both the 

Shift and Ctrl keys. When you release the mouse button, the copied block 

plops down into your document with a dark highlight. It’s your clue that the 

copy is linked to the original; changes in the original are reflected in the copy 
and vice versa. If the linked copy doesn’t update, right-click the text and 

choose the Update Link command.

Viewing the Clipboard

All text you copy or cut is stored in a location called the Clipboard —­the­standard­
cut-copy-paste holding bin for text in Windows. In Word, however, the Clipboard 
is­more­powerful­than­in­other­Windows­programs.­Specifically,­you­can­use­the­
Clipboard task pane to examine items cut or copied, and then paste them again in 
your document in any order.

To copy a chunk of text from the task pane to a document, heed these steps:

1. Place the insertion pointer in the document where you want the pasted 

text to appear.

2. Click the Home tab.

3. In the Clipboard group, click the dialog box launcher.

You see the Clipboard task pane, along with all text cut or copied since you’ve 

started the Word program, similar to what’s shown in Figure 6-4.

4. Click an item to paste its contents into the document.
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Unlike using the Ctrl+V keyboard shortcut or the Paste button on the Ribbon, you 
can paste text from the Clipboard in any order, and even summon text you copied 
or­cut­hours­ago­or­text­you­copied­or­cut­from­other­Microsoft­OfÏce­programs.­
(See­the­Excel­item­in­Figure 6-4?)

Also­see­Chapter 32­for­information­on­using­the­Collect­and­Paste­feature,­which­
takes advantage of the Clipboard task pane.

FIGURE 6-4: 
The Clipboard 

task pane.
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Chapter 7

Spell It Write

S
pelling in English really wasn’t a thing until Noah Webster published his 
dictionary. Suddenly, busybodies had another reason to criticize you: Your 
spelling wasn’t up to Webster’s standard. And though Mark Twain wrote 

that he pitied the man who knew only one way to spell a word, Webster has pre-
vailed. Spelling matters. Grammar does, too. For these reasons, Word features 
document­proofing,­a­feature­that’s­automatic­and­irritating­at­the­same­time.

Check Your Spelling

Word’s­ Spell­ Check­ feature­ works­ the­ second­ you­ start­ typing.­ Offending­ or­
unknown words are immediately underlined with the red zigzag of shame. Leave 
the word be, correct it, or add it to your own dictionary just to spite Mr. Webster.

 » Spell checking works thanks to a digital dictionary stocked with zillions of 

words, all spelled correctly. Every time you type a word, it’s checked against 

this dictionary. When the word isn’t found, it’s marked as suspect in 

the document.

IN THIS CHAPTER

 » Dealing with typos and spelling errors

 » Checking AutoCorrect settings

 » Fixing grammatical boo-boos

 » Adding or ignoring unknown words

 » Correcting words automatically

 » Reviewing your document

 » Customizing proofing options
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 » Don’t let the red zigzag of a failed elementary education perturb you. My 

advice is to keep typing. Focus on getting your thoughts on the page. Go back 

later to fix the inevitable typos.

 » The Spell Check feature also flags repeated words by underlining them with a 
red zigzag. Your choice is to either delete the repeated word or just ignore 

ignore it.

 » Word doesn’t spell-check certain types of words, such as words with numbers 

in them or words written in all capitals.

 » To disable automatic spell checking, see the later section “Document Proofing 
Settings.”

 » An alternative to on-the-fly spell checking is to perform a manual spell check. 
See the later section “All-at-Once Document Proofing.”

Fixing a misspelled word

Don’t let that red zigzag of shame vex you any longer! Follow these steps when 
you see it:

1. Click the misspelled word.

Up pops a shortcut menu, with the spelling issue highlighted and alternatives 

suggested, as shown in Figure 7-1.

2. From the menu, choose the proper word.

In Figure 7-1, the word deadlines fits the bill. Click that word to replace the 
spurious word.

FIGURE 7-1: 
Deal with  

that typo.
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If the word you intended to type isn’t on the list, don’t fret: Just take another stab 
at­spelling­the­word­phonetically­and­then­correct­it­again.­For­extremely­difÏcult­
spelling,­type­the­word­into­a­search­engine­on­the­web,­which­may­also­offer­a­
correct spelling.

Dealing with incorrectly flagged words
Occasionally, Word’s spell checker bumps into a word it doesn’t recognize, such 
as your last name or perhaps your city. Word dutifully casts doubt on the word by 
scribbling beneath it the notorious red zigzag. Yes, this is one of those cases where 
the computer is wrong.

To correct a falsely accused word, right-click it. Choose one of these options from 
the Spelling submenu:

Add to Dictionary: This command adds the word to your custom dictionary. The 

word is no longer flagged as misspelled in the current document or any other 
document.

Ignore All: This command directs Word to ignore the term and accept it as 

correctly spelled throughout the entire document.

If the word is intentionally misspelled and you don’t want to ignore all instances 
or add it to the custom dictionary, just leave it be.

 » See the section “Rechecking a document,” later in this chapter, for information 

on reversing your decision to ignore a spelling error.

 » For information on viewing or editing the custom dictionary, see the later 

section “Customizing the custom dictionary.”

YEW RIGHT GRATE

Word’s document-proofing tools are as technologically advanced as the programmers 
at Microsoft can make them. As the title of this sidebar suggests, however, something 

must be said about context.

Just because a document appears to contain no proofing errors doesn’t mean that 
everything is perfect. You have no better way to proof a document than to read it with 

human eyes. Consider this book! Its contents have been proofed by Word, by several 

editors, the author, and other low-paid-but-dedicated contributors. And still it has 

mitsakes.
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THE 25 MOST FREQUENTLY 
MISSPELLED WORDS
a lot

accidentally

acquire

amateur

argument

atheist

collectible

consensus

definite

embarrass

gauge

grammar

independent

kernel

liaison

maneuver

no one

occurrence

realize

receive
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AutoCorrect in Action

Word­ quickly­ fixes­ hundreds­ of­ common­ typos­ and­ spelling­ errors­ on­ the­ fly,­
meaning you may never see the embarrassing red zigzag. The AutoCorrect feature 
is responsible, and you have to be quick to see it.

For example, in Word you can’t type the word mispell (with only one s). That’s 
because­AutoCorrect­fixes­that­typo­the­split­second­you­press­the­spacebar­or­use­
punctuation to end the word.

AutoCorrect also converts common text shortcuts into their proper single charac-
ters. For example, type (C) and AutoCorrect properly inserts the © copyright sym-
bol. Ditto for (TM) for the trademark. Typing  ➪    is translated into an arrow, and :) 
becomes a happy face. 

Beyond­spelling,­AutoCorrect­fixes­common­punctuation.­It­automatically­capital-
izes­ the­first­ letter­of­a­sentence.­AutoCorrect­capitalizes­ I when you forget to, 
properly­capitalizes­the­names­of­days,­fixes­the­iNVERSE­cAPS­lOCK­pROBLEM,­
plus other common typos.

Undoing an AutoCorrect correction

You can reverse AutoCorrect instant changes, but only when you’re quick. The 
secret is to press Ctrl+Z (the Undo command) immediately after AutoCorrect 
makes its correction. The change is gone.

Even when you’re not quick with the Undo command, you can peruse AutoCorrect 
changes.­These­are­flagged­by­a­weensy­blue­rectangle­that­appears­under­the­first­
letter­of­the­corrected­text,­as­illustrated­in­Figure 7-2.­Position­the­mouse­pointer­
at that rectangle, and click to see various AutoCorrect options, also illustrated in 
Figure 7-2.

ridiculous

separate

supersede

their

weird
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To restore the text to how it was typed originally, choose the option Change Back 
to whatever, where whatever­is­the­original­text­(shown­as­the­:)­in­Figure 7-2).

To prevent AutoCorrect from ever making the change again, choose the option 
Stop Automatically Correcting whatever.­Keep­in­mind­that­though­the­text­won’t­
be automatically corrected, it may still show up as a typo or a spelling error.

See­the­later­section­“Adjusting­AutoCorrect­settings”­for­information­on­the­final­
option, Control AutoCorrect Options.

Adding a new AutoCorrect entry

It’s possible, though not obvious, to create your own AutoCorrect entries. The 
process is similar to correcting any spelling mistake, but you must remember to 
take a few extra steps:

1. Right-click a misspelled word that you want to add as an AutoCorrect 

entry.

The word must be flagged as misspelled, underlined by the red zigzag of 
shame.

2. From the Spelling submenu, choose the menu to the right of the correctly 

spelled word.

For example, right-click on suwbay and choose Spelling, subway, and then the 

submenu next to subway (the correct spelling).

FIGURE 7-2: 
Adjusting an 

AutoCorrect 

correction.
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3. Choose Add to AutoCorrect.

The spelling error is added to AutoCorrect’s repertoire. It’s automatically 

corrected for you from now on.

Words you accidentally add as AutoCorrect entries can be removed, should you 
make a mistake. See the next section.

Adjusting AutoCorrect settings

To control how AutoCorrect behaves, as well as manage the words it corrects, fol-
low these steps:

1. Click the File tab.

2. Choose Options.

The Word Options dialog box appears.

3. Choose the Proofing category on the left side of the window.

4. Click the AutoCorrect Options button.

The AutoCorrect dialog box appears, with the AutoCorrect tab forward.

The AutoCorrect tab lists all of AutoCorrect’s superpowers, such as capitalizing 
the­first­letter­of­a­sentence.­Click­the­Exceptions­button­to­manage­specific­words­
where the rules need not apply.

More­specific­to­your­AutoCorrect­desires­is­the­long­list­showing­the­words­auto-
matically­replaced­as­you­type.­This­list­is­where­you­find­items­such­as­teh, which 
is autocorrected to the.­You­also­find­words­you’ve­added­to­the­list­as­described­in­
the preceding section.

To­remove­an­entry­from­the­AutoCorrect­list,­scroll­to­find­that­item,­such­as­:)­
for the happy face. Click to select the entry, and then click the Delete button.

To­add­an­entry,­use­ the­Replace­and­With­ text­boxes.­For­example,­ to­ replace­
kludge with kluge, type kludge­in­the­Replace­box­and­kluge in the With box.

Click­the­OK­button­when­you’re­done­adjusting,­and­then­close­the­Word­Options­
dialog box.

Also­see­Chapter 33­for­information­on­disabling­various­AutoCorrect­and­Auto-
Format features.
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Grammar Be Good

Mark Twain once referred to English spelling as “drunken.” If that’s true, English 
grammar­must­ be­ a­ hallucination.­ To­ help­ you­ detox,­Word­ offers­ on-the-fly­
grammar checking. It’s just like having your eighth grade English teacher inside 
your­computer —­only­it’s­all­the­time­and­not­just­during­third­period.

Word’s­grammar­checker­works­like­its­spell­checker.­The­main­difference­is­that­
offenses­are­flagged­with­a­frigid­blue­double­underline,­such­as­the­one­shown­in­
Figure  7-3­ (although­ the­ zigzag­ looks­ gray­ in­ this­ book).­ That’s­ your­ hint­ of­
Word’s­sense­of­grammatical­justice.­Even­then,­the­offense­is­most­likely­mild­
and, given the illusionary nature of English grammar, can probably be ignored.

To­address­a­grammar­issue,­click­the­blue-underlined­text,­as­shown­in­Figure 7-3.­
Use the pop-up menu to discover what’s wrong and, optionally, choose an alterna-
tive.­You­can­also­choose­to­ignore­the­error,­which­I­find­myself­doing­quite­often.

 » The most common source of grammatical woe in English is verb agreement, 

or matching the subject to the correct verb. In Figure 7-3, the subject ducks is 

plural, but the verb fits is third person singular.

 » The grammar checker is excellent at spotting two spaces between words 
when you need only one space. It’s not so good at spotting fragments.

 » You may see false grammar errors when using Word’s revision tracking 

feature with the No Markup setting enabled. Reveal all revision marks to see 

what’s up. Refer to Chapter 26 for details.

 » To customize or turn off grammar checking, refer to the sections “Disabling 
automatic proofing” and “Curtailing grammar checking,” later in this chapter.

FIGURE 7-3: 
A grammatical 

error is flagged.
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All-at-Once Document Proofing
If you prefer to ignore the red zigzag underline of shame, or perhaps you’ve dis-
abled­this­feature,­you­can­resort­to­performing­a­final­document­proof.­It’s­an­
all-in-one spelling-and grammar-checking process, which is how spell check 
worked­before­it­became­an­on-the-fly­feature.

Reviewing all those errors

To­perform­all-at-once­document­proofing,­top­to­bottom,­follow­these­steps:

1. Click the Home tab.

2. In the Editor group, click the Editor button.

The Editor pane appears. Below a rather rude judgment of your grammatical 

abilities, you see spelling and grammar errors categorized. It’s ugly.

3. Click the Spelling item.

This button is located below the Corrections heading.

4. Review each spelling error and deal with the offense.

You can choose a suggested word, retype it, ignore it, or add it to the diction-

ary, for example.

5. Click the forward chevron to page through the remaining spelling errors.

After you’re done checking the spelling, repeat the process by choosing Grammar 
at Step 3.

You­can­easily­enter­a­trancelike­state­while­you’re­document­proofing.­You­might­
find­yourself­clicking­the­Ignore­button­too­quickly.­My­advice:­Use­the­Undo­com-
mand, Ctrl+Z, to go back and change text that you may not have paid attention to.

Word­disables­its­on-the-fly­proofing­when­your­document­grows­larger­than­a­
certain­size —­say,­100­pages.­You­see­a­warning­message­when­this­change­hap-
pens. At this point, you must perform an all-at-once document check, as described 
in this section.

Rechecking a document

Clicking the Ignore or Ignore All button has consequences for accidentally ignored 
spelling errors in a document. If you’ve abused these options too often, you can 
direct Word to recheck the document, which re-admits ignored misspelled words 
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and­grammatical­blunders­back­into­the­realm­of­document­proofing.­Obey­these­
steps:

1. Click the File tab.

2. Choose Options to display the Word Options dialog box.

3. Choose the Proofing category.

4. Click the Recheck Document button.

It’s found beneath the heading When Correcting Spelling and Grammar in 

Word.

5. Click the Yes button to confirm that you want to un-ignore items you’ve 
chosen to ignore before.

6. Click the OK button to dismiss the Word Options dialog box.

The­document­represents­itself,­again­flagging­all­those­words­and­items­you’ve­
chosen to ignore before.

 » Rechecking a document doesn’t undo any additions you’ve made to Word’s 

custom dictionary. See the later section “Customizing the custom dictionary.”

 » If spelling and grammar errors fail to appear after rechecking, the option to 

hide them might be enabled, as described in the later section “Hiding all 

proofing errors in a document.”

Document Proofing Settings
Whether you adore or detest Word’s capability to ridicule your language abilities, 
you­have­the­final­say-so.­Plenty­of­settings­and­options­are­available­to­control­
Word’s­document-proofing­tools.

Customizing the custom dictionary

You­build­the­custom­dictionary­by­adding­properly­spelled­words­that­are­flagged­as­
misspelled. You can also manually add words, remove words, or just browse the dic-
tionary to see whether you’re making old Noah Webster jealous. Follow these steps:

1. Click the File tab.

2. Choose Options to display the Word Options dialog box.

3. Choose Proofing.
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4. Click the Custom Dictionaries button.

The Custom Dictionaries dialog box appears.

The current version of Word uses the file RoamingCustom.dic as its custom 
dictionary. You may see other files in the list, especially if you’ve upgraded from 
older versions of Microsoft Word.

5. Select the item RoamingCustom.dic (Default).

6. Click the button labeled Edit Word List.

You see a scrolling list of words you’ve added to the custom dictionary.

To add a word to the custom dictionary, type it in the Word(s) text box. Click the 
Add button.

To remove a word from the custom dictionary, select the word from the scrolling 
list. Click the Delete button.

Click­the­OK­button­when­you’re­done­with­the­custom­dictionary.­Then­click­the­
various­OK­buttons­to­close­the­open­dialog­boxes­and­return­to­the­document.

Disabling automatic proofing
To banish the angry red zigzag underlines and bitter blue underlines from a doc-
ument,­ which­ effectively­ disables­ on-the-fly­ document­ proofing,­ follow­ these­
steps:

1. Click the File tab and choose Options.

The Word Options dialog box appears.

2. On the left side of the dialog box, choose Proofing.

3. Remove the check mark by the item Check Spelling as You Type.

4. While you’re at it, remove the check mark by the item Mark Grammar 
Errors as You Type.

5. Click the OK button.

See? You’ve just improved your spelling, though I wouldn’t get cocky about it.

Also­see­the­later­section­“Hiding­all­proofing­errors­in­a­document.”
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Curtailing grammar checking

I­find­Word’s­grammar­checker­ to­be­ insistently­ incorrect.­After­all,­English­ is­
fluid.­Especially­if­you’re­writing­poetry­or­you­just­know­the­rules­and­prefer­to­
bend them or toss them asunder, consider throttling back some of Word’s more 
aggressive­grammar­flags.

To adjust grammar settings, follow these steps:

1. Click the File tab.

2. Choose Options to display the Word Options dialog box.

3. Choose Proofing.

Below the heading, When Correcting Spelling and Grammar in Word, look for 

the Writing Style item. Next to it is the Grammar and Refinements menu. And 
to the right, you see the Settings button.

4. Click the Settings button.

The Grammar Settings dialog box appears.

5. Uncheck those items you no longer desire Word to mark as offensive.

The categories are general, which makes deselecting a rule difÏcult. That’s 
because whenever Word flags a grammar error, you see a specific rule and not 
the general ones listed in the Grammar Settings dialog box.

6. Click the OK button to dismiss the Grammar Settings dialog box.

7. Click OK to close the Word Options dialog box.

You­can­train­Word­to­ignore­specific­grammar­incidents­by­clicking­the­option­to­
ignore­a­rule­when­it’s­flagged­in­the­document.

Hiding all proofing errors in a document
It’s possible to direct Word to continue to spell-check yet hide the angry red zig-
zag and chilling blue underlines. All-at-once document checking still works, and 
words­are­still­flagged­as­misspelled,­but­they­don’t­appear­as­such­in­the­text.­To­
hide­the­proofing­marks,­obey­these­steps:

1. Summon the Proofing area in the Word Options dialog box.

Refer to Steps 1–3 in the preceding section.
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2. At the bottom of the right side of the Word Options dialog box, set check 

marks by the options Hide Spelling Errors in This Document Only and 

Hide Grammar Errors in This Document Only.

3. Click OK.

The proofing flags disappear throughout the document.

You­might­want­to­confirm­the­status­of­these­options­when­you­believe­Word’s­
document­proofing­to­be­broken.­For­example,­you­type­a­misspelled­word­on­pur-
pose and the red zigzag underline doesn’t appear! In this situation, document 
proofing­marks­may­be­disabled.­If­so,­follow­the­steps­in­this­section­but­remove­
the­check­marks­in­Step­2.
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Chapter 8

Documents New, Saved, 
and Opened

I 
like the word document.­ It’s­elegant.­ It’s­much­better­ than­saying­“a­file”­or­
“that­thing­I­created­with­my­word­processor.”­A­document­can­include­every-

thing­from­a­quick­shopping­list­to­a­vast­cycle­of­medieval­fantasy­novels­you­
keep­reading­despite­knowing­that­the­TV­version­didn’t­end­so­well.

Regardless­of­size­or­importance,­a­word­processing­file­is­called­a­document. It’s 

the­result­of­your­efforts­in­Word.­You­create­new­documents,­save­them,­open­old­
documents, and close documents. This is the document cycle.

IN THIS CHAPTER

 » Learning the terms

 » Creating a new document

 » Saving documents

 » Updating (resaving) a document

 » Opening a document

 » Inserting one document inside 

another

 » Retrieving a lost document
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Some Terms to Get Out of the Way

To­best­understand­the­document­concept,­you­must­escape­the­confines­of­Word­
and­wander­into­the­larger­dominion­of­computer­storage.­A­basic­understanding­
of­files­and­storage­is­necessary­if­you’re­to­get­the­most­from­your­word­process-
ing­efforts.

File:­A­Word­document­is­a­file.­A­file on a computer is information stored for the 

long­term,­which­can­be­recalled­again­and­shared­with­others.­Windows­manages­
files­and­their­storage,­backup,­copying,­moving,­and­renaming.

Folder:­Files­dwell­in­containers­called­folders.­A­folder­stores­files­and­other­fold-

ers, which creates a hierarchical system for data storage. This is how folders play 

a­role­in­file­organization.

Local storage:­ Files­ are­kept­ for­ the­ long­ term,­ saved­ to­your­ computer’s­hard­
drive­or­solid­state­drive­(SSD).­Because­this­hardware­exists­on­your­computer,­
it’s referred to as local storage.

Cloud storage: Files can also be kept for long-term storage on the Internet. This 

storage is commonly referred to as cloud storage.­With­regard­to­Word­(and­the­rest­
of­Microsoft­OfÏce),­the­preferred­form­of­cloud­storage­is­Microsoft­OneDrive.­
Files­saved­to­cloud­storage­are­available­to­your­computer­as­well,­but­the­benefit­
is­that­you­can­access­your­cloud­storage­from­any­Internet-connected­device.

Behold! A New Document

To­conjure­a­new­document­when­Word­first­starts,­choose­a­template­thumbnail­
on­the­Word­Start­screen;­the­Blank­thumbnail­presents­a­fresh,­empty­document.­
But­here’s­a­shortcut:­Press­Ctrl+N to summon a new document. It’s quicker.

If­you’ve­disabled­the­Word­Start­screen­(as­revealed­in­Chapter 33),­you­can­see­
its­contents­and­peruse­various­document­templates­to­start­a­new­document,­by­
obeying­the­following­steps.­You­can­also­follow­these­steps­anytime­you’re­using­
Word,­not­just­when­it­first­starts:

1. Click the File tab.

The File screen appears.

2. Choose New from the left side of the window.

The New screen works similarly to the Start screen. It shows popular templates 

and recently opened documents.
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3. Click the Blank Document thumbnail to create a new, blank document 

(probably because you forgot the Ctrl+N keyboard shortcut), or select a 

template.

A new Word window appears, ready for typing action.

You­can­start­as­many­new­documents­as­are­needed.­Word­lets­you­work­with­
several­documents­at­a­time.

 » See Chapter 24 for details on how to best work with multiple document 
windows all open at once.

 » Chapter 16 contains information on templates, which can greatly boost your 
performance by providing common document elements, including preset text 
and styles, automatically for you.

Save Your Stuff!
It­doesn’t­matter­whether­you’re­writing­the­next­Great­American­Novel­or­jotting­
down­notes­for­tonight’s­PTA­meeting,­the­most­important­thing­you­can­do­to­a­
document is save it.

Save! Save! Save!

HOW LONG CAN A WORD DOCUMENT BE?

The quick answer is that no length limit is assigned to a Word document. If you like, your 

document can be thousands of pages long. Even so, I don’t recommend putting that 
limit to the test.

The longer a document, the more apt Word is to screw up. You probably won’t encoun-

ter any issues for typical-size documents, even those of 100 pages or more. For larger 
projects, however, I recommend splitting your work into chapter-size chunks. Organize 
those chapter documents in their own folder.

The book Word 2016 For Professionals For Dummies (Wiley) offers a host of hints for man-

aging large manuscripts, including publishing novels and other weighty tomes.
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Saving­creates­a­permanent­copy­of­the­document,­encoding­the­text­as­a­file­on­
the computer’s storage system. This way, you can work on the document again, 

publish­it­electronically,­or­print­it.­All­these­tasks­are­possible,­providing­you­save­
the document.

Saving a document for the first time
You­ don’t­ have­ to­ finish­ a­ document­ before­ you­ save­ it.­ No!­ You­ should­ save­
­immediately —­as­soon­as­you­jot­down­a­few­sentences­or­paragraphs.

To­save­a­document­for­the­first­time,­follow­these­steps:

1. Press Ctrl+S.

You see the Save This File dialog box, shown in Figure 8-1. If it doesn’t appear, 
the document has already been saved. See the later section “Saving or 
updating a document.”

2. Type a name for the document in the File Name box.

Word automatically selects the first several words of the document as a 
filename and places this text in the File Name box. If that’s not okay, type a 
better name.

Be descriptive with the filename! The more concisely you name a document, 
the easier it is to recognize it by that name in the future.

FIGURE 8-1: 
The Save This File 

dialog box.
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3. Choose a location for the document.

Word has already chosen a location for you, either the Documents folder in 

Windows or the Documents folder on OneDrive. Click the location button to 
choose another, recent folder. You can click More Locations to switch to the 

Save As screen, which isn’t very helpful, but that’s what happens.

4. Click the Save button.

The file is safely stored.

And­now . . . the­secret.

If­ you’re­ comfortable­ using­Windows,­ use­ this­ keyboard­ shortcut­ to­ save­ your­
files:­F12.­Pressing­this­key­summons­the­good­ol’­Save­As­dialog­box­from­years­
gone by. Thank me later.

 » The document window doesn’t close after you save. You don’t need to quit 
Word. You can keep working. As you do so, continue to save. See the later 
section “Saving or updating a document.”

 » You can also save a document from the File tab: Choose the Save As or Save a 
Copy command. This part of Windows is known as the backstage.

 » If the computer’s current folder-organization scheme isn’t to your liking, use 
the New Folder button to create a new folder in the current folder. Word 
proceeds to save your document in the newly created folder.

 » For a folder you use frequently, such as a current project folder, point the 

mouse at the folder name and click the Pushpin icon, shown in the margin. 

Clicking the pushpin pins the folder to the top of the folder list or makes it 

available in the Pinned category on the Start screen. Use this technique to 
keep favorite folders handy when saving documents.

 » Your clue that the document is saved successfully is that its filename appears 
on the document’s title bar, at the top center of the Word window.

 » The Save As command can also be used to save a document with a new name, 
to a different location, or in a different format. See Chapter 24.

 » Do not save a document to removable media, such as a thumb drive or media 
card. Instead, save the document to the computer’s primary storage device: 
the hard drive or SSD. Then you can copy the file to the removable media. If 
you save directly to a thumb drive and it’s accidentally removed, you run the 
risk of losing the document.
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 » The advantage of using OneDrive cloud storage is that the document is 
available to any device you use with Internet access. If you have an OfÏce 365 
subscription, you can use Word on the web to edit the document. You can 
also employ Word’s collaboration features to share and work with others on 
the same document. See Chapter 26 for collaboration information.

Dealing with document-save errors

Saving­a­document­involves­coordination­between­Word­and­Windows.­This­com-

plexity­doubles­the­chances­of­something­going­wrong,­so­it’s­high­time­for­an­
error message. One such error message is

The file whatever already exists

Here­are­your­choices­and­my­suggestions:

 » Replace Existing File: Nope.

 » Save Changes with a Different Name: Yep.

 » Merge Changes into Existing File: Nope.

Choose­the­middle­option­and­click­OK. Type­a­different­filename­as­you­repeat­the­
initial­save­operation.

Another­common­problem­occurs­when­a­message­that’s­displayed­reads­some-
thing­like­this:

The filename is not valid

This­message­is­Word’s­less-than-cheerful­way­of­telling­you­that­the­filename­
contains a forbidden character. To be safe, use letters, numbers, and spaces when 

naming­a­file.­Check­the­nearby­sidebar,­“Trivial —­but­important —­information­
about­filenames.”

Saving or updating a document

As­ you­ continue­ to­ work­ on­ your­ document,­ you­ should­ save­ as­ you­ work:­
Ctrl+S. The­frequent­resave­captures­any­changes­you’ve­made­since­the­last­time­
you­saved,­keeping­it­fresh.­It­never­hurts­to­save­a­document­multiple­times.
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 » I save my document whenever I pause to think, rise to pour another cup of 
coffee, or answer the phone.

 » You can perform a quick save by clicking the Save button on the Quick 
Access toolbar.

Saving automatically on OneDrive

If­you’ve­saved­a­document­to­OneDrive­and­the­AutoSave­feature­is­active,­you­
never­ really­ need­ to­ save­ again.­ Word­ automatically­ updates­ your­ documents­
for you.

To­ensure­that­AutoSave­is­active,­look­for­the­AutoSave­item­on­the­Quick­Access­
toolbar,­similar­to­what’s­shown­in­the­margin.­If­the­switch­is­off,­click­it.­Auto-

Save­is­active­when­you­see­the­word­On­(as­shown­nearby).

TRIVIAL — BUT IMPORTANT — 
INFORMATION ABOUT FILENAMES

Be creative in the document, but also be creative when saving the document and chris-

tening it with a name. These names must abide by the Windows rules and regulations 
for all filenames:

• Short, descriptive filenames are best.

• A filename can be longer than 200 ridiculous-something characters, but don’t tempt 
the gods.

• A filename can include letters, numbers, and spaces, and can start with a letter or a 
number.

• A filename can contain periods, commas, hyphens, and even underlines.

• A filename cannot contain any of these characters: \ / : * ? “ < > |.

• Files saved to the cloud may have further naming restrictions imposed.

Word automatically appends a filename extension to all documents you save — like a last 
name. You may or may not see the filename extension, depending on how you’ve con-

figured Windows. Either way, don’t type the extension. Only concern yourself with giving 
the document a proper and descriptive filename.
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 » When the AutoSave item is disabled, the document has been saved to local 
storage or a location other than OneDrive. This feature might also be disabled 
in some versions of Word.

 » The Save icon on the Quick Access toolbar changes for documents saved to 
OneDrive. The updated icon appears in the margin. Click this button to force a 
save to the cloud.

 » If you don’t see the AutoSave item, click the menu button on the far right end 
of the Quick Access toolbar. Choose Automatically Save from the menu.

Forgetting to save before you quit

When­you’re­done­writing­in­Word,­you­close­the­document,­close­the­window,­or­
quit­Word­outright.­No­matter­how­you­call­it­quits,­if­the­document­hasn’t­been­
saved­one­last­time,­you’re­prompted:­The­Save­Your­Changes­to­This­File­dialog­
box­appears,­looking­like­the­Save­This­File­dialog­box­shown­earlier,­in­Figure 8-1.­ 
It­lists­three­options:

Save:­Click­this­button­to­save­the­document­and­close.­If­you’ve­been­naughty­and­
haven’t­ yet­ saved­ the­ document,­ the­ document­ is­ saved­ using­ the­ suggested­
filename.

Don’t Save:­When­you­click­this­button,­the­document­is­closed­without­saving.­It­
might­still­be­available­for­later­recovery.­See­the­later­section­“Recover­a­Draft.”

Cancel:­Click­this­button­to­forget­about­saving­and­return­to­the­document­for­
more­editing­and­stuff.

I­recommend­that­you­choose­the­Save­option.

Open a Document

Saving­a­document­means­nothing­unless­you­have­a­way­to­retrieve­that­docu-

ment­later.­As­you­might­suspect,­Word­offers­multiple­ways­to­open a document 

on either local storage or the cloud.

The­original­“open”­command­in­Word­was­File,­Transfer,­Load.­I­think­“open”­
sounds better.
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Using the Open command

Open­is­the­standard­computer­command­used­to­fetch­an­existing­document.­Once­
you­ find­ and­ open­ the­ document,­ it­ appears­ in­Word’s­window­ as­ though­ it’s­
always been there.

To­open­a­document­in­Word,­follow­these­steps:

1. Click the File tab.

2. Choose the Open command.

The Open screen materializes, similar to what’s shown in Figure 8-2.

If you spy the desired document lurking on the Recent list, click it. The docu-

ment opens on the screen. Congratulations — you’re done.

FIGURE 8-2: 
The Open screen.
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3. Choose Folders to view a list of recently accessed folders.

If you don’t see the folder you want, click the Browse button (refer to Figure 8-2). 
Use the traditional Open dialog box to hunt down the proper folder.

4. Select a recent folder from the list.

5. Click a document when you find it.

The document opens, ready for editing.

The­file­you­open­appears­in­the­Word­window.­Word­may­highlight­the­last­loca-
tion­where­you­were­writing­or­editing,­along­with­a­“Welcome­back”­message.

After­the­document­is­open,­you­can­edit­it,­look­at­it,­print­it,­or­do­whatever­you­
want.

 » The shortcut key to access the Open screen is Ctrl+O. Also, the Open com-

mand button appears on the Quick Access toolbar.

 » The keyboard shortcut to directly access the good ol’ traditional Open dialog 
box is Ctrl+F12. You can better remember this shortcut if you also know that 
the F12 key brings up the traditional Save As dialog box.

 » To access recently opened documents, right-click the Word icon on the 

taskbar. Choose a document from the pop-up list (called the jump list) to 

open it.

 » Opening a document doesn’t erase it from storage. In fact, the file stays on 
the storage system until you use the Save command to save and update the 
document with any changes.

 » When you position the mouse pointer at a recently opened document or 

folder on the Open screen, you see a Pushpin icon, as shown in the margin. 
Click this icon to make a document or folder “stick” to the Open screen. This 
way, the document or folder is always available for quick access later.

 » To remove a document from the Recent list, right-click the document’s entry. 
Choose the command Remove from List.

 » Avoid opening a file on any removable media, such as a thumb drive or 
media card. Though it’s possible, doing so can lead to headaches later, 
should you remove the media before Word is done with the document. 
Instead, I recommend that you use Windows to copy the document from the 

removable media to the computer’s primary storage. Then open it in Word.
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Opening one document inside another

Inserting­the­contents­of­one­document­into­another­is­possible­in­Word,­and­no­
surgery­ or­ screaming­ is­ involved.­ For­ example,­ at­ the­ end­of­ a­ paper,­ you­ can­
insert­another­document­that­may­have­a­short­bio —­including­your­picture.­To­
do­so,­follow­these­steps:

1. Position the insertion pointer where you want the other document’s 

contents to appear.

The text is inserted at this position.

2. Click the Insert tab.

3. From the Text group, click the menu (downward-pointing chevron) by the 

Object button.

The Object button is shown in the margin.

4. Choose the menu item Text from File.

The Insert File dialog box appears. It’s similar to the traditional Open dia-

log box.

5. Locate and select the document you want to insert.

Browse the various folders to find the document icon. Click to select its icon.

6. Click the Insert button.

The document’s contents are inserted into the current document, just as 
though you had typed and formatted it yourself.

The­resulting­combined­document­retains­ the­name­of­ the­first­document.­The­
document you inserted remains unchanged.

 » You can insert any number of documents into another document.

 » Inserting text from one document into another is often called boilerplating. For 

example, you can save a commonly used piece of text in a document and then 
insert it into other documents as necessary. This process is also the way that 

sleazy romance novels are written.

 » If you find yourself inserting common bits of text into documents, consider 
instead creating a document template. See Chapter 16.

 » Biography. Résumé. Curriculum vitae. The more important you think you are, 

the more alien the language used to describe what you’ve done.
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Recover a Draft

When­you­forget­ to­save­a­document —­or­ the­computer­crashed­or­ the­power­
went­out —­Word­offers­you­some­hope:­You­can­recover­some,­but­perhaps­not­
all,­of­an­unsaved­document.­Valiantly­make­this­attempt:

1. Press Ctrl+O to summon the Open screen.

2. Ensure that Recent is chosen as the file location.

3. Click the Recover Unsaved Documents button, found at the bottom of 

the list of recent files. (Refer to Figure 8-2.)

The Open dialog box appears, listing the contents of a special folder: 
UnsavedFiles. It’s Word’s graveyard. Actually, it’s more like a morgue in a county 
with a lousy EMS.

4. Select a document to recover.

The document may have an unusual name, especially when it’s never been 
saved.

5. Click the Open button to open and recover the document.

The­document­you­recover­might­not­be­the­one­you­wanted­ it­ to­be.­ If­so,­ try­
again and choose another document.

You­might­also­find­that­the­recovered­document­doesn’t­contain­all­the­text­you­
typed­or­thought­would­be­there.­Remember­that­this­feature­is­just­Word­being­
kind­to­you.­It’s­doesn’t­have­to­be.­(Trust­me.)­Rather­than­be­upset,­just­remem-
ber to save everything­in­the­first­place!

The­recovery­of­drafts­is­possible­because­of­Word’s­AutoRecover­feature.­Refer­to­
Chapter 31­for­more­information­on­AutoRecover.
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Chapter 9

Publish Your Document

A
fter­writing,­editing,­formatting,­and­proofing,­the­final­step­in­document­
preparation­ is­publishing.­Don’t­get­all­ excited:­Publishing­ in­Word­has­
nothing­to­do­with­seeing­your­book­on­the­New York Times­bestseller­list­

(although­it­could­happen).­Publishing­is­a­general­topic­that­includes­printing­a­
document­to­paper­as­well­as­generating­an­electronic­document­you­can­share­
online.­Times­have­changed.

Your Document on Paper

The­word­processor­is­the­best­writing­tool­ever­invented.­It’s­also­the­first­writing­
tool­ that­avoids­paper­until­your­document­ is­complete.­Even­then,­you­choose­
whether­to­generate­a­dead-tree­version­of­the­document,­also­called­a­printout or 

hard copy.

IN THIS CHAPTER

 » Previewing a document before 

printing

 » Printing a specific part of a document

 » Printing multiple copies of a 

document

 » Canceling a print job

 » Making a document compatible for 

sharing

 » Sending a document as an 

attachment

 » Exporting a document as a PDF
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 » Configuring the printer is done in Windows, not Word. Use the Settings app to 
set up and configure a printer, though it’s pretty much an automatic 
operation.

 » I assume that your computer has a printer attached or available on a network 
and that everything is set up just peachy. That setup includes stocking the 
printer with ink or toner and plenty of paper.

 » Printing works differently when using the online version of Word. Primarily, it’s 
your web browser that does the printing, not Word as described in this 
chapter.

Previewing before printing

Before­you­print,­preview­the­look­of­the­final­document.­Yeah,­even­though­your­
document­is­supposed­to­look­the­same­on­the­screen­as­it­does­on­paper,­you­may­
still­see­surprises:­missing­page­numbers,­blank­pages,­screwy­headers,­and­other­
jaw-dropping­blunders,­for­example.

Fortunately,­a­print­preview­of­your­document­appears­as­part­of­the­Print­screen,­
as­shown­in­Figure 9-1.

To­preview­a­document,­follow­these­steps:

1. Save the document.

Yep — always save. Saving before printing is a good idea.

2. Press Ctrl+P.

You can also click the File tab and choose chose the Print item from the left 
side of the File screen. Ctrl+P is quicker.

The Print screen appears, similar to what’s shown in Figure 9-1.

3. Use the buttons at the bottom of the Print screen to peruse the 

document.

Look at the margins. Examine footnotes, headers, or footers, to see how they 
lay out. The idea is to spot anything that’s dreadfully wrong before you print. 
You can use the Zoom control (refer to Figure 9-1) to enlarge or reduce the 
image.

When­you’re­ready,­print­the­document.­Details­are­offered­in­the­next­section,­but­
when­things­need­ to­be­repaired,­click­ the­Back­button­or­press­ the­Esc­key­ to­
return­to­your­document.
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Printing the entire document

It’s­time­to­enshrine­your­document­on­paper.­Heed­these­directions:

1. Make sure that the printer is on and ready to print.

Printing works fastest when the printer is on.

2. Save the document.

3. Press Ctrl+P, or, if you’re being paid by the hour, click the File tab and 

choose the Print item.

The Print screen appears. (Refer to Figure 9-1.)

4. Click the big Print button.

The Print screen closes, and the document spews forth from the printer.

FIGURE 9-1: 
The Print screen.
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Printing­speed­depends­on­the­complexity­of­ the­document­and­how­dumb­the­
printer­is.­Fortunately,­you­can­continue­working­while­the­document­prints.

 » Obligatory Ctrl+P joke goes here.

 » If nothing prints, don’t repeat the Print command! Most likely, nothing is awry; 
the computer is still thinking or sending information to the printer. If you don’t 
see an error message, everything will probably print, eventually.

 » The computer prints one copy of your document for every Print command 
you incant. If the printer is just being slow and you impatiently click the Print 
button ten times, you end up printing ten copies of the document. (See the 
section “Canceling a print job,” later in this chapter.)

 » When the document format specifies a unique paper size, the printer urges 
you to load that paper size. Stand by to produce and load the proper paper 
when the printer prompts you.

Printing a specific page
Because­the­printer­chewed­up­page­16 in­your­document,­you­must­reprint­that­
one­page.­Rather­than­reprint­the­entire­document­and­throw­away­everything­but­
page­16,­print­only­that­page.­Follow­these­steps:

1. Move the insertion pointer so that it’s sitting somewhere on the page you 

want to print.

Double-check the page number on the status bar to ensure that you’re on the 
correct page.

DELETE THE TRAILING BLANK PAGE

Occasionally, you may be surprised when your document prints one extra page — a 
blank page. And you’re not only bothered because you forgot to preview before printing 
(which I recommend in this chapter) but also vexed because you cannot get rid of it! 
Until now.

To remove the blank page that follows your document like a phantom caboose, press 
Ctrl+End. With the insertion pointer at the very bottom of your document, press the 
Backspace key repeatedly until the extra page is gone. How can you tell? Keep an eye on 
the total page-count tally on the status bar. When the page count decreases by one, you 
know that the extra page is gone.
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2. Press Ctrl+P.

3. Click the Print Range button below the Settings heading.

Refer to Figure 9-2 for the button’s location. It typically says Print All Pages.

4. Choose Print Current Page from the menu.

The page to reprint appears in the preview.

5. Click the Print button.

The­single­page­prints­with­all­ the­formatting­you­applied,­ including­footnotes­
and­page­numbers­and­everything­else,­just­as­though­you­plucked­that­page­from­
a­complete­printing­of­the­entire­document.

Printing a range of pages

Word­enables­you­to­print­a­range­of­pages,­odd-numbered­pages,­even-numbered­
pages,­or­a­hodgepodge­combination­of­given­pages­from­within­a­document.­To­
print­a­range­or­group­of­pages,­summon­the­Print­screen:­Press­Ctrl+P.

FIGURE 9-2: 
Specific buttons 

on the Print 
screen.
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On­the­Print­screen,­look­for­the­Pages­text­box,­illustrated­in­Figure 9-2.­Here­are­
some­suggestions­for­what­to­type­in­that­text­box:

To print pages 3 through 5, type 3–5.

To print pages 1 through 7, type 1–7.

To print pages 2 and 6, type 2,6.

To print page 3, pages 5 through 9, pages 15 through 17, and page 19 (boy, that 
coffee went everywhere, didn’t it?), type 3, 5–9, 15–17, 19.

Typing­any­value­into­the­box­changes­the­Print­Range­selection­from­Print­All­
Pages­to­Custom­Print.

Click­the­big­Print­button­when­you’re­ready­to­print.­Only­the­pages­you­specify­
churn­from­the­printer.

Printing on both sides of the page

If­the­printer­is­capable­of­duplex­printing,­you­can­direct­Word­to­print­your­doc-
ument­on­both­sides­of­a­sheet­of­paper.­Follow­these­steps:

1. Press Ctrl+P right after saving the document.

2. Click the Duplex Printing button on the Print screen.

Refer to Figure 9-2 for the button’s location.

3. Choose Print on Both Sides, Flip Pages on Long Edge.

Don’t bother with the Short Edge option unless you plan to bind the document 
that way.

If you don’t see the Print on Both Sides options, you must manually print on 
both sides of the paper. See the next section.

4. Click the big Print button to print the document.

The­document­ is­sent­ to­ the­printer­with­directions­ to­print­on­both­sides­of­a­
sheet­of­paper.­It’s­the­printer’s­job­at­this­point­to­perform­the­magic.­If­not,­read­
the­next­section.
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Printing odd- and even-numbered pages

When­your­printer­lacks­the­capability­to­print­on­both­sides,­you­must­perform­a­
manual­duplex­print­run:­First,­print­all­odd-numbered­pages­in­the­document.­
Flip­the­paper­and­reinsert­it­in­the­printer.­Then­print­all­even-numbered­pages.­
The­result­is­text­printed­on­both­sides­of­the­page.

To­print­all­odd-numbered­pages­or­all­even-numbered­pages,­follow­these­steps:

1. Press Ctrl+P to summon the Print screen.

2. Click the Print Range button below the Settings heading.

Refer to Figure 9-2 for the button’s location.

3. Choose Only Print Odd Pages from the menu.

4. Click the Print button to print odd-numbered pages in the document.

To­ print­ even­ pages,­ repeat­ these­ steps,­ but­ in­ Step­ 3­ choose­Only­ Print­ Even­
Pages.

I­recommend­printing­only­a­single­odd-and-even­page­first,­to­ensure­that­when­
you­reinsert­the­paper,­it’s­set­in­the­proper­orientation.

REMOVE THE DOCUMENT  
PROPERTIES SHEET

A printing problem that can potentially annoy you is finding the Document Properties 
sheet printing with your document. This extra sheet of paper prints first, listing docu-
ment trivia. The Document Properties sheet isn’t printed unless its option is set, and for 
some reason the option gets set on some folks’ computers.

To prevent the Document Properties sheet from printing, click the File tab and choose 
the Options command. In the Word Options dialog box, choose Display from the left 
side of the window. In the Printing Options area on the Display screen, remove the 
check mark by the Print Document Properties item. Click OK.
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Printing a block

After­you­mark­a­block­of­text­in­your­document,­you­can­beg­the­Print­command­
to­print­only­that­block.­Here’s­how:

1. Mark the block of text you want to print.

See Chapter 6 for all the block-marking instructions in the world.

2. Press Ctrl+P to summon the Print screen.

3. Click the Print Range button below the Settings heading.

4. From the menu, choose the Print Selection item.

The Print Selection item is available only when a block is selected in the 
document.

5. Click the Print button.

The­ block­ you­ selected­ prints­ at­ the­ same­ position­ with­ the­ same­ formatting­
(including­headers­and­footers)­as­though­you­had­printed­the­entire­document.

Printing more than one copy of something

When­it­comes­time­to­provide­a­copy­of­your­report­to­all­five­members­of­the­cult­
and­the­photocopier­is­broken,­just­print­multiple­copies.­Here’s­how:

1. Press Ctrl+P on the keyboard to summon the Print screen.

2. Enter the number of copies in the Copies text box.

To print five copies, for example, click the box and type 5.

3. Click the big Print button to print your copies.

Under­normal­circumstances,­Word­prints­each­copy­of­the­document,­one­after­
the­other.­This­process­is­known­as­collating.­However,­if­you’re­printing­five­cop-
ies­of­a­document­and­you­want­Word­to­print­five­copies­of­page­1­and­then­five­
copies­of­page­2­(and­so­on),­choose­the­Uncollated­option­from­the­Collated­menu­
button,­illustrated­in­Figure 9-2.

Choosing another printer

Your­computer­may­have­access­to­several­printers,­depending­on­how­many­are­
available­directly­or­over­the­network.­To­choose­a­specific­printer,­such­as­that­
fancy­color­printer­that’s­on­the­network­but­hidden­in­Ed’s­ofÏce,­follow­these­
steps:



CHAPTER 9  Publish Your Document      107

1. Press Ctrl+P to summon the Print screen.

2. Click the Select Printer button below the Printer heading.

The button shows the name of the currently selected printer, the one set by 
Windows as the default.

3. Choose another printer from the list.

Unfortunately, not every printer features a clear and descriptive name. Also, 
not every printer listed is a physical printer. Some are document printers, such 
as Microsoft Print to PDF, which is covered later in this chapter.

4. Click the Print button to print the document on the selected printer.

Adding­and­managing­printers­falls­under­the­domain­of­Windows,­not­Word.­To­
add­printers,­rename­printers,­or­set­the­default­printer,­use­Windows.­Windows­
is­also­to­blame­if­the­default­printer­keeps­changing.

Canceling a print job

The­fastest,­easiest­way­to­cancel­a­print­job­is­to­rush­up­to­the­printer­and­set­it­on­
fire.­Lamentably,­this­method­is­frequently­met­with­frowns­by­local­fire­ofÏcials.

A­majority­of­modern­computer­printers­feature­a­Cancel­button.­Press­this­button­
to­stop­a­print­job­run­amok.­The­Cancel­button­typically­features­an­X,­often­col-
ored­red.­Touch­that­button­and­the­printer­stops —­maybe­not­at­once,­but­the­
button­cancels­the­rest­of­the­document­from­printing.

For­slow­printers,­or­those­without­a­Cancel­button,­you­can­attempt­to­use­Win-
dows­to­halt­a­print­job­run­amok.­Obey­these­steps:

1. Double-click the little Printer icon in the notification area on the taskbar.

If you don’t see the li’l printer icon, it’s too late to cancel the print job. 
Otherwise, you see the printer’s control window, which lists any queued 
printing jobs.

2. Select the document from the job list.

3. Choose either the Document ➪   Cancel command or the 
Document ➪   Cancel Printing command.

4. Click Yes or OK to terminate the job.

5. Close the printer’s control window.

This­method­frequently­meets­with­failure­because­the­printer­is­fast­and­working­
these­steps­takes­time.­Still,­it’s­worth­a­try,­especially­when­the­printer­lacks­a­
Cancel­button.
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 » It may take time for the printer to stop printing. That’s because printers have 
their own memory, and a few pages of the document may be stored and 

continue to print even after you yell at the printer to stop.

 » Stopping a print job is a Windows task, not one that Word has control over.

Electronically Publishing Your Document

Not­ every­ document­ needs­ to­ hit­ paper.­ For­ example,­ I­ never­ print­my­ books.­
They’re­ sent­ electronically­ to­ the­ publisher­ and­ eviscerated­ right­ there­ on­ the­
screen.­eBooks­don’t­need­to­be­printed.­And­sometimes­documents­can­be­more­
effectively­distributed­by­email­than­by­paper.­It’s­all­part­of­electronically­pub-
lishing­your­document.

Preparing a document for publishing

Lots­of­interesting­things­can­find­their­way­into­your­Word­document,­informa-
tion­that­you­may­not­want­published.­These­items­include­comments,­revision­
marks,­hidden­text,­and­other­tidbits­useful­to­you­or­your­collaborators,­which­
would­mess­up­a­document­you­share­with­others.­The­solution­is­to­use­Word’s­
Check­for­Issues­tool,­like­this:

1. Ensure that your document is finished, finalized, fabulous, and saved.

2. Click the File tab.

3. Choose Info from the list of items on the left side of the window.

4. Click the Check for Issues button.

5. Choose Inspect Document.

The Document Inspector window appears. All items relevant to your document 
are selected.

6. Click the Inspect button.

After a few moments, the Document Inspector window shows up again, listing 
any potential problems.

7. Optionally, click the Remove All button next to any issues you want to 

clear up.

Now that you know what the issues are, you can always click the Close button 
and return to your document to manually inspect them.
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8. Click the Close button, or click Reinspect to give your document another 

once-over.

After­completing­inspection,­you­can­go­forward­with­publishing­the­document­or­
continue­working.

Making a PDF

Word­document­files­are­considered­a­standard.­Therefore,­it’s­perfectly­accepta-
ble­to­send­one­of­your­document­files­as­an­email­attachment­or­make­it­available­
for­sharing­with­others,­such­as­on­cloud­storage.

It’s­also­possible­to­save,­or­publish,­your­document­in­the­Adobe­Acrobat­docu-
ment­format,­also­known­as­a­PDF­file.­This­type­of­electronic­publishing­offers­a­
digital­way­to­publish­your­document.­Obey­these­steps:

1. Finish your document.

Yes, this step means saving it one last time.

2. Press Ctrl+P to summon the Print screen.

3. Click the Printer button.

A list of available printers appears.

4. Choose Microsoft Print to PDF.

5. Click the Print button.

Nothing is printed on paper, but the document is “printed” to a new PDF file. 
That requires the use of the special Save Print Output As dialog box.

6. Work the dialog box controls.

Locate a proper folder in which to save the file and specify a filename.

7. Click the Save button.

The­ PDF­ file­ is­ created.­ The­ original­ document­ remains­ in­ the­Word­ window,­
unchanged­by­the­print-to-PDF­operation.

 » You can also open and edit PDF files in Word. In the traditional Open dialog 
box, choose the item PDF Files (*.pdf) from the File Type menu. Only PDF 
documents appear in the folder window. Choose one. Click OK to confirm that 
the process may take time. Once complete, the PDF file is open for editing as a 
Word document.

 » You need a copy of the Adobe Reader program to view PDF files. Don’t worry: 
It’s free. Go to get.adobe.com/reader.

http://get.adobe.com/reader
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Exporting your document

Beyond­the­Word­document­format­and­PDF,­you­can­export­your­document­into­
other,­ common­ file­ formats.­ These­ formats­ allow­ for­ easy­ document­ sharing,­
though­they’re­not­as­common­as­they­once­were.

To­export­your­document­into­another­file­format,­follow­these­steps:

1. Click the File tab.

2. Choose Export from the items on the left side of the screen.

3. Choose Change File Type.

A list of available file types appears on the right side of the screen. These types 
include Word formats and other file types such as Plain Text, Rich Text Format 
(RTF), and Web Page (HTML).

4. Select a file type.

5. Click the Save As button.

You may have to scroll down the list to find the Save As icon.

The Save As dialog box appears. It’s the same Save As dialog box as covered in 
Chapter 8, though the Save As Type menu lists the file type you selected in 
Step 3.

6. Work the dialog box to set a folder or another location for the file, or to 
change its name.

7. Click the Save button to export the document into the alien file type.

It may look like the document hasn’t changed, but it has! The title bar now 
specifies that you’re working on the exported document, not the original Word 
document.

8. Close the document.

Press Ctrl+W or otherwise dismiss the document.

By­closing­the­document,­you­ensure­that­any­changes­you­make­aren’t­made­to­
the­exported­copy.­To­continue­working­on­the­original­document,­open­it­again­ 
in­Word.



3Fun with 
Formatting
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Choose a font, size, and color for your document’s 

text.

Apply paragraph formats, including line spacing, space 

before-and-after, and indenting.

Get to know the ruler and all the ways you can use 

tabs to align the text.

Find out how to change page size, orientation, and 

margins.

Become familiar with adding headers, footers, and 

cover pages.

Learn all you need to know about creating and 

applying styles and using templates.
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Chapter 10

Character Formatting

A
t the atomic level, the most basic element you can format in a document is 

text —­letters,­numbers,­and­characters.­You­can­format­text­to­be­bold,­
underlined,­italicized,­small­or­large,­in­different­fonts­or­colors,­and­with­

all­sorts­of­pretty­and­distracting­attributes.­Word­gives­you­a­magnificent­amount­
of­control­over­the­appearance­of­your­text.

For an in-depth examination of fonts, typefaces, and character formatting in 

Word,­refer­to­my­book­Word 2016 For Professionals For Dummies­(Wiley).

Text Formatting Techniques

You­can­format­text­in­a­document­in­one­of­two­ways:

 » Use text formatting commands as you type, turning them on or off.

 » Type the text first. Go back and select the text to format. Apply the format.

IN THIS CHAPTER

 » Applying a text format

 » Setting basic text formats

 » Selecting a font

 » Changing the text size

 » Adding color to your words

 » Changing the text case

 » Removing text formatting

 » Exploring the Font dialog box
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Either­method­works,­though­I­recommend­that­you­concentrate­on­your­writing­
first­and­return­to­formatting­later.

Suppose­that­you­want­to­write­and­format­the­following­sentence:

His toe was severely swollen.

The­first­way­to­format­is­to­type­the­sentence­until­you­reach­the­word­severely.­
Press Ctrl+I­to­apply­the­italic­format.­Type­the­word.­Press­Ctrl+I­again­to­turn­off­
the­format.­Continue­typing.

The­way­I­formatted­the­sentence­was­to­type­the­entire­thing­first.­Then­I­double-
clicked­the­word­severely­ to­select­ it.­Finally,­ I­pressed­Ctrl+I­ to­apply­the­ italic­
format.

Refer­to­Chapter 6­for­more­information­on­marking­blocks­of­text.

Basic Text Formats

Word­stores­the­most­common­text-formatting­commands­on­the­Home­tab,­in­
the­Font­group,­as­illustrated­in­Figure 10-1.

The Font group’s gizmos not only control the text format but also describe the 

format­for­the­selected­text:­In­Figure 10-1,­the­text­format­uses­the­Calibri­font,­
and­the­text­size­is­11­points.

In­addition­to­the­Home­tab’s­Font­group,­text­formatting­commands­are­available­
on­ the­ mini­ toolbar.­ It­ appears­ whenever­ text­ is­ selected,­ as­ described­ in­
Chapter 6.

Selecting a font

The­base­attribute­of­text­is­its­typeface,­or­font.­The­font­sets­the­way­the­text­
looks­and­its­overall­style.­Choosing­the­best­font­can­be­agonizing­(and,­indeed,­
many­graphic­artists­are­barely­paid­to­choose­just­the­right­font),­but­the­process­
isn’t­too­difÏcult.­It­goes­like­this:

1. Click the Home tab.

2. In the Font group, click the down arrow by the Font item.

A list of fonts appears, shown on the right in Figure 10-1.
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3. Choose a font.

As you point the mouse pointer at a font, text in the document changes to 

preview the font. Click to choose the font and change the text format.

The­Font­menu­is­organized­to­help­you­locate­the­font­you­need.­The­top­part­of­
the­menu­lists­fonts­associated­with­the­document­theme. The next section con-

tains­fonts­you’ve­chosen­recently,­which­is­handy­for­reusing­fonts.­The­rest­of­
the­list,­which­can­be­quite­long,­shows­all­fonts­available­to­Word,­including­fonts­
you­can­download­by­selecting­them.­The­fonts­appear­in­alphabetical­order­and­
are­displayed­as­they­would­appear­in­the­document.

 » To quickly scroll to a specific part of the Font menu, type the first letter of the 
font you need. For example, type T to find Times New Roman.

 » When a font name doesn’t appear in the Font group (the text box is blank), it 
means that more than one font is selected in the document.

 » Refer to Chapter 16 for more information on document themes.

FIGURE 10-1: 
Text formatting 

commands in the 

Font group.
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 » Fonts are the responsibility of Windows, not Word. Bazillions of fonts are 
available for Windows, and they work in all Windows applications.

 » Graphic designers prefer to use two fonts in a document: one for the text and 
one for titles. Word is configured this way as well. The Body font is set for text. 
The Heading font is set for titles. These two fonts are set as part of the 
document theme.

Applying character formats

On­the­lower­left­side­of­the­Font­group,­you­find­some­of­the­most­common­char-
acter­formats.­These­formats­enhance­the­selected­font­or­typeface.

To­make­text­bold,­press­Ctrl+B­or­click­the­Bold­command­button.

Use bold­to­make­text­stand­out­on­a­page —­for­titles­and­captions­or­when­you’re­
uncontrollably­angry.

To­make­text­italic,­press­Ctrl+I­or­click­the­Italic­command­button.

Italic­has­replaced­underlining­as­the­preferred­text­emphasis­format.­ Italicized­
text­is­light,­wispy,­poetic,­and­often­lacking­undergarments.

Underline text by pressing Ctrl+U­or­clicking­the­Underline­command­button.­You­
can­click­the­down­arrow­next­to­the­Underline­command­button­to­choose­from­a­
variety­of­underline­styles­or­set­an­underline­color.

The double-underline format is available from the Underline command button’s 

menu,­but­it­does­have­a­keyboard­shortcut:­Ctrl+Shift+D.

Also­available­is­word­underlining­format.­Word­underlining­looks­like­this.­The­
keyboard­shortcut­is­Ctrl+Shift+W.

Strike­through­text­by­clicking­the­Strikethrough­command­button.­(A­keyboard­
shortcut­is­unavailable.)

I­don’t­know­whom­the­Strikethrough­command­bribed­to­make­it­into­the­Font­
group.­If­I­were­king­of­Microsoft,­I­would­have­put­small­caps­up­there­instead.­
But­who­am­I?­Strikethrough­ is­ commonly­used­ in­ legal­documents,­when­you­
mean to say something but then change your mind­ think­of­something­better­
to­say.
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Click­the­Subscript­command­button­to­make­text­subscript.­The­keyboard­short-
cut is Ctrl+=­(equal­sign).

Subscript­text­appears­below­the­baseline,­such­as­the­2 in­H2O.

To­make­text­superscript,­click­the­Superscript­command­button.­The­keyboard­
shortcut is Ctrl+Shift+=­(equal­sign),­which­is­the­shifted­version­of­the­subscript­
keyboard­shortcut.

Superscript­text­appears­above­the­line,­such­as­the­10 in­210.

Another popular format, but apparently not popular enough to sport a command 

button­ in­ the­ Fonts­ group,­ is­ small­ caps.­ The­ small­ caps­ keyboard­ shortcut­ is­
Ctrl+Shift+K.

Small­caps­formatting­is­ideal­for­headings.­I­use­it­for­character­names­when­I­
write­a­script­or­play:

Bill: That’s a clever way to smuggle a live grenade into prison.

The­all-caps­text­format­sets­the­text­to­uppercase­letters­only.­As­with­small­caps,­
this­ format­ doesn’t­ feature­ a­ command­ button,­ though­ it­ has­ a­ shortcut­ key:­
Ctrl+Shift+A.

To­find­all­these­text­formats­and­more,­open­the­Font­dialog­box.­Refer­to­the­
section­“Behold­the­Font­Dialog­Box,”­later­in­this­chapter.

 » More than one character format at a time can be applied to any text. For 
example, use Ctrl+B and then Ctrl+I to apply the bold and italic formats.

 » The best way to use superscript or subscript is to write text first and then 
apply the superscript or subscript format to selected text. So 42 becomes 42 

and CnH2n+1OH becomes C
n
H2n+1OH. If you apply superscript or subscript as 

you type, the text can become difÏcult to edit.

 » When will the Underline text attribute die? I’m bafÒed. Honestly, I think we’re 
waiting for the last typewriter clutching librarian from the 1950s to pass on 
before underlining ofÏcially disappears as a text attribute. And please don’t 
fall prey to the old rule about underlining book titles. It’s Crime and 

Punishment, not Crime and Punishment.
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Text Transcending Teensy to Titanic

Text size is set in a document based on the ancient typesetter’s measurement 

known­as­points.­One­point­is­equal­to­1 72­of­an­inch.­Although­this­value­is­myste-
rious­and­fun,­don’t­bother­committing­it­to­memory.­Instead,­here­are­some­point­
pointers:

 » The bigger the point size, the larger the text.

 » Most printed text is either 10 or 12 points tall.

 » Headings are typically 14 to 24 points tall.

 » In Word, fonts can be sized from 1 point to 1,638 points. Point sizes smaller 
than 6 are generally too small for a human to read.

 » A 1-inch-high letter is roughly 72 points.

 » The point size of text is a measure from the bottom of the descender to the 
typeface’s cap height, which is often above the ascender — for example, from 
the bottom of the lowercase p to the top of the capital E. Because of this 
measurement, the typical letter in a font is smaller than its given point size. In 
fact, depending on the font design, text formatted at the same size but with 
different fonts (typefaces) doesn’t appear to be the same size. It’s just one of 
those typesetting oddities that causes regular computer users to start 
binge-drinking.

Setting the text size

To­set­the­size­of­text­you’re­about­to­type,­or­text­in­a­selected­block,­heed­these­
steps:

1. Click the Home tab.

2. In the Font group, click the down arrow next to the Font Size box.

A menu of font sizes appears, as shown in the center in Figure 10-1.

3. Choose a font size.

As you point the mouse pointer at various values, text in the document (an 
individual word or a selected block) changes to reflect the size. Click to set the 
size.

The­Size­menu­lists­only­common­text­sizes.­To­set­the­text­size­to­a­specific­value,­
type­the­value­in­the­box.­For­example,­to­set­the­font­size­to­11.5,­click­in­the­Size­
box and type 11.5.
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The­keyboard­shortcut­to­set­text­size­is­Ctrl+Shift+P. Think­P­for­points.

Nudging text size

Rare­is­the­student­who­hasn’t­fudged­the­length­of­a­term­paper­by­inching­up­the­
font­size­a­notch­or­two.­To­accommodate­those­students,­or­anyone­else­trying­to­
set­text­size­visually,­Word­offers­two­command­buttons­in­the­Home­tab’s­Font­
group.

To­increase­the­font­size,­click­the­Increase­Font­Size­command­button.­The­key-

board shortcut is Ctrl+Shift+>.

The­ Increase­Font­Size­ command­nudges­ the­ font­ size­up­ to­ the­next­ value­ as­
listed­on­the­Size­menu.­(Refer­to­Figure 10-1.)­So,­if­the­text­is­12­points,­the­com-

mand­increases­its­size­to­14­points.

To­decrease­the­font­size,­click­the­Decrease­Font­Size­command­button.­Its­key-

board shortcut is Ctrl+Shift+<.

The­Decrease­Font­Size­command­works­in­the­opposite­direction­of­the­Increase­
Font­Size­command:­It­reduces­text­size­to­the­next-lower­value­displayed­on­the­
Size­menu.­(Refer­to­Figure 10-1.)

To­remember­the­text-size­keyboard­shortcuts,­think­of­the­less-than­and­greater-
than­ symbols.­ To­ make­ the­ text­ size­ greater­ than­ the­ current­ size,­ use­ the­
Ctrl+Shift+>­ shortcut.­ To­ make­ the­ text­ size­ less­ than­ its­ current­ size,­ use­
Ctrl+Shift+<.

To increase or decrease the font size by smaller increments, use these shortcut 

keys:

Ctrl+] Makes text one point size larger

Ctrl+[ Makes text one point size smaller

More Colorful Text

Adding­color­to­your­text­doesn’t­make­your­writing­more­colorful.­All­it­does­is­
make­you­wish­that­you­had­more­color­ink­when­it’s­time­to­print­the­document.­
Regardless,­you­can­splash­color­on­your­text,­without­the­need­to­place­a­drop­
cloth­below­the­computer.
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Coloring the text

To­change­the­color­of­text­in­a­document,­follow­these­steps:

1. Click the Home tab.

2. In the Font group, click the Font Color command button.

The current word, any selected text, or any new text you type is assigned the 
button’s color.

The­Font­Color­button­shows­which­color­it­assigns­to­text.­To­change­the­color,­
click­ the­menu­ triangle­ to­ the­button’s­ right­ and­ choose­a­new­color­ from­ the­ 
palette­that’s­displayed.

 » To restore the font color, choose Automatic from the Font Color menu. The 
Automatic color is set according to the text style. See Chapter 15 for details 
on styles.

 » Theme colors are associated with the document theme. Refer to Chapter 16.

 » To craft your own, custom colors, select the More Colors item from the Font 
Color menu to display the Colors dialog box.

 » The printer companies would love it if you’d use more colored text in your 
documents. Colored text works only on a color printer, so buy more ink!

 » Avoid using faint colors for a font, which can make text extremely difÏcult to 
read.

 » Don’t confuse the Font Color command button with the Text Highlight Color 
command button, to its left. Text highlighting is used for document markup, 
as described in Chapter 26.

Shading the background

To­set­the­text­background­color,­use­the­Shading­command.­Follow­these­steps:

1. Click the Home tab.

2. In the Paragraph group, click the Shading command button.

The color shown on the button shades the current word or selected block or 
sets the background color for new text you type.

To­switch­colors,­click­the­menu­button­to­the­right­of­the­Shading­command­but-
ton.­Select­a­color­from­the­list,­or­choose­More­Colors­to­create­a­custom­color.
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 » If you want to remove the background color, choose No Color from the 
Shading command’s menu.

 » The Shading command is used also to shade other objects on the page, such 
as cells in a table. That’s why it dwells in the Paragraph group and not in the 
Font group.

 » To create white-on-black text, first select the text. Change the text color to 
white, and then change the background (shading) to black.

 » If you need to apply a background color to an entire page, use the Page Color 
command. See Chapter 13.

Change Text Case

When­you­forget­to­type­text­the­proper­way­in­the­first­place,­or­when­the­Auto-

Correct and AutoFormat features forget to do their jobs, the Change Case com-

mand­is­available.­Follow­these­steps:

1. Click the Home tab.

In the Font group, click the Change Case command button.

2. Choose the proper case from the menu.

The list of menu items reflects how the case is changed, as shown in 
Figure 10-2.

The­Change­Case­command­isn’t­really­a­formatting­command;­its­effect­doesn’t­
stick­with­the­text­you­type.

FIGURE 10-2: 
Options for 

changing the  

text case.
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 » The keyboard shortcut for the Change Case command is Shift+F3. Press this 
key combination to cycle between three case options: ALL CAPS, lowercase, 
and Capitalize Each Word.

 » Back in the days of mechanical type, a font came in a case, like a briefcase. 
The upper part of the case held the capital letters. The lower part held the 
miniscule letters. This is where the terms uppercase and lowercase originated.

Clear Character Formatting

So­many­Word­formatting­commands­are­available­that­it’s­possible­for­your­text­
to­look­more­like­a­pile­of­runes­than­a­modern­document.­Word­understands­this­
problem,­so­it­offers­the­Clear­Formatting­command.­Use­this­command­to­peel­
away­all­formats­from­the­text,­just­like­you­peel­the­skin­from­a­banana.

To­remove­text­formatting,­follow­these­steps:

1. Click the Home tab.

2. In the Font group, click the Clear Formatting command button.

Text formats are removed from selected text or from all new text you type.

The­formatting­isn’t­removed­as­much­as­it’s­restored:­After­you­issue­the­Clear­
Formatting­command,­text­reflects­the­currently­applied­style.­This­style­includes­
font,­size,­and­other­attributes.

 » The keyboard shortcut for the Clear Formatting command is Ctrl+spacebar.

 » The Clear Formatting command removes the ALL CAPS text format, but 
doesn’t otherwise change the text case.

 » You cannot use the Clear Formatting command to remove text highlighting, 
which is covered in Chapter 26.

 » Using the Clear Formatting command to change the text color doesn’t reset 
the background color. See the section “Shading the background,” earlier in this 
chapter.
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Behold the Font Dialog Box

Word­features­a­single­location­where­all­your­font­formatting­dreams­can­come­
true.­It’s­the­Font­dialog­box,­shown­in­Figure 10-3.

To­summon­the­Font­dialog­box,­obey­these­steps:

1. Click the Home tab.

2. In the Fonts group, click the Dialog Box Launcher button-thing.

The button is found in the lower right corner of the Font group. (Refer to 
Figure 10-1.)

The Font dialog box hosts all­the­commands­for­formatting­text,­including­quite­a­
few­that­didn’t­find­their­way­into­the­Font­group­on­the­Ribbon.­As­with­all­text­
formatting,­the­commands­you­choose­in­the­Font­dialog­box­affect­any­new­text­
you­type­or­any­selected­text­in­your­document.

FIGURE 10-3: 
The neatly 

organized Font 
dialog box.
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When­you’ve­finished­setting­up­your­font­stuff,­click­the­OK­button.­Or­click­Can-

cel­if­you’re­just­visiting.

 » Use the Ctrl+D keyboard shortcut to quickly summon the Font dialog box.

 » The best benefit of the Font dialog box is its Preview window, at the bottom. 
This window shows you exactly how your choices affect text in the document.

 » The Font names +Body and +Heading refer to the fonts selected by the current 
document theme. This is done so that you can use Word’s theme commands 
to quickly change body and heading fonts for an entire document all at one 
time.

 » Click the Font dialog box’s Text Effects button to access interesting text 
attributes, such as Shadow, Outline, Emboss, and Engrave. See Chapter 17 for 
information about this button.

 » The Font dialog box’s Advanced tab hosts options for changing the size and 
position of text on a line.

 » The Set As Default button in the Font dialog box changes the font that Word 
uses for new documents. If you prefer to use a specific font for all your 
documents, choose the font (plus other text attributes) in the Font dialog box, 
and then click the Set as Default button. In the dialog box that appears, 
choose the option All Documents Based On the Normal Template. Click the 
OK button. Afterward, all documents start with the font options you selected.
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Chapter 11

Paragraph Formatting

I
f you’re after formatting fun, a standard paragraph of text presents you with 

the most opportunities. Word’s paragraph-formatting commands are vast, 

mostly because so many aspects of a typical paragraph can be adjusted and 

customized to present text just the way you like.

For­specific­and­grueling­details­on­paragraph­formatting,­see­my­tome­Word 2016 

For Professionals For Dummies (Wiley). It goes into scintillating detail on paragraph 

formatting, covering topics not mentioned here, including fancy indentation, 

spacing, hyphenation, and more.

IN THIS CHAPTER

 » Understanding paragraph formatting

 » Finding paragraph formatting 

commands

 » Aligning paragraphs left, center, 

right, and full

 » Changing line spacing

 » Adding room between paragraphs

 » Indenting a paragraph

 » Making a hanging indent

 » Using the ruler
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Paragraph Formatting Rules  
and Regulations

Word’s­paragraph­level­formatting­commands­affect­paragraphs­in­a­document.­
This­notion­is­obvious,­but­how­does­Word­define­a­paragraph?

Writing conventions aside, to Word a paragraph is any chunk of text that’s termi-

nated when you press the Enter key. A single character, a word, a sentence, or a 

document full of sentences is a paragraph, so long as you stab the Enter key when 

you’re done typing.

The Paragraph symbol (¶) appears in a document to mark the end of a paragraph. 

Normally, this character is hidden, but you can order Word to display it for you. 

Follow these steps:

1. Click the File tab.

2. Choose the Options command.

The Word Options dialog box appears.

3. Choose Display.

4. Place a check mark by Paragraph Marks.

5. Click OK.

Now, every time you press the Enter key, the ¶ symbol (called a pilcrow) appears, 

marking the end of a paragraph.

Also­see­Chapter 2­for­information­on­the­Show/Hide­command,­which­also­dis-
plays paragraph symbols in a document as well as other, secret text.

Formatting a paragraph

You can format a paragraph in one of several ways:

Change an existing paragraph. With the insertion pointer in a paragraph, use a 

paragraph­formatting­command.­Only­the­current­paragraph­format­is­affected.

Change a block of paragraphs.­Select­one­or­more­paragraphs­and­then­use­the­
formatting­command­to­affect­the­lot.
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Just start typing. Choose a paragraph formatting command, and then type a par-

agraph. The chosen format is applied to the new text.

 » To format every dang doodle paragraph in a document, press Ctrl+A to select 

all text, and then apply the format.

 » If your desire is to apply the same format to multiple paragraphs in the 

document, consider creating a style. See Chapter 15.

Locating the paragraph formatting 
commands

In­a­vain­effort­to­confuse­you,­Word­uses­not­one­but­two locations on the Ribbon 

to­house­its­paragraph­formatting­commands.­The­first­Paragraph­group­is­found­
on­the­Home­tab.­The­second­is­located­on­the­Layout­tab.­Both­groups­are­illus-
trated­in­Figure 11-1.

But­wait!­There’s­more.

To­conjure­the­Paragraph­dialog­box,­shown­in­Figure 11-2,­click­the­Dialog­Box­
Launcher­button­in­either­of­the­Paragraph­groups.­(Refer­to­Figure 11-1.)­In­it,­
you­find­controls­and­settings­not­offered­by­the­command­buttons­on­the­Ribbon.

A smattering of paragraph-formatting commands are also found on the mini 

toolbar, which appears after you select text.

FIGURE 11-1: 
Paragraph 

groups.
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Justification and Alignment
Paragraph­alignment­has­nothing­to­do­with­politics,­and­justification­has­little­to­
do with the reasons behind putting text in a paragraph. Instead, both terms refer 

to how the left and right edges of the paragraph look on a page. The four options 

are­Left,­Center,­Right,­and­Fully­Justified,­each­covered­in­this­section.

 » All alignment-formatting command buttons are found on the Home tab, in the 

Paragraph group.

 » The left and right indents of a paragraph are measured from the page margin. 

See Chapter 13 for information on page margins.

Line up on the left!

Left alignment is considered standard, probably thanks to the mechanical type-

writer and, before that, generations of grammar-school teachers who preferred 

text­lined­up­on­the­left­side­of­a­page.­The­right­side­of­the­page?­Who­cares!

To left-align a paragraph, press Ctrl+L­or­click­the­Align­Left­command­button,­
found­in­the­Home­tab’s­Paragraph­group.

FIGURE 11-2: 
The Paragraph 

dialog box.
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 » This type of alignment is also known as ragged right.

 » Left-aligning a paragraph is how you undo the other types of paragraph 

alignment.

Everyone center!

Centering a paragraph places each line in that paragraph in the center of the page, 

with an equal amount of space to the line’s right and left.

To center a paragraph, press Ctrl+E or use the Center command button, found in 

the­Home­tab’s­Paragraph­group.

 » Centering is ideal for titles and single lines of text. It’s ugly for longer para-

graphs and makes reading the text more difÏcult — unless you’re a poet, in 
which case you’ll ignore me anyway.

 » Use a center tab stop to center a single word in the middle of a line. See 

Chapter 12.

 » See Chapter 17 for information on centering text on a page, top to bottom.

Line up on the right!

The mirror image of left alignment is right alignment: The right edge of the para-

graph is aligned, and the left margin is not. When do you use this type of format-

ting?­I­have­no­idea,­but­it­sure­feels­funky­typing­a­right-aligned­paragraph.

To­flush­text­along­the­right­side­of­the­page,­press­Ctrl+R or click the Align Right 

command button.

 » This type of alignment is also known as ragged left or flush right.

 » To right-justify text on a single line, use a right tab stop. See Chapter 12 for 
more info.

Line up on both sides!

Lining­up­both­sides­of­a­paragraph­is­full justification:­Both­the­left­and­right­sides­
of­a­paragraph­are­neat­and­tidy,­flush­with­the­margins.
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To­ apply­ full­ justification,­ press­ Ctrl+J­ or­ click­ the­ Justify­ command­ button,­
located,­as­you­might­guess,­in­the­Home­tab’s­Paragraph­group.

 » Fully justified paragraph formatting is often used in newspapers and maga-

zines, which makes the narrow columns of text easier to read.

 » Full justification is preferred when using multiple columns of text on a page.

 » Word makes each side of the paragraph line up by inserting tiny slivers of 

extra space between words in a paragraph. The extra space is recycled from 

government computers designed to look impressive, but which merely create 

extra space.

Make Room Before, After, or  
Inside Paragraphs

Sentences­ in­a­paragraph­can­stack­as­tightly­as­a­palette­of­plywood.­Alterna-
tively,­you­can­choose­to­keep­paragraphs­all­light­and­airy,­like­a­soft,­fluffy­cake.­
Space­can­cushion­above­or­below­the­paragraph.­These­paragraph­air­settings­are­
illustrated­in­Figure 11-3.

Commands to control paragraph spacing include the traditional line spacing com-

mands­as­well­as­the­Space­Before­and­Space­After­commands.­These­commands­
are­found­in­the­Paragraph­groups­on­both­the­Home­and­Layout­tabs.

FIGURE 11-3: 
Spacing in and 

around a 

paragraph.
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Setting the line spacing

To set the space between all lines in a paragraph, follow these steps:

1. Click the Home tab.

2. In the Paragraph group, click the Line Spacing command button.

A menu appears.

3. Choose a new line spacing value.

Word adds the extra space below each line of text in the current or selected 

paragraphs.

Four keyboard shortcuts are available for the most common line-spacing values:

Ctrl+0, choose 1.15 line space (don’t ask me to explain this value)

Ctrl+1, apply single-spacing

Ctrl+2, apply double-spacing

Ctrl+5, apply 1½ line spacing

PERSNICKETY LINE SPACING OPTIONS

For seriously precise line spacing, turn to the Paragraph dialog box: Click the Home tab, 

and in the lower right corner of the Paragraph group, click the Dialog Box Launcher icon.

In the Paragraph dialog box, the Line Spacing drop-down list features some specific 
items: At Least, Exactly, and Multiple. These items are used with the At box to indicate 

line spacing as follows:

At least: The line spacing is set to a minimum value. Word can disobey this value and 

add more space whenever necessary to make room for larger type, different fonts, or 
graphics on the same line of text.

Exactly: Word uses the specified line spacing and doesn’t adjust the spacing to accom-

modate larger text or graphics.

Multiple: Use this option to enter line spacing values other than those specified in the 
Line Spacing drop-down list. For example, to set the line spacing to 4, choose Multiple 

from the Line Spacing drop-down list and type 4 in the At box.

Click the OK button to confirm these settings and close the Paragraph dialog box.
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By­the­way,­when­you­want­text­to­stack­up­one­line­atop­another­line,­such­as­
when typing a return address, use the soft return at the end of a line: Press 

Shift+Enter.­Refer­to­Chapter 4.

Making space between paragraphs

To help separate one paragraph from another, you add space either before or after 

the­paragraph.­(Refer­to­Figure 11-3.)­What­you­don’t­do­is­press­Enter­twice­to­
end a paragraph. That’s extremely unprofessional, and doing so causes rooms full 

of educated people to scowl at you.

To add space before or after a paragraph, follow these steps:

1. Click the Layout tab.

2. In the Paragraph group, use the Before gizmo to add space before a 

paragraph of text or use the After gizmo to add space after the 

paragraph.

Measurements are made in points, the same measurement used for font size.

To­create­the­effect­of­pressing­the­Enter­key­twice­to­end­a­paragraph,­set­the­
After value to a point size about two-thirds the size of the current font. As an 

example, for a 12-point font, an After value of 8 looks good.

 » Most of the time, space is added after a paragraph. You can add space before 

a paragraph — for example, to further separate text from a document 
heading or subhead.

 » The space you add before or after a paragraph becomes part of the para-

graph format. Like other formats, it sticks with subsequent paragraphs you 

type or can be applied to a block of paragraphs.

 » Graphics designers prefer to insert more space between paragraphs when 

the first line of a paragraph isn’t indented, as in this book. When you indent 
the first line, it’s okay to have less or no spacing between paragraphs. See the 
next section.
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Paragraph Indentation Madness

Paragraphs­fill­the­page’s­margin­from­side­to­side,­as­dictated­by­the­alignment,­
or justification.­Exceptions­to­this­rule­can­be­made.­A­paragraph’s­first­line­can­be­
indented, the rest of the lines can be indented, and the left and right sides can be 

indented.­It’s­paragraph­indentation­madness!

 » Adjusting a paragraph’s indentation doesn’t affect the paragraph’s alignment.

 » Paragraphs are indented relative to the page’s margins. Refer to Chapter 13 
for information on page margins.

Indenting the first line of a paragraph
Back­in­the­old­days,­it­was­common­to­start­each­paragraph­with­a­tab.­The­tab­
would­indent­the­first­line,­helping­the­reader­identify­the­new­paragraph.­Word­
can save you tab-typing energy by automatically formatting each paragraph with 

an­indent­on­the­first­line.­Here’s­how:

1. Click the Home tab.

2. In the Paragraph group, click the dialog box launcher.

The Paragraph dialog box appears.

3. Click the Special drop-down list and choose First Line.

4. Confirm that the By box lists the value 0.5”.

The By box shows half an inch, which is the standard tab stop and a goodly 

distance to indent the first line of text.

5. Click OK.

The first line of the current paragraph or all selected paragraphs is indented 
per the amount specified in the By box.

To­remove­the­first-line­indent­from­a­paragraph,­repeat­these­steps­but­select­
(none)­from­the­drop-down­list­in­Step­3.

Word’s­AutoCorrect­feature­can­automatically­indent­the­first­line­of­a­paragraph,­
which is handy but also annoying. What AutoCorrect does is convert the tab char-

acter­ into­ the­First­Line­ Indent­paragraph­format,­which­may­not­be­what­you­
want. If so, click the AutoCorrect icon (shown in the margin), and choose the Con-

vert­Back­to­Tab­command.­I­recommend­using­the­steps­in­this­section­and­not­
AutoCorrect­to­format­first-line­indents.
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If­you­choose­to­indent­the­first­line,­you­don’t­need­to­add­space­after­the­para-
graph.­See­the­earlier­section­“Making­space­between­paragraphs.”

Making a hanging indent (an outdent)

A hanging indent­isn’t­in­imminent­peril.­No,­it’s­a­paragraph­in­which­the­first­line­
breaks­the­left­margin­or,­from­another­perspective,­in­which­all­lines­but­the­first­
are­indented.­Here’s­an­example:

Dr. Cornelius: Never mind! The effects are only temporary. 

Eventually your sense of balance will be restored, the nausea 

will diminish, and your desire to continue spending on your 

credit card will be fully restored.

The simple way to create such a beast is to press Ctrl+T,­the­Hanging­Indent­key-

board­ shortcut.­ The­ command­ affects­ the­ current­ paragraph­ or­ all­ selected­
paragraphs.

The not-so-simple way to hang an indent is to use the Paragraph dialog box: In 

the­Indentation­area,­click­the­Special­menu­and­choose­Hanging.­Use­the­By­text­
box to set the indent depth.

 » Every time you press Ctrl+T, the paragraph is indented by another half-inch.

 » To undo a hanging indent, press Ctrl+Shift+T. That’s the Unhang keyboard 
shortcut, the chiropractor that puts the paragraph’s neck back in shape.

Indenting a whole paragraph

To draw attention to a paragraph, its left side can be sucked in a notch. This pres-

entation is often used for quoted material in a longer expanse of text.

To indent a paragraph, heed these steps:

1. Click the Home tab.

2. In the Paragraph group, click the Increase Indent command button.

The paragraph’s left edge hops over one tab stop (half an inch).

To­unindent­an­indented­paragraph,­click­the­Decrease­Indent­command­button­in­
Step­2.
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When­you­want­ to­get­ specific­with­ indents,­ as­well­ as­ indent­ the­paragraph’s­
right­side,­click­the­Layout­tab­and­use­the­Indent­Left­and­Indent­Right­controls­
to­set­specific­indentation­values.­Set­both­controls­to­the­same­value­to­set­off­a­
block quote or a nested paragraph.

 » The keyboard shortcut to indent a paragraph is Ctrl+M. The shortcut to 
unindent a paragraph is Shift+Ctrl+M.

 » To undo any paragraph indenting, click the Layout tab, and in the Paragraph 

group, set both Left and Right indent values to 0.

 » Indent only one paragraph or a small group of paragraphs. This format isn’t 

intended for long stretches of text.

 » Don’t try to mix left and right indenting with a first-line indent or a hanging 
indent while drowsy or operating heavy equipment.

Using the ruler to adjust indents

The most visual way to adjust a paragraph’s indents is to use the ruler. This tip is 

helpful only when the ruler is visible, which it normally isn’t in Word. To unhide 

the ruler, follow these steps:

1. Click the View tab.

2. In the Show area, ensure that the Ruler option is active.

Click to place a check mark by the Ruler option if it isn’t active.

The­ruler­appears­above­the­document­text.­In­Print­Layout­view,­a­vertical­ruler­
also appears on the left side of the document.

On the ruler, you see the page margins left and right, and to the far left is some-

thing I call the tab gizmo­(covered­in­Chapter 12).­Figure 11-4­illustrates­the­impor-
tant parts of the ruler with regard to paragraph formatting.

FIGURE 11-4: 
The ruler.
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Four­doojobbies­on­the­ruler­reflect­the­current­paragraph­indents.­Use­these­con-

trols to adjust the paragraph indents in a visual manner.

Drag­the­Left­Indent­control­left­or­right­to­adjust­a­paragraph’s­left­margin.­Mov-

ing­this­gizmo­doesn’t­affect­the­first-line­indent.

PARAGRAPH FORMATTING SURVIVAL 
GUIDE

This table contains all the paragraph formatting commands you can summon by hold-

ing down the Ctrl key and pressing a letter or number. By no means should you memo-

rize this list.

Format Key Combination Command Button

Center Ctrl+E

Fully justify Ctrl+J

Left-align (flush left) Ctrl+L

Right-align (flush right) Ctrl+R

Indent Ctrl+M

Unindent Ctrl+Shift+M

Hanging indent Ctrl+T n/a

Unhanging indent Ctrl+Shift+T n/a

Line spacing Alt+H, K n/a

Single-space lines Ctrl+1 n/a

1.15 line spacing Ctrl+0 n/a

Double-space lines Ctrl+2 n/a

1.5-space lines Ctrl+5 n/a
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Drag­the­First­Line­Indent­control­left­or­right­to­set­the­first-line­indent­indepen-

dently of the left margin.

Drag­the­Both­control­to­adjust­both­the­left­indent­and­first-line­indent­together.

Drag­the­Right­Indent­control­right­or­left­to­adjust­the­paragraph’s­right­margin.

As you drag controls on the ruler, a vertical guide drops down into the document. 

Use­this­guide­to­help­adjust­ indents­ for­ the­current­paragraph­or­any­selected­
paragraphs.

 » The ruler measures from the page’s left margin, not from the left edge of the 

page. The page’s left margin is set when you format a page of text. See 

Chapter 13.

 » For more precise setting of indents, use the Paragraph dialog box instead of 

the gizmos on the ruler.
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Chapter 12

Tab Formatting

O
n my ancient Underwood typewriter, the Tab key is located on the right 

side of the keyboard. It’s named Tabular Key. On other old typewriters, 

I’ve seen it named Tabulator. The root of these words is the same as the 

root of table, which is the Latin word tabula, meaning “list.”

In Word, tabs are used to make lists or indent text. This concept sounds simple, 

but for some reason, tabs remain one of the most complex formatting topics.

Once Upon a Tab

As with other keys on the keyboard, pressing the Tab key inserts a tab character 

into the document. The tab character works like the space character, with the 

exception that the character that’s inserted has a variable width. The width is set 

at­a­predefined­location­marked­across­a­page.­This­location­is­called­the­tab stop.

It’s the tab stop that makes the tab character work: Press the Tab key, and the 

insertion pointer hops over to the next tab stop. You use tabs and tab stops to 

IN THIS CHAPTER

 » Revealing tab stops and characters

 » Viewing the ruler

 » Working in the Tabs dialog box

 » Setting left tab stops

 » Using right, center, and decimal tabs

 » Decorating with the bar tab

 » Setting leader tabs

 » Removing tabs and tab stops
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precisely­ line­ up­ text­ on­multiple­ lines.­ This­ approach­ is­ more­ effective­ than­
whacking the spacebar multiple times to line up columns of text.

 » Word presets tab stops at every half-inch position across the page. And, of 

course, you can create your own tab stops.

 » Anytime you press the spacebar more than once, you need a tab. Believe me, 

your documents will look prettier and you’ll be happier after you understand 

and use tabs instead of multiple spaces to line up your text.

 » What happens to text after you type the tab character is determined by the 

type of tab stop. In Word, multiple tab-stop types help you format a line of 

text in many ways.

 » As with any other character, you press the Backspace or Delete keys to 

remove a tab character.

 » Tabs work best on a single line of text or for only the first line of a paragraph. 
For more complex table formatting, use Word’s Table command. See 

Chapter 19.

 » The diet beverage Tab was named for people who like to “keep a tab on” how 

much they consume.

Seeing tab characters

Tab characters are normally hidden in a document. They look like blank spaces, 

which is probably why too many Word users use spaces instead of tabs.

It’s not necessary to see tab characters to use them, although if you’re having 

trouble setting tab stops and using tabs, viewing the tab characters is helpful.

Use the Show/Hide command to quickly view tabs in a document: Click the Home 

tab, and in the Paragraph group, click the Show/Hide command button, which 

looks like the Paragraph symbol (¶).

When Show/Hide is active, tab characters appear in the text as left-pointing 

arrows, similar to the one shown in the margin.

To direct Word to show tab characters at all times, regardless of the Show/Hide 

command setting, follow these steps:

1. Click the File tab.

2. Choose Options.

The Word Options dialog box appears.
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3. Choose Display from the left side of the window.

4. Put a check mark by the Tab Characters option.

5. Click OK.

With the Tab Characters option set, tabs always appear in a document. They don’t 

print that way, but viewing them in the text may help you solve some formatting 

puzzles.

Seeing tab stops

Tab stops are invisible; you can’t see them in your document, but they exist, and 

they­affect­the­text­that’s­typed­after­you­press­the­Tab­key.­The­best­way­to­view­
the tab stop locations and types, as well as to set new ones, is to summon the 

ruler. Follow these steps:

1. Click the View tab.

2. In the Show area, ensure that the check box by the Ruler item has a 

check mark in it.

If not, click to set the check mark.

The­ruler­appears­just­above­the­document.­Figure 12-1­illustrates­how­the­ruler­
might look when various tab stops are set. It also shows the location of the tab 

gizmo,­which­is­a­handy­tool­you­can­use­to­access­different­tab­stop­types.

If tab stops aren’t visible on the ruler, Word is using its default setting of one tab 

stop every half-inch. The default tab stops don’t appear on the ruler.

 » When several paragraphs are selected, you may spot a light gray, or phantom, 

tab stop on the ruler. The ghostly appearance indicates that a tab stop is set in 

one paragraph but not in all. To apply the tab stop to all selected paragraphs, 

click the phantom tab stop once.

 » See the later section “Tab Stop, Be Gone!” for information on using the ruler to 

remove, or unset, a tab stop.

FIGURE 12-1: 
Tab stops on the 

ruler.
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Using the ruler to set tab stops

The visual and quick way to set a tab stop is to use the ruler. Assuming that the 

ruler is visible (see the preceding section), the process involves these two steps:

1. Click the tab gizmo until the desired tab stop type appears.

Later sections in this chapter discuss what each of the five types of tab 
stops does.

The tab gizmo also shows paragraph-indent controls, which are covered in 

Chapter 11. These two items don’t relate to setting tabs.

2. Click the ruler at the exact spot where you want the tab stop set.

For example, click the number 2 to set a tab stop 2 inches from the page’s 

left margin.

The Tab Stop icon appears on the ruler, marking the paragraph’s tab stop posi-

tion. You can further adjust the tab by dragging left or right with the mouse. If a 

tab character already sits in the current paragraph, its format updates as you drag 

the top stop hither and thither.

 » To set a tab stop in the online version of Word, right-click the ruler at the 

position where you desire a tab stop. Choose Insert Tab Stop and the tab stop 

type from the submenu.

 » The tab stop is a paragraph-level format. It’s applied to the current paragraph, 

selected paragraphs, and any further paragraphs you type. Refer to Chapter 6 
for details on selected text.

Using the Tabs dialog box to set tabs

For precisely setting tabs, summon the Tabs dialog box. It’s also the only way to 

access special types of tabs, such as dot leader tabs, which are covered elsewhere 

in this chapter.

Keep in mind that the Tabs dialog box doesn’t work like a typical Word dialog box: 

You­must­assign­the­tab­stop’s­position­and­type­first­and­then­click­the­Set­but-
ton. Click the OK button only when you’re done setting tabs. Generally speaking, 

the process works like this:

1. Click the Home tab.

2. In the lower right corner of the Paragraph group, click the dialog box 

launcher.
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The Paragraph dialog box appears. Tab stops are, after all, a paragraph-level 

format.

3. Click the Tabs button.

The Tabs dialog box appears, as shown in Figure 12-2.

4. Enter the tab stop position in the Tab Stop Position box.

You can be precise, if you like, such as 3.11 inches.

5. Choose the type of tab stop from the Alignment area.

Word’s five tab stop types are covered elsewhere in this chapter.

6. Click the Set button.

The tab stop is added to the Tab Stop Position list.

7. Continue setting tab stops.

Repeat Steps 2–6 for as many tab stops as you need to set.

8. Click OK.

Now you can click OK.

You must click the Set button to set a tab stop! I don’t know how many times I 

click OK instead, thinking that the tab stop is set when it isn’t.

If the ruler is visible, you can quickly summon the Tabs dialog box: Double-click 

any existing tab stop.

FIGURE 12-2: 
The Tabs (tab 

stop) dialog box.
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The Standard Left Tab Stop

The left tab stop is the traditional type of tab stop. When you press the Tab key, 

the insertion pointer advances to the left tab stop position, where you continue to 

type text. This type of tab stop works best for typing lists, organizing information 

in­single-line­paragraphs,­and­indenting­the­first­line­of­a­multiline­paragraph.

Creating a basic tabbed list

A­common­use­for­the­left­tab­stop­is­to­create­a­simple­2-column­list,­as­shown­
in­Figure 12-3.

RESET WORD’S DEFAULT TAB STOPS

Word presets default tab stops, marching them across the page at half-inch intervals. 

This way, though you haven’t set any tab stops yourself, when you press the Tab key, a 

(left) tab stop is available for text-positioning.

The default tab stops are removed when you set your own tab stop. For example, set-

ting a tab stop at the 3-inch position erases all default tab stops to the left of that 

location.

You can’t eliminate the default tab stops, but you can change their spacing. In the Tabs 

dialog box, type a new interval value in the Default Tab Stops box. (Refer to Figure 12-2.) 
For example, to set default tab stops to 1-inch intervals, type 1 in the box and then click 

the OK button.

FIGURE 12-3: 
Two-column list.
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Follow these steps to create this type of list:

1. On a new line, press Tab.

2. Type the item for the first column.

This item should be short — two or three words, max.

3. Press Tab again.

4. Type the item for the second column.

Again, make it short.

5. Press Enter to end that line and start a new line.

Yes, your list looks horrible! Don’t worry. Type first, then format.

6. Repeat Steps 2–5 for each line in the list.

After the list is finished, you use the ruler to visually set the tab stops.

7. Select all lines of text that you want to organize in a 2-column tabbed list.

8. Choose a left tab stop from the tab gizmo on the ruler.

If necessary, click the tab gizmo until the Left Tab Stop icon shows up, as 

shown in the margin.

9. Click the ruler to set the first tab stop.

If the text doesn’t line up right, drag the tab stop left or right to adjust.

10. Click to set the second tab stop.

Drag the tab stop left or right, if necessary, to line up text.

You could add a third column to the list, but then the text starts to get crowded. In 

fact, anytime you need this type of complex list, consider instead cobbling together 

a­table.­See­Chapter 19.

You need only one tab between items in a column list. That’s because the tab stop, 

not the tab character, lines up the text.

Creating a 2-tab paragraph-thing

By using the power of tabs coupled with a paragraph’s hanging-indent format, 

you­can­create­a­tab-tab-paragraph­list,­similar­to­the­one­shown­in­Figure 12-4.
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It­looks­fancy­but­isn’t­horrendous­to­configure,­providing­you­follow­these­steps:

1. On a new line, type the first item.

The shorter, the better. This item sits at the left margin, so don’t type a tab to 

start the line.

2. Press Tab.

3. Type the second item and press Tab.

This step is optional; you can create a simpler tab-paragraph list, which looks 

just like the one shown in Figure 12-4, but without the Dish column (and 
spaced accordingly).

4. Type the paragraph text.

You’re free to type more text here. This final paragraph column wraps, as 
shown in Figure 12-4, so it can be longer than the first two items.

5. Press Enter to end the line.

Don’t let the text’s ugly appearance deceive you. You’re not finished.

6. Repeat Steps 1–5 for each item in the tab-tab-paragraph list-thing.

Now that the list is done, you set the tab stops and make the entire thing look 

beautiful.

7. Select all the lines of text you want to organize into a tab-tab-paragraph 

list.

8. Ensure that the left tab stop is chosen on the tab gizmo.

The margin shows the Left Tab Stop icon. If you don’t see this icon, click the tab 

gizmo until it shows up.

FIGURE 12-4: 
Tab-tab- 

paragraph  

format for text.
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9. Set a left tab stop to mark the second item in the list.

The first item is set at the start of the line. After you set the left tab stop for the 
second item in the list, the second column snaps into place.

10. Slide the paragraph’s left indent to the start of the text item.

The Left Indent triangle is shown in the margin. It sets the left margin for all 

text in a paragraph, except for the first line. (See Chapter 11 for details.) Slide 
the triangle rightward until its location passes items in the second column, as 

illustrated in Figure 12-4.

11. Adjust the tab stop and left indent as necessary.

Make the adjustments while text is selected, which provides visual feedback for 

the paragraphs.

As­with­formatting­any­complex­list,­it’s­perfectly­okay­to­give­up.­See­Chapter 19­
for­information­on­adding­a­table­to­your­document.­You­might­find­that­using­a­
table works better than all this paragraph-formatting nonsense.

The Center Tab Stop

The center tab is a unique critter with a special purpose: Unlike when you center a 

paragraph, only text typed after the tab character is centered on a line. This fea-

ture is ideal for centering a wee bit of text in a header or footer, which is about the 

only time you need a center tab stop.

Figure 12-5­shows­an­example­of­a­center­tab.­The­text­on­the­left­is­at­the­start­of­
the­paragraph,­which­is­left-justified.­But­the­text­typed­after­the­tab­is­centered­
on the line, thanks to the center tab stop. Follow these steps to create such a beast 

in your document:

1. Start a new paragraph, one containing text that you want to center.

Center tabs thrive in single-line paragraphs.

2. Click the tab gizmo on the ruler until the center tab stop shows up.

The Center Tab Stop icon is shown in the margin.

3. Click the ruler to set the center tab stop’s position.

Generally speaking, the center tab stop dwells in the center of the line. This 

location could be the 3-inch mark or thereabouts.

4. Optionally, type text to start the line.

In Figure 12-5, the text A Trip To Uranus appears at the start of the line.
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5. Press the Tab key.

The insertion pointer hops over to the center tab stop.

6. Type the text you want to center.

As you type, the text is centered on the line. Don’t type too much; the center 

tab is a single-line thing.

7. Press Enter to end the line of text.

When you need only centered text on a line, use the center paragraph format 

instead of a center tab stop. See Chapter 11.

See Chapter 14 for information on headers and footers.

The Right Tab Stop

The­right­tab­stop’s­effect­is­to­right-align­text­that’s­typed­after­you­press­the­
Tab key. As with the center tab stop, the right tab stop is frequently used in head-

ers and footers or when a paragraph contains only a single line of text. Otherwise, 

to­right-align­text,­use­the­Right­Justification­paragraph­formatting­command,­as­
described­in­Chapter 11.

Making a right-stop, left-stop list

A­clever­way­to­format­a­2-column­list­is­to­employ­both­a­right­tab­stop­and­a­left­
tab­stop.­The­list­lines­up­on­a­centerline,­as­shown­in­Figure 12-6.

FIGURE 12-5: 
Center tab  

stop in action.
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To build such a list, follow these steps:

1. Start out on a blank line, the line you want to format.

2. Click the tab gizmo until the right tab stop shows up.

The Right Tab Stop icon appears in the margin.

3. Click near the center of the ruler to place the right tab stop.

4. Click the tab gizmo until the left tab stop appears.

Click, click, click until you see the Left Tab Stop icon, as shown in the margin.

5. Click to place the left tab stop just to the right side of the right tab stop 

on the ruler.

Use Figure 12-6 as your guide.

Now it’s time to type the text. Don’t worry about getting the tab stops correct at 

this point in the process; you can adjust them later.

6. Press the Tab key.

The insertion pointer hops over to the right tab stop’s position.

7. Type text for the first, right-justified column.

8. Press the Tab key.

9. Type some text for the second, left-justified column.

10. Press Enter to end the line of text.

11. Repeat Steps 6–10 to complete the list.

If­further­adjustments­are­necessary­after­you’re­finished,­select­all­lines­and­use­
the mouse to adjust the tab stops’ positions on the ruler as necessary.

FIGURE 12-6: 
Right tab stops 

are used to 

center-align  

this list.
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Building a 2-column right-stop list

The­right­tab­stop­can­be­used­on­the­second­column­of­a­2-column­list.­The­pres-
entation appears commonly in programs, similar to what’s shown in 

Figure 12-7.

Here’s how to concoct such a thing:

1. Start on a blank line of text.

2. Click the tab gizmo until the right tab stop appears.

The Right Tab Stop icon is shown in the margin.

3. Place the right tab stop on the far right end of the ruler.

The position is just a guess at this point. Later, you can adjust the right tab stop 

position to one that’s more visually appealing.

4. Type the first-column text.

The text is left-justified, as it is normally.

5. Press the Tab key.

The insertion pointer hops to the right tab stop.

6. Type the second-column text.

The text you type is right-justified, pushing to the left as you type.

7. Press Enter to end the line of text.

8. Repeat Steps 4–7 for each line in the list.

Afterward, you can adjust the list’s appearance: Select all text as a block, and then 

drag the right tab stop back and forth on the ruler.

FIGURE 12-7: 
Right tab stops 

right-align the 

second column of 

this list.
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The Decimal Tab

Use the decimal tab to line up columns of numbers. You can use a right tab for this 

job, but the decimal tab is a better choice. Rather than right-align text, as the 

right tab does (see the preceding section), the decimal tab aligns numbers by their 

decimal —­the­period­in­the­number,­as­shown­in­Figure 12-8.

Here’s how to work with such a beast:

1. Start a blank line of text.

2. On the ruler, click the tab gizmo until the decimal tab stop appears.

The Decimal Tab Stop icon is shown in the margin.

3. Click the ruler to set the decimal tab stop.

You can adjust the position later.

4. Type the first-column text.

This step is optional, though in Figure 12-8 you see the first column as a list of 
items.

5. Press the Tab key.

6. Type the number.

The number is right-justified until you press the Period key. After that, the rest 
of the number is left-justified.

7. Press Enter to end the line of text.

8. Repeat Steps 4–7 for each line in the list.

You can make adjustments after the list is complete: Select all lines in the list, and 

then drag the decimal tab stop left or right.

FIGURE 12-8: 
Using the decimal 

tab to line up 

numbers.
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When a line doesn’t feature a period, text typed at a decimal tab stop is right-

justified,­as­shown­by­the­word­Free­in­Figure 12-8.­You­can­always­reformat­such­
a line to set a left tab stop, which may look better on the page.

The Bar Tab

Aside from being a most excellent pun, the bar tab isn’t a true tab stop in Word; it 

has­ no­ effect­ on­ the­ tab­ character.­ Instead,­ the­ bar­ tab­ is­ considered­ a­ text­
decoration.

Setting­a­bar­tab­inserts­a­vertical­bar­in­a­line­of­text,­as­shown­in­Figure 12-9.­
Using a bar tab is much better than using the pipe (|) character on the keyboard to 

create a vertical line in a multicolumn list. That’s because you can adjust all the 

bar tab characters just as you can adjust any tab stop.

To set a bar tab stop, follow these steps:

1. Click the tab gizmo until the bar tab stop appears.

The Bar Tab Stop icon is shown in the margin.

2. Click the ruler to place the bar tab stop.

At each position, a vertical bar appears in the text. The bar appears whether 

the current line contains any tab characters or not.

To best use the bar tab stop, mix in a few other tab stops. For example, in  

Figure 12-9,­left­tab­stops­are­set­to­the­side­of­each­bar­tab­stop.­The­effect­is­that­
text is organized into columns, but the bar tab serves only to decorate the text. It 

has­no­effect­otherwise.

FIGURE 12-9: 
The mysterious 

bar tab.
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Fearless Leader Tabs

Press the Tab key, and the insertion pointer hops over to the next tab stop. The 

space occupied by the tab character is empty, but it doesn’t have to be. Word lets 

you­apply­different­styles­to­the­empty­tab­space,­which­helps­to­create­something­
called a leader tab.

A leader tab shows a series of dots or other characters where the tab character 

appears on the page. Three styles are available: dot, dash, and underline, as illus-

trated­in­Figure 12-10.

You can apply a leader to any tab stop in Word other than the bar tab. To do so, 

follow these steps:

1. Create the tab-formatted list.

Refer to sections elsewhere in this chapter for information on creating a list of 

items.

2. Select the text as a block.

3. Bring forth the Tabs dialog box.

The quick shortcut is to double-click a tab on the ruler. Also see the earlier 

section “Using the Tabs dialog box to set tabs.”

4. Select the tab stop from the Tab Stop Position list.

5. In the Leader area, choose the leader style.

6. Click the Set button.

Don’t click OK before you set the tab stop to add the leader. This step is the 

one you forget most often.

7. Click OK.

The leader is applied.

FIGURE 12-10: 
Leader tab styles.
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Use­the­underline­leader­tab­to­create­fill-in-the-blank­forms.­In­the­Tabs­dialog­
box, set a left tab stop at the far right margin (usually, 6.0 inches). Choose the 

underline­leader­style­(number­4).­Click­Set­and­then­click­OK. Back­in­the­docu-

ment,­type­a­tab­to­create­a­fill-in-the-blank­line,­such­as:

Your name: _______________________

This format is far better than typing a zillion underlines.

Tab Stop, Be Gone!

To unset or clear a tab stop, follow these steps:

1. Select the paragraph(s) with the offending tab stop.

2. Drag the tab stop from the ruler.

Drag downward. The tab stop is removed from the paragraph(s).

Removing the tab stop doesn’t remove the tab character from the paragraph. Refer 

to the earlier section “Seeing tab characters,” for help in hunting down rogue 

tabs.

Word places automatic tab stops on every line of text. These cannot be removed.

For complex tab stop removal, such as when tab stops are close to each other or to 

the paragraph indent controls on the ruler, use the Tabs dialog box: Click to select 

the tab in the Tab Stop Position list, and then click the Clear button. Click OK to 

exit the Tabs dialog box.

 » Clicking the Clear All button in the Tabs dialog box removes all tab stops from 

the current paragraph or selected paragraphs in one drastic sweep.

 » Tab characters are deleted like any other character: Press the Delete or 

Backspace keys.
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Chapter 13

Page Formatting

W
ord is only mildly interested in the concept of a page. Unlike in the real 

world, where a page is a physical sheet of paper, Word conjures new 

pages when needed, pulling them in from the electronic ether. This 

digital magic makes the concept of a page ethereal. To root things in reality, Word 

lets­you­define­the­page­format,­which­ includes­ the­page­size,­orientation,­and­
margins as well as other page formats and attributes.

Describe That Page

Word­begins­its­page­formatting­odyssey­by­defining­exactly­what­a­page­looks­
like. Attributes include the page’s physical dimensions and which portion of the 

page­contains­text.

IN THIS CHAPTER

 » Choosing the page size

 » Switching the page orientation

 » Setting margins

 » Automatically numbering pages

 » Changing page numbers

 » Creating a new page

 » Coloring the page background

 » Including a watermark
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Setting page size

You­probably­assume­that­each­new­document­starts­with­a­page­size­reflecting­a­
typical sheet of paper.

Such foolishness.

Word’s­Normal­template,­the­one­used­to­start­a­new­document,­specifies­a­page­
size­equivalent­to­a­standard­sheet­of­paper.­In­the­US,­that’s­8½­by­11­inches.­In­
Europe,­the­A4­size­is­used.­You’re­not­stuck­with­either­size,­because­the­page­size­
is part of the page format and you can change it. Follow these steps:

1. Click the Layout tab on the Ribbon.

2. In the Page Setup group, click the Size button.

The Size icon is shown in the margin.

3. Choose a page size from the list.

For example, if you want to print on that tall, legal-size paper, choose Legal 

from the list.

The­entire­document­is­updated­to­reflect­the­new­page­size,­from­first­page­to­
last.

 » To select a size not shown on the menu (refer to Step 3), choose the More 

Paper Sizes menu item. The Page Setup dialog box appears. Use the controls 

on the Paper tab to manually specify the paper size.

 » Page size can be changed at any time, whether the document is empty or full 

of text. Obviously, page size affects layout, so a major change like this one is 
probably something you don’t want to do at the last minute.

 » Your document can sport multiple page sizes. To do so, split the document 

into sections and apply a different page size to each section. See Chapter 14 
for information on sections. Applying page formats one section at a time is 

done in the Page Setup dialog box, as described later in this chapter.

 » Page size definitely plays a role when a document is printed. Despite your zeal 
to choose an oddball page size, unless the printer can handle that paper size, 

the document can‘t be printed. It can, however, be published electronically. 

That process is covered in Chapter 9.
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Changing orientation (landscape  
or portrait)

An­aspect­of­page­size­is­whether­the­page­is­oriented­vertically­or­horizontally.­
(I’m­assuming­it’s­no­longer­the­fashion­to­print­on­square­paper.)­Page­orienta-
tion­can­be­set­by­adjusting­the­page­size,­but­it’s­much­easier­to­change­the­page­
orientation. Follow these steps:

1. Click the Layout tab.

2. Click the Orientation button.

The Orientation button is illustrated in the margin. It has two items on its 

menu: Portrait and Landscape.

3. Choose Portrait to set the page vertically or Landscape to set the page 

horizontally.

Word­ shifts­ the­ orientation­ for­ every­ page­ in­ the­ document.­ Text­ still­ prints­
 left-to-right across the page, only the paper’s orientation has changed.

 » Make the decision to have your document in landscape orientation before 
you do any extensive formatting. This orientation affects paragraph format-
ting, which may require you to adjust the document’s margins; see the 
next section.

 » Page orientation changes affect the entire document unless you split the 
document into sections. In this case, the change applies to only the current 

section. Read Chapter 14 for details on sections, including directions on how 
to stick a single landscape page into a document that’s otherwise portrait 
oriented.

 » Scientists who study such things have determined that human reading speed 

slows drastically when people must scan a long line of text, which happens 

when you use landscape orientation. Reserve landscape orientation for 

printing lists, graphics, and tables for which portrait page orientation is too 

narrow.

 » Landscape printing is ideal for using multiple columns of text. See Chapter 20.

 » If you just want sideways text without turning the page, use a text box. See 
Chapter 23 for information on text boxes.
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Setting the page margins

Margins­create­the­text­area­on­a­page­left,­right,­top,­and­bottom.­They­provide­
room­between­the­text­and­the­page’s­edge,­which­keeps­the­text­from­leaking­out­
of­a­document­and­all­over­the­computer.

Word­automatically­sets­page­margins­at­one­ inch­ from­every­page­edge.­Most­
English­teachers­and­book­editors­want­margins­of­this­size­because­these­people­
love­to­scribble­in­the­margins.­(They­even­write­that­way­on­blank­paper.)

To adjust page margins in Word, obey these steps:

1. Click the Layout tab.

2. Click the Margins button.

It’s found in the Page Setup group and shown in the margin.

Clicking the Margins button displays a menu full of common margin options.

3. Pluck a proper margin setting from the menu.

Or choose More Margins to visit the Page Setup dialog box and set your own, 

custom page margins. Refer to the next section for more information.

The­new­margins­affect­all­pages­in­the­document —­unless­you­split­the­docu-

ment into sections, in which case the changes apply to only the current section. 

See­Chapter 14­for­information­on­sections.

 » The Layout tab’s Margins button sets page margins. To set paragraph indents, 

also confusingly called margins, refer to Chapter 11.

 » The orange stars appearing on the Margins menu’s icons represent popular or 

recent margin choices you’ve made.

 » Many printers cannot print on the outside half-inch of a piece of paper, 

usually on one side — top, bottom, left, or right. This space is an absolute 

margin. You can direct Word to set a margin of 0 inches, though text may not 
print there. Instead, use a minimum of 0.5 inches for all margins.

Using the Page Setup dialog box

When­you­want­more­control­over­page­ formatting,­you­must­beckon­ the­Page­
Setup­dialog­box,­as­shown­in­Figure 13-1.­Specifically,­you­use­the­Margins­tab­in­
that­dialog­box,­which­is­shown­in­the­figure,­to­set­specific­margins­on­the­page.
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To­use­the­Page­Setup­dialog­box­to­specifically­set­page­margins,­obey­these­steps:

1. Click the Layout tab.

2. Click the dialog box launcher in the lower right corner of the Page Setup 

group.

The Page Setup dialog box appears.

3. On the Margin tab, type the margin offsets in the Top, Bottom, Left, and 
Right boxes.

Or you can use the spinner gizmo to set the values.

Use the preview to check the margins as they relate to page size.

4. Ensure that Whole Document is chosen from the Apply To menu button.

You can reset margins for only a section or selected text if you instead choose 

those options from the menu. See Chapter 14 for information on sections.

5. Click the OK button to confirm your new settings and close the Page 
Setup dialog box.

The­Gutter­settings­help­set­margins­when­you­need­extra­space­on­one­edge­of­
the­page­for­binding.­For­example,­if­you­plan­to­use­a­3-hole­punch­on­the­left­
side­of­a­page,­choose­Left­from­the­Gutter­Position­menu.­Then­increase­the­Gut-
ter­margin­to­accommodate­for­the­three­holes­in­the­page­without­affecting­the­
left margin setting.

FIGURE 13-1: 
The Margins tab 

in the Page Setup 

dialog box.
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Page Numbering

I­remain­puzzled­by­people­who­manually­number­their­pages­ in­Word.­Such­a­
thing is silly beyond belief. That’s because

Your word processor numbers your pages for you!

Memorize­it.­Live­it.­Be­it.

Adding an automatic page number

Word­automatically­numbers­your­pages.­But­wait!­There’s­more:­Word­also­lets­
you­place­the­page­number­just­about­anywhere­on­the­page­and­in­a­variety­of­fun­
and useful formats. Heed these directions:

NUTTY MULTIPLE-PAGE OPTIONS

In the Page Setup dialog box, Margins tab, you find the Pages area. (Refer to Figure 13-1.) 
The Multiple Pages drop-down list tells Word how to use a single sheet of paper for print-

ing complex documents. This feature is something you can avoid at all costs, yet I’m com-

pelled by the Computer Book Writers Union to describe the various settings:

Normal means one page per sheet of paper. You can’t get more normal than that.

Mirror Margins is used when the printer is smart enough to print on both sides of a 

sheet of paper. With this setting chosen, every other page is flip-flopped so that their 
margins always line up. For example, the gutter may be on the left side of one page but 

on the right for the page’s back side.

2 Pages per Sheet splits the paper right down the middle and forces Word to print two 

“pages” per sheet of paper. Note that this option works best when the pages are for-
matted in landscape orientation.

Book Fold is Word’s attempt to create a multiple-page booklet by printing the proper 
pages on both sides of a sheet of paper. The Sheets per Booklet option that appears 
tells Word how long the booklet is.

Despite having these options, Word is a poor bookbinding program. If you’re into docu-

ment publishing, consider obtaining a desktop publishing program, such as Adobe 
InDesign or Microsoft Publisher, which are far better equipped to deal with publishing 
manuscripts.
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1. Click the Insert tab.

2. In the Header & Footer area, click the Page Number command button.

A menu drops down, showing various page number locations: Top of Page, 

Bottom of Page, Page Margins (the sides of the page), and so on.

3. Choose from the submenu where to place the page numbers.

I want my page numbers on the bottom of the page, so I regularly choose the 

Bottom of Page submenu.

4. Pluck a page numbering style from the list.

You see oodles of samples, so don’t cut yourself short by not scrolling the 

menu. You can even choose those famous page X of Y formats.

Dutifully,­Word­numbers­each­page­in­your­document,­starting­with­1­on­the­first­
page,­up­to­however­many­pages­long­the­thing­grows.

Here’s­the­good­part:­If­you­delete­a­page,­Word­renumbers­everything­for­you.­
Add­ a­ page?­Word­ renumbers­ everything­ for­ you­ again,­ automatically.­ As­ long­ 
as you insert the page number as described in this section, Word handles 

everything.

 » To change the page number format, choose a different one from the Page 
Number menu.

 » To reference the current page number in your document’s text, choose the 

Current Position item in Step 3. Word inserts the current page number at the 

insertion pointer’s location. Also see Chapter 23.

 » The page numbers inserted atop or at the bottom of the document are placed 

in the document’s header or footer. See Chapter 14 for information on 
headers and footers.

 » Page numbers can be removed just as easily: See the section “Removing page 
numbers,” later in this chapter.

 » The page number is inserted as a field, not as plain text. In Word, fields can be 
updated and changed based on changing information.

 » If the page number that’s inserted looks something like { PAGE \* 

MERGEFORMAT }, right-click that ugly thing and choose the Toggle Field 
Codes command. You can also click the mouse inside the field codes and 
press Shift+F9.
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Starting with a different page number
You­and­I­know­that­the­first­page­of­a­document­is­page­1,­but­Word­doesn’t­care.­
It­lets­you­start­numbering­your­document­at­whichever­value­you­want.­If­you­
want to start numbering your document at page 42, you can do so.

Assuming that page numbers are already set in your document, follow these 

instructions:

1. Click the Insert tab.

2. In the Header & Footer area, choose Page Number ➪   Format Page 
Numbers.

The Page Number Format dialog box materializes, as shown in Figure 13-2.

3. Click the Start At radio button.

4. Type the starting page number in the box.

5. Click OK.

Word­starts­numbering­your­document­at­the­specified­page­number.­So,­if­you­
enter­42 in­Step­4,­the­first­page­of­the­document­is­now­page­42,­the­next­page­is­
43,­and­so­on.

For­more­page­number­control,­split­the­document­into­sections.­Different­page­
numbering­styles­or­sequences­can­be­set­ for­ individual­sections.­You­can­even­
suppress­page­numbers­for­a­section,­such­as­not­numbering­the­first­(cover)­page­
of­a­document.­See­Chapter 14­for­more­information­on­sections.

FIGURE 13-2: 
Gain more 

control over page 

numbers.
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Numbering with Roman numerals

When the urge hits you to regress a few centuries and use Roman numerals to tally 

a document’s pages, Word is happy to oblige. Sic facite:

I. Set the location for page numbers in the document.

Refer to the earlier section “Adding an automatic page number.” After page 

numbers are established, you can set a different format.

II. Click the Insert tab.

III. Click the Page Number command button and choose Format Page 

Numbers.

The Page Number Format dialog box appears.

IV. Choose a style from the Number Format menu.

Two Roman numeral styles are available: lowercase and uppercase.

V. Click OK.

Hail­Caesar!

Removing page numbers

To­banish­automatic­page­numbers­from­above,­below,­or­anywhere­else­around­
your­text,­follow­these­steps:

1. Click the Insert tab.

2. Click the Page Number command button.

3. Choose Remove Page Numbers.

And they’re gone.

These­steps­remove­only­the­page­numbers­set­by­using­the­Page­Number­com-

mand­button,­as­described­earlier­in­this­chapter.­Page­numbers­you’ve­inserted­in­
the­ text­ are­ unaffected,­ as­ are­ any­ page­ numbers­ you’ve­manually­ added­ to­ a­
document’s header or footer.

To­ remove­ a­ manually­ inserted­ page­ number,­ press­ the­ Backspace­ key­ twice­
because­ these­ page­ numbers­ are­ actually­ document­ fields.­ See­ Chapter  23­ for­
information­on­fields.
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New Pages from Nowhere

With­Word,­you­never­have­the­excuse­“I­need­more­paper”­when­writing­text.­
That’s because Word adds new, blank pages as needed. These pages are appended 

to­the­end­of­the­document,­so­even­if­you’re­typing­in­the­midst­of­a­chapter,­the­
extra­pages­keep­appearing­so­that­no­text­is­lost­and­nothing­falls­off­the­edge.­
That’s refreshing, but it’s not the end of Word’s capability to thrust new pages 

into a document.

Starting text on a new page

You­have­two­choices­when­it­comes­to­starting­text­at­the­top­of­a­page­in­the­
middle of a document.

The­first­choice­is­to­keep­whacking­the­Enter­key­until­that­new­page­shows­up.­
This­approach­is­horribly­wrong.­It­works,­but­it­leads­to­trouble­later­as­you­con-

tinue to create your document.

The second, and preferred, choice is to insert a hard page break:

1. Position the insertion pointer where you want one page to end and the 

next page to start.

I recommend splitting the page at the start of a new paragraph.

2. Click the Insert tab.

3. In the Pages group, click the Page Break command button.

Text before the insertion pointer flows to the previous page, and text after the 
insertion pointer rests on the next page.

The­hard­page­break­stays­with­the­text.­No­matter­how­you­edit­or­add­text,­the­
split between pages remains.

 » The keyboard shortcut to split pages is Ctrl+Enter.

 » To remove a hard page break, position the insertion pointer at the top of the 
page, just after the break. Press the Backspace key. If you goof up, use Ctrl+Z 

to undo.

 » Use the Show/Hide command to view the hard-page-break character. See 
Chapter 2 for information on the Show/Hide command

 » The hard page break is easier to see in Draft view.
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Inserting a blank page

Suddenly, you need a blank page in the middle of a document. Follow these steps:

1. Click the Insert tab.

2. In the Pages group, click the Blank Page command button.

A new, blank page appears at the insertion pointer’s position.

Any­text­before­the­insertion­pointer­appears­before­the­blank­page.­Any­text­after­
the insertion pointer appears after the new page.

 » The Blank Page command inserts two hard page breaks in the document.

 » Be mindful of the material you place on the new, blank page. Because two 
hard page breaks produce the page, it’s best suited for single-page items, such 
as graphics or a table. Any material longer than a page makes the rest of the 
document formatting look funky.

 » You don’t need to use this command to add a new page at the end of your 

document. Just keep typing.

Page Background Froufrou
A­page­is­also­a­canvas,­a­background­upon­which­your­document­rests.­This­back-

ground sports a few formatting options of its own, items that dwell outside a doc-

ument but remain part of the page formatting.

Coloring pages

The simple way to print colored pages is to use color paper. When the price of 

printer ink isn’t an option, you can direct Word to format each page in a document 

with­a­different­background­color.­Follow­these­steps:

1. Click the Design tab.

2. In the Page Background group, click the Page Color button.

You see a menu full of colors.

3. Choose a color from the palette.

Or choose the More Colors menu item to mix your own page background 
color.
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The­color­chosen­in­Step­3­is­applied­to­the­document’s­pages.

To­remove­the­color,­in­Step­3­choose­the­No­Color­item.

 » The colors displayed on the Page Color menu are based on the document 

theme. See Chapter 16 for information on document themes.

 » Page color is independent of text foreground and background colors. See 
Chapter 10 for information on text colors.

 » Unlike page size, orientation, and numbering, page background color is 
unaffected by document sections. The color is applied to every page in in the 
document. See Chapter 14 for more information on document sections.

 » Choose the Fill Effects menu item in Step 3 to view the Fill Effects dialog box. 
Click the Gradient tab to set gradients, or multiple colors, as the page back-

ground. Use the Picture tab to apply an image to each page’s background.

Printing colored pages

Viewing­a­colored­page­on­the­screen­is­one­thing.­Seeing­it­printed­is­another.­In­
Word, you must direct the printer to print the page background color by following 

these steps:

1. Click the File tab and choose Options.

The Word Options dialog box appears.

2. Choose Display from the left side of the Word Options dialog box.

3. In the Printing Options area, put a check mark by the item labeled Print 

Background Colors and Images.

4. Click OK.

The page background color now appears whenever the document is printed — 
well, assuming that you have a color printer.

Because­Word’s­ page­ color­ isn’t­ part­ of­ the­ paper,­ it­ doesn’t­ cover­ the­ entire­
printed page. That’s because your printer cannot mechanically access the outside 

edge­of­a­page,­so­a­white­border­(or­whatever­other­color­the­paper­is)­appears­
around the colored page. Yes, it’s just easier to print on colored paper than to 

waste­all­that­expensive­printer­ink­or­toner.
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Adding a watermark

Word’s watermark feature isn’t like the watermark you see when you hold up a 

sheet­of­fine­paper­to­the­light.­Nope,­it’s­for­slapping­a­quick­background­on­the­
page to let people know it’s a draft or sample or to warn people not to copy the 

page. Yes, this watermark feature is utilitarian, which is why you see it a lot in 

government.

To­slap­a­watermark­on­every­page­in­your­document,­follow­these­steps:

1. Click the Design tab.

2. In the Page Background group, click the Watermark button.

A menu plops down with a host of predefined watermarks that you can safely 
tuck behind the text on the document’s pages.

3. Choose a watermark from the menu.

The watermark is applied to every page in the document.

To­rid­ the­document’s­pages­of­ the­watermark,­choose­ the­Remove­Watermark­
command­in­Step­3.

 » To customize the watermark, choose the Custom Watermark command from 
the Watermark menu. Use the Printed Watermark dialog box to create your 
own watermark text or to import an image, such as the company logo.

 » The watermark is unaffected by section breaks. See Chapter 14 for informa-

tion on section breaks.

 » If the watermark doesn’t show up in the printed document, you may need to 
enable the Print Background Colors and Images setting. Refer to the preced-

ing section.
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Chapter 14

Section Formatting

W
ord­ page­ formats  —­ such­ as­ paper­ size,­ margins,­ orientation,­ and­
­columns —­apply­to­an­entire­document,­from­“once­upon­a­time”­to­
“happily­ever­after.”­That­is,­unless­you­split­your­document­into­sec-

tions.­A­section­is­a­page-level­container,­limiting­the­effects­of­page­formatting­
to­the­confines­of­the­section.­These­formats­include­page­size,­margins,­orienta-
tion,­and­columns,­all­of­which­are­covered­in­Chapter 13.

Sections­also­affect­headers­and­footers,­which­are­text­tidbits­that­appear­at­the­
top­ or­ bottom­ of­ each­ page­ in­ a­ document.­No!­ Let­me­ correct­ that­ assertion:­
Headers­and­footers­are­consistent­within­a­section.­There.­I­just­gave­you­more­
section­fodder­to­consider.

Section­breaks­are­not­a­feature­of­the­online­version­of­Word.

IN THIS CHAPTER

 » Using sections

 » Placing a cover page on your 

document

 » Adding a header or footer

 » Creating unique headers and footers

 » Suppressing the header and footer on 

the first page

 » Working with headers and footers in 

sections

 » Deleting a header or footer
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Slice a Document into Sections

A­section­is­a­page­formatting­container.­All­documents­feature­one­section,­which­
is­why­the­various­page­formatting­commands­affect­the­entire­document —­they’re­
applied­to­the­single­section.­A­document,­however,­can­be­sliced­into­multiple­sec-
tions.­Each­section­sports­its­own­page­format,­independent­of­the­other­sections.

Figure 14-1­illustrates­three­examples­of­how­sections­can­affect­page­formatting.

In­Example­1,­the­document­contains­two­sections.­The­first­section­uses­Roman­
numeral­page­numbers.­The­second­uses­human­numerals.­Each­section­restarts­
page­numbering.

The­document­in­Example­2­contains­a­single-page­section­for­its­cover­page.­The­
second­section —­all­remaining­pages —­uses­page­numbering.

FIGURE 14-1: 
How sections 

control page 

formatting.
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In­Example­3,­the­document­has­three­sections.­The­first­and­third­sections­sport­
the­same­page­formatting;­the­second­section­was­created­so­that­page­6­can­be­
presented­in­landscape­orientation.

In­all­three­examples,­the­document’s­text­and­paragraph­formats­remain­unaf-
fected­ by­ sections.­ Only­ page­ level­ formatting­ is­ affected.­ Even­ then,­ you­ can­
choose­whether­to­apply­a­page­level­format­to­the­current­section­or­to­the­entire­
document.

Creating a section

It­helps­to­think­of­a­section­like­a­hard­page­break,­though­it’s­page­formatting­
that’s­“broken,”­not­a­physical­page­in­the­document.­To­create­a­new­section­in­
a­document —­to­insert­a­section­break —­heed­these­steps:

1. Position the toothpick cursor where you want the new section to start.

Click the mouse where you need to begin a new section, similar to creating a 

hard page break. For most sections, position the insertion pointer at the start 

of a paragraph.

2. Click the Layout tab on the Ribbon.

3. In the Page Setup area, click the Breaks button.

The last four items on the menu are various section breaks.

4. Choose Next Page from the Breaks button menu.

A new section has started, which also serves as a page break.

Pages­before­the­section­break­are­in­one­document­section,­and­pages­after­are­in­
the­ next.­ Page­ formatting­ commands­ can­ be­ applied­ independently­ to­ either­
section.

Here­is­a­summary­of­the­different­types­of­section­breaks:

Next Page: Start a new section and break the page, like a hard page break. 

(See Chapter 13.)

Continuous: Start a new section on a flexible boundary, depending on which page 
formatting command is used. A continuous section break may start a new page, or 

it may not.

Even Page: This section break is similar to the Next Page choice, but the page 
starting the new section is on an even-numbered page, the left side of a bound 

manuscript.
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Odd Page: This section break works like an Even Page section break, though the 

page following the break will be odd, or on the right side of a bound manuscript.

When­working­with­sections,­I­recommend­activating­the­Section­item­on­the­sta-
tus­bar:­Right-click­the­status­bar­and­choose­Section­from­the­pop-up­menu.­The­
Section­ item­ shows­ the­ current­ section­ by­ number­ as­ you­ work­ through­ the­
document.

Using sections

You­have­two­options­to­apply­a­page­formatting­command­to­a­specific­section­
within­a­document.­In­both­instances,­the­insertion­pointer­must­roost­in­the­sec-
tion­you­want­to­format.

To­apply­a­page­format­to­the­current­section,­select­that­format­from­the­Ribbon,­
as­described­in­Chapter 13.­For­example,­set­a­new­page­orientation,­and­that­for-
mat­affects­only­the­current­document­section.

In­ the­ Page­ Setup­ dialog­ box,­ however,­ use­ the­ Apply­ To­ drop-down­menu­ to­
apply­page­formatting­changes­to­the­current­document­section,­as­illustrated­in­
Figure 14-2.

FIGURE 14-2: 
Applying page 

formatting to one 

section only.
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Each­tab­in­the­Page­Setup­dialog­box­features­the­Apply­To­drop-down­menu,­like­
the­ one­ shown­ in­ Figure  14-2.­Use­ it­ to­ apply­ page­ formatting­ changes­ to­ the­
entire­document­or­to­only­the­current­section.

Removing a section break

Section­breaks­are­invisible­in­Print­Layout­view,­though­you­can­see­them­in­Draft­
view.­To­remove­the­section­break,­you­delete­it.­Follow­these­steps,­though­you­
can­start­at­Step­3­when­using­Draft­view:

1. Click the Home tab.

2. In the Paragraph group, click the Show/Hide command button.

Hidden codes and characters are revealed in the document.

3. Position the insertion pointer to the start (left end) of the double-dashed 

lines that say Section Break.

4. Press the Delete key.

The section break is gone.

5. Click the Show/Hide command button again to hide the codes.

After­the­section­break­vanishes,­the­page­formatting­changes,­adopting­the­for-
mat­ from­ the­previous­ section.­This­ update­ is­ to­ be­ expected,­ but­ it­may­ alter­
things­you­can’t­see,­such­as­page­numbering­and­headers­and­footers.

That First Page

Even­when­you’re­blessed­with­a­superior­knowledge­of­paragraph­formatting­and­
you­fully­understand­the­magic­of­the­section­break,­formatting­that­first­page­can­
be­a­bother.­The­kids­at­Microsoft­are­aware­of­your­frustration,­so­they­concocted­
some­special­first-page­formatting­features­for­Word.

Adding a cover page

The­sneakiest­way­to­slap­down­a­cover­page­on­a­document­is­to­use­Word’s­Cover­
Page­command.­Here’s­how­it­works:

1. Click the Insert tab.

2. In the Pages group, click the Cover Page button.
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If you don’t see the Pages group or Cover Page button, click the Pages button 

and then click the Cover Page icon.

The Cover Page button displays a fat, fun menu full of various cover page 

layouts.

3. Choose a cover page layout that titillates you.

The cover page is immediately inserted as the first page in the document.

Many­ preset­ cover­ pages­ feature­ replaceable­ text,­ such­ as­ [COMPANY­ NAME].­
Click­ this­ text­ and­ type­ something­ appropriate,­ such­ as­ your­ actual­ company­
name,­unless­you­actually­work­for­the­Company­Name­Corp.­Do­so­for­all­brack-

eted­text­on­the­inserted­cover­page.

 » You can change a cover page at any time by choosing a new one from the 

Cover Page menu. The new cover page retains any replacement text 
you typed.

 » To remove a cover page, summon the Cover Page menu and choose the 

Remove Current Cover Page item.

 » The cover page you add is followed by a hard page break. It’s not a section 

break. Even so, it’s treated differently from certain page formatting com-

mands applied to the rest of the document. That means if you add page 

numbers or a header or footer to your document, the formatting applies to 

only the second page and later pages, not to the cover page.

Inserting a cover page manually

When­you’re­dissatisfied­with­Word’s­cover­page­designs,­you­can­craft­your­own­
cover­page.­All­the­formatting­tools­and­document­tricks­presented­in­this­book­are­
at­your­disposal.­You­just­need­to­insert­the­page­at­the­start­of­the­document.

Here­are­the­general­steps­to­take:

1. Before writing the cover page, position the toothpick cursor at the 

tippy-top of the document.

The keyboard shortcut is Ctrl+Home.

2. Click the Layout tab.

3. Choose Breaks ➪   Next Page.

A section break effectively inserts a new, first page into the document as its 
own section.
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4. Create the cover page.

On the new first page, add a title, additional text, graphics, and various 
document froufrou.

Because­the­first­(cover)­page­is­now­its­own­section,­the­page­formatting­it­sports­
can­be­separated­from­the­rest­of­the­document.­For­example,­you­can­apply­page­
numbering­to­the­second­section,­which­keeps­the­cover­page­unnumbered.­Refer­
to­Figure 14-1,­Example­2.

Headers and Footers

It’s­easy­to­confuse­the­concept­of­headers­and­footers­with­headings­and­foot-
notes.­To­help­you­understand­the­difference,­consider­these­definitions:

 » A header is text that appears at the top of every page in a document.

 » A heading is a text style used to break up a long document, to introduce new 
concepts, and to help organize the text. See Chapter 15.

 » A footer is text that appears at the bottom of every page in a document.

 » A footnote is a tiny bit of text that appears at the bottom of a page, usually a 
reference to some text on that page. See Chapter 21.

In­Word,­headers­and­footers­dwell­in­special,­exclusive­areas­outside­the­realm­of­
regular­text.­These­areas­are­found,­top­and­bottom,­on­all­pages­in­a­document.­
Unless­you­place­some­text­or­other­items­inside­these­areas,­they­remain­invisible.

Text­that­typically­finds­its­way­into­a­header­or­footer­(or­both)­includes­page­
numbers,­your­name,­the­document­name,­the­date,­and­other­information­that’s­
handy­to­have­on­every­page.

Using a preset header or footer

Most­documents­use­standard,­noncreative­headers­and­footers,­placing­common­
information­into­one­or­both­locations.­To­accommodate­your­hurried­desires,­you­
can­quickly­shove­one­of­these­preset­headers­or­footers­into­your­document.­Heed­
these­steps:

1. Click the Insert tab.
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2. From the Header & Footer group, choose the Header button.

The Header menu shows a list of preformatted headers.

3. Choose a header design.

The design’s contents are added to the document, saved as part of the page 

format. Also, the Header & Footers Tools Design tab appears on the Ribbon.

4. Change any [Type here] text in the header.

Click the bracketed text and type to personalize your header.

5. Use the commands on the Insert group of the Header & Footer Tools 

Design tab to add specific items in the header.

Examples are offered in the sections that follow.

6. When you’re done working on the header, click the Close Header and 

Footer button.

Or you can double-click in the main text body.

To­add­a­footer,­choose­the­Footer­button­in­Step­2­and­think­of­the­word­footer 
whenever­you­see­the­word­header­in­the­preceding­steps.

After­you­exit­from­the­header­or­footer,­you­see­its­text­at­the­top­or­bottom­of­the­
document­in­Print­Layout­view.­It­appears­ghostly,­to­let­you­know­that­it’s­there­
but­ not­ part­ of­ the­ document.­ To­ edit­ the­ header­ or­ footer,­ double-click­ that­
ghostly­text.

Creating a custom header or footer

When­one­of­ the­preset­header/footer­ designs­doesn’t­ cut­ it,­ consider­ creating­
your­own.­The­secret­is­to­double-click­the­space­at­the­top­or­bottom­of­the­page­
in­Print­Layout­view.­This­location­is­the­header­or­footer­area,­respectively.­When­
it­becomes­active,­you­can­manually­craft­a­header­or­footer­to­match­your­inner-
most­desires.

A­header­or­footer­can­contain­text,­a­graphical­goober,­a­field,­or­any­other­item­
you­can­slap­down­into­the­main­part­of­the­document.­Common­and­useful­com-

mands­appear­on­the­Header­&­Footer­Tools­Design­tab,­but­you­can­use­other­tabs­
on­the­Ribbon­to­create­and­customize­a­header­or­footer.

To­switch­between­the­header­and­footer­while­editing,­click­the­Go­to­Footer­or­
Go­to­Header­button.­These­buttons­are­found­on­the­Header­&­Footer­Tools­Design­
tab­in­the­Navigation­group.
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Type text

Any­text­you­type­in­a­header­or­footer­becomes­part­of­the­header­or­footer.­It­
doesn’t­have­to­be­fancy­text, just­whatever­text­you­want­appearing­at­the­top­or­
bottom­of­every­page­in­the­document.

Word’s­default­format­for­lines­in­a­header­or­footer­includes­two­tab­stops:­A­­center­
tab­stop­in­the­middle­of­the­page­and­a­right­tab­stop­aligned­with­the­right­mar-
gin.­Use­these­tab­stops,­as­illustrated­in­Figure 14-3,­to­create­useful­header­text.

Add a page number

It’s­tempting,­and­it­seems­like­the­obvious­choice,­but­don’t­use­the­Page­Number­
command­on­the­Header­&­Footer­Tools­Design­toolbar.­If­you­need­a­page­number­
in­a­header­or­footer,­add­a­document­page-number­field.­Follow­these­steps:

1. Position the insertion pointer where you want the page number to 

appear in the header or footer.

2. On the Header & Footer Tools Design tab, in the Insert group, click the 

Document Info button and choose Field.

The Field dialog box appears. It’s a busy place, covered in full detail in 
Chapter 23.

3. From the Categories menu, choose Numbering.

4. In the Field Names list, select Page.

5. Choose a page number style from the Format list.

For example, choose the item 1, 2, 3, to use that numbering style.

FIGURE 14-3: 
Text in a header 

and a footer.
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6. Click the OK button.

The Page field is inserted in the header. It reflects the current page number for 
every page printed in the document.

 » You don’t have to go to Page 1 to insert a page number in a header. Word is 

smart enough to place the proper number on the proper page, no matter 

where you’re editing the header in the document.

 » If you want one of those Page 3 of 45 indicators in a header or footer, you 

need two fields: the Page field, as described in this section, and the NumPages 
field. To add this field, repeat the steps in this section, but in Step 3 choose the 
Document Information category and in Step 4 choose the NumPages field 
name.

Add the date and time

To­place­the­current­date­or­time­or­an­updating­time­field­in­a­header­or­footer,­
follow­these­steps:

1. Position the insertion pointer where you want the date or time to 

appear.

2. On the Header & Footer Tools Design tab, in the Insert group, click the 

Date & Time command button.

The Date and Time dialog box appears.

3. Choose a format for the date or the time, or both.

4. To keep the date and time information current, place a check mark by 

the Update Automatically option.

5. Click OK.

Also­see­Chapter 23­for­information­on­the­PrintDate­field.

Working with multiple headers and footers

Headers­ and­ footers­ come­ in­ a­ variety­ of­ types,­ allowing­ you­ to­ change­ them­
depending­on­whether­the­page­is­odd­or­even,­or­to­alter­the­header­or­footer­for­
a­given­document­section.­You­can­even­suspend­the­header­and­footer­for­a­page­
or­ two,­providing­ those­pages­dwell­ in­ their­own­section.­Such­agility­ requires­
knowing­a­few­tricks,­which­I’m­happy­to­share.
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Odd and even headers and footers

See­how­this­book­has­different­footers­on­its­odd-­and­even-numbered­pages?­The­
even-numbered­pages­show­the­page­number­and­part­title;­the­odd-numbered­
pages­show­the­chapter­title­and­page­number.­To­configure­such­odd/even­­headers­
(and­footers)­for­your­document,­obey­these­steps:

1. Create or edit a header or footer, as described elsewhere in this chapter.

2. Click the Header & Footer Tools Design tab.

3. Click the Different Odd & Even Pages check box.

With this feature active, Word sets up headers and footers for odd- and 

even-numbered pages. The Header and Footer tags in the document reflect 
the change as well, saying Odd Page Footer or Even Page Footer. The tag tells 

you which header or footer you’re editing.

4. Create the header and footer for the odd-numbered pages.

Follow the suggestions listed in this chapter.

5. On the Ribbon’s Header & Footer Tools Design tab, in the Navigation 

group, click the Next button.

Word displays the even page header or footer, allowing you to create or edit its 

contents. The Header or Footer tag changes to reflect which header you’re 
editing.

If clicking the Next button does nothing, your document has only one page! 
Add a page to enable the even-page headers and footers.

To return to the odd-page header or footer, click the Previous button.

6. Close the header or footer when you’re done.

To­return­to­using­only­one­header­and­footer­for­a­document,­repeat­these­steps­
but­in­Step­3­remove­the­check­mark.­Any­even-page­header­or­footer­you’ve­set­is­
removed,­leaving­only­the­odd-page­header­and­footer.

The­even-numbered­page­is­always­on­the­left.

No header or footer on the first page
Most­people­don’t­want­the­header­or­footer­on­their­document’s­first­page,­which­
is­usually­the­title­page­or­the­cover­page.­Suppressing­the­header­for­that­page­is­
easy,­if­you­follow­these­steps:

1. Edit the document’s header or footer.
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2. Click the Header & Footer Tools Design tab.

3. In the Options group, place a check mark by Different First Page.

That’s it.

The­Header­or­Footer­tag­on­the­first­page­changes­to­read­First­Page­Header­or­
First­Page­Footer.­It’s­your­visual­clue­that­the­first­page­of­the­document­sports­a­
different­header­from­the­ones­in­the­rest­of­the­document.­If­you­don’t­want­any-

thing­to­appear­there,­leave­it­blank.

Headers, footers, and sections

One­way­to­apply­different­headers­and­footers­to­your­document­is­to­use­sec-
tions.­This­way,­you­can­change­the­header­and­footer­between­sections,­but­only­
when­you­unlink­ the­headers­and­ footers.­Unless­you­know­this­ trick,­working­
with­headers­and­footers­in­different­sections­can­be­frustrating.

To­break­the­link­between­the­current­section’s­header­and­footer­and­the­previous­
section’s­header­and­footer,­follow­these­steps:

1. Edit the document’s header or footer in the section that you want to be 

different from the previous section’s header and footer.

2. Click the Header & Footer Tools Design tab.

3. In the Navigation group, click the Next button to locate the start of the 

next section’s header or footer.

The Header tag or Footer tag is updated to reflect the current section, as 
shown in Figure 14-4. You also see the tag Same as Previous, which is your clue 
that the header is identical to the one in the previous section. For example, if 
you change something in the first section’s header, the change is reflected in all 
linked headers.

4. In the Navigation group, click the Link to Previous button.

The link is broken. The Same as Previous tag disappears. The header or footer 

doesn’t change — yet.

5. Edit the section’s header or footer.

Changes made apply to only the current section.
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The­link­is­what­confuses­a­lot­of­people.­They­know­about­sections,­but­when­they­
change­ the­ header­ or­ footer­ in­ one­ section,­ the­ text­ isn’t­ updated.­ This­ effect­
means­that­the­Same­as­Previous­link­still­exists­between­the­header­or­footer.­To­
fix­the­problem,­break­the­link.

To­restore­the­link,­return­to­the­given­section’s­header­or­footer­and­repeat­the­
steps­in­this­section.­Clicking­the­Link­to­Previous­button­a­second­time­reestab-

lishes­the­link.

 » Unlinking a header or footer may not work if your document uses different 
headers and footers on odd- and even-numbered pages, as described earlier 

in this chapter.

 » The Different First Page option, described earlier in this chapter, doesn’t link 
the header or footer between the first page and the rest of the document.

Removing a header or a footer

You­can’t­destroy­the­header­or­footer­area­in­a­document,­but­you­can­remove­all­
text­and­other­stuff:­Edit­the­header­or­footer,­press­Ctrl+A­to­select­everything,­
and­press­the­Delete­key.­Poof!

The­more­ofÏcial­way­to­remove­a­header­or­footer­is­to­follow­these­steps:

1. Edit the document’s header or footer.

2. Click the Header & Footer Tools Design tab.

3. In the Header & Footer group, click the Header button.

4. Choose Remove Header.

The header is gone.

5. Click the Footer button and choose Remove Footer.

The footer is gone.

FIGURE 14-4: 
Header in 

Section 2, linked 
to Section 1.





CHAPTER 15  Style Formatting      183

Chapter 15

Style Formatting

I
f all of Word’s formatting commands are ingredients, a style is a recipe. A style 
is a single command that applies a virtual stew of formatting commands, 
everything at once. Even better, when you update or change a style, all text 

formatting with that style applied changes as well. Styles help you save time and 
make your documents look fabulous.

The Big Style Overview

A style is a collection of text and paragraph formats given a single name and 
applied to text, just like any other format. When you apply a style, you apply all 
the formats stored in that style. Update a style, and all text in a document with the 
style applied is updated. For heavy-duty formatting, creating and using styles 
saves time.

Styles are available in all documents. The default style is called Normal, and it’s 
applied to text in a new document unless you apply another style. Along with the 
Normal style, many other preset styles are available for your use, or you can create 
your own.

IN THIS CHAPTER

 » Understanding styles

 » Finding where Word hides styles

 » Applying styles

 » Removing styles

 » Creating your own styles

 » Modifying styles

 » Assigning a style shortcut key
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For­the­current­version­of­Word,­the­Normal­style­is­defined­as­the­Calibri­font,­ 
11­ points­ tall,­ left-justified­ paragraphs,­multiple­ line­ spacing­ at­ 1.08­ lines,­ no­
indenting, zero margins, and 8 points of space after every paragraph.

Other­preset­styles­include­the­Heading­styles­and­Caption.­You­use­the­Heading­
styles,­such­as­Heading­1­for­a­document’s­top­level­heading,­and­the­Caption­style­
for­figure­and­table­captions.­The­names­reflect­how­to­use­the­style.

Styles­are­also­categorized­by­which­part­of­the­document­they­affect.­Five­style­
types are available:

Paragraph: The paragraph style contains both paragraph- and text-formatting 
attributes:­indent,­tab,­font,­text­size —­you­name­it.­It’s­the­most­common­type­
of style.

Character:­ The­ character­ style­ applies­ only­ to­ characters.­ It­ uses­ the­ character­
formatting­commands,­which­are­mentioned­in­Chapter 10.

Linked: The linked style can be applied to both paragraphs and individual charac-
ters.­The­difference­depends­on­which­text­is­selected­when­the­style­is­applied.

Table: The table style is applied to tables, to add lines and shading to the table 
cells’­contents.­Refer­to­Chapter 19­for­more­information­on­tables­in­Word.

List: The list style is customized for presenting lists of information. The styles can 
include bullets, numbers, indentation, and other formats typical for the parts of a 
document­that­present­lists­of­information.­See­Chapter 21­for­info­on­lists.

These types come into play when you create your own styles as well as when 
you’re perusing styles to apply to text.

Finding the styles

Styles dwell on the Home tab, in the aptly named Styles group, illustrated in  
Figure 15-1.­What­you­see­on­the­Ribbon­is­the­Style­Gallery,­which­can­be­expanded­
into­a­full­menu­of­style­choices,­as­shown­in­the­figure.

Click­the­dialog­box­launcher­in­the­lower­right­corner­of­the­Styles­group­to­view­
the­Styles­pane,­also­shown­in­Figure 15-1.­To­dismiss­the­Styles­pane,­click­the­X­
(Close)­button­in­its­upper­right­corner.
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 » The Styles pane lists more styles than the Style Gallery, including styles 

you’ve created.

 » To preview the styles in the Styles pane, put a check mark in the box by the 

Show Preview option, found at the bottom of the Styles pane.

 » You can see more information about a style by simply hovering the mouse 

pointer over the style’s name in the Styles pane.

 » To view all available styles in the Styles pane, click the Options link (in the 

lower right corner). In the Styles Pane Options dialog box, choose All Styles 

from the Select Styles to Show menu. Click OK.

 » Word’s predefined styles are specified in the Style Gallery, though you can 
customize the list to replace Word’s styles with your own. See the section 

“Customizing the Style Gallery,” later in this chapter.

Using a style

Styles are applied to text, just like any other formatting: Select a block of text and 
then­apply­ the­style:­Select­ the­style­ from­the­Style­Gallery­or­ the­Styles­pane.­
(Refer­to­the­preceding­section.)­You­can­also­choose­a­style­and­start­typing.­In­
both cases, the formats held in the style are applied to the text.

FIGURE 15-1: 
Where Word 

styles lurk.
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 » Some styles are assigned a keyboard shortcut. For example, the shortcut for 

the Normal style is Ctrl+Shift+N. Use the keyboard shortcut to apply the style.

 » Heading styles play a special role in Word. They’re used for document 

navigation and outlining as well as for creating a table of contents. See the 

later section “Creating heading styles” for details.

 » As with any other formatting, applying a style replaces the previously applied 

style in the text.

 » If the Live Preview feature is enabled, you can hover the mouse pointer over a 

style in the Style Gallery to see how it affects selected text in the document. To 
enable this feature, click the File tab and choose Options. In the Word Options 

dialog box, General category, add a check mark by the Enable Live Preview 

item.

Discovering the current style

To­determine­which­style­is­in­use,­gander­at­the­Home­tab’s­Style­Gallery.­The­
style for selected text, or wherever the insertion pointer is blinking, is highlighted. 
If­the­Styles­pane­is­visible,­the­current­style­also­appears­highlighted­there.

To­microscopically­examine­the­style­for­any­text,­use­the­Style­Inspector.­Follow­
these steps:

1. Place the insertion pointer in a specific chunk of text.

2. If the Styles pane isn’t visible, click the Home tab, and in the Styles group, 

click the Launcher icon.

3. Click the Style Inspector button.

The Style Inspector icon is shown in the margin.

Upon­success,­ you­ see­ the­Style­ Inspector­window,­ similar­ to­what’s­ shown­ in­
Figure 15-2.­The­Style­Inspector­discloses­the­formatting­of­the­text­based­on­the­
style plus any additional formatting applied to the style.

To­see­even­more­details,­such­as­the­specific­formats­used,­click­the­Reveal­For-
matting­button,­as­illustrated­in­Figure 15-2.­Use­the­Reveal­Formatting­pane­to­
examine all details for the style.

The shortcut key to summon the Reveal Formatting pane is Shift+F1.
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Removing style formatting

You­don’t­remove­style­formatting­from­text­as­much­as­you­reapply­another­style.­
In­Word,­to­effectively­remove­a­style,­you­replace­it­with­the­default­style,­Normal.

Because­many­Word­users­don’t­understand­styles,­Word­comes­with­Clear­For-
matting­commands.­You­can­see­such­commands­referenced­in­Figure 15-2,­which­
illustrates­the­Style­Inspector.­Clicking­those­buttons­replaces­the­given­style­with­
the Normal style.

 » See the later section “Changing the Normal style,” for more details on setting 

default formatting.

 » Also see Chapter 10 for information on using the Clear Formatting command, 
which applies to font formats.

Make Your Own Styles

To­convince­you­that­styles­are­important,­consider­this:­You­create­a­custom­for-
mat­for­your­document’s­headings.­You­pick­the­right­font,­size,­and­color­and­add­
just enough space after the heading. Then you decide to change the font. When 
you create a style, you make only one change and all the document’s headers are 
updated. Otherwise, you must change each individual heading. And that sucks.

FIGURE 15-2: 
Style Inspector.
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Creating a style

The easiest way to make up a new style is to format a single paragraph just the 
way you like. After the character and paragraph formatting has been applied, fol-
low these steps to create the new style:

1. Select the text you’ve formatted.

2. Click the Home tab.

3. In the Styles group, display the full Quick Styles Gallery.

Click the down-pointing arrow in the lower right corner of the gallery. Refer to 

Figure 15-1.

4. Choose the Create a Style command.

The Create New Style from Formatting dialog box appears.

5. In the Name box, type a short and descriptive name for your style.

For example, you might type proposal body for the main text of a proposal or 

dialogue for a character’s lines in a play.

6. Click the OK button to create the style.

The style is created and applied to the selected text.

The­style­you­create­appears­on­the­Ribbon­in­the­Style­Gallery­as­well­as­in­the­
Styles­pane­(if­visible).

 » Styles you create are saved with the document, along with the text and other 

document info.

 » To make the style available to other documents, build a template, as 

described in Chapter 16. Styles in a template are available to all documents 
created by using that template.

 » To fine-tune a style after it’s created, see the later section “Modifying a style.”

Using the Create New Style from  
Formatting dialog box
A­more­detailed­way­to­build­a­style­is­to­summon­the­Create­New­Style­from­For-
matting dialog box, which has the same name as its tiny cousin, described in the 
preceding­section,­but­offers­far­more­controls­and­details.
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The­Create­New­Style­from­Formatting­dialog­box­lists­all­of­Word’s­formatting­
settings­and­options­in­one­place.­If­you’re­familiar­with­using­Word’s­formatting­
commands, this dialog box serves as a useful tool to create new styles. Follow 
these steps:

1. Summon the Styles pane.

The keyboard shortcut is Ctrl+Shift+Alt+S. If you don’t want to tie your fingers in 
a knot, see the earlier section “Finding the styles” for the long way to bring up 

the Styles pane.

Because I use a lot of styles, I prefer to keep the Styles pane opened in my 

documents. If you drag the pane over the document window’s right edge, it 

docks permanently.

2. Click the New Style button.

The button is shown in the margin. Click it to see the Create New Style from 

Formatting dialog box, as shown in Figure 15-3.

3. Type a short, descriptive name for the new style.

4. Ensure that Paragraph is chosen as the style type.

FIGURE 15-3: 
The Create New 

Style from 

Formatting 

dialog box.
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Or, if the format is a character style, choose Character. An example of a 

character style is blue, bold, Courier, 12-point — the one that I use in my 
documents for filenames.

5. Choose an existing style as a base from the Style Based On drop-down 
list.

Following this step saves time. If the style you’re creating features similar 

formatting as an existing style, choose that style from the list. The formats 

from that style are copied over, letting you build upon them or reuse them in a 

different way.

For example, your B-level heading is the same as the A-level heading style, but 

14 points instead of 18. So you base the B-level heading style upon the A-level 

style, modifying only the font size.

6. Use the controls in the dialog box to set the style’s format.

The Create New Style from Formatting dialog box is brimming with style 

command buttons.

Use the Format button in the dialog box’s lower left corner to apply specific 
formatting commands. Choose a category from the button’s menu to see a 

dialog box specific to one of Word’s formatting categories.

7. Click the OK button when you’re done.

The new style is created.

Modifying a style

Styles change. Who knows? Maybe blow-dried hair and wide lapels will creep back 
into vogue someday.

THE FOLLOW-ME STYLE
A helpful way to quickly apply styles in a document is to take advantage of the Style for 

Following Paragraph menu, found at the top of the Create New Style from Formatting 

dialog box. When you choose a style from this item’s menu, Word switches automati-

cally to that style after using the current style. It’s what I call the “follow-me” style.

Suppose that your Document Title style is followed by the First Paragraph style. After 

you type the Document Title text and press Enter, Word switches to the First Paragraph 

style for you. That type of formatting control saves you time in formatting a document 

where you know that one style always follows another.
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When­you­change­your­mind­about­a­style­and­want­to­update­a­specific­element,­
heed these steps:

1. Summon the Styles pane.

Keyboard shortcut: Ctrl+Shift+Alt+S.

2. Position the mouse pointer over the style you want to change.

Don’t click the mouse, which applies the style. Instead, hover the pointer in the 

style’s entry; a menu button appears on the right.

3. Click the menu button.

The style’s menu appears.

4. Choose Modify.

The Modify Style dialog box appears, though it’s the same Create New Style 
from Formatting dialog box (refer to Figure 15-3), just with a shorter name.

5. Change the style’s formatting.

Use the Format button to alter specific styles: font, paragraph, tab, and so on. 
You can even add new formatting options or assign a shortcut key (covered in 

the next section).

6. Click OK when you’re done.

Modifying the style instantly updates text with that style applied. For example, if 
you­change­the­font­for­your­Figure­Caption­style,­all­figure­caption­text­changes­
at once. That’s the power of using styles.

Assigning a shortcut key to a style

When­you­find­yourself­applying­ the­same­styles­over­and­over,­assign­ them­a­
special shortcut key. Follow these steps:

1. Press the keyboard shortcut Ctrl+Shift+Alt+S to summon the Styles pane.

I know: You can’t use Ctrl+Shift+Alt+S for the style, because it’s already assigned 

to the Styles pane.

2. In the Styles pane, click a style’s menu button.

Position the mouse pointer over the style you want to change; the menu 

button appears.

3. Choose Modify.

The Modify Style dialog box appears.
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4. Click the Format button and choose Shortcut Key from the menu.

The Customize Keyboard dialog box appears. The two items you must pay 

attention to are the Press New Shortcut Key box and the area just below the 
Current Keys list.

5. Press the shortcut-key combination.

Use at least two of the shift keys — Shift, Alt, or Ctrl — when pressing the 
shortcut-key combination. Most of the Ctrl+Alt key combinations are unas-

signed in Word.

The keys you press are named in the Press New Shortcut Key box.

If you make a mistake, press the Backspace key and then choose another key 

combination.

6. Confirm that the key combination you chose isn’t already in use.

Look below the Current Keys list. The text there explains which Word com-

mand uses the key combination you’ve pressed. When you see [unassigned], it 

means that your key combination is available for use.

7. Click the Assign button.

8. Click the Close button.

The Customize Keyboard dialog box skulks away.

9. Click the OK button to dismiss the Modify Style dialog box.

Try out your shortcut: Position the insertion pointer in a block of text and press 
the key combination. The style is applied instantly.

I’ll­be­honest:­All­the­good­shortcut­keys­are­taken.­Word­uses­most­of­them­for­its­
important commands. That leaves you with some Shift+Alt­and­Ctrl+Alt key com-
binations. Having these available is better than nothing.

Deleting a style

To peel away any style you’ve created, follow these steps:

1. Display the Styles pane.

The keyboard shortcut is Ctrl+Shift+Alt+S.

2. Right-click the style you want to obliterate.

3. Choose the Delete item.

The Delete item is followed by the style’s name.
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4. Click the Yes button to confirm.

The style is removed from the document.

The­Normal­style­is­applied­to­the­affected­text.

You­cannot­delete­any­of­Word’s­default­styles,­including­Normal­and­the­various­
heading styles.

Style Tips and Tricks

Awash in a sea of styles, it’s easy to overlook some of the more subtle aspects of 
Word’s styles. For example, the Normal style need not be stuck as the default for 
all­ new­ documents.­ And­ those­ heading­ styles­ offer­more­ power­ than­ you­may­
suspect.

Changing the Normal style

All documents sport the Normal style, which is the standard text-and-paragraph 
style and probably the style upon which all your personal styles are based. Like 
just­about­anything­in­Word,­the­Normal­style­can­be­modified —­but­I­urge­cau-
tion if you do so.

To modify the Normal style’s font or paragraph formats, summon the Font or 
Paragraph­dialog­boxes.­(Refer­to­specific­steps­in­Chapters 10­and 11,­respectively,­
for­details.)­In­both­dialog­boxes,­you­find­a­Set­As­Default­button.­Click­this­but-
ton to update the Normal style.

For example, to reset the Normal style’s font to Times New Roman, follow these 
steps:

1. Apply the Normal style to the current paragraph.

2. Press Ctrl+D to summon the Font dialog box.

3. Choose Times New Roman as the font.

4. Click the Set As Default button.

A dialog box appears.
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5. Choose the All Documents option to update the Normal template and 

change the Normal style for all documents.

If you choose the This Document Only option, the style is updated only for the 

current document.

6. Click OK.

I­ don’t­ recommend­ making­ this­ choice­ unless­ you’re­ determined­ to­ alter­ the­
Normal style. Mostly, people get into trouble when they accidentally change 
the Normal­style­and­then­want­to­change­it­back.­If­so,­follow­the­steps­in­this­
section to restore the Normal style. A description of Word’s current Normal style 
can be found in the earlier section “The Big Style Overview.”

Creating heading styles

Word’s­heading­styles­are­numbered­Heading­1,­Heading­2,­on­down­to­Heading­9.­
You­use­them­to­identify­different­parts­of­a­document,­but­they­also­take­advan-
tage of other Word features.

For example, text formatted with a heading style appears whenever you use the 
vertical scroll bar to skim a document. Headings can be expanded or collapsed, as 
part­of­Word’s­Outline­feature,­as­described­in­Chapter 25.­Headings­appear­in­the­
navigation pane when you search for text. They can be used when creating a table 
of contents.

You’re­not­stuck­with­using­Word’s­preset­heading­styles;­you­can­create­your­own­
heading- or document-level styles. The key is to set the paragraph’s outline level: 
In­the­Paragraph­dialog­box,­use­the­Outline­Level­menu­to­set­the­heading­level:­
Set­Level­1­for­top­level­headings.­For­the­next­heading­level­(subheading),­choose­
Level­2,­and­so­on.­These­paragraph­formats­are­used­by­Word’s­document­orga-
nization­tools,­such­as­the­navigation­pane­and­the­Table­of­Contents­command.

Follow­the­steps­in­the­earlier­section­“Using­the­Create­New­Style­from­Format-
ting­dialog­box”­to­update­your­heading­styles­to­reflect­the­proper­outline-level­
paragraph format.

 » Heading text is typically only one line long. Larger font sizes are usually 

selected. The Space After paragraph format is frequently applied.

 » Word’s predefined Title style isn’t a heading style.
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Customizing the Style Gallery

To­ensure­that­the­styles­you­use­the­most­appear­in­the­Style­Gallery,­follow­these­
steps:

1. Summon the Styles pane.

Press the ungainly Ctrl+Shift+Alt+S key combination.

2. Right-click the style you want to add to the Style Gallery.

3. Choose the command Add to Style Gallery.

To­remove­a­style­from­the­Style­Gallery,­right-click­the­style­in­the­gallery­and­
choose­the­command­Remove­from­Style­Gallery.

This­trick­can­be­useful,­but­the­Style­Gallery­shows­only­a­pittance­of­the­styles­
available­ to­ a­ document.­When­ you­find­ yourself­ using­ a­ lot­ of­ styles,­ use­ the­
Styles pane instead.
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Chapter 16

Template and Themes 
Formatting

C
omputers­are­supposed­to­save­you­time,­so­why­exert­great­effort­on­the­
formatting­ task,­ specifically­ with­ regard­ to­ selecting­ fonts­ and­ colors?­
Instead,­you­can­save­time­by­using­a­template­or­a­theme,­or­both.­These­

tools­format­your­prose­easily­and­rapidly.­You­can­choose­from­a­preset­template­
or­theme,­or­you­can­craft­your­own­to­preserve­previous­formatting­choices.

Instant Documents with Templates

A­template­lets­you­create­documents­that­use­the­same­styles,­formatting,­and­
common­ text­ elements­ without­ the­ need­ to­ re-create­ all­ the­ work­ and­ effort.­
A template­saves­time.

IN THIS CHAPTER

 » Understanding templates

 » Using templates

 » Attaching a template to a document

 » Creating a document template

 » Changing a template

 » Understanding themes

 » Formatting a document with a theme

 » Creating your own themes
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 » Choosing a specific template for a document is optional.

 » When you don’t choose a template, you use Word’s default new-document 
template, called Normal.

 » All documents in Word are based on a template. The template is attached to 
the document.

 » Word offers templates in two categories: OfÏce and Personal. The OfÏce 
templates are those supplied by Microsoft and made available over the 
Internet. The Personal templates are those you create.

 » Using a template doesn’t mean you can neglect saving your work. The 
template merely helps you get started by providing common document 
elements.

 » Word uses three filename extensions for its document templates: .dot, .dotx, 
and .dotm. Older Word templates use the .dot extension. Word 2007 and later 
uses the .dotx extension, with macro-enabled templates using the .dotm 
extension. Filename extensions are not normally visible in Windows, though 
these extensions are referenced when choosing a file type in the Open 
dialog box.

Using a template to start a new document

When­you­press­Ctrl+N­to­create­a­new,­blank­document­in­Word,­you­see­a­new­
document­ based­ on­ the­Normal­ template.­ To­ use­ another­ template,­ either­ one­
supplied­by­Microsoft­or­one­you’ve­created,­follow­these­steps:

1. Click the File tab.

The File screen appears.

2. Choose New from the left side of the File screen.

You see a list of template thumbnails. Atop are recently opened templates or 
those you’ve pinned to the New screen. Below this list, the templates are 
divided into two categories or tabs, OfÏce and Personal, as illustrated in 
Figure 16-1.

3. Choose a template.

If you don’t see the template you need, click the Personal tab to review 
templates you’ve created.

4. If prompted, click the Create button.

The button appears when you use one of Word’s predefined templates.
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5. Start working on the new document.

Text, graphics, headers, and footers may appear in the document, if these 
items are supplied with the template. You also have access to all styles saved in 
the template.

Save­your­work!­You­use­a­template­to­start­the­document,­but­if­you­check­the­
window’s­title­bar,­you­see­that­it­ isn’t­saved:­Use­the­Save­command­and­give­
your­document­a­proper­name­as­soon­as­possible.

 » Using a template to create a new document doesn’t change the template. To 
modify a template, see the section “Modifying a template,” later in 
this chapter.

 » Refer to the later section “Templates of Your Own” for information on making 
your own templates.

 » It’s possible to pin your personal templates to the Featured screen: Click the 
Pushpin icon, as illustrated in Figure 16-1. This way, you can quickly choose 
one of your own templates to quickly start a new document.

FIGURE 16-1: 
Choosing a 

template from 
the New screen.
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Changing a document’s attached template

All­Word­documents­are­based­on­a­specific­template.­Even­a­blank­document­uses­
the­Normal­template.­When­you­choose­the­wrong­template­or­suddenly­desire­to­
change­or­reassign­a­document’s­template,­follow­these­steps:

1. Open the document that needs a new template attached.

2. Click the File tab.

3. On the File screen, choose the Options command.

The Word Options dialog box appears.

4. Choose Add-Ins from the left side of the Word Options dialog box.

5. From the Manage drop-down list, choose Templates.

You find the Manage drop-down list near the bottom of the dialog box.

6. Click the Go button.

The Templates and Add-Ins dialog box appears. You should see which 
template is attached to the document, such as Normal.

7. Click the Attach button.

Word displays the Attach Template dialog box, which looks and works like the 
Open dialog box. It displays the contents of your personal template folder.

8. Select the template you want to attach.

9. Click the Open button.

The template is attached to your document.

10. Ensure that the option Automatically Update Document Styles is 

selected.

Updating styles means that your document’s current styles are changed to 
reflect those of the new template, which is probably what you want.

11. Click OK.

The document is now attached to the template. Any styles stored in the 
template are available.

If­the­template­has­any­preset­text­or­graphics,­reassigning­that­template­doesn’t­
import­ these­ items­ into­ your­ document.­ Only­ the­ styles,­ custom­ toolbars,­ and­
macros­are­merged­into­your­document.

You­can­also­follow­these­steps­to­unattach­a­template.­Do­that­by­selecting­Nor-
mal­(normal.dotm)­as­the­template­to­attach­in­Step­8.
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Templates of Your Own

If­you­enjoy­the­thrill­and­excitement­of­templates,­you’ll­just­burst­at­the­thought­
of­ creating­ your­ own.­ Over­ time,­ you­ build­ up­ a­ collection.­ Custom­ templates­
greatly­help­expedite­your­document­production­duties.

Creating a template based on a  
document you already have

The­easiest­way­to­create­a­new­template­(the­way­I­do­it­about­90­percent­of­the­
time)­is­to­base­the­template­on­an­existing­document —­for­example,­a­document­
you’ve­already­written­and­formatted­to­perfection.­The­template­retains­the­doc-
ument’s­formatting­and­styles­so­that­you­can­instantly­create­a­new­document­
with­those­same­settings.

To­make­a­template­based­on­a­document­you’ve­already­created,­follow­these­steps:

1. Open or create the document, one that has styles or formats or text that 

you plan to use repeatedly.

2. Strip out any text that doesn’t need to be in every document.

For example, my play-writing template has all my play-writing styles in it, but 
the text includes only placeholders — enough to get me started.

3. Press the F12 key.

The F12 key is the ancient keyboard shortcut to the Save As dialog box. By 
using this key, you save about four other, ugly steps.

4. Type a name for the template.

Type the name in the File Name box. Be descriptive. You don’t need to use the 
word template when naming the file.

5. From the Save As Type drop-down list, choose Word Template (*.dotx).

Ah-ha! This is the secret. The document must be saved in a document template 
format. That’s what makes a template different from a typical, boring Word 
document.

Don’t worry about choosing the document’s location. All Word templates are 
saved in a predefined folder, which Word automatically chooses for you after 
you set the file type as a Word template.

6. Click the Save button.

Your efforts are saved as a document template, nestled in the proper storage 
location, where Word keeps all its document templates.
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7. Close the template.

The reason for closing it is that any changes you make from now on are saved 
to the template. If you want to use the template to start a new document, you 
choose that template from the New window, as described earlier in this 
chapter.

Refer­to­the­later­section­“Modifying­a­template”­for­information­on­updating­or­
changing­a­template.

Making a new template from scratch

If­you­want­a­simple­ template,­you­can­create­ it­ from­scratch,­especially­when­
you’re­well­versed­in­using­Word’s­style­commands­and­you­know­exactly­which­
elements­the­template­needs.

To­start,­create­any­common­text.­Next,­create­the­styles­and­any­text­formatting­
you­plan­to­use­in­the­template.

When­everything­is­set,­use­the­Save­As­dialog­box­to­save­the­document­as­a­tem-
plate,­as­described­in­the­preceding­section.

Modifying a template

You­have­two­options­for­changing­a­template.­The­first­is­to­start­a­new­document­
by­using­the­template.­Make­the­changes­you­want.­Then­save­the­document­as­a­
template­file,­overwriting­the­original­file.

The­second­way­is­to­open­the­template­file­directly.­This­way­is­more­difÏcult­
because­Word­keeps­the­template­files­in­a­special­folder­that’s­not­easy­to­find:­
The­ template­ folder­ dwells­ in­ the­ Document­ folder.­ It’s­ named­ Custom­ OfÏce­
Templates.­Use­the­Open­dialog­box­to­open­a­template­file­held­in­that­location.

 » If you use Word’s Open command to open a template but no templates 
appear to be in the folder, don’t panic! Instead, click the File Type menu button 
and choose Word Template. You should see the lot.

 » Changing a template has a widespread effect. When you update or modify 
a template, you change all documents using the template. Although such a 
change can be beneficial, and one of the best reasons for using a template, 
be mindful of your changes!
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The Theme of Things

Themes­apply­decorative­styles,­such­as­fonts­and­colors,­to­a­document,­giving­
your­ written­ efforts­ a­ professionally­ formatted­ feel­ while­ keeping­ hordes­ of­
graphics­designers­unemployed.

A­theme­consists­of­these­three­elements:

Colors: A set of colors is chosen to format the text foreground and background, 
any graphics or design elements in the theme, plus hyperlinks.

Fonts: Two fonts are chosen as part of the theme — one for the heading styles and 
a second for the body text.

Graphical effects: These effects are applied to any graphics or design elements in 
your document. The effects can include 3D, shading, gradation, drop shadows, and 
other design doodads.

Each­of­these­elements­is­organized­into­a­theme,­given­a­name,­and­placed­on­the­
Design­tab’s­Themes­menu­for­easy­application­in­your­document.

 » A professionally licensed, certified mentally stable graphics designer creates a 
theme’s fonts, colors, and design effects so that they look good and work 
well together.

 » A theme doesn’t overrule styles chosen for a document. Instead, it accents the 
styles. The theme may add color information, choose different fonts, or 
present various graphical elements.

 » The graphical effects of a theme are only applied to any graphics in the 
document; applying a theme doesn’t insert graphics into your text. See 
Chapter 22 for information on graphics in Word.

 » Choosing a theme affects the entire document all at once. To affect individual 
paragraphs or bits of text, apply a style or format manually. Refer to 
Chapter 15.

Applying a document theme

To­apply­a­theme­to­a­document,­follow­these­directions:

1. Click the Design tab.

2. Click the Themes button.

Built-in themes are listed along with any custom themes you’ve created. 
Figure 16-2 illustrates the Themes menu.
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Each­ built-in­ theme­ controls­ all­ three­ major­ theme­ elements­ (colors,­ fonts,­
graphical­ effects),­ changing­ your­ document’s­ contents­ accordingly.­ Hover­ the­
mouse­pointer­over­a­theme­to­visually­preview­its­effect.­Click­a­theme­to­choose­it.

 » Because a document uses only one theme at a time, choosing a new theme 
replaces the current theme.

 » To unapply a theme from your document, choose the OfÏce theme or the 
menu command Reset to Theme from Template. (Refer to Figure 16-2.)

 » If you would rather change only one part of a theme, such as a document’s 
fonts, use either the Colors, Fonts, or Effects command button on the 
Design tab.

Modifying or creating a theme

You­ can’t­ create­ your­ own­ themes­ from­ scratch,­ but­ you­ can­modify­ existing­
themes­to­make­your­own,­custom­theme.­You­start­by­selecting­an­existing­theme.­
Choose­one­of­these­options­while­viewing­the­Design­tab:

To create a custom color theme, choose Colors ➪   Customize Colors. Use the 
Create New Theme Colors dialog box to pick and choose which colors to apply to 
text or various graphical elements in your document.

FIGURE 16-2: 
The Themes 

menu.
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To create a custom font theme, choose Fonts ➪   Customize Fonts. Use the Create 
New Theme Fonts dialog box to select fonts — one for the headings and another 
for the body text.

For­each­option,­give­the­new­theme­a­name­and­save­it.­You­can­then­choose­the­
theme­from­the­Custom­area­of­either­the­Colors­menu­or­the­Fonts­menu.

After­customizing­various­elements,­on­the­Design­tab,­click­the­Themes­menu­
button­and­choose­Save­Current­Theme.­Use­the­Save­Current­Theme­dialog­box­to­
give­your­theme­a­proper­descriptive­name­and­save­it.­The­theme­you­create­then­
appears­ in­ the­ Custom­ area­ of­ the­ Themes­ menu,­ as­ illustrated­ earlier,­ in­
Figure 16-2.

To­remove­a­custom­theme,­right-click­it­on­the­Themes­menu­and­choose­the­
Delete­command.­Click­the­Yes­button­to­confirm­and­remove­the­theme.
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Chapter 17

Random Drawer 
Formatting

E
veryone has one, even neatniks who proudly profess to be organized. It’s the 

random-stuff­drawer.­Maybe­ it’s­ in­ the­kitchen­or­ a­ desk­drawer­ in­ your­
home­ofÏce.­Perhaps­you­have­several­such­random-stuff­drawers.­These­are­

necessary­because­everyone­needs­a­location­for­stuff­that­ just­doesn’t­fit­any-

where else.

Welcome­ to­ the­ random-drawer­ formatting­ chapter.­ Here­ you­ find­ formatting­
commands­various­and­sundry.­They­just­don’t­fit­in­well­with­the­other­format-
ting­chapters­found­in­this­part­of­the­book.

Weird and Fun Text Effects
On­the­Home­tab,­in­the­Font­group,­is­a­button­adorned­with­a­fuzzy,­blue­A, as 

shown­in­the­margin­(but­not­the­blue­part).­It’s­the­Text­Effects­and­Typography­
button.­Click­this­button­to­view­the­Text­Effects­menu,­as­shown­on­the­far­left­in­
Figure  17-1.­This­menu­ lists­ special­ text­decorations,­well­beyond­ the­standard­
text­attributes­covered­in­Chapter 10.­Choose­an­effect­from­the­menu­to­apply­it­
to­your­text.

IN THIS CHAPTER

 » Using fancy text formatting

 » Swiping text formats

 » Formatting quotes, fractions, and 
stuff

 » Creating automatic lists and borders

 » Centering a title page
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If­the­effects­on­the­Text­Effects­menu­aren’t­exactly­what­you­want,­you­can­cre-
ate­ your­ own:­ You­ can­ choose­ custom­ effects­ from­ the­ submenus­ on­ the­ Text­
Effects­and­Typography­menu,­or­you­can­use­the­Format­Text­Effects­dialog­box,­
shown­in­the­center­and­on­the­right­in­Figure 17-1.­To­access­this­dialog­box,­fol-
low these steps:

1. Press Ctrl+D.

The Font dialog box appears.

2. Click the Text Effects button.

The Format Text Effects dialog box appears. It features two categories: Text Fill 
& Outline and Text Effects, shown in the center and on the right in Figure 17-1, 
respectively.

3. Manipulate the controls in the dialog box to customize text effects.

Choose a category, and then click a triangle to expand items in a subcategory. 
Controls appear, as illustrated in Figure 17-1, which let you customize the 
effect. Sadly, the dialog box lacks a preview window, so you have to make your 
best guess about the results.

4. Click the OK button to dismiss the Format Text Effects dialog box.

5. Click the OK button to close the Font dialog box.

FIGURE 17-1: 
Text effects 

galore.
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The­options­you­select­affect­any­selected­text­in­the­document­or­any­text­you­
type from this point onward.

 » Font effects are best used for document headings and other decorative text.

 » The Text Effects button is unavailable (dimmed) if you attempt to use this 
command on an older Word document. See Chapter 24 for information on 
converting such documents. If the document is based on an older template, 
you also need to update the template and then reattach the document to that 
template. It’s a bother. See Chapter 16.

Steal This Format!
It’s­not­a­whisk­broom,­and­it’s­definitely­not­a­shaving­brush.­No,­it’s­a­paint-
brush.­Not­only­that,­but­it’s­also­a­special­paintbrush —­one­that­steals­text­and­
paragraph­formatting,­lifting­it­from­one­place­in­your­document­and­splashing­it­
down­in­another.­It’s­the­Format­Painter,­and­here’s­how­it’s­used:

1. Place the insertion pointer in the midst of the text that has the format-

ting you want to copy.

Think of this step as dipping a brush into a bucket of paint.

2. Click the Home tab.

3. In the Clipboard group, click the Format Painter command button.

The mouse pointer changes to a paintbrush/I-beam, as depicted in the margin. 
Use it to select and reformat text.

4. Hunt for the text you want to change.

5. Select the text.

Drag over the text you want to change — to “paint” it.

Voilà!­The­text­is­changed.

 » The Format Painter works with character and paragraph formatting, but not 
with page formatting.

 » To change the formatting of multiple bits of text, double-click the Format 
Painter. The Format Painter mouse pointer stays active, ready to repaint lots 
of text. Press the Esc key to cancel your Dutch Boy frenzy.
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 » If you tire of the mouse, you can use the Ctrl+Shift+C key combination to copy 
the character format from one location to another. Use the Ctrl+Shift+V key 
combination to paste the character format.

 » You can sorta kinda remember to use Ctrl+Shift+C to copy character format-
ting and use Ctrl+Shift+V to paste, because Ctrl+C and Ctrl+V are the 

 copy-and-paste shortcut keys. Sorta kinda.

 » Don’t confuse the Format Painter with the highlighting tool, found in the Font 
group. See Chapter 26.

Automatic Formatting
Part­of­Word’s­AutoCorrect­feature­(covered­in­Chapter 7)­is­a­tool­named­AutoFor-
mat.­Whereas­AutoCorrect­fixes­typos­and­common­spelling­boo-boos,­AutoFormat­
fixes­formatting­fumbles.

Enjoying automagical text
AutoFormat­controls­some­minor­text­formatting­as­you­type.­All­its­settings­are­
visible­in­the­AutoCorrect­dialog­box’s­AutoFormat­As­You­Type­tab,­as­shown­in­
Figure 17-2.

FIGURE 17-2: 
AutoFormat As 

You Type 
settings.
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To­display­ the­AutoCorrect­dialog­box­and­access­ the­AutoFormat­As­You­Type­
features, heed these steps:

1. Click the File tab.

2. Choose Options.

The Word Options dialog box appears.

3. Select Proofing from the left side of the window.

4. Click the button labeled AutoCorrect Options.

The AutoCorrect dialog box says hello.

5. Click the AutoFormat As You Type tab.

This part of the dialog box you see is where all the AutoFormat options dwell. 
(Well, aside from the AutoFormat tab, which is redundant.) Add or remove a 
check mark to turn an option on or off, respectively.

The­best­way­to­demonstrate­the­AutoFormat-as-you-type­concept­is­to­have­a­
Word­document­on­the­screen­and­then­type­the­examples­in­the­following­sec-
tions.­These­samples­demonstrate­only­a­few­of­the­tricks­AutoFormat­can­perform.

Smart quotes
The­quote­characters­on­the­keyboard­are­tick marks: " and '.­AutoFormat­converts­
them­into­the­more­stylish­open­and­closed­curly­quotes.­Type­hither:

He said, “Darling, truly I love you, but the monster

is coming and you broke your ankle, so I figured that

you'd understand.”

Both­the­single­and­double­quotes­are­converted.

Real fractions
You­can­format­a­fraction­by­formatting­the­first­value­in­superscript­and­the­sec-
ond­value­in­subscript.­Or­you­can­let­AutoFormat­do­it­for­you.­Here’s­an­example:

I spend twice the time doing ½ the work.

The­characters­1/2­are­converted­into­the­single­character­½.­This­trick­works­for­
some,­but­not­all,­common­fractions.­When­it­doesn’t­work,­use­superscript/subscript­
formatting,­as­described­in­Chapter 31.
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Hyperlinks
Word­ can­ underline­ and­ activate­ hyperlinks­ that­ are­ typed­ in­ your­ document,­
such­as

I've been to http://www.hell.com and back.

The­ website­ http://www.hell.com­ is­ automatically­ underlined,­ colored,­ and­
turned­into­an­active­web­page­link­for­you.­(To­follow­the­link,­Ctrl+click­the­text.)

Ordinals
You’re guessing wrong if you think that ordinals are a baseball team or a group of 

religious­leaders.­They’re­numbers­that­represent­an­order­(get­it?),­such­as­first,­
second,­third,­and­so­on.­Here’s­how­AutoFormat­deals­with­ordinals:

There were two of us in the race; I came in 1st

and Oglethorpe came in 3rd.

Word’s­AutoFormat­feature­automatically­superscripts­ordinal­numbers,­making­
them­look­oh-so-spiffy.

Em dashes
An­em dash­is­the­ofÏcial­typesetting­term­for­a­long­dash,­longer­than­the­hyphen­
(or­its­evil­twin,­the­en­dash).­Most­people­type­two­hyphens­to­emulate­the­em 

dash.­Word­fixes­that­problem:

A red one is a slug bug—not a punch buggy.

After­you­type­the­-­-­(“dash­dash”)­and­then­the­word­that­follows,­AutoFormat­
replaces­it­with­the­ofÏcial­em­dash­character.

 » The keyboard shortcut for typing an em dash is Ctrl+Alt+minus sign, where 
the minus sign (–) is the minus key on the numeric keypad.

 » The single hyphen is also converted into a en dash when you follow it with a 
word.

 » The keyboard shortcut for typing an en dash is Ctrl+minus sign.

 » The en dash is approximately the width of the letter N in the current font. 
Likewise, the em dash is the width of the letter M.

http://www.hell.com
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Formatting tricks for paragraphs
At­the­paragraph­level,­AutoFormat­helps­you­quickly­handle­some­otherwise­irk-

some­formatting­issues.­Some­folks­enjoy­this­feature,­some­despise­it.­The­fol-
lowing­sections­provide­a­few­examples­of­what­AutoFormat­is­capable­of.

Numbered lists
Anytime­you­start­a­paragraph­with­a­number,­Word­assumes­(through­AutoFor-
mat)­that­you­need­all­your­paragraphs­numbered.­Here’s­the­proof:

Things to do today:

1. Get new treads for the tank.

Immediately after typing 1.,­you­probably­saw­the­infamous­AutoCorrect­Lightning­
Bolt­icon­and­noticed­your­text­being­reformatted.­Darn,­this­thing­is­quick!­That’s­
the­AutoFormat­feature­guessing­that­you’re­about­to­type­a­ list.­Go­ahead­and­
finish­typing­the­line;­after­you­press­Enter,­you­see­the­next­line­begin­with­the­
number 2.

Keep­typing­until­the­list­ends­or­you­get­angry,­whichever­comes­first.­To­end­the­
list,­press­the­Enter­key­twice­to­erase­the­final­number­and­restore­the­paragraph­
formatting to unnumbered.

 » This numbering trick works also for letters (and Roman numerals). Just start 
something with a letter and a period, and Word picks up on the next line by 
suggesting the next letter in the alphabet and another period.

 » Bulleted lists can also be created in this way: Start a line by typing an asterisk 
(*) and a space to see what happens.

 » See Chapter 21 for more information on Word’s numbered and bulleted list 
formats.

 » You don’t press the Enter key twice to end a typical paragraph in a document, 
but pressing Enter twice to terminate an AutoFormat list is completely 
acceptable. Doing so doesn’t add an empty paragraph to your document.

Borders (lines)
A­line­above­or­below­a­paragraph­is­typographically­called­a­rule, but Word uses 

the term border.­Most­folks­call­them­lines.­Here’s­how­to­use­AutoFormat­to­whip­
out a border:

– – –
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Type­three­hyphens­and­press­the­Enter­key.­Word­instantly­transmutes­the­three­
wee­hyphens­into­a­solid­line­that­touches­the­left­and­right­paragraph­margins.

 » To create a double line, type three equal signs and press Enter.

 » To create a bold line, type three underlines and press Enter.

 » Refer to Chapter 18 for details on borders and boxes around the text.

Undoing an AutoFormat

You­have­two­quick­ways­to­undo­autoformatting.­The­first,­obviously,­is­to­press­
the Ctrl+Z­keyboard­shortcut­for­the­Undo­command.­Easy.

You­can­also­use­the­Lightning­Bolt­icon­to­undo­autoformatting.­Click­the­icon­to­
display­a­drop-down­menu,­shown­in­Figure 17-3.­Use­the­options­displayed­to­
control­the­AutoFormat­options­as­you­type.

Choosing­ the­first­option,­Undo­whatever­ (refer­ to­Figure  17-3),­ is­ the­same­as­
pressing Ctrl+Z on the keyboard.

Selecting­the­second­option,­Stop­Automatically­doing whatever,­disables­the­specific­
AutoFormat­feature­so­that­it­never­happens­again.­People­enjoy­selecting­this­option.

Choosing­the­final­option,­Control­AutoFormat­Options,­summons­the­AutoCorrect­
dialog­box’s­AutoFormat­As­You­Type­tab,­which­is­shown­earlier,­in­Figure 17-2.

Also­see­Chapter 33­for­more­details­on­disabling­AutoFormat­features.

Center a Page, Top to Bottom
Nothing­makes­a­document­title­nice­and­crisp­like­having­it­sit­squat­in­the­center­
of­a­page,­as­shown­in­Figure 17-4.­The­title­is­centered­from­left­to­right,­which­
is­a­paragraph­formatting­trick,­but­how­can­it­be­centered­from­top­to­bottom­on­
the­page?

FIGURE 17-3: 
AutoFormat 

options.
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If­you’re­thinking­about­whacking­the­Enter­key­17­times­in­a­row­to­center­a­title­
from­top­to­bottom,­stop!­Let­Word­do­the­math­to­make­the­title­perfectly­cen-

tered­vertically­on­a­page.­Here’s­how:

1. Press the Ctrl+Home key combination.

The insertion pointer jets to the start of the document.

2. Type and format the document’s title.

It can be on a single line or on several lines.

To center the title paragraph, apply center paragraph justification: Press 
Ctrl+E. Apply any additional font or paragraph formatting as necessary.

If the title is split between two or more lines, use Ctrl+Enter to break a line, 
which reduces the spacing.

Avoid the temptation to press the Enter key to add space above or below the 
title. Such space isn’t needed, and would wreck Word’s automatic centering 
powers.

3. Position the mouse pointer at the end of the title.

Press the End key on the last line of the title, or the author line. (Refer to 
Figure 17-4.)

FIGURE 17-4: 
This title is 

centered on a 
page.
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4. Click the Layout tab.

5. In the Page Setup group, choose Breaks ➪   Next Page.

A next-page section break is inserted into the document. The title now sits on 
its own page as its own section.

6. Click the document’s first page.

You need to be on the page you want to format.

7. Click the Layout tab.

8. Click the dialog box launcher in the lower right corner of the Page Setup 
area.

9. In the Page Setup dialog box, click the Layout tab.

10. Click the Vertical Alignment drop-down list and choose Center.

11. Confirm that the Apply To drop-down list shows This Section.

12. Click OK.

The­first­page­of­the­document­is­centered­from­top­to­bottom.­Because­that­page­
is­its­own­section,­the­top-to-bottom­centering­applies­to­only­that­page­and­not­
the­rest­of­the­document.

 » Review Chapter 14 for more information on document sections.

 » Also see my book Word 2016 For Professionals For Dummies (Wiley) for many 
additional formatting tips, tricks, and suggestions.
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Document
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Use borders, draw lines, and add color to a 

document’s background.

Add tables to your documents.

Split text into multiple columns.

Discover how to make several types of lists, including 

bulleted lists, numbered lists, and indexes.

Insert images and captions into a document.
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Chapter 18

They’re Called Borders

I
 

f you try to use any of these characters to draw a line or box in a Word docu-

ment, your computer will explode: - = _ + |

Well, maybe not explode, but it will get angry with you. That’s because Word hosts 

a collection of line-drawing tools to artfully place borders in and around your text. 

You have no need to pore over the keyboard and scout out the best character to box 

some chunk of text in your document. All you must know is that the text format is 

called a border and the graphical element is a line.

 » This chapter covers the border, which is a linear graphical doojobbie 

applied to text.

 » Lines are graphical elements that you can set in your document. See 

Chapter 22.

 » To create a fill-in-the-blank underline, refer to Chapter 12.

 » Terms aside, graphics designers refer to any line in the text as a rule.

IN THIS CHAPTER

 » Understanding borders

 » Drawing lines around paragraphs

 » Putting paragraphs in boxes

 » Creating a fancy document title

 » Adding a box around words

 » Putting a border around a page

 » Inserting a horizontal line
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The Basics of Borders

A border is a paragraph-level format. Yes, it’s a line. People call it a line. But as a 

paragraph format, a border is coupled to a paragraph on the top, bottom, left, or 

right or some combination thereof. The line can be thick, thin, doubled, tripled, 

dashed, or painted in a variety of colors.

Like any paragraph style, a border sticks to the paragraph it’s applied to: When 

you add a border to the left of the current paragraph and press Enter, the next 

paragraph inherits the same border.

Borders can also be part of a style, applied to text like any other format.

To control the border format, on the Home tab, in the Paragraph group, look for the 

Borders button. The button reveals the current paragraph’s border style, such as 

Bottom Border, shown in the margin. Click this button to apply the format shown. To 

choose another border style, and view other options, click the downward-pointing 

chevron next to the button to view the Borders menu, shown in Figure 18-1.

The­final­ item­on­ the­Borders­menu­summons­ the­Borders­and­Shading­dialog­
box,­covered­in­the­later­section­“The­Borders­and­Shading­Dialog­Box.”­Use­this­
dialog box to gain more control when formatting paragraph borders.

FIGURE 18-1: 
The Borders and 

Shading menus.
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Other sections in this chapter describe how to use the Borders button to apply 

borders (lines) to paragraphs in a document.

Putting borders around a paragraph

To apply a border to any or all sides of a paragraph, follow these steps:

1. Place the insertion pointer in a paragraph.

2. Click the Home tab.

3. In the Paragraph group, click the triangle next to the Borders command 

button.

The Borders menu appears.

4. Choose a border style from the menu.

For example, to place a line atop the paragraph, choose Top Border. Its icon is 
shown in the margin.

The border is applied using the line style, thickness, and color set in the Borders 

and­Shading­dialog­box.­See­the­ later­section­“The­Borders­and­Shading­Dialog­
Box”­for­details.

 » When multiple paragraphs are selected, the border is applied to all para-
graphs as a group. Therefore, a top or bottom border appears on only the 
first or last paragraph in the selected block. To set lines between paragraphs, 
see the next section.

 » Horizontal borders stretch between the paragraph’s left and right margins. 
These margins are different from the page margins. See Chapter 11 for 
information on setting a paragraph’s left and right margins.

 » A common use of paragraph borders is to set off a document title or heading. 
See the later section “Creating a fancy title” for formatting tips.

 » If you press Enter to end the paragraph, the border formatting is applied to 
the following paragraph. For top and bottom borders, the effect is that only 
the first or last paragraph displays the border line.

Boxing multiple paragraphs

To stick a box around a paragraph, use the Outside Borders command, found on 

the Borders menu and shown in the margin. When multiple paragraphs are 

selected, the box wraps around the group.
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If you desire to box several paragraphs in a row and keep lines between the para-

graphs, use the All Borders command instead of Outside Borders. The All Borders 

icon is shown in the margin.

 » More and fancy options for boxing paragraphs can be found in the Borders 
and Shading dialog box. See the later section “The Borders and Shading 

Dialog Box.”

 » Before you go paragraph-boxing crazy, what you might need in your docu-
ment instead is a table. See Chapter 19 for information on tables.

Removing borders

To peel away the border format from one or more paragraphs of text, apply the No 

Border­format:­Select­the­paragraph(s),­click­the­Borders­button,­and­then­choose­
No Border, as shown in the margin.

To­ remove­ specific­parts­ of­ a­ border,­ use­ the­Borders­ and­Shading­dialog­box,­
­covered —­why,­it’s­in­the­next­section!

The Borders and Shading Dialog Box

To­fully­flex­Word’s­border­bravado,­summon­the­Borders­and­Shading­dialog­box:

1. Click the Home tab.

2. In the Paragraph group, click the chevron by the Borders button to 

display the Borders menu.

3. Choose the Borders and Shading command.

The­Borders­and­Shading­dialog­box­appears,­as­shown­in­Figure 18-2.

Unlike­the­Borders­menu,­additional­and­custom­border-setting­options­are­avail-
able­in­the­Borders­and­Shading­dialog­box.­Most­notably,­you­can­set­the­border­
line style, thickness, and color.

 » The Borders and Shading dialog box also allows you to place a border around 

a page, which is covered in the later section “Applying a page border.”

 » You can use the commands in the Borders and Shading dialog box to format a 
table. See Chapter 19 for information on tables in Word.
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Creating a fancy title

To create custom titles for newsletters, documents, or anything else you want to 

pretend is painfully important, click to select a paragraph and then go nuts in the 

Borders­and­Shading­dialog­box.­You­may­end­up­with­a­result­similar­to­the­one­
shown in Figure 18-3.

To properly apply a special border, follow these general steps in the Borders and 

Shading­dialog­box:

1. Choose a line style in the Style list.

Scroll the list to view the full variety of styles. (Refer to Figure 18-2.)

2. Set the color in the Color list.

The Automatic color uses black, or the standard color as set by the document’s 
theme (usually, black).

FIGURE 18-2: 
The Borders and 

Shading 

dialog box.

FIGURE 18-3: 
Fancy borders.
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3. Choose a width in the Width list.

4. Click in the Preview part of the dialog box to place the line: top, bottom, 

right, or left.

To remove a line, click it in the Preview window.

To start out quickly, select a preset design from the list of icons on the right side 

of­the­dialog­box.­(Refer­to­Figure 18-2.)

Click the OK button to apply the customized border to your document’s text.

Boxing text

The border is primarily a paragraph level format, though you can also wrap bor-

ders around tiny tidbits of text as a character format. To do so, follow these steps:

1. Select the text.

2. Summon the Borders and Shading dialog box.

Directions are found earlier in this chapter.

3. Set the border style you desire.

Only the Box and Shadow options are available, although you can set the color 
and line thickness.

4. Ensure that the Apply To menu shows Text and not Paragraph.

5. Click OK.

Also­see­Chapter 10­for­information­on­shading­text.­From­a­design­point­of­view,­
I believe shading text is a better option than wrapping it in a box.

Applying a page border

One­gem­hidden­in­the­Borders­and­Shading­dialog­box­is­the­tool­to­place­a­border­
around an entire page of text. The border sits at the page’s margins and is in addi-

tion to any paragraph borders you might apply.

Here are the secret directions to set a page border:

1. Place the insertion pointer on the page you want to border.

For example, you might put it on the first page in the document.
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2. Summon the Borders and Shading dialog box.

3. Click the Page Border tab.

4. Set the border style.

Choose a preset style, line style, color, thickness.

Use the Art drop-down list to choose a funky pattern for the border.

5. Click the Apply To menu button to select which pages you want bordered.

Choose Whole Document to put borders on every page. To select the first 
page, choose the This Section — First Page Only item. Other options let you 
choose other pages and groups, as shown in the drop-down list.

And now, the secret:

6. Click the Options button.

The Border and Shading Options dialog box appears.

7. In the Measure From drop-down list, choose the Text option.

The Edge of Page option just doesn’t work with most printers. Text does.

To add more “air” between the text and the border, increase the values in the 
Margin area.

8. Click OK.

9. Click OK to close the Borders and Shading dialog box.

To­ remove­ the­ page­ border,­ choose­ None­ under­ Settings­ in­ Step­ 4­ and­ then­
click OK.

A page border is a page level format. If you desire borders to sit on only certain 

pages,­split­the­document­into­sections.­Use­the­Apply­To­drop-down­menu­(refer­
to­Step­5)­to­select­the­current­section­for­the­page­borders.­See­Chapter 14­for­
more information on section formatting.

Stick a thick line between paragraphs

It’s not a border, nor is it a paragraph level format, but the horizontal line can be 

used to break up paragraphs of text by sticking a line between them. To add such 

a horizontal line, follow these steps:

1. Position the insertion pointer where you want the horizontal line to 

appear.
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A horizontal line works best as its own paragraph; otherwise, it appears 
wherever the insertion pointer blinks. It can split a paragraph — if that’s what 
you want.

2. Click the Home tab.

3. In the Paragraph group, click the Borders button.

4. Choose Horizontal Line.

Word inserts a line stretching from the left to right margins.

Click­the­line­to­adjust­its­size:­Use­the­mouse­to­drag­one­of­the­six­handles­(top­
and bottom and the four corners) to set the line’s width or thickness.

To­format­the­horizontal­line,­double-click­it.­Use­the­Format­Horizontal­Line­dia-
log box to set the width (as a percentage), height, color, and alignment.

To­remove­the­horizontal­line,­click­once­to­select­it­and­then­press­the­Delete­key.
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Chapter 19

Able Tables

W
riting­is­a­linear­task.­Characters­flow­into­words,­which­flow­into­sen-

tences,­ which­ form­ paragraphs.­ You­ start­ reading­ here­ and­ end­ up­
there.­That’s­how­ it­works —­until­ the­ information­you’re­ trying­ to­

organize­is­best­presented­in­a­grid.­Then­you­must­summon­a­table.

Put a Table in Your Document

In­olden­times,­writers­used­the­Tab­key­to­build­a­table­and­rows­and­columns.­
They­would­set­various­and­clever­tab­stops­and­format­the­text­accordingly.­This­
approach­worked,­but­Word­offers­a­better­one:­the­Table­menu­and­its­collection­
of­table-making­commands.

Word’s­table­commands­create­a­grid­with­a­given­number­of­cells­organized­into­
rows­and­columns.­Each­cell­can­be­formatted­with­its­own­margins,­spacing,­or­
paragraph­style.­And­ into­ those­ formatted­cells­you­can­place­ text­or­graphics.­
Lines­and­background­colors­complete­ the­ table­design­palette.­These­ feats­are­
beyond­the­capabilities­of­the­silly­old­Tab­key.

IN THIS CHAPTER

 » Understanding tables in Word

 » Building a table

 » Converting between text and a table

 » Selecting items in a table

 » Setting text alignment

 » Adding or inserting rows and columns

 » Applying table quick styles

 » Putting a caption on the table
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Working with tables in Word

To­begin­your­table­making­journey,­click­the­Ribbon’s­Insert­tab.­In­the­Tables­
group,­the­only­item­is­the­Table­button.­Click­this­button­to­see­the­Table­menu,­
shown­in­Figure 19-1.

The­Table­menu­features­multiple­methods­for­slapping­down­a­table­in­the­doc-
ument,­each­of­which­is­covered­in­the­following­sections.­Or,­if­you­already­used­
the­Tab­key­to­create­tabular­text,­you­can­convert­its­clumsy­self­into­a­nifty­table;­
see­the­later­section­“Convert­tab-formatted­text­into­a­table.”

After­the­table­is­created,­fill­it­in.­See­the­later­section­“Typing­text­in­a­table”­for­
what­to­do­next.

To­help­you­modify­tables­and­make­them­look­pretty,­two­new­tabs­appear­on­the­
Ribbon­ when­ a­ table­ is­ selected:­ Table­ Tools­ Design­ and­ Table­ Tools­ Layout.­
Details­about­using­the­commands­on­these­two­table­tabs­are­offered­throughout­
this­chapter.

Creating a table

Word­offers­multiple­ways­to­create­a­table,­ from­right­brain­to­ left­brain­with­
options­between.­The­choices­allow­for­more­flexibility­but­also­make­this­chapter­
longer­than­it­would­be­otherwise.

FIGURE 19-1: 
The Table menu.
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 » I recommend placing the table on a blank line by itself. Furthermore, add a 

second blank line after the table. This line makes it easier to continue typing 

text below the table.

 » Don’t worry about getting the table dimensions wrong. You can easily add or 

remove rows or columns after creating the table. See the later section “Adding 

or removing rows or columns.”

The quick way to create a table

The­fastest­way­to­make­a­table­in­Word­is­to­use­the­grid­on­the­Table­button’s­
menu.­Follow­these­steps:

1. Click the mouse at the location in the document where you want the 

table to appear.

2. On the Insert tab, click the Table button.

3. Drag through the grid to set the number of rows and columns.

In Figure 19-2, a 4-column-by-3-row table is created. As you drag the mouse 
pointer on the menu, the table’s grid magically appears in the document, as 

shown in the figure.

4. Release the mouse button to begin working on the table.

See­the­later­section­“Text­in­Tables”­to­continue­the­table­creation­task.

The right-brain way to create a table

When­dialog­boxes­make­more­sense­than­using­menus­and­graphical­goobers,­
follow­these­steps:

1. On the Insert tab, click the Table button.

2. From the Table menu, choose the Insert Table command.

The Insert Table dialog box appears.

3. Enter the number of rows and columns.

4. Click the OK button to plop down the table.
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The left-brain way to create a table

Free­your­mind­from­the­constraints­of­conventionalism,­clutch­a­crystal,­and­use­
the­mouse­to­draw­a­table­inside­your­document:

1. Click the Table button and choose Draw Table.

The mouse pointer changes to a pencil, as shown in the margin.

2. Drag to draw the table’s outline in the document.

Start in the upper left corner and drag to the lower right corner, which tells 

Word where to insert the table. You see an outline of the table as you drag 

down and to the right, as shown in Figure 19-3.

3. Draw horizontal lines to create rows; draw vertical lines to create 

columns.

Refer to Figure 19-3 (on the right) for an example of drawing a row.

As long as the mouse pointer looks like a pencil, you can use it to draw the 

rows and columns in the table.

4. Press the Esc key when you’ve finished drawing the table.

FIGURE 19-2: 
Creating a 4-by-3 

table.
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Convert tab-formatted text into a table

If­you’ve­used­the­Tab­key­to­create­rows­and­columns­of­text,­you­can­quickly­
snap­that­part­of­the­document­into­an­ofÏcial­Word­table.­Follow­these­steps:

1. Select the tab formatted text.

If columns are separated by tabs, great. If not, each paragraph you select 

becomes a row in a single-column table.

2. Click the Insert tab.

3. Choose Table ➪   Convert Text to Table.

4. Confirm the values in the Convert Text to Table dialog box.

Word has guessed at the proper number of columns and rows for the new 

table. If the columns are separated by tabs, ensure that Tabs is chosen at the 

bottom of the dialog box.

Use the mouse to relocate the Convert Text to Table dialog box so that you can 

better see the text in the document.

5. Click OK.

A table is born.

See­the­later­section­“Table­Modification”­for­information­on­fixing­the­freshly­
created­table.

The “I can’t do anything — please help” approach 
to creating a table

Word­comes­with­an­assortment­of­spiffy­predefined­tables.­Plopping­one­down­in­
a­document­is­as­easy­as­using­the­Quick­Tables­submenu:­Click­the­Table­button,­
and­from­the­menu,­choose­Quick­Tables.­Select­a­table­type­from­the­submenu.

FIGURE 19-3: 
Drawing a table 

in a document.
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After­the­table­is­inserted,­you­can­add­or­edit­the­existing­text,­add­more­rows­or­
columns,­ or­ otherwise­ modify­ the­ table.­ Refer­ to­ directions­ elsewhere­ in­ this­
chapter­for­specifics.

A­Quick­Table­is­the­fastest­way­to­create­a­calendar­in­Word.

Converting a table to text

At­some­point,­you­may­surrender­the­notion­of­needing­a­table,­and­desire­the­
text­to­be­freed­from­the­table’s­confines.­To­perform­such­a­jailbreak,­you­convert­
the­table­back­into­plain­text­or­even­tab-formatted­text.­Obey­these­steps:

1. Click inside the table you want to convert.

Don’t select anything — just click the mouse.

2. Click the Table Tools Layout tab.

3. From the Table group, choose Select ➪   Select Table.

4. From the Data group, choose Convert to Text.

The Convert to Text dialog box appears. It guesses how you want the table 

converted, such as using tabs or paragraphs.

5. Click OK.

Bye-bye, table. Hello, ugly text.

Some­post-table-destruction­clean-up­might­be­necessary,­but­generally­the­con-

version­goes­well.­The­only­issue­you­may­have­is­when­a­cell­contains­multiple­
paragraphs­of­text.­In­this­case,­undo­the­operation­(press­Ctrl+Z)­and­choose­Par-
agraph­Marks­from­the­Convert­to­Text­dialog­box­(before­Step­5).

Deleting a table

To­utterly­remove­the­table­from­a­document,­text­and­all,­heed­these­destruction­
directions:

1. Click inside the table.

2. Click the Table Tools Layout tab.

3. In the Rows & Columns group, choose Delete ➪   Delete Table.

The table is blown to smithereens.
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Deleting­the­table­deletes­its­contents­as­well.­If­you­must­save­the­contents,­I­rec-
ommend­converting­the­table­instead­of­deleting­it.­See­the­preceding­section.

Text in Tables

Text­fills­a­table­on­a­cell-by-cell­basis.­A­cell­can­be­empty­or­contain­anything­
from­a­single­letter­to­multiple­paragraphs.­The­cell­size­automatically­changes­to­
accommodate­larger­quantities­of­text.

 » Within a cell, text is formatted just as it is elsewhere in Word, including 
margins and tabs.

 » Although a single cell can deftly handle vast quantities of text, graphics artists 

don’t put a lot of text into a single cell. Consider another way to present such 

information.

 » I don’t recommend formatting text inside a cell with first-line indents. 
Although it’s possible, such formatting can be a pain to manipulate.

 » Show the ruler when you work with formatting text in a table: Click the View 

tab, and in the Show group, place a check mark by the Ruler item.

 » You can also perform math in tables, similar to what Excel does but without all 

the heartburn. Refer to the book Word 2016 For Professionals For Dummies 

(Wiley) for details on table math, headings, sorting, splitting, and spifÏng up 
tables in an expert way.

Typing text in a table

Text­appears­in­whichever­cell­the­insertion­pointer­is­blinking.­Type­some­text­
and­it­wraps­to­fill­the­cell.­Don’t­worry­if­it­doesn’t­look­right;­you­can­adjust­the­
cell­size­after­you­type­the­text,­as­described­in­the­later­section­“Adjusting­row­
and­column­size.”

 » To move to the next cell, press the Tab key.

 » To move back one cell, press Shift+Tab.

 » Pressing Tab at the end of a row moves the insertion pointer to the first cell in 
the next row.

 » Pressing the Tab key while the insertion pointer is in the table’s lower right cell 

adds a new row to the table.

 » To produce a tab character within a cell, press Ctrl+Tab. Even so:
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• I don’t recommend putting tabs into table cells. It makes the cell formatting 

all funky.

• When you press the Enter key in a cell, you create a new paragraph in the 

cell, which probably isn’t what you want.

• Use the Shift+Enter key combination (a soft return) to break up long lines 
of text in a cell.

Selecting in a table

Selecting­within­a­table­refers­to­selecting­text­but­also­cells,­rows,­columns,­and­
the­entire­table.­Here­are­my­suggestions:

 » Triple-click in a cell to select all text in that cell.

 » Select a single cell by positioning the mouse pointer in the cell’s lower left 

corner. The pointer changes to a northeastward-pointing arrow, as shown in 
the margin. Click to select the cell, which includes the cell’s text but also the 

cell itself.

 » Move the mouse pointer into the left margin and click to select a row of cells.

 » Move the mouse pointer above a column and click to select that column. 

When the pointer is in the sweet spot, it changes to a downward-pointing 
arrow (shown in the margin).

 » Clicking the table’s handle selects the entire table. The handle is visible 

whenever the mouse points at the table or when the insertion pointer blinks 

inside the table.

If­you­have­trouble­selecting­any­part­of­a­cell,­click­the­Table­Tools­Layout­tab.­In­
the­Table­group,­the­Select­button’s­menu­provides­commands­to­select­the­entire­
table,­a­row,­a­column,­or­a­single­cell.

Aligning text in a cell

Text­in­a­cell­sports­some­special,­table-specific­alignment­options.­To­adjust­the­
position­of­text­in­a­cell,­follow­these­steps:

1. Click in the cell’s text.

2. Click the Table Tools Layout tab.

3. In the Alignment group, click an icon representing the desired alignment.



CHAPTER 19  Able Tables ­­­­­235

The­Alignment­ group­ features­nine­ icons­ representing­nine­position­ combina-
tions:­left,­center,­and­right­with­top,­middle,­and­bottom.

Click­ the­ Alignment­ group’s­ Text­ Direction­ button­ (shown­ in­ the­ margin)­ to­
change­ the­ way­ text­ reads­ in­ a­ cell.­ Keep­ clicking­ the­ button­ to­ reset­ the­
orientation.

Table Modification
No­table­is­perfect.­You­may­need­to­add­or­remove­a­row­or­column,­adjust­the­
width­or­height,­or­otherwise­fine-tune­and­format­the­table.­The­tools­to­help­you­
are­found­on­two­special­tabs­on­the­Ribbon:­Table­Tools­Design­and­Table­Tools­
Layout.­ To­ summon­ these­ tabs,­ click­ anywhere­ in­ a­ table.­ Then­ start­making­
adjustments.

The­best­time­to­format­and­fix­a­table­is­after­you­add­text.

Adding or removing rows or columns

You­can­not­only­add­rows­and­columns­ to­any­of­a­ table’s­ four­sides­but­also­
squeeze­new­rows,­columns,­and­even­cells­inside­a­table.­The­secret­is­to­click­the­
Table­Tools­Layout­tab.­In­the­Rows­&­Columns­group,­use­the­Insert­buttons­to­
add­new­rows­and­columns.

To­remove­a­row­or­column,­click­to­position­the­mouse­and­then­click­the­Table­
Tools­Layout­tab.­In­the­Rows­&­Columns­group,­choose­the­proper­command­from­
the­Delete­button­menu.

 » Rows and columns are added relative to the insertion pointer’s position: First 

click to select a cell, and then choose the proper Insert command to add a row 

or column relative to that cell.

 » Refer to the earlier section “Selecting in a table” for information on selecting a 

row or column. Make that selection before choosing a Delete command to 

ensure that the proper row or column is removed.

 » When you choose the Delete ➪   Delete Cells command, you see a dialog box 
asking what to do with the other cells in the row or column: Move them up or 

to the left. Also see the later sections “Merging cells” and “Splitting cells.”
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 » A mousey way to add a new row is to position the mouse pointer outside the 

table’s left edge. A Plus (+) button appears, as shown in the margin. Click that 
button to insert a new row.

 » Likewise, if you position the mouse pointer at the table’s top edge, click the 

Plus (+) button, shown in the margin, to insert a new column.

Adjusting row and column size

After­text­is­in­the­table,­you­should­adjust­row­height­and­column­width­to­best­
present­the­information.­This­process­works­best­after­you’ve­added­text.

To­automatically­adjust­the­column­width,­position­the­mouse­pointer­at­the­left­
side­of­the­column,­just­on­the­vertical­border.­The­mouse­pointer­changes­to­the­
icon­shown­in­the­margin.­Double-click­and­the­column­width­is­adjusted.

To­adjust­all­column­widths,­put­the­mouse­pointer­at­the­far­left­vertical­border­
in­the­table.­Double-click.

To­evenly­distribute­row­and­column­sizes,­click­the­Table­Tools­Layout­tab.­In­the­
Cell­ Size­ group,­ click­ the­ Distribute­ Rows­ and­ Distribute­ Columns­ command­
buttons.

To­oddly­distribute­row­and­column­sizes,­click­the­Auto­Fit­button,­also­found­in­
the­Cell­Size­group­on­the­Table­Tools­Layout­tab.­Use­the­commands­on­the­Auto­
Fit­menu­to­choose­how­to­adjust­a­table’s­row­and­column­size.

The­most­common­way­to­adjust­rows­and­columns­in­a­table­is­to­use­the­mouse:­
Position­ the­mouse­ pointer­ at­ the­ vertical­ or­ horizontal­ border­within­ a­ table.­
When­the­pointer­changes­to­a­left–right­or­up–down­pointy­thing,­drag­to­the­
left,­right,­up,­or­down­to­change­the­border’s­position.

Merging cells

The­completely­rational­way­to­combine­two­cells­into­one­or­to­split­one­cell­into­
two­is­to­use­the­table­drawing­tools.­Heaven­have­mercy­on­you­should­you­decide­
to­merge­or­split­cells­in­any­other­fashion.

To­combine­two­cells,­erase­the­line­that­separates­them.­Follow­these­steps:

1. Click the Table Tools Layout tab.

2. In the Draw group, choose Eraser.
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The mouse pointer changes to a bar of soap, shown in the margin, but it’s 

supposed to be an eraser.

3. Click the line between the two cells.

The line is gone.

4. Click the Eraser tool again to quit merging.

Or you can tap the Esc key.

To­merge­a­clutch­of­cells,­select­them­and­click­the­Merge­Cells­button.­This­but-
ton­is­found­on­the­Table­Tools­Layout­tab,­in­the­Merge­group,­and­shown­in­the­
margin.

Splitting cells

The­easy­way­to­turn­one­cell­into­two­is­to­draw­a­line­separating­the­cell.­Follow­
these­steps:

1. Click the Table Tools Layout tab.

2. In the Draw group, click the Draw Table button.

The mouse pointer changes to the pencil pointer.

3. Draw a line in the table to split a cell.

You can draw horizontally or vertically.

4. Click the Draw Table button again when you’re done.

Any­text­in­the­cell­you­split­goes­to­one­side­of­the­drawn­line.

You­can­also­split­cells­by­selecting­a­single­cell­and­then­choosing­the­Split­Cells­
command­from­the­Table­Tools­Layout­tab’s­Merge­group.­Use­the­Split­Cells­dia-
log­box­to­determine­how­to­best­mince­up­the­cell.

Making the table pretty

Unless­you­want­the­table­to­look­like­it­was­made­from­hog­wire,­I­recommend­
applying­some­table­formatting.­You­can­set­the­line’s­thickness,­color,­and­style­
and­apply­color­to­the­various­rows­and­columns.­The­commands­necessary­are­
found­on­the­Table­Tools­Design­tab;­click­anywhere­within­a­table­to­summon­
that­tab­on­the­Ribbon.
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Rather­than­get­bogged­down­with­details,­you­should­know­that­the­spifÏest­way­
to­spruce­up­a­table­ is­ to­choose­a­preset­format­from­the­Table­Styles­gallery:­
Click­inside­the­table,­and­then­position­the­mouse­pointer­at­a­thumbnail­in­the­
gallery­to­see­a­preview.­Click­the­thumbnail­to­apply­that­format­to­the­table.

 » More thumbnails are available in the Table Styles gallery than are shown on 

the Ribbon: Scroll the list or click the down-pointing arrow (below the scroll 
bar on the left) to view the full gallery.

 » If you’d rather format the table in a more painful manner, use the Shading 

button as well as the commands located in the Borders group. These are the 

same borders applied to a paragraph, as revealed in Chapter 18.

 » To remove the table’s borders, select the table and choose No Border from 

the Borders menu. If you choose this format, the borders vanish and working 

with the table becomes more difÏcult. Therefore, I recommend that you also 
select the table and choose the View Gridlines command from the Borders 

menu. Unlike borders, a table’s gridlines show up in the document window, 

but they don’t print.

Adding a table caption

The­best­way­to­stick­a­title­or­caption­on­a­table­is­to­use­Word’s­Insert­Caption­
command.­Don’t­bother­trying­to­find­that­command­on­any­of­the­Table­Tools­
tabs.­Instead,­follow­these­steps:

1. Click in the table you want to caption.

2. Click the References tab.

3. Click the Insert Caption button.

The Caption dialog box appears.

4. Type the table’s caption in the Caption text box.

The text Table 1 might already appear. You cannot remove this text, so type a 

space after it and continue typing the table’s caption.

If the text says Figure 1 instead of Table 1, click the Label menu and choose 

Table. Or, you can click the New Label button and concoct your own label.

5. Click the Position menu and choose whether to place the caption above 

or below the table.

6. Click OK to set the caption.

A­benefit­of­using­Word’s­Insert­Caption­command­is­that­you­can­easily­create­a­
list­of­tables­for­a­document.­See­Chapter 21­for­details­on­building­such­a­list.
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Chapter 20

Columns of Text

I
f someone asks about columns and you immediately think of a review written 

in a magazine or grizzled newspaper reporter, you’re a reader. If you think 

Doric, Ionic, and Corinthian, you’re a history nerd. And if you think of rows of 

marching­soldiers­or­rolling­tanks,­you’re­a­military­buff.­What­you­probably­don’t­
think­of­are­columns­of­text­in­a­document,­despite­Word­sporting­such­a­clever­
formatting tool.

All about Columns

Here’s­a­shocker:­All­Word­documents­have­a­column­format.­Even­when­you­fail­
to­see­it,­a­page­of­text­in­Word­is­formatted­as­a­single­column­of­text.­Otherwise,­
the only time you notice the column format is when you cleave a document’s text 

into more than one column.

To­set­ the­number­of­ text­ columns­on­a­page,­use­Word’s­Columns­command:­
Click the Layout tab, and in the Page Setup group, click the Columns button. 

A menu­appears,­ listing­common­column-formatting­options,­as­shown­on­the­
left­in­Figure 20-1.

IN THIS CHAPTER

 » Understanding columns

 » Breaking text into columns

 » Creating a three-column brochure

 » Returning to one-column text

 » Switching column layouts in a 

document

 » Breaking up a column on a page
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To­be­more­specific­with­column­layout,­choose­the­More­Columns­command,­at­
the bottom of the Columns menu. The Columns dialog box appears, as shown on 

the­right­in­Figure 20-1.

The Columns dialog box helps you create and design multiple columns not avail-
able on the Columns menu: Use the Number of Columns box to set the quantity of 

columns desired. Use the Preview window to determine how the page is formatted. 

Click­the­OK­button­to­apply­the­column­format­to­the­text.

 » When using multiple columns in a document, click the mouse to position the 

insertion pointer. Otherwise, the keyboard’s cursor-movement keys don’t 

operate in a predictable manner when navigating between more than one 

column of text.

 » The column is a page format. Choosing a column format from the Columns 

button menu affects the entire document, reformatting every page to the 
number of columns specified.

 » If you need to set different column formats on different pages, split the 
document into sections and apply the column format to only the current 

section. See Chapter 14 for more information on sections.

 » When you’re working with columns and notice that Word starts acting slow 

and fussy, save your work!

FIGURE 20-1: 
The Columns 

menu and 

dialog box.
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 » The maximum number of columns per page depends on the page size. 

Word’s minimum column width is half an inch, so a typical sheet of paper can 

have up to 12 columns — not that such a layout would be appealing or 
anything.

 » Columns look best when using Print Layout view. Use this view when format-

ting columns.

 » To quickly adjust column widths, show the ruler: On the View tab, ensure that 

a check mark appears by the Ruler item (in the Show group). You can use 

controls on the ruler to adjust column width and position.

Making 2-column text

When­you­desire­to­impress­someone­with­your­word­processing­prowess,­I­sug-
gest putting two columns on the page. Any more columns and the text width is too 

skinny­and­difÏcult­to­read.­Two­columns,­however,­is­a­great­way­to­get­fancy­
and remain legible. Follow these steps:

1. Click the Layout tab.

2. Click the Columns button and choose Two.

You’re done.

If­the­document­already­has­text,­it­flows­into­two­columns.­If­you­create­text­after­
setting­the­number­of­columns,­you­see­your­scribblings­flow­down­the­left­side­of­
the page and then hop up to the upper right to start a new column.

 » To restore the document to one column, choose One from the menu 

(in Step 2).

 » Columns look best when full justification is applied to all paragraphs. The 
keyboard shortcut is Ctrl+J. See Chapter 11 for more information on para-

graph alignment.

 » You can make specific column adjustments in the Width and Spacing area of 
the Columns dialog box. (Refer to Figure 20-1.)

 » If you want an attractive line to appear between the columns of text, visit the 

Columns dialog box and put a check mark in the Line Between box.

 » The space between columns is the gutter. Word sets a gutter width at half an 

inch (0.5”). This amount of white space is pleasing to the eye without being too 

much of a good thing.
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Building a trifold brochure

The­ 3-column­ text­ format­ works­ nicely­ on­ standard-size­ paper­ in­ Landscape­
mode.­This­method­is­how­most­trifold­brochures­are­created.­Obey­these­steps­
after you’ve written the document’s text:

1. Click the Layout tab.

2. Choose Orientation ➪   Landscape.

The document’s pages appear in landscape orientation, which is best for  

three columns of text and traditional for trifold brochures, programs, and 

documents.

3. Click the Columns button and choose Three.

Your trifold brochure is effectively formatted. Three columns are evenly spaced 
across the page, as illustrated in Figure 20-2.

For­more­sprucing­up,­use­the­Columns­dialog­box:­On­the­Layout­tab,­click­the­
Columns­ button­ and­ choose­More­ Columns­ from­ the­menu.­ In­ the­ dialog­ box,­
adjust the spacing between columns, add a line between, and perform other magic.

FIGURE 20-2: 
Trifold brochure 

in Word.
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See­ Chapter  22­ for­ information­ on­ sticking­ graphics­ into­ a­ document,­ such­ as­
those­shown­in­Figure 20-2.

Giving up on columns

Columns­can’t­be­removed­from­a­document­because­all­Word­documents­feature­
at least one column. The key to “removing” columns is to reset multiple columns 

back to that single column:

1. Click the Layout tab.

2. Click the Columns button and choose One.

The document’s text layout is restored.

When­these­steps­don’t­work,­summon­the­Columns­dialog­box­(refer­to­Figure 20-1)­
and­choose­One­from­the­list­of­presets.­Ensure­that­Whole­Document­is­chosen­from­
the­Apply­To­menu­and­then­click­the­OK­button.­The­columns­are­gone.

Removing columns from a document doesn’t remove sections or section breaks. 

See­Chapter 14­for­information­on­deleting­section­breaks.

Column Tricks

Columns need not march uninterrupted. You can employ a few tricks to change 

the column format in a document or halt a column halfway down a page. These 

tricks­give­you­more­control­over­columns­in­a­document,­and­they­will­definitely­
impress historians and architects.

Changing column formats

As­with­other­page-level­formats,­you­can­change­column­formats­throughout­a­
document: Part of the document is in one column and another part is in two col-
umns and then maybe another part goes back to one column. The secret is to fol-
low these steps:

1. Click to place the insertion pointer at the spot where you need the 

column format to change.

2. Click the Layout tab.
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3. Click the Columns button and choose More Columns.

The Columns dialog box appears.

4. Choose the new column format.

Click one of the presets or use the clicker-thing to set a specific number of 
columns.

5. From the Apply To drop-down list, choose This Point Forward.

6. Click OK.

The­text­is­broken­at­a­specific­point­in­the­document­(which­you­set­in­Step­1).­
Above this point, one column format is used; after this point, the format chosen 

in Step 4 is used.

 » To help you pull off this feat, Word inserts a continuous section break in 
the document.

 » If you choose to manually insert the continuous section break, choose This 

Section from the Apply To drop-down list in Step 5.

 » Refer to Chapter 14 for more information on section breaks.

Placing a column break

Just­as­you­can­break­a­page­of­text,­you­can­break­the­vertical­flow­of­a­column.­
This column break works only on multicolumn pages. It forces the column’s text to 

stop at some point down the page and then continue at the top of the next column.

In­Figure 20-3,­you­see­an­example­of­a­column­break,­inserted­in­the­column­on­
the left. This column break stops the left side column and continues the text at the 

top of the right column.

To break a column, heed these steps:

1. Click to place the insertion pointer in the document.

The insertion pointer’s location becomes the start of the next column.

2. Click the Layout tab.

3. In the Page Setup group, click the Breaks button.

A menu appears.

4. Choose Column.

The text hops to the top of the next column.
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A column break doesn’t terminate the column format. Instead, it splits a column, 

ending text at a certain point on a page and starting the rest of the text at the top 

of the next column.

Use­the­Show/Hide­command­in­the­Home­group­(the­Paragraph­Mark­button)­to­
spy exactly where to place the column break. You might want to insert the column 

break after­a­paragraph­mark­(¶)­to­have­the­columns­line­up­at­the­top­of­the­
page.

To remove a column break, switch to Draft view: Click the View tab and choose 

Draft. The column break appears in the text as a line by itself. Delete that line. 

Switch back to Print Layout view to examine your document’s columns.

FIGURE 20-3: 
Column break.
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Chapter 21

Lots of Lists

L
ists can be simple, such as a list of the various diets you’ve tried over the 

years. A list can be complex, such as a table of contents or an index or another, 

more professional, listy thing. In Word, you can type such lists manually, but 

it’s better to use the proper tools. This way, a list of anything can be formatted 

automatically and updated as necessary.

Lists with Bullets and Numbers

Whenever you have more than two items to describe in your text, consider using 

one of Word’s automatic list-formatting commands. These tools format the list in 

a way that draws attention, calling the items out from the rest of the text.

 » Word’s list commands are found on the Home tab, in the Paragraph group.

 » You might find Word overly eager to format a list for you. The feature is called 
AutoFormat. See Chapter 33 for information on disabling this potentially 
annoying feature.

IN THIS CHAPTER

 » Automatically bulleting or 

numbering text

 » Building a multilevel list

 » Numbering lines on a page

 » Adding a TOC to a document

 » Creating an index

 » Using footnotes and endnotes
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Making a bulleted list

In typesetting, a bullet is a graphical element, such as a ball or a dot, that high-

lights items in a list. The word bullet comes from the French word boulette, which 

has­more­to­do­with­food­than­with­round­pieces­of­lead­quickly­exiting­a­firearm,­
like this:

 » Bang!

 » Bang!

 » Bang!

To apply bullets to the text, drop the gun and select several paragraphs. On the 

Home tab, in the Paragraphs group, click the Bullets button, shown in the margin. 

Instantly, the text is not only formatted with bullets but also indented and made 

all neat and tidy.

 » To choose a different bullet style, click the menu chevron next to the Bullets 
command. Select a new bullet graphic from the list, or use the Define New 
Bullet command to concoct your own bullet style.

 » The bullet is a paragraph format. As such, bullets stick to the paragraphs you 
type until you remove the format.

 » To remove bullets from the text, select the bulleted paragraphs and click the 
Bullet command button. You can stop applying bullets as you type by pressing 
the Enter key twice.

Numbering a list

To have Word number a list, heed these directions:

1. Write the text, the items in the numbered list.

Don’t write the numbers at the start of each paragraph. Word does that for you 
in Step 3.

2. Select the paragraphs as a block.

3. On the Home tab, in the Paragraph group, click the Numbering command 

button.

The button is shown in the margin. The Numbering command assigns a 
number to each paragraph — plus, it formats the paragraphs with a hanging 
indent, which looks nice.
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You can also click the Numbering command button and then type the list. Press 

the­Enter­key­twice,­or­click­the­Numbering­command­button­again­to­turn­off­
automatic numbering.

As a bonus, if you insert or rearrange paragraphs in the list, Word automatically 

renumbers everything. This trick makes using the Numbering command better 

than trying to manually number and format the paragraphs.

 » To choose another numbering format, click the menu triangle next to the 
Numbering command button. You can choose letters or Roman numerals, or 
you can concoct a numbering scheme by choosing the Define New Number 
Format command.

 » The None number format removes numbering from a paragraph.

 » More details on numbering lists, including tips on resetting the starting 

number, can be found in my book Word 2016 For Professionals For Dummies 

(Wiley).

Creating a multilevel numbered list

A multilevel list consists of items and subitems all properly indented, similar to 

those­presented­in­Figure 21-1.­Word­automatically­formats­such­a­list,­but­it’s­a­
tricky thing to do. Pay attention!

1. Start typing the list.

Type the first, top-level item, such as the line that reads Purpose in Figure 21-1. 
You do not need to type the number (or letter) before this initial item.

FIGURE 21-1: 
A multilevel list.
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2. On the Home tab, in the Paragraph group, click the Multilevel List button.

The button is shown in the margin. Immediately, the first line grows one 
number or letter, depending on the list format.

3. Continue typing the list.

Press the Tab key to indent and create a sublevel. Press Shift+Tab to unindent 

and promote an item to a higher level. Word labels the paragraphs according 
to the multilevel list format.

You can also write the entire list in advance, select it, and then click the Multilevel 

List button to format it. As long as you use Tab and Shift+Tab to organize the top-

ics, you don’t break the format, and the list stays intact.

 » To change the list’s format, select all paragraphs and then choose a new 

presentation from the Multilevel List menu.

 » Where you can get into trouble is when you try to edit the list, insert new 
items, or move items around. Unless you remember the trick about pressing 
Tab and Shift+Tab to format the list, things can get screwy. If so, reapply the 
multilevel list format, as explained in the preceding bullet.

 » If you’re creating a complex, hierarchical list, use Word’s Outline view instead 
of the multilevel list format. See Chapter 25.

Numbering lines on a page

Word lets you slap down numbers for every line on a page, a popular feature with 

those in the legal profession. Here’s how it goes:

1. Click the Layout tab.

2. In the Page Setup group, click the Line Numbers command button to 

display its menu.

3. Choose a numbering format.

For example, to number lines on each page 1 through whatever, choose the 
Restart Each Page option. Or, to number all lines on all pages cumulatively, 
choose Continuous.

To remove the line numbers, choose None from the Line Numbers command 

 button. Or choose Suppress for Current Paragraph if you don’t want the selected 

paragraph numbered.
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Line numbering is a page level format. It sticks to each page in the document. 

If you­prefer­to­number­only­one­page,­set­aside­that­page­as­its­own­section.­See­
Chapter 14­for­more­information­on­sections.

Document Content Lists

One reason to obey some of Word’s silly rules is that when things are done just so, 

you can easily construct a useful document content list. For example, when you 

use Word’s heading styles (or properly created heading styles of your own), 

you­ an­quickly­create­a­table­of­contents.­You­can­mark­specific­tidbits­of­text­for­
inclusion in an instant index. And, if you bother with Word’s Caption command, 

you­can­build­a­list­of­figures­or­tables.­These­feats­would­be­excruciatingly­difÏ-

cult if attempted on your own in a manual manner.

Creating a table of contents

The trick to creating a quick table of contents, or TOC, for your document is to use 

Word’s­heading­styles.­Use­Heading­1­for­main­heads,­Heading­2­for­subheads,­and­
Heading 3 for lower-level heads and titles. Word’s Table of Contents command 

uses­these­formats­to­build­a­table-of-contents­field,­which­reflects­the­heading­
names and their page numbers.

Providing that you’ve used the heading (or equivalent) styles in your document, 

follow these steps to create a table of contents:

1. Create a separate page for the TOC.

Word places the TOC field at the insertion pointer’s location, though I prefer to 
have the thing on its own page. Refer to Chapter 13 for information on creating 
pages; a blank page near the start of the document is ideal for a TOC.

2. Click the mouse to place the insertion pointer on the blank page.

The TOC field is inserted at that point.

3. Click the References tab.

4. In the Table of Contents group, click the Table of Contents button.

The Table of Contents menu appears.

5. Choose a format.

The TOC is created and placed in the document, page numbers and all.
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A preset title may be applied, such as Contents. Feel free to edit the preset title to 

make it clever, such as Table of Contents. Do not format that title as a heading 

unless you want it included in the table of contents.

 » When the steps in this section don’t produce the effect you intended, it usually 
means that the document doesn’t use the heading styles.

 » If your document uses your own heading styles, ensure that the paragraph 
format specifies the proper outline level. See Chapter 15 for more 
information.

 » If, instead of the TOC, you see a field such as { TOC \o “1-3” \h \z\ u }, click the 
mouse in that ugly monster and press Alt+F9.

 » The TOC field is static, so it doesn’t reflect further edits in the document. To 
update the field, click once to select it. On the References tab, in the Table of 
Contents group, click the Update Table button. Use the Update Table of 
Contents dialog box and choose to update the TOC. Click OK.

 » Cool people in publishing refer to a table of contents as a TOC, pronounced 

“tee-oh-see” or “tock.”

 » See Chapter 23 for more information about fields in a document.

Building an index

An index is yet another document reference or list, one that Word can help you 

build and format. The secret is to mark text in a document for inclusion in the 

index.­Once­words­and­phrases­are­marked,­an­index­field­is­inserted,­which­dis-
plays the index.

Select index entries

To­flag­a­bit­of­text­for­inclusion­in­an­index,­follow­these­steps:

1. Select the text you want to reference.

The text can be a word or a phrase or any old bit of text.

2.  On the References tab in the Index group, click the Mark Entry button.

The selected text appears in the Mark Entry dialog box.

3. If the entry needs a subentry, type that text in the Mark Index Entry 

dialog box.
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The subentry further clarifies the main entry. For example, the word you 
select (the main entry) might be boredom and you type In a waiting room as 

the subentry.

4. Click one of the buttons, either Mark or Mark All.

Click the Mark button to mark only the selected text. Click the Mark All button 
to direct Word to include all matching instances of the text in the document.

When you mark an index entry, Word activates the Show/Hide command, 
where characters such as spaces, paragraph marks, and tabs appear in the 
document. Don’t let it freak you out.

Because Show/Hide is on, the Index code appears in the document. It looks 
something like this:

{⋅XE⋅"boredom" ⋅}

5. Continue scrolling the document and looking for items to mark for the 

index.

The Mark Index Entry dialog box remains open as you continue to build the 
index.

6. Click the Close button when you’re done, or just tired, to banish the Mark 

Index Entry dialog box.

7. Press Ctrl+Shift+8 to cancel the Show/Hide command.

Use the 8 key on the keyboard, not on the numeric keypad.

Place the index in the document

After you mark bits and pieces of text for inclusion in the index, the next step is to 

build and place the index. Do this:

1. Position the insertion pointer where you want the index to appear.

If you want the index to start on a new page, create a new page in Word (see 
Chapter 13). I also recommend putting the index at the end of the document, 

which is what the reader expects.

2. Click the References tab.

3. In the Index group, click the Insert Index button.

The Index dialog box appears. Here are my recommendations:

• The Print Preview window is misleading. It shows how the index might look 
but doesn’t use the actual index contents.
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• Use the Formats drop-down list to select a style for the index. Just about 
any choice from this list is better than the From Template example.

• The Columns setting tells Word how many columns wide to make the 
index. The standard is two columns. I usually choose one column, which 
looks better on the page, especially in shorter documents.

• I prefer to use the Right Align Page Numbers option.

4. Click the OK button to insert the index into the document.

What you see is an index field, displayed using the information culled from the 
document. See Chapter 23 for more information on fields.

Review the index. Do it now. If you dislike the layout, press Ctrl+Z to undo and 

start over. Otherwise, you’re done. But:

If­you­modify­a­document,­update­its­index:­Click­the­index­field.­Then­choose­the­
Update Index command button from the Index group. Word updates the index to 

reference any new page numbers and includes freshly marked index entries.

 » Feel free to add a heading for the index, because Word doesn’t do it for you.

 » Use a heading style for the index header so that it’s included in the docu-
ment’s table of contents. See the earlier section “Creating a table of contents.”

 » Word uses continuous section breaks to place the index field in its own 
document section. Refer to Chapter 14 for more information on sections.

Adding a list of figures
The References tab’s groups help you insert other document lists, but only if 

you’ve created the list appropriately.

For­example,­you­can­create­a­table­of­figures,­providing­you’ve­used­the­Refer-
ences­tab’s­Caption­button.­To­build­the­table­of­figures,­click­the­Insert­Table­of­
Figures button. The process works similarly to inserting a table of contents or an 

index, but it works only when you’ve properly inserted the captions.

For­full­details­on­creating­a­list­of­figures,­tables,­or­captions,­obtain­my­book­
Word 2016 For Professionals For Dummies (Wiley).
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Footnotes and Endnotes

Both­footnotes­and­endnotes­contain­bonus­information,­clarifications,­or­asides­
to supplement text on a page. Each is marked by a superscripted number or letter 

in the text.1

The­difference­between­a­footnote­and­an­endnote­lies­in­its­placement:­A­footnote 

appears at the bottom of the page, and an endnote appears at the end of the docu-

ment. Otherwise, both references are created in a similar way:

1. Click the mouse so that the insertion pointer sits immediately to the 

right of a word or some text that you want the footnote or endnote to 

reference.

There’s no need to type the note’s number; it’s done automatically.

2. Click the References tab.

3. From the Footnotes group, choose either the Insert Footnote or Insert 

Endnote command button.

A superscripted number is inserted into the text, and you’re instantly whisked 
to the bottom of the page (footnote) or the end of the document (endnote).

4. Type the footnote or endnote.

5. To return to the spot where you last edited the document, press Shift+F5.

Here are some footnote/endnote notes:

 » The keyboard shortcut for inserting a footnote is Alt+Ctrl+F (F for footnote).

 » The keyboard shortcut for inserting an endnote is Atl+Ctrl+D (D for da 

endnote).

 » If you’re curious, know that the keyboard shortcut Alt+Ctrl+E, which should be 

the Endnote command keyboard shortcut, instead enables and disables 
Word’s Revision Marks feature, covered in Chapter 26.

 » If you add a new footnote or endnote, all footnotes and endnotes are updated 
to be numbered sequentially in the document.

 » To browse footnotes and endnotes, click the References tab. In the Footnotes 
group, use the Next Footnote button’s menu to browse the footnote and 
endnote references.

 » You can preview a footnote’s or endnote’s contents by hovering the mouse 
pointer at the superscripted number in the document’s text.
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 » Use the Show Notes button (References tab, Footnotes group) to examine 
footnotes or endnotes as they appear on the page.

 » To delete a footnote or an endnote, highlight its reference number in the text 
and press the Delete key. Word magically renumbers any remaining footnotes 
or endnotes.

 » To convert a footnote to an endnote, right-click the footnote’s text at the 
bottom of the page. Choose the Convert to Endnote command. Likewise,  
you can convert endnotes to footnotes by right-clicking the endnote text  
and choosing the Convert to Footnote command.

 » For additional control over footnotes and endnotes, click the Dialog Box 
Launcher button in the Footnotes group. Use the Footnote and Endnote 
dialog box to customize the reference text location, format, starting number, 
and other options.
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Chapter 22

Here Come the Graphics

I
t’s sacrilege, of course. Word processing is about words. Images and words mix 

and mingle in the software realm of desktop publishing. Regardless, the mighty 

Microsoft Word allows you to slap down a picture, insert an object, edit images, 

and otherwise pretend it’s some sort of graphics program. This trick might just 

save you 1,000 words, providing you know how it works.

Graphical Goobers in the Text

The door to Word’s graphical closet is found on the Insert tab. The command but-

tons nestled in the Illustrations group place various graphical goobers into the 

text. Here’s how the process works for pictures and graphical images:

1. Click the mouse at the spot in the text where you desire the image to 

appear.

You don’t need to be precise, because you can always move the image later.

IN THIS CHAPTER

 » Inserting a graphic or an image into a 

document

 » Removing images

 » Playing with WordArt

 » Making text wrap around an image

 » Changing the size of an image

 » Cropping an image

 » Modifying an image’s appearance

 » Working with multiple images
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2. Click the Insert tab.

3. Use one of the command buttons to choose which type of graphical 

goober to add.

You can also paste a previously copied image, as described in the next section.

Figure 22-1­illustrates­how­a­freshly­added­image­looks,­highlighting­some­of­its­
features.

While the image is selected, a new tab appears on the Ribbon. For pictures, it’s the 

Picture Format tab; for other types of graphics, the Shape Format tab appears. 

Both­ tabs­ offer­ similar­ tools­ to­ help­ you­ perfect­ the­ recently­ inserted­ graphic.­
Later sections in this chapter cover using those tools, as well as the controls illus-

trated­in­Figure 22-1.

 » To remove an image, click to select it and then tap the Delete key. If the 

graphical object, such as a shape, contains text, ensure that you’ve clicked the 

object’s border before you tap the Delete key.

 » How the image sits in the document is important, and you should consider 

making these adjustments after adding the image. Refer to the later section 

“Image Layout” for information on precise image placement.

 » The more graphics you add in Word, the more sluggish it becomes. My advice: 

Write first. Add graphics last. Save often.

FIGURE 22-1: 
An image in a 

document.



CHAPTER 22  Here Come the Graphics      259

Copying and pasting an image

A simple way to stick an image into a document is to paste it in from elsewhere. 

Follow these steps:

1. Select the image in another program or from the web.

2. Press Ctrl+C to copy the image.

For a web page image, right-click and choose the Copy or Copy Image 

command.

3. Switch to the Word document window.

4. In Word, position the insertion pointer where you want the image to 

dwell.

5. Press Ctrl+V to paste the image into the document.

If the image doesn’t paste, it might be in a graphical format incompatible with 

Word.

You can also obtain an image from the web directly, by performing a web image 

search from within Word: On the Insert tab, in the Illustrations group, choose 

Pictures, Online Pictures. Use options in the Insert Pictures window to locate an 

online image, courtesy of Microsoft’s Bing search engine.

Plopping down a picture

Your­computer­is­most­likely­littered­with­picture­files.­No­matter­how­the­image­
was created, as long as it’s found somewhere on your PC, you can stick it into your 

document. Follow these steps:

1. Click the mouse in the text where you want the image to appear.

2. On the Insert tab, in the Illustrations group, click the Pictures button.

The Pictures button is shown in the margin.

3. From the Pictures menu, choose This Device.

4. Use the Insert Picture dialog box to hunt down and select the image.

5. Click the Insert button.

The image is slapped down in the document.
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A nifty picture to stick at the end of a letter is your signature. Use a desktop scan-

ner­ to­digitize­your­ John­Hancock.­Save­ the­signature­as­an­ image­file­on­your­
computer, and then follow the steps in this section to insert that signature picture 

in the proper place in the document.

Refer to the book Word 2016 For Professionals For Dummies (Wiley) for details on 

adding a caption to an image and creating a list of captions for the manuscript.

Slapping down a shape

Word comes with a library of common shapes ready to insert in a document. These 

include­ basic­ shapes,­ such­ as­ squares,­ circles,­ geometric­ figures,­ lines,­ and­
arrows —­plus­popular­and­unpopular­symbols.­Graphics­professionals­refer­to­
these types of images as line art.

To place some line art in a document, follow these steps:

1. Click the Insert tab.

2. In the Illustrations group, click the Shapes button.

The button, shown in the margin, holds a menu that lists shapes organized by 

type.

3. Choose a predefined shape.

The mouse pointer changes to a plus sign (+) in preparation for you to draw 

the shape in the document.

4. Drag to create the shape.

The shape is placed into the document, floating in front of the text.

At this point, you can adjust the shape: Change its size, location, or colors. Use the 

Shape Format tab, conveniently appearing on the Ribbon while the shape is 

selected,­to­affect­those­changes.

 » Instantly change the image by using the Shape Styles group on the Ribbon’s 
Shape Format tab. Choose a new style from the Shape Gallery. Styles are 
related to the document’s theme; see Chapter 16 for information on themes.

 » Other items in the Shape Styles group affect the selected shape specifically: 
Click the Shape Fill button to set the fill color; use the Shape Outline button to 
set the shape’s outline color; choose an outline thickness from the Shape 
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Outline button’s menu, on the Weight submenu; use the Shape Effects button 
to apply 3D effects, shadows, and other fancy formatting to the shape.

 » To more effectively format a shape, click the Launcher in the lower right 
corner of the Shape Styles group. Use the Format Shape pane to manipulate 
settings for any selected shape in the document.

Sticking things into a shape

Shapes need not be colorful distractions. You can use a shape to hold text or frame 

a­picture,­which­makes­it­one­of­the­more­flexible­graphical­goobers­to­add­to­a­
document.

To slip a smidgen of text into a shape, right-click the shape and choose the Add 

Text command. The insertion pointer appears within the shape. Type and format 

the text.

To place a picture into a shape, select the shape. Click the Shape Format tab. In the 

Shape Styles group, click the Shape Fill button and choose the Picture menu item. 

Use the Insert Pictures window to hunt down an image to frame inside the shape.

 » Yes, it’s possible to have both a picture and text inside a shape.

 » To further deal with text in a shape, click the shape and then click the Shape 
Format tab on the Ribbon. The Text group contains buttons to manipulate the 

shape’s text.

 » To remove text from a shape, select and delete the text.

 » To remove a picture, select a solid color from the Shape Fill menu.

 » Also see Chapter 23 for information on text boxes, which are similar to shapes 
with text inserted.

Using WordArt

Perhaps the most overused graphic goober that’s stuck into any Word document 

is WordArt. This feature is almost too popular. If you haven’t used it yourself, 

you’ve­probably­seen­it­in­a­thousand­documents,­fliers,­and­international­trea-
ties. Here’s how it works:

1. Click the Insert tab.

2. In the Text group, click the WordArt button to display the WordArt menu.
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The Word Art button is shown in the margin.

3. Choose a style from the WordArt gallery.

A WordArt graphical placeholder appears in the document. It’s a graphical 

element that holds specially formatted text.

4. Type the (short and sweet) text that you want WordArt-ified.

Use the Word Art Styles group on the Shape Format tab to customize WordArt’s 

appearance. If you don’t see the Shape Format tab, select the WordArt graphic.

Image Layout

To keep text and graphics living in harmony within a document, you must provide 

the proper layout options. These options control how the text and graphics inter-

act, creating a visually impressive presentation where things don’t look (to use 

graphics designer terminology) dorky.

In Word, layout options fall into three general categories:

 » Inline: The image is inserted directly into the text, just like a large, single 

character. It stays with the text, so you can press Enter to place it on a line by 

itself or press Tab to indent the image, for example.

 » Wrapped: Text flows around the graphic, avoiding the image like cheerlead-

ers at a high school dance avoid the guys in the chess club.

 » Floating: The image appears in front of or behind the text. Shapes (or line art) 
inserted in the document appear floating in front of the text by default.

To set image layout options, click to select an image and then click the Layout 

Options button. It appears to the upper right of a selected image (refer to Fig-

ure 22-1)­and­is­shown­in­the­margin.­The­Layout­Options­menu­lists­various­lay-

out­settings,­as­illustrated­in­Table 22-1.
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Wrapping text around an image

For smaller images, or images that otherwise break up a document in an inelegant 

manner, choose one of the text-wrapping layout options. Heed these steps:

1. Click to select the image.

A selected image appears with eight handles, as shown earlier, in Figure 22-1.

2. Click the Layout Options button.

Word features four text wrapping options, found in the With Text Wrapping 

area of the Layout Options menu. These options are Square, Tight, Through, 
and Top and Bottom, described in Table 22-1.

3. Choose a text wrapping option.

Examine the image to see how text wraps around. If you’re displeased, repeat 

these steps and choose another layout option in Step 3.

To remove text wrapping, choose the Inline option from Step 3.

TABLE 22-1 Image Layout Options

Icon Setting What It Does

Inline The image acts like a character, moving with other text on the page.

Square Text flows around the image in a square pattern, regardless of the image’s 
shape.

Tight Text flows around the image and hugs its shape.

Through Text flows around the image but also inside the image (depending on the 
image’s shape).

Top and Bottom Text stops at the top of the image and continues below the image.

Behind Text The image floats behind the text, looking almost like the image is part of the 
paper.

In Front of Text The image floats on top of the text, like a photograph set on the page.
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Floating an image

When you want an image to be placed in the document independently of the text, 

you­float­the­image.­The­image­can­float­in­front­of­the­text,­like­some­little­kid­
pasted­a­sticker­on­the­page,­or­float­behind­the­text,­as­though­the­image­were­
part of the paper.

To­float­an­image,­select­it­and­then­click­the­Layout­Options­button,­shown­in­the­
margin.­Choose­Behind­Text­or­In­Front­of­Text.­Refer­to­Table 22-1­for­the­appro-

priate icons.

After choosing either Behind Text or In Front of Text, you see the image released 

from­the­confines­of­the­text.­The­image­floats­freely,­either­behind­or­in­front­of­
the text.

Keeping an image with text

Graphics­and­images­in­Word­belong­to­a­specific­paragraph­in­the­text.­It’s­as­
though­the­image­is­linked­or­anchored­to­a­specific­paragraph,­which­helps­asso-

ciate the document’s graphics with the tidbit of text that references them.

To see which paragraph belongs to an image, click to select the image. Then look 

for the Anchor icon, shown in the margin, next to a paragraph of text. This is the 

paragraph the image sticks to, which it follows as you work on the document’s 

text.

To­ change­ anchor­ paragraphs,­ drag­ the­ anchor­ icon­ to­ another­ paragraph —­
hopefully, one that references the image. This way, if the paragraph moves to 

another page, the image moves with it.

To keep an image pasted to the same spot on a page, select the image and then 

click the Layout Options button. Choose the Fix Position on Page setting. The 

image­becomes­“stuck”­on­the­page­at­a­specific­location,­regardless­of­how­the­
text­flows­around­it.

Image Editing

Word is neither a graphics application nor a photo editor program. It’s a word 

processor. Still, Word features a handful of commands to manipulate pictures and 

images in a document. For serious work, however, I recommend that you use an 

image editing program or any application designed to manipulate graphics.
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 » Use Word’s Undo command, Ctrl+Z, to undo any image editing boo-boos.

 » When you’re using a document theme, theme effects are automatically 
applied to any graphic inserted into your document. Refer to Chapter 16 for 
more information on themes.

Resizing an image

To make an image larger or smaller, heed these steps:

1. Select the image.

Click the image and it grows handles, as shown earlier, in Figure 22-1.

2. Drag one of the image’s four corner handles inward or outward to make 

the image smaller or larger, respectively.

If you hold down the Shift key as you drag, the image is proportionally resized.

On the Picture Format tab, in the Size group, you can use the Height and Width 

controls­to­nudge­the­image­size­vertically­or­horizontally­or­to­type­specific­val-
ues for the image’s size.

Cropping an image

In graphics lingo, cropping works like taking a pair of scissors to the image: You 

make the image smaller, but by doing so, you eliminate some content, just as an 

angry, sullen teen would use shears to remove his cheating scumbag former girl-

friend­from­a­prom­picture.­Figure 22-2­shows­an­example.

To crop an image in a document, put away those shears and obey these 

directions:

1. Click the image once to select it.

The Picture Format tab appears on the Ribbon.

2. On the Picture Format tab, in the Size group, click the Crop button and 

choose Crop.

The button is shown in the margin. After you choose the Crop command, the 

image grows eight thick crop handles.
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3. Drag one of the crop handles to discard a portion of the image.

4. Press the Enter key to crop the image.

The portion of the image not contained within the crop handles is eliminated.

I use the edge (left, right, top, or bottom) handles to crop. The corner handles 

never crop quite the way I want them to.

 » Items other than Crop on the Crop menu let you crop the image to a pre-

defined shape or aspect ratio.

 » The image isn’t completely altered by Word’s Crop command; only a portion 

of the image is hidden. If you recrop the image, it’s possible to restore the 

originally cropped portion.

Rotating an image

You have two handy ways to rotate an image, neither of which involves turning 

the computer’s monitor or craning your neck to the point of chiropractic necessity.

To freely rotate an image, use the mouse to “grab” the rotation handle at the top of 

the­image.­(Refer­to­Figure 22-1.)­Drag­the­mouse­to­orient­the­image­to­any­angle.

FIGURE 22-2: 
Cropping an 

image.
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For more precise rotation, on the Picture Format tab in the Arrange group, click 

the Rotate command button. From its menu, you can choose to rotate the image 

90­degrees­to­the­left­or­right­or­to­flip­the­image­horizontally­or­vertically.

Changing an image’s appearance

To manipulate a selected image, click the Picture Format tab and use the tools in 

the­ Adjust­ group.­ Specifically,­ use­ these­ tools:­ Corrections,­ Color,­ and­ Artistic­
Effects.­As­a­bonus,­each­tool’s­button­shows­a­menu­full­of­options­previewing­
how­the­changes­will­affect­the­image.­To­make­the­change,­choose­an­option­from­
the appropriate button’s menu. Here are some suggestions:

 » Brightness and contrast settings are made from the Corrections button menu.

 » To wash out a picture you placed behind the text, click the Color button and 

choose the Washout color from the Recolor area.

 » To convert a color image to monochrome (black-and-white), click the Color 

button and choose the first item on the menu: Saturation 0%.

 » A slew of interesting, artistic brushstrokes and other effects are found on the 
aptly named Artistic Effects button menu.

Image Arrangement

Managing more than one image on a page can be toilsome, especially when the 

images­overlap.­You­may­find­yourself­unable­to­click­an­image­to­select­ it.­Or,­
maybe you prefer one image to be in front of the other, perfectly aligned, or you 

must move two images together. All these image arranging tasks are made easier, 

thanks to magical graphics tools available in Word, providing you know where to 

find­them­and­how­to­incant­the­spells.

 » To arrange images, click a graphic to summon either the Picture Format tab or 

Shape Format tab. For either tab, the tools you need are located in the 
Arrange group.

 » To select multiple images, press and hold the Shift key as you click each one.
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Moving an image hither and thither

To relocate an image to a better spot, point the mouse at the image. The mouse 

pointer changes to a 4-way arrow, similar to the one shown in the margin. When 

you see this mouse pointer, drag the image nigh and yon.

 » Point the mouse at the center of the image to drag. If you accidentally point at 

one of the image’s handles, you resize the image.

 » An image’s layout options determine where and how you can move it. When 

an image floats behind the text, you may need to open up a spot in the text so 
that you can grab the image. To do so, position the mouse pointer by or on 

the same line as the image and then whack the Enter key a few times. After 

moving the image, delete the extra blank paragraphs you created when you 

pressed the Enter key.

Aligning graphics

Image alignment is necessary to keep two or more graphical objects looking neat 

and­tidy­on­the­page.­Especially­when­the­images­use­a­floating­or­wrapped­layout,­
you want to ensure that they line up by the top edges, side to side, or centered.

To align graphics, follow these steps:

1. Click the first image to select it.

2. Hold down the Shift key and click the rest of the images.

3. On the Picture Format tab, in the Arrange group, click the Align Object 

button.

The button is shown in the margin. Click that button to display a menu of 

alignment choices.

4. Choose an alignment command.

For example, choose Align Top to ensure that the top edge of both pictures are 

aligned on the page.

If­you’d­rather­eyeball­the­arrangement,­activate­Grid:­Click­the­Align­Object­but-
ton­and­choose­View­Gridlines­from­the­menu.­Instantly,­the­page­looks­like­it’s­a­
sheet of graph paper. Use the grid to help position multiple images. Choose the 

View­Gridlines­command­again­to­hide­the­grid.
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The­Distribute­commands­on­the­Align­Object­menu­help­you­organize­multiple­
images evenly across a page. For example, if you have three images left-to-right 

and­you­want­to­space­them­evenly,­first­align­the­images­by­choosing­Align­Mid-

dle.­Then­choose­Distribute­Horizontally­to­evenly­space­the­images.

ShufÒing images front or back
Graphics­are­plunked­down­on­a­page­one­atop­the­other.­This­arrangement­is­dif-
ficult­to­notice­unless­two­images­overlap,­as­shown­in­Figure 22-3.­To­change­the­
order­and­shufÒe­images­in­front­of­or­behind­each­other,­click­the­Picture­Format­
tab, and in the Arrange group, use the Bring Forward or Send Backward 

commands.

To­move­one­image­in­front­of­another,­first­click­that­image.­Choose­Bring­For-
ward ➪  ­Bring­Forward­ to­shufÒe­that­ image­ forward­one­position.­To­bring­ the­
image in front of all other images, choose Bring Forward ➪   Bring to Front.

Likewise, use the Send Backward ➪   Send Backward or Send Backward ➪   Send to 

Back­commands­to­shufÒe­an­image­to­the­background.

Grouping images

When­you­use­smaller­shapes­to­cobble­together­a­complex­image,­use­the­Group­
command to keep those items together. That way, you can move them as a single 

unit,­copy­and­paste­them,­and­apply­image­effects­to­the­entire­group.

FIGURE 22-3: 
Working with 

multiple images.
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To group two or more graphical objects in a document, select the images: Click the 

first­one,­and­then­press­and­hold­the­Shift­key­as­you­click­other­images.­When­
the­group­is­selected,­on­the­Picture­Format­tab,­in­the­Arrange­Group,­click­the­
Group­button­and­choose­the­Group­command.­The­images­are­then­treated­as­a­
unit,­such­as­the­palm­tree­shown­earlier,­in­Figure 22-3,­which­is­a­collection­of­
individual shapes.

To ungroup, click the grouped images and then choose the Ungroup command 

from­the­Group­menu.
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Chapter 23

Insert Tab Insanity

A
side from formatting, everything from text to graphics that’s put into a 
Word document is inserted. This approach makes me curious why the 
magicians at Microsoft sought to dedicate a tab on the Ribbon to the topic 

of Insert. What weird, wonderful, and wanted buttons could crowd that tab’s var-
ious­groups —­especially­those­items­not­covered­elsewhere­in­this­book.

Characters Foreign and Funky

The­computer’s­keyboard­lets­you­type­all­26­letters­of­the­alphabet —­plus­num-
bers, a smattering of symbols, and punctuation thingies. Writers weave these char-
acters into a tapestry of text heretofore unseen in literary history. As if that weren’t 
enough, you can sprinkle even more characters into the document, those not directly 
found on a computer keyboard, spicing up your document like garlic in a salad.

Nonbreaking spaces and hyphens
The space and the hyphen characters are special in Word. They’re used to wrap a 
line of text: The space splits a line between two words, and the hyphen (using 
hyphenation) splits a line between a word’s syllables.

IN THIS CHAPTER

 » Typing nonbreaking spaces and 
hyphens

 » Inserting foreign language characters

 » Getting at special symbols

 » Breaking up text with a text box

 » Creating dynamic text with fields

 » Inserting the date and time into 
the text
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When you don’t want a space or hyphen to split a line of text, you use one of the 
unbreakables:

 » The nonbreaking hyphen character is Ctrl+Shift+ – (hyphen).

 » The nonbreaking space is Ctrl+Shift+spacebar.

For example, if you don’t want a phone number split between two lines, press 
Ctrl+Shift+– (hyphen) instead of using a standard hyphen. And when two words 
must remain together in a paragraph, use Ctrl+Shift+spacebar to marry them.

Typing characters such as Ü, Ç, and Ñ
You can be boring and type deja vu or be all fancy and type déjà vu or café or résumé. 
Such­tricks­make­your­readers­think­that­you­know­your­stuff,­but­what­you­really­
know is how to use Word’s diacritical mark keys.

Diacritical is not an urgent medical situation. Instead, it’s a term that refers to 
symbols appearing over certain letters. Foreign languages use diacritical marks, 
such as the examples used in the preceding paragraph.

To­create­a­diacritical­mark­in­Word,­you­press­two­keys:­first­a­special­Control-
key­combination­prefix­and­then­the­character­to­adorn­with­the­mark.

The­Control-key­combination­prefix­key­somewhat­represents­the­diacritical­mark­
you need, such as Ctrl+’­to­produce­the­’­diacritical­mark.­Table 23-1­lists­the­pre-
fixes­and­their­associated­character­hats.

For example, to insert an é into a document, press Ctrl+’ and then type uppercase 
E for É or lowercase e for é. This shortcut makes sense because the apostrophe (’) 
is essentially the diacritical mark you’re adding to the vowel.

 » The apostrophe (or tick) and the accent grave (or back tick) are two different 
characters, found at two different locations on the keyboard.

 » For the Ctrl+@, Ctrl+:, Ctrl+^, and Ctrl+~ key combinations, you must also press 

the Shift key. Therefore, Ctrl+~ is really Ctrl+Shift+`.

 » Word’s AutoCorrect feature recognizes a few special characters. For example, 
when you type café, Word automatically sticks that whoopty-doop over the e.
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Inserting special characters and symbols
On the far right side of the Insert tab dwells the Symbols group. One of the two 
items residing in this group is Symbol. Click this button to see some popular or 
recently used symbols. Choose a symbol from the menu to insert the special sym-
bol directly into the text.

To see the complete host of available symbols and characters, click the Symbol 
button and choose the More Symbols command. The Symbol dialog box appears, 
as­shown­in­Figure 23-1.­Choose­a­decorative­font,­such­as­Wingdings,­from­the­
Font menu to see strange and unusual characters. To see the gamut of what’s pos-
sible with normal text, choose (normal text) from the Font drop-down list. Use 
the­Subset­drop-down­list­to­see­specific­symbols­and­such.

To stick a character into the document from the Symbol dialog box, select the 
symbol and click the Insert button.

You must click the Cancel button when you’re done using the Symbol dialog box.

 » Click the Insert button once for each symbol you want to insert. For example, 
when you’re putting three Σ (sigma) symbols into the document, you must 
locate the symbol on the grid and then click the Insert button three times.

 » Symbols you choose from the Symbols dialog box later appear on the 
Symbols menu.

 » Some symbols have shortcut keys, which appear at the bottom of the Symbol 

dialog box (refer to Figure 23-1). For example, the shortcut for the degree 

TABLE 23-1 Those Pesky Foreign Language Characters

Prefix Key Characters Produced

Ctrl+’ á é í ó ú

Ctrl+` à è ì ò ù

Ctrl+, ç

Ctrl+@ å

Ctrl+: ä ë ï ö ü

Ctrl+^ â ê î ô û

Ctrl+~ ã õ ñ

Ctrl+/ Ø
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symbol (°) is Ctrl+@, spacebar: Press Ctrl+@ (actually, Ctrl+Shift+2) and then 
type a space.

 » You can insert symbols by typing the symbol’s character code and then 

pressing the Alt+X keyboard shortcut. For example, the character code for Σ 

(sigma) is 2211: Type 2211 in the document and then press Alt+X. The number 
2211 is magically transformed into the Σ character. The character code 
appears in the Symbol dialog box, as illustrated in Figure 23-1.

Spice Up a Document with a Text Box

A text box­ is­ a­ graphical­ element­ that­ contains —­hold­ your­ breath,­wait­ for­ it,­
wait —­text. The text is used as a decorative element commonly called a pull quote 
or callout, or it can be an information box or an aside, such as those elements that 
litter the pages of USA Today. The primary purpose of the text box is to prevent the 
document from becoming what graphics designers refer to as the dreaded Great 
Wall of Text.

To shove a text box into a document, follow these steps:

1. Click the Insert tab.

2. In the Text group, choose Text Box.

FIGURE 23-1: 
The Symbol 

dialog box.
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3. Choose a preformatted text box from the list.

The text box is splashed onto the current page in your document.

4. Rewrite the text in the box.

Despite its purpose, a text box is a graphical element in Word. As such, the Shape 
Format tab appears on the Ribbon when the text box is selected. Use this tab to 
format the text box, apply a layout, and so on.

 » You can set the layout options for the text box just as you would for any 
graphical goober in the document; options are presented in Chapter 22.

 » It’s common to copy and paste text from the document into the box, which is 
how pull quotes work.

 » To change text orientation within the text box, click the box and then click the 
Shape Format tab. In the Text group, click the Text Direction button to peruse 
orientation options.

 » To remove a text box, click its edge (so that the box is selected, not its text) 
and press the Delete key.

Fun with Fields

What­ you­write­ in­Word­ isn’t­ carved­ in­ stone —­well,­ unless­ you­ have­ a­ cool­
printer I’ve not heard of. Still, the text you scribble remains static until you change 
it or until the computer screws up.

To liven things up a tad, Word lets you add dynamic elements to a document. 
Unlike the text you normally compose, dynamic­text­changes­to­reflect­a­number­
of factors. To add these dynamic elements to a document, you use a Word feature 
called fields.

Understanding fields
Word’s­dynamic­field­feature­is­part­of­the­Quick­Parts­tools.­To­add­a­field­to­a­
document,­click­the­Insert­tab,­and­in­the­Text­group,­click­the­Quick­Parts­button,­
shown in the margin. Choose the Field command to behold the Field dialog box, 
shown­in­Figure 23-2.

The scrolling list on the left side of the Field dialog box shows categories. These 
represent various dynamic nuggets you can insert in a document. Choose a spe-
cific­category­to­narrow­the­list­of­field­names.
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The center and right part of the dialog box contain formats, options, and other 
details­for­a­selected­field.­(Examples­are­described­in­the­sections­that­follow.)

To­insert­the­field,­click­the­OK­button.­The­field­appears­just­like­other­text,­com-
plete­with­formatting­and­such,­but­the­information­displayed­changes­to­reflect­
whatever­the­field­represents.­For­example,­the­current­page­number­field­always­
shows the current page.

When­the­insertion­pointer­is­placed­inside­a­field,­the­text­is­highlighted­with­a­
dark­gray­background.­It’s­your­clue­that­the­text­is­a­field­and­not­plain­text.­Also­
see­the­later­section­“Deleting­fields.”

Adding some useful fields
Word­offers­an­abundance­of­fields­you­can­thrust­into­a­document.­Of­the­lot,­you­
might use only a smattering. My favorites are listed in this section.

These subsections assume that the Fields dialog box is open, as described in the 
preceding section.

FIGURE 23-2: 
The Field 

dialog box.
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Page numbers
To­ensure­that­the­document­accurately­reflects­the­current­page­number,­insert­a­
current­page­number­field:

1. In the Field dialog box, select Numbering from the Categories drop-down 
list.

2. Select Page from the Field Names list.

3. In the Field Properties section of the Field dialog box, select a format for 
the page number.

4. Click OK.

The current page number appears in the document. No matter how you edit or 
modify­the­document,­that­number­reflects­the­current­page­number.

Total number of pages
To insert the total number of pages in a document, heed these directions:

1. Select Document Information from the Categories drop-down list.

2. Select NumPages from the Field Names list.

3. Select a format.

4. Click OK.

Word count
Getting paid by the word? Stick an automatic word count at the end of the 
document:

1. From the Categories list, select Document Information.

2. Select NumWords from the Field Names list.

3. Click OK.

Document filename
Many­organizations­place­ the­ document’s­filename­ into­ a­ document­header­ or­
footer.­Rather­than­guess,­why­not­use­a­field­that­contains­the­document’s­exact­
name? Do this:

1. From the Categories list, select Document Information.

2. Select FileName from the Field Names list.
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3. In the field properties list, choose a text case format.

4. Optionally (though recommended), put a check mark by the option Add 
Path to Filename.

5. Click OK.

The­FileName­field­always­reflects­the­name­of­the­file,­even­when­you­change­it.

Updating a field
Page­number­fields­update­automatically,­but­other­fields­require­some­encour-
agement.­To­perform­a­manual­update­and­freshen­a­field’s­contents,­right-click­
the­field­and­choose­the­Update­Field­command.­The­field’s­text­is­refreshed.

Printing­fields­update­only­when­you­print­the­document.

Changing a field
When­you­don’t­get­the­field’s­text­quite­right —­for­example,­you­desire­a­date­
format­that­displays­the­weekday­name­instead­of­an­abbreviation —­right-click­
the­field­and­choose­the­Edit­Field­command.­Use­the­Field­dialog­box­to­make­
whatever­modifications­you­deem­necessary.

Viewing a field’s raw data
Just as those mutants at the end of Beneath the Planet of the Apes removed their 
human­masks,­you­can­remove­a­field’s­mask­by­right-clicking­it­and­choosing­
the­Toggle­Field­Codes­command.­For­example,­the­FileSize­field­looks­like­this:

{ FILESIZE \* MERGEFORMAT }

To­restore­the­field­to­human-readable­form,­right-click­it­again­and­choose­the­Tog-
gle Field Codes command. The keyboard shortcut is Alt+F9. All praise be to the bomb.

Deleting fields
Removing­a­field­works­almost­like­deleting­text.­Almost.­The­difference­is­that­
you must press the Delete or Backspace key twice.

For­example,­when­you­press­Backspace­to­erase­a­field,­the­entire­field­is­high-
lighted.­This­visual­update­is­your­clue­that­you’re­about­to­erase­a­field,­not­regu-
lar­text.­Press­Backspace­again­to­remove­the­field.
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The Date and Time

With few exceptions, time travelers are the only ones who bother asking for the 
current­year.­Otherwise,­people­merely­want­to­know­the­month­and­day­or­just­
the day of the week. Word understands these people (but not time travelers), so it 
offers­ a­ slate­ of­ tools­ and­ tricks­ to­ insert­ date-and-time­ information­ into­ a­
document.

Adding the current date or time
Rather than look at a calendar and type a date, follow these steps:

1. Click the Insert tab.

2. In the Text group, click the Date and Time button.

The button may say Date & Time, or you may see only the icon, shown in the 
margin.

3. Use the Date and Time dialog box to choose a format.

THE MYSTERY OF CONTENT CONTROLS

Word’s fields aren’t the only dynamic text gizmos you can stick into a document. 
Another changing goober is the content control. It’s not really a field, though it can be 
inserted and updated in a similar manner. The primary difference is how a content  
control looks, which is something like this:

Content controls are usually inserted by Word commands, such as those that automati-

cally create headers or footers or insert page numbers. On the Insert tab, in the Text 
group, you can choose Quick Parts ➪   Document Property to insert a property control. 
The Equation menu, found in the Insert tab’s Symbols group, also inserts content 

controls.

For more information on content controls, including those fill-in-the-blanks items you 
frequently find in document templates, refer to my book Word 2016 For Professionals For 

Dummies (Wiley).
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4. If desired, click the Update Automatically option so that the 
 date-and-time text remains current with the document.

Setting the Update Automatically option ensures that the date-and-time values 

are updated when you open or print the document.

5. Click the OK button to insert the current date or time into the document.

The keyboard shortcut to insert the current date is Alt+Shift+D. To­insert­the­cur-
rent time, press Alt+Shift+T.

Using the PrintDate field
The­date­field­I­use­most­often­is­PrintDate.­This­field­reflects­the­current­date­
(and time, if you like) when a document prints. It’s marvelous for including in a 
letterhead­template­or­in­another­document­you­print­frequently.­Here’s­how­it­
works:

1. Click the Insert tab.

2. In the Text group, click Quick Parts ➪   Field.

The Field dialog box, which is covered earlier in this chapter, appears.

3. Select Date and Time from the Categories drop-down list.

4. Select PrintDate from the Field Names list.

5. Choose a date-and-time format from the Field Properties area.

6. Click OK.

The­field­looks­odd­until­you­print­the­document,­which­makes­sense.­Also,­the­
field­reflects­the­last­day­you­printed­the­document.­It’s­updated­when­you­print­
again.
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Work with multiple documents at one time.

Explore writing tools such as Outline view.

Collaborate on documents with comments and 

revisions.

Create multiple documents by using mail merge.

Print labels and generate envelopes.
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Chapter 24

Multiple Documents, 
Windows, and File 
Formats

Y
ou need not limit your word processor usage to toiling with one document 

in a single window. Oh, no! You can open multiple documents, working on 

the lot and moving from window to window at your whim. You can even 

split a single document into two views in a single window or open one document 

in­ two­windows.­Word­ does­ it­ all —­plus,­ it­ lets­ you­work­with­ documents­ in­
strange and alien non-Word formats.

IN THIS CHAPTER

 » Working with more than one 

document at a time

 » Comparing documents side by side

 » Seeing one document in two windows

 » Splitting the screen

 » Opening a non-Word document

 » Converting older Word documents
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Multiple Document Mania

It’s not a question of whether Word can work on more than one document at a 

time. No, it’s a question of how you open those documents. Let me count the ways:

 » Keep using the Open command to open documents. No ofÏcial limit exists 
on the number of documents Word can have open, though I suppose your 
sanity weighs into the equation at some point.

 » In the Open dialog box, select multiple documents to open. Press and 
hold the Ctrl key as you click to select documents. Click the Open button, and 
all the documents open like flowers, each in its own pot (window).

 » From any folder window, select multiple Word document icons. Lasso 
them with the mouse, or Ctrl+click to select multiple documents. Press the 
Enter key to open the lot.

Each document dwells cozy in its own Word program window. To switch between 

windows, click one, or choose one by clicking the Word icon on the Windows task-

bar. Or, in Word, you can follow these steps:

1. Click the View tab.

2. In the Window group, click the Switch Windows button.

The Switch Windows button is shown in the margin.

3. Choose a document from the menu.

When some folks are insane enough to have more than nine documents open at a 

time,­the­final­command­on­the­Switch­Windows­menu­is­More­Windows.­Choose­
this item to view the Activate dialog box, which lists all open document windows. 

Select­a­document­from­the­window­and­click­OK­to­switch­to­it.

 » Should you spy any document in the list named Document1, Document2, or 
similar, immediately switch to that window and save before it’s too late!

 » Refer to Chapter 8 for details on opening and saving Word documents.

Arranging open document windows

To see two or more documents displayed on the screen at the same time, select the 

View tab and click the Arrange All button, shown in the margin. Immediately, 

Word organizes all its windows on the screen, arranging them like patches of fab-

ric in a quilt.



CHAPTER 24  Multiple Documents, Windows, and File Formats      285

 » The Arrange All command works best when only a few documents are open. 
Otherwise, the document windows are too teensy to be useful.

 » Word arranges only windows visible on the desktop, not minimized windows.

 » Though you can see more than one document at a time, you can work on only 
one at a time. The document with the highlighted title bar is the one “on top.” 
Click a document to put it on top. Merely looking at the window doesn’t do 
squat.

Comparing two documents side by side

A nifty way to review two documents is to arrange them side by side. Both docu-

ments are visible on the screen, and their scrolling is locked so that you can peruse 

them in parallel. Here’s how to accomplish this trick:

1. Open both documents.

2. On the View tab, in the Window group, click the View Side by Side button.

The View Side by Side button is shown in the margin. After you click this button, 
Word arranges both documents in vertical windows.

3. Scroll either document.

Scrolling one document also scrolls the other. In this mode, you can compare 
the documents.

You can disable synchronous scrolling by clicking the Synchronous Scrolling 
button, found in the Window group.

4. When you’re done, choose View Side by Side again.

Also­see­Chapter 26,­which­covers­reviewing­changes­made­to­a­document.

Viewing one document in multiple windows

A­handy­document­viewing­trick —­especially­for­long­documents —­is­to­open­a­
single document in two windows. This perspective makes writing and editing eas-

ier than hopping back and forth within the same document window and poten-

tially losing your place.
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To open a second window on a single document, obey these steps:

1. Click the View tab.

2. In the Window group, click the New Window button.

After you click the New Window button, shown in the margin, a second window 
opens, showing the current document.

To­confirm­that­the­same­document­is­open­in­two­windows,­check­the­title­bar:­
The­first­window’s­filename­is­followed­by­:1,­and­the­second­window’s­filename­
is followed by :2.

When you no longer need the second window, close it. You can close either  

window :1 or :2; it doesn’t matter. The document is still open and available for 

editing in the remaining window.

 » Don’t be fooled by the two windows! You’re still working on only one docu-

ment. The changes you make in one window are reflected in the other.

 » This feature is useful for cutting and pasting text or graphics between sections 
of a long document.

 » You can even open a third window by choosing the New Window command 
again, but that’s just nuts.

Using the old split-screen trick

Splitting the screen allows you to view two parts of a document in the same win-

dow. No need to bother with extra windows here: The top part of the window 

shows one part of the document; the bottom part, another. Each window half 

scrolls­individually,­so­you­can­peruse­different­parts­of­the­same­document­with-

out switching windows.

To split a window, heed these directions:

1. Click the View tab.

2. In the Window group, click the Split Window button.

A line bisects the document, splitting it from side to side, as illustrated in 
Figure 24-1. If the ruler is visible, a copy appears for both document splits.

You can scroll the top or bottom part of the document independently. This way, 

you­can­peruse­or­edit­different­parts­of­the­document­in­the­same­window.
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To­undo­ the­split,­ choose­ the­Remote­Split­ command­ from­the­Window­group.­
(This­command­replaces­the­Split­command).­Or,­you­can­double-click­the­ line­
separating the document.

The split line is adjustable; drag it up or down to change the split proportions.

Many, Many Document Types

Word begrudgingly recognizes that it’s not the only word processor and that its 

document­file­type­isn’t­the­only­one.­As­such,­the­program­condescends­to­allow­
for the accommodation of lesser, mortal document formats. This feature allows 

you to read and edit non-Word documents as well as share documents with non-

Word­users,­who­aim­to­be­blessed­by­Word’s­beneficence.

Understanding document formats

When you save a document, Word places the document’s text, formatting, and 

other­ information­ into­ a­file.­ To­ keep­ the­ information­ organized,­Word­ uses­ a­
specific­file format.­The­file­format­makes­a­Word­document­unique­and­different­
from­other­types­of­files­lounging­on­your­computer’s­storage­system.

FIGURE 24-1: 
Splitting a 
document 

window.



288      PART 5  The Rest of Word

Word’s document format is popular, but it’s not the only word processing docu-

ment format available. Other word processors, as well as document utilities such 

as­Adobe­Acrobat­(PDF),­use­their­own­formats.­Word­permits­you­to­open­docu-

ments saved in those formats as well as save your Word documents in the alien 

formats. I’m not certain whether the software is pleased to do so, but it’s capable.

 » Basic document opening and saving information is found in Chapter 8.

 » The best way to save a file in another format is to use the Export command, 
discussed in Chapter 9.

 » The standard Word document format uses the .docx filename extension. This 
extension is applied automatically to all Word documents you save, though it 
may not be visible when viewing files in a folder. The older Word document 
format used the .doc filename extension. See the later section “Updating an 
older Word document.”

Opening a non-Word document

Word can magically open and display a host of weird, non-Word documents. 

Here’s how it works:

1. Press Ctrl+F12 to summon the traditional Open dialog box.

2. Choose a file format from the menu button.

The menu button has no label, though it might say All Word Documents, as 
shown in Figure 24-2.

When you choose a specific file format, Word narrows the number of files 
displayed in the Open dialog box; only files matching the specific file format 
are shown.

If you don’t know the format, choose All Files from the drop-down list.

3. Click to select the file.

Or, work the controls in the dialog box to find another storage media or folder 
that contains the file.

4. Click the Open button.
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The­ alien­ file­ appears­ onscreen,­ ready­ for­ editing,­ just­ like­ any­ other­ Word­
­document —­or­not.­Word­tries­its­best­to­open­other­file­formats,­but­it­may­not­
get everything 100 percent okey-doke.

 » For some document types, Word displays a file conversion dialog box. Use its 
controls to preview the document, though clicking the OK button is usually 
your best bet.

 » The Recover Text from Any File option is useful for peering into unknown files, 
especially from antique and obscure word processing file formats.

 » Word remembers the file type! When you use the Open dialog box again, the 
same file type is already chosen from the Files of Type drop-down list. That 
means your regular Word document may be opened as a plain text docu-

ment, which looks truly ugly. Remember to check the Files of Type drop-down 
list if such a thing happens to you.

 » Accordingly, when you open a Word document after opening an HTML 
document, or especially when using the Recover Text from Any File option, 
you must choose Word Documents from the list. Otherwise, Word may open 
documents in a manner that seems strange to you.

 » You may see a warning when opening a document downloaded from the 
Internet. Word is just being safe; the document is placed into Protected view. 
You can preview the document, but to edit it, you need to click the Enable 
Editing button.

FIGURE 24-2: 
Change file types 

in the Open 
dialog box.
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 » Don’t blame yourself when Word is unable to open a document. Many, many 
file formats are unknown to Word. When someone is sending you this type of 
document, ask the person to resend it using a common file format, such as 
HTML, PDF, or RTF.

Updating an older Word document

Microsoft­Word­has­been­around­for­ages.­It­has­used­the­same­.doc­file­format­
since the early days, back when Word ran on steam powered computers that took 

three people to hoist onto a table.

In­ 2007,­ Word­ changed­ its­ document­ file­ format.­ Gone­ was­ the­ .doc­ format,­
replaced by the .docx format. Because a lot of people still use older versions of 

Word,­and­given­the­abundance­of­older­.doc­files­still­available,­it­became­neces-
sary to work with and convert those older documents.

Working with an older Word document is cinchy: Open the document. You see the 

text [Compatibility Mode]­after­the­filename­at­the­top­of­the­window.­This­text­is­a­
big clue that you’re using an older Word document. Another clue is that a lot of 

Word’s features, such as the capability to preview format changes and document 

themes, don’t work when editing an older document.

To update an older document, follow these steps:

1. Click the File tab.

2. On the Info screen, click the Convert button.

The Convert button is shown in the margin. After you click it, a descriptive 
dialog box appears. If not, skip to Step 5.

3. In the Microsoft Word dialog box, click to place a check mark by the item 

Do Not Ask Me Again about Converting Documents.

4. Click the OK button.

5. Click the Save button to save the document.

Use the Save As dialog box as covered in Chapter 8. If you look at the File Type 
menu, you see that the chosen file format is Word Document (*.docx). The 
document is updated.

The older document isn’t removed when you follow these steps, though you’re 

free to delete it.

See­ Chapter  8­ if­ you­ desire­ to­ save­ a­ current­ document­ in­ the­ older­Word­file­
format.
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Chapter 25

Word for Writers

T
he word processor is the best tool for writers since the ghostwriter. Of 
course, cobbling together words in a word processor doesn’t make you a 
writer any more than working with numbers in a spreadsheet makes you an 

accountant. Even so, beyond its basic word processing capabilities, Word comes 
with an armada of tools for making a writer’s job easier. Whether you’re writing 
your­ first­ guest­ piece­ for­ the­ church­ newsletter­ or­ crafting­ your­ 74th­ horror-
thriller, you’ll enjoy Word’s features for writers.

Organize Your Thoughts

Good writers use an outline to organize their thoughts. Back in the old days, an 
outline­would­dwell­on­a­stack­of­3-by-5­cards.­Today,­an­outline­is­a­Word­docu-
ment, which makes it easier to not confuse your outline with grandma’s recipes.

Word’s Outline view presents a document in a unique way: It takes advantage of 
Word’s heading styles to help you group topics, ideas, or plotlines in a hierarchical 

IN THIS CHAPTER

 » Creating an outline in Word

 » Adding topics, subtopics, and text 

topics

 » Rearranging topics in an outline

 » Demoting and promoting topics

 » Printing an outline

 » Making a master document

 » Using the thesaurus

 » Pulling a word count
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fashion.­Outline­tools­make­it­easy­to­shufÒe­around­topics,­make­subtopics,­and­
mix in text to help organize your thoughts. Even if you’re not a writer, you can use 
Word’s Outline mode to create lists, work on projects, or look busy when the boss 
comes around.

The­outlining­feature­is­missing­from­the­online­version­of­Word.

Entering Outline view

To­enter­Outline­view,­click­the­View­tab,­and­in­the­Views­group,­click­the­Outline­
button,­shown­in­the­margin.­The­document’s­presentation­changes­to­show­Out-
line­view,­and­the­Outlining­tab­appears­on­the­Ribbon,­as­shown­in­Figure 25-1.

FIGURE 25-1: 
A typical outline.
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To­exit­Outline­view,­click­the­View­tab­and­choose­another­document­view.­You­
can­also­click­the­big,­honkin’­Close­Outline­View­button­(labeled­in­Figure 25-1).

 » A squat, horizontal bar marks the end of the outline. You cannot 

delete this bar.

 » All basic Word commands work in Outline view. You can use the cursor keys, 

delete text, check spelling, save, insert oddball characters, print, and so on.

 » Don’t worry about the text format in Outline view; outlining isn’t about 

formatting.

 » Word uses the Heading 1 through Heading 9 styles for the outline’s topics. 

Main topics are formatted in Heading 1, subtopics in Heading 2, and so on.

 » Use the Body style or Normal style to make notes or add text to the outline. 

See the section “Adding a text topic,” later in this chapter.

 » An outline isn’t a special type of document; it’s a document view. You can 

switch between Outline view and any other view, and the document’s 

contents don’t change.

Typing topics in the outline

Outlines are composed of topics and subtopics. Topics are main ideas; subtopics 
describe the details. Subtopics can contain their own subtopics, digging down to 
several­levels­of­detail.­The­amount­of­detail­you­use­depends­on­how­organized­
you want to be.

To­create­a­topic,­type­the­text.­Word­automatically­formats­the­topic­using­a­spe-
cific­heading­style­based­on­the­topic­level,­as­shown­in­Figure 25-2.

FIGURE 25-2: 
Topics in an 

outline.
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Keep the main topic levels short and descriptive. Deeper topics can go into more 
detail. Press the Enter key when you’re done typing one topic and want to start 
another.

 » Use the Enter key to split a topic. For example, to split the topic Pots and Pans, 

replace the word and with a press of the Enter key.

 » To join two topics, press the End key to send the insertion pointer to the end 

of the first topic. Then press the Delete key. This method works just like 
joining two paragraphs in a regular document.

 » Don’t worry about organizing the outline when you first create it. In Word’s 
Outline view, you can rearrange topics as your ideas solidify. My advice is to 

start writing things down now and concentrate on organization later.

Rearranging topics

Outlines­ are­fluid.­As­ you­work,­ some­ topics­may­become­more­ important­ and­
others­less­important.­To­these­changes,­you­can­move­a­topic­up­or­down:

 » Click the Move Up button (or press Alt+Shift+↑) to move a topic up a line.

 » Click the Move Down button (or press Alt+Shift+↓) to move a topic down a line.

You­can­also­drag­a­topic­up­or­down:­Point­the­mouse­pointer­at­the­circle­to­the­
topic’s left. When the mouse is positioned just right, the mouse pointer changes 
to­ a­ 4-way­ arrow.­ (See­ the­margin.)­ I­ recommend­ using­ this­ trick­ only­when­
you’re moving topics a short distance; dragging beyond the current screen can 
prove unwieldy.

If­you­need­to­move­a­topic­and­all­its­subtopics,­first­collapse­the­topic.­When­the­
topic is expanded, only the topic itself is moved. See the later section “Expanding 
and collapsing topics.”

Demoting and promoting topics

Outline organization also includes demoting topics that are actually subtopics and 
promoting subtopics to a higher level. Making such adjustments is a natural part 
of working in Outline view.

 » Click the Demote button (or press Alt+Shift+→) to demote a topic into a subtopic.

 » Click the Promote button (or press Alt+Shift+←) to promote a topic.
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New­topics­you­type­are­created­at­the­same­level­as­the­topic­above­(where­you­
pressed­the­Enter­key).

 » To instantly make any topic a main-level topic, click the Promote to 

Heading 1 button.

 » You can use the mouse to promote or demote topics: Drag the topic’s circle 

left or right. I admit that this move can be tricky, which is why I use the 
keyboard shortcuts or buttons on the Ribbon to promote or demote topics.

 » You don’t create subtopics in Word as much as you demote higher-level topics.

 » Promoting or demoting a topic changes the text’s paragraph format. For 

example, demoting a top-level topic changes the style from Heading 1 to 

Heading 2. The subtopic also appears indented on the screen. (Refer to 

Figures 25-1 and 25-2.)

 » The Level menu in the Outlining tab’s Outline Tools group changes to reflect 
the current topic level. You can also use this item’s drop-down list to promote 

or demote the topic to any specific level in the outline.

 » Unlike with main topics, you can get wordy with subtopics. After all, the idea 

here is to expand on the main topic.

 » According to Those Who Know Such Things, you must have at least two 

subtopics for them to qualify as subtopics. When you have only one subtopic, 

either you have a second main topic or you’ve created a text topic. See the 

later section “Adding a text topic” for information.

Expanding and collapsing topics

A­ detailed­ outline­ is­ wonderful,­ the­ perfect­ tool­ to­ help­ you­ write­ that­ novel,­
organize­a­meeting,­or­set­priorities.­To­help­you­pull­back­from­the­detail­and­see­
the Big Picture, you can collapse all or part of an outline. Even when you’re orga-
nizing, sometimes it helps to collapse a topic to help keep it in perspective.

Any­topic­with­subtopics­shows­a­plus­sign­(+)­in­its­circle.­To­collapse­the­topic­
and temporarily hide its subtopics, you have several choices:

 » Click the Collapse button (shown in the margin) on the Outlining toolbar.

 » Press the Alt+Shift+_ (underline) keyboard shortcut.

 » Double-click the plus sign to the topic’s left.
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When a topic is collapsed, it features a fuzzy underline, in addition to a plus sign 
in­the­icon­to­the­topic’s­left.­To­expand­a­collapsed­topic,­you­have­several­choices:

 » Click the Expand button (shown in the margin) on the Outlining toolbar.

 » Press Alt+Shift++ (plus sign).

 » Click the topic’s plus sign.

The­fastest­way­to­display­an­outline­at­a­specific­topic­level­is­to­choose­that­level­
from­the­Show­Level­drop-down­list.­To­find­that­command,­look­on­the­Outlining­
toolbar,­in­the­Outline­Tools­group.

For example, to show only Level 1 and Level 2 topics, choose Level 2 from the 
Show­Level­button’s­menu.­Topics­at­Level­3­and­higher­remain­collapsed.

To­see­the­entire­outline,­choose­Show­All­Levels­from­the­Show­Level­menu.

When some of the subtopics get wordy, place a check mark by the Show First Line 
Only­option.­(Look­on­the­Outlining­tab­in­the­Outline­Tools­group­for­this­setting.)­
When­this­option­is­active,­Word­displays­only­the­first­topic­line­of­text­in­any­topic.

Adding a text topic

Creating­an­outline­can­potentially­be­about­writing­text —­when­the­mood­hits­
you,­ write!­ Rather­ than­ write­ prose­ as­ a­ topic,­ use­ the­ Demote­ to­ Body­ Text­
command.

Here’s how:

1. Press the Enter key to start a new topic.

2. On the Outlining tab, in the Outline Tools group, click the Demote to 

Body Text button (shown in the margin).

The keyboard shortcut is Ctrl+Shift+N, which is also the keyboard shortcut for 

the Normal style.

THE JOY OF COLLAPSIBLE HEADERS

You may have seen a side effect of Word’s Outline view when using the heading styles in 
a document: A tiny triangle button appears to the left of a heading-style paragraph 

whenever a document is shown in Print Layout view. Click this button to expand or col-

lapse the heading and all its contents — including any subheadings. Using this trick is a 
great way to collapse parts of a document without having to switch to Outline view.
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These­steps­change­the­text­style­to­Body­Text.­That­way,­you­can­write­text­for­a­
speech, some instructions in a list, or a chunk of dialogue from your novel and not 
have it appear as a topic or subtopic.

Key Combo What It Does

Alt+Shift+→ Demotes a topic

Alt+Shift+← Promotes a topic

Alt+Shift+↑ Moves a topic up one line

Alt+Shift+↓ Moves a topic down one line

Ctrl+Shift+N Demotes a topic to body text

Alt+Shift+1 Displays only top-level topics

Alt+Shift+2 Displays first- and second-level topics

Alt+Shift+n Displays all topics up to Level n, such as Alt+Shift+4 for Level 4

Alt+Shift+A Displays all topics

Alt+Shift++ (plus sign) Displays all subtopics in the current topic

Alt+Shift+_ (underline) Hides all subtopics in the current topic

Printing an outline

Printing an outline works just like printing any other document in Word but with 
one­big­difference:­Only­visible­topics­are­printed.­Yes,­the­print­preview­shows­all­
the topics printing. It’s a lie.

To­control­visible­topics,­use­the­Show­Level­menu,­as­discussed­earlier,­ in­the­
“Expanding and collapsing topics” section. For example, to print the entire out-
line,­choose­All­Levels­from­the­Show­Level­menu­and­then­print.

OUTLINE MANIPULATION SHORTCUT KEYS

I prefer using Word’s shortcut keys whenever possible. Especially when working an out-
line, when I’m typing more than mousing, it helps to know these outline-manipulation 
shortcut keys:
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To­print­only­the­first­two­levels­of­an­outline,­choose­Level­2­from­the­Show­Level­
drop-down­list­and­then­print.

 » Word uses the heading styles when it prints the outline, though it doesn’t 

indent topics.

 » See Chapter 9 for more information on printing documents in Word.

Large Documents

The­first­novel­I­wrote­(and­never­published,­of­course)­was­several­hundred­pages­
long. It was saved as a single document. Word documents can be any length, but 
putting everything into one document can be impractical. Editing, copying and 
pasting, searching and replacing, and all other word processing operations become 
less­efÏcient­the­larger­the­document­grows.

A­better­solution­for­long­documents­is­to­store­each­chapter,­or­large­chunk,­as­its­
own­file.­This­is­how­publishers­I­work­with­prefer­to­see­things.­An­exception­is­
for­eBooks,­where­the­document­must­be­a­single­file —­usually,­HTML­formatted.­
Either way, you can assemble the individual chapters when it comes time to pub-
lish,­though­for­writing,­editing,­and­organizing,­individual­chapter­files­always­
make more sense.

 » What qualifies as a large document? Anything over 100 pages qualifies, as far 
as I’m concerned.

 » When writing a novel, create each chapter as its own document. Keep these 

documents in their own folder. Further, use clever filenames to help with 
organization. For example, I name chapters by using numbers: The first 
chapter is 01, the second is 02, and so on.

 » For more self-publishing information, see my book Word 2016 For Professionals 

For Dummies (Wiley).

Stitching together chapter documents

If you choose to write your book as separate chapter documents, good! I believe 
you’ll­find­it­easier­to­work­with­the­material,­especially­should­you­need­to­rear-
range­things.­Above,­all,­ensure­that­all­ these­chapter­documents­use­the­same­
template.­If­you­use­a­different­template­for­each,­you­must­do­more­formatting­
when it comes time to assemble all the documents.
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When it’s time to stitch together the chapter documents, start with a new docu-
ment­using­the­same­template­file.­One­at­a­time,­insert­the­chapters:

1. From the Insert tab, in the Text group, choose Object, Text from File.

Behold the first chapter, inserted along with all the proper formatting.

2. On the Layout tab, in the Page Setup group, choose Breaks, Odd Page.

An odd page section break is inserted into the document, ensuring that the 

next chapter starts on the righthand page.

If you’re creating an eBook, you can choose Next Page from the Breaks menu. 
This choice is better than Odd Page, because eBooks aren’t printed.

3. Repeat Steps 1 and 2.

Continue to insert the chapter documents, assembling the final manuscript.

Once the document is assembled, you can mess with headers and footers and page 
numbering­as­well­as­build­the­index,­TOC,­and­other­document­references.

Keep the original chapter documents! Just in case anything goes awry or you need 
to start over for some reason, having the original documents is easier than work-
ing with a long manuscript document.

Splitting a document

If­your­Great­American­Novel­already­exists­as­a­single­document,­it’s­possible­to­
split it into separate chapter documents. Doing so isn’t a requirement, but the 
separate chapter documents may help maintain your sanity when you have a lot of 
reorganization to do.

Here’s how to split a document:

1. Select the portion of the document you want to split into a new 

document.

For example, split the document at the chapter breaks or a main heading 

break.

2. Cut the selected block.

Press Ctrl+X to cut the block.

3. Summon a new, blank document.

Ctrl+N does the trick. Or, if you’re using a template (and you should be), start a 

new document by using that template. See Chapter 16.
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4. Paste the document portion.

Press Ctrl+V to paste. If the text doesn’t paste in with the proper formatting, 
click the Home tab, and in the Clipboard group, click the Paste button (shown 

in the margin). Click the Keep Source Formatting command button.

5. Save the new document.

Continue­splitting­the­larger­document­by­repeating­these­steps.­After­you’ve­fin-
ished splitting the larger document, you can safely delete it.

Avoiding the master document feature

For the longest time in this book, I’ve recommended using Word’s Master  
Document­ feature­ to­ collect­ and­ coordinate­ individual­ documents  —­ called­ 
subdocuments —­and­cobble­them­into­one­large­document.­The­problem­is­that­
the Master Document feature is a pain in the butt. It’s awkward to understand and 
use. Its result isn’t quite the same as just inserting all chapter documents into a 
single,­large­manuscript.­(Refer­to­the­earlier­section­“Stitching­together­chapter­
documents.”)

Dan’s Writing Tips

Nothing­beats­advice­from­someone­who­has­been­there­and­done­that.­As­a­pro-
fessional writer, I’m excited to pass along my tips, tricks, and suggestions to any 
budding scrivener.

Choosing the best word

When two words share the same meaning, they’re said to be synonyms —­ for­
example, big and large.­Synonyms­are­helpful­in­that­they­allow­you­to­find­better,­
more descriptive words and, especially, to avoid using the same tired old words 
over and over. Obviously, knowing synonyms is handy for any writer.

To­ find­ a­ word’s­ synonym,­ right-click­ the­ word­ in­ the­ document.­ From­ the­ 
pop-up­menu,­choose­the­Synonyms­submenu­to­see­a­list­of­words­that­have­a­
similar meaning. Choose a word from the menu and it replaces the word in the 
document.
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 » To see more word alternatives, right-click a word and choose 

Synonyms ➪   Thesaurus. The Thesaurus pane appears, listing multitudinous 
alternative words.

 » To use a word from the Thesaurus pane, right-click the word and choose the 

Insert command. The word is placed in the document at the toothpick cursor’s 
location.

 » Antonyms, or words that mean the opposite of the selected word, might also 

appear on the Synonyms submenu.

 » For more research on a specific word, right-click and choose the Smart 
Lookup command. The Insights pane appears, which lists sources from online 
references to help you determine whether you’re using the best word.

Counting every word

You­pay­the­butcher­by­the­pound.­The­barkeep­is­paid­by­the­drink.­Salespeople­
keep­a­percentage­of­their­sales.­Writers?­They’re­paid­by­the­word.

If you’re lucky enough to be paid for your writing, you know that word count is 
king.­Magazine­editors­demand­articles­based­on­word­length.­“I­need­350­hilari-
ous­words­on­tech­support­phone­calls,”­an­editor­once­told­me.­And­novel­writers­
typically­boast­about­how­many­words­are­in­their­latest­efforts.­“My­next­book­is­
350,000­words,”­they­say­in­stuffy,­nasal­voices.­How­do­they­know­how­many­
words they wrote?

The­best­way­to­see­how­many­words­dwell­in­a­document­is­to­view­the­status­bar.­
The­word­count­appears­by­the­Words label, and the count is updated as you type.

If­you­don’t­see­the­word­count­at­the­bottom­of­the­window,­right-click­the­status­
bar and choose Word Count.

To­obtain­more­than­a­word­count,­click­the­Review­tab.­In­the­Proofing­group,­
click­the­Word­Count­button­(shown­in­the­margin).­The­detailed­Word­Count­dia-
log box appears, listing all sorts of word counting trivia.

Also­ see­ Chapter  23­ for­ information­ on­ inserting­ a­ Word­ Count­ field­ in­ a­
document.
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Writing for writers

Here’s a smattering of tips for any writer using Word:

 » Thanks to the AutoFormat feature, Word fixes ellipses for you. When you type 
three periods in a row, Word inserts the ellipsis character (. . .). Don’t correct it! 
Word is being proper. When you don’t want to use the ellipsis character, 

separate the three periods with spaces.

 » You can format paragraphs by separating them with a space or by indenting 

the first line of each paragraph. Use one or the other, not both.

 » Keep the proper heading formats: Heading 1, Heading 2, and so on. Or, create 

your own heading styles that properly use the Outline Level format. That way, 

you can easily create a table of contents as well as use other Word features 

that display headings in documents.

 » Use Outline view to collect your thoughts. Keep working on the outline and 

organizing your thoughts. When you find yourself writing text-level topics, 
you’re ready to write.

 » Use the soft return (Shift+Enter) to split text into single lines. I use the soft 
return to break up titles and write return addresses, and I use it at other times 
when text must appear one line at a time, such as in a chapter heading or title.

 » Word is configured to select text one word at a time. This option isn’t always 
best for writers, where it’s often necessary to select text by character. To fix 
that setting, from the File tab menu, choose Options. In the Options dialog 
box, click the Advanced item. Remove the check mark by the When Selecting, 

Automatically Select Entire Word item. Click OK.
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Chapter 26

Let’s Work This Out

W
riting isn’t a team sport, but it can be. Eventually, writers encounter 

collaboration, welcome or not. Often, it comes in the form of an editor, 

after the writing is done. In today’s connected society, collaboration 

can happen at any time with just about anyone. Word recognizes this challenge 

and, to help you cope, provides some useful work-it-out-together tools.

Comments on Your Text

The least aggressive method of collaboration is to add a comment as part of a 

document’s­text.­Perhaps­you­do­this­yourself:­Use­a­different­font­or­color,­type­
in all CAPS, or surround your observations with triple curly brackets. Rather than 

do such silly things, click the Review tab and prepare to use some handy com-

menting tools in the Comments group.

Adding a comment

To gently thrust a comment into a document, heed these steps:

1. Select the chunk of text upon which you desire to comment.

The more contextual you are with your selection, the more effective the 
comment.

IN THIS CHAPTER

 » Sticking comments in a document

 » Highlighting text

 » Finding changes in a document

 » Tracking changes in a document

 » Reviewing document changes

 » Sharing by using online collaboration
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2. Click the Review tab.

3. In the Comments group, click the New Comment button.

The New Comment button is shown in the margin. Click it to see the 

Comments box appear to the right of the current page, similar to the one 

shown in Figure 26-1. The side of the page where the comment appears is 
called the markup area.

4. Type a comment.

Jot down your thoughts. I’m not sure how long a comment can be; if you want 
to blab, send an email instead. For some reason, text formatting can be 
applied in the comment.

5. Press the Esc key, close the comment window (refer to Figure 26-1), or 

click in the document’s text when you’ve finished typing the comment.

Don’t click the Reply button to end your comment. See the next section.

Replying to a comment

Comments­ aren’t­ intended­ to­hang­ in­ space —­unless­ you­ just­want­ to­ ignore­
them. Otherwise, you have two choices for dealing with a comment.

To reply to a comment, click the Reply button, illustrated in the margin. Your 

name­appears­in­the­Comments­box­(refer­to­Figure 26-1),­and­you’re­offered­the­
opportunity to jot down a counterpoint, rebuttal, or curse.

When the commented issue is no longer an issue, mark the comment as resolved: 

Click the comment’s Resolve button. The original comment is dimmed, which 

allows collaborators to still read it. And, if further issues arise, click the Reopen 

button­(which­still­ looks­like­the­one­shown­in­the­margin)­to­continue­adding­
comments.

FIGURE 26-1: 
Comments on a 

text passage.
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When you’re collaborating online, the jerk who originally made the comment is 

informed of your reply or resolution. Otherwise, they must review the document 

personally to have their egos crushed.

Showing or hiding comments

The­markup­area­(to­the­right­of­the­text)­appears­whenever­a­document­features­
comments. To hide this area, click the Review tab. In the Tracking group, click the 

Display for Review button, shown in the margin. The four available options set 

how comments, as well as other document revisions (covered elsewhere in this 

chapter),­are­displayed:

Simple Markup: Choose this item to display markup items as lines on the left side 
of the document and to display comments as cartoon bubble icons on the right.

All Markup: Choose this item to display the full markup area, where all comments 
and revisions are shown.

No Markup: Choose this item to hide the markup area. Comments don’t appear, 
and any revisions are hidden in the text.

Original: Choose this item to hide the markup area as well as any revisions made 
to the document. With regard to comments, this item is identical to No Markup.

The default display mode for comments is All Markup. In this mode, comments 

appear as cartoon bubbles in the document’s right margin, as shown in this book’s 

left margin. Click the bubble to view the comment.

 » To view all comments, no matter which document view is chosen, summon 
the Reviewing pane: On the Review tab, in the Tracking group, click the 
Reviewing Pane button. Choose either the horizontal or vertical display to 
summon the Reviewing pane and peruse comments as well as text revisions.

 » See the later section “Tracking changes as they’re made,” for information on 
revisions.

Perusing comments one at a time

To gain an idea of how commenting goes, don’t just randomly scroll the docu-

ment,­trying­to­find­the­next­gripe­or­compliment.­Instead,­use­the­Next­Comment­
and Previous Comment buttons. These buttons are found on the Review tab, in the 

Comments group.
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Click­the­Next­Comment­button­to­jump­to­the­next­comment­in­the­document.

Click the Previous Comment button to jump to the previous comment in the 

document.

Clicking­ either­ the­ Next­ Comment­ or­ Previous­ Comment­ button­ activates­ All­
Markup view, as covered in the preceding section.

Printing comments (or not)

Yes, it’s horrible, but comments print with the document. This output probably 

isn’t what you intended, so follow these steps:

1. Press Ctrl+P.

The Print screen appears.

2. Click the Print All Pages button.

A menu appears.

3. Remove the check mark by the Print Markup menu item.

This setting controls whether comments, as well as other text markup covered 
in this chapter, print. Removing the check mark suppresses comments in the 
output.

Check the print preview to confirm that the comments and other markup are 
gone.

4. Click the big Print button to print the document.

You must follow these steps every time you print the document; otherwise, the 

comments print.

See­Chapter 9­for­more­information­on­printing­documents­in­Word.

Deleting comments

Not­only­is­the­comment’s­issue­resolved,­but­neither­do­you­want­to­be­reminded­
of the comment ever again. Work these steps:

1. Click the Review tab.

2. Click the Next Comment or Previous Comment button to locate the 

offending comment.

Upon success, the comment is highlighted in the markup area.
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3. In the Comments area, choose Delete ➪   Delete.

The Delete button is shown in the margin. It’s one of those menu button 
icon-things that you must click to access the commands.

4. Repeat Steps 2 and 3 to remove additional comments.

Or, just repeat Step 2 until you find a comment worthy of obliteration.

To delete all comments from a document in a single act of massive retaliation, use 

the Delete Comment button’s menu: Choose Delete ➪   Delete All Comments in 

Document.

The Yellow Highlighter

Word comes with a digital pen that lets you highlight and colorize the text in a 

document without damaging the computer’s monitor. To highlight text, abide by 

these steps:

1. Click the Home tab.

2. In the Font group, click the Text Highlight button.

The mouse pointer changes to a — well, I don’t know what it is, but the point is 
that Word is now in Highlighting mode.

3. Drag the mouse over the text you want to highlight.

The text becomes highlighted — just as though you used a highlighter on 
regular paper but minus the felt pen smell.

4. Click the Text Highlight button again to return the mouse to normal 

operation.

Or, press the Esc key to exit Highlighting mode.

The highlight need not be yellow. Click the menu chevron to the right of the Text 

Highlight­button,­and­choose­a­different­highlighter­color­from­the­palette­that’s­
displayed.

To remove highlighting from the text, highlight it again in the same color or 

choose­None­as­the­highlight­color.

 » To highlight multiple chunks of text, double-click the Text Highlight button. 
The mouse pointer stays in Highlighting mode until you click the Text Highlight 
button again or press the Esc key.
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 » To highlight a block of text, mark the block and then click the Highlight button 
that appears on the mini toolbar.

 » Highlighting isn’t the background color, nor is it a text format. See Chapter 10 
for information on setting the text background color.

Look What They’ve Done to My Text, Ma

All good writers should enjoy feedback. Still, I’d like to know what’s been done to 

my­text,­to­not­only­see­the­effect­but­also­learn­something.­Word’s­revision­track-

ing tools make such a review possible.

Comparing two versions of a document

You­have­the­original­copy­of­your­document —­the­stuff­you­wrote.­You­also­have­
the copy that Brianne, the soulless automaton from the legal department, has 

worked over. Your job is to compare them to see exactly what’s been changed from 

the original. Here’s what to do:

1. Click the Review tab.

2. In the Compare group, choose Compare ➪   Compare.

The Compare Documents dialog box shows up.

3. Choose the original document from the Original Document  

drop-down list.

The list shows recently opened or saved documents. Choose one, or use the 
Browse item to summon the Open dialog box and hunt down the document.

4. Choose the edited document from the Revised Document drop-down list.

Choose the document from the list, or use the Browse item to locate the 
changed, altered, or mangled document.

5. Click OK.

Word compares the two documents. The changes are displayed in a quadruple-

split­window,­as­illustrated­in­Figure 26-2.­This­presentation­is­actually­a­third­
document, titled Compare Result.
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Look it over! Peruse the changes made to your pristine prose by the barbarian 

interlopers: Scrolling is synchronized between all three documents: original, 

edited, and compared. Click a change in the Reviewing pane (shown on the left in 

Figure 26-2)­to­quickly­see­which­part­of­your­document­was­folded,­spindled,­or­
mutilated.

 » Changed text is highlighted in two ways: Added text is underlined. Removed 
text is shown in strikethrough style.

 » You can confirm or reject the changes in the Compare Result document, just 
as you would when tracking changes manually. See the upcoming section 
“Reviewing changes.”

Tracking changes as they’re made

To be a kind and gentle collaborator, activate Word’s Tracking feature before you 

make changes to someone else’s text: Click the Review tab, and in the Tracking 

group, click the Track Changes button, shown in the margin. From this point on, 

FIGURE 26-2: 
The shameful 

changes show  

up here.
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any changes made to the document are color coded based on who is making the 

changes and what level of markup is displayed:

 » For Simple Markup, a color-coded bar appears to the left of a paragraph, 
indicating that a change was made.

 » For All Markup, new text is color coded, depending on who made the changes. 
Added text appears underlined, and deleted text appears as strikethrough. 
These text highlights are called revision marks. These are not text formatting 

attributes.

 » For No Markup, the changes are tracked but not displayed in the document. 
Choosing this option is a useful method for making changes in a less distract-
ing manner. (The revision marks are revealed by choosing All Markup instead 
of No Markup.)

Refer to the earlier section “Showing or hiding comments,” for information on 

the­Simple­Markup,­All­Markup,­and­No­Markup­settings.

Word­ continues­ to­ track­ changes­ and­ edits­ in­ the­document­until­ you­ turn­off­
Track Changes. To do so, click the Track Changes button again.

Although the Track Changes button appears highlighted while the feature is 

active,­a­better­way­to­check —­and­use —­this­feature­is­to­activate­the­Track­Set-
tings option on the status bar. To set this option, right-click the status bar and 

choose Track Changes. As a bonus, you can click this item on the status bar to 

activate or deactivate revision marks in the document.

Reviewing changes

After your poor, bruised document is returned to you, the best way to review the 

damage­inflicted­is­to­use­the­commands­on­the­Review­tab,­located­in­the­Changes­
group.­These­commands­are­illustrated­in­Figure 26-3;­depending­on­the­window­
size, you may not see text explaining what each one does.

FIGURE 26-3: 
Buttons for 

reviewing 
changes.
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To­review­changes­throughout­the­document,­click­the­Next­or­Previous­buttons.­
Click a button to hop from one change in the text to the next change.

It’s best to choose the All Markup command from the Display for Review menu 

button to see the changes in your document. Then proceed:

 » Click the Accept button when you tolerate the change.

 » Click the Reject button to remove the change, restoring your original text.

After clicking either button, you instantly see the next change in the document, 

until all the changes are dealt with.

The Accept and Reject buttons host menus with commands that accept or reject all 

changes in a document in one fell swoop. The only thing missing is the “swoop!” 

sound when you use these commands.

Be careful! You can easily get confused when reviewing changes. For example, 

rejecting a deletion restores the text. Carefully peruse each choice as you review 

the document. Remember that Ctrl+Z can undo the Accept or Reject commands.

Collaborate on the Internet

Most document changes are made sequentially: You write something, save, and 

then someone else works on the document. If this chaos isn’t enough for you, 

Word allows you to invite people to edit a document while you’re working on it. 

This collaboration feature is called Sharing, probably because a better name  

wasn’t available or Microsoft was pressed for time.

To make document sharing work, save your document to the cloud, or Internet 

storage. For example, the document can be saved to Microsoft’s OneDrive storage. 

See­Chapter 8­for­details­about­OneDrive.

Sharing a document

After saving a document to OneDrive online storage, follow these steps to make 

the document available for collaboration:

1. Click the Share button.

The Share button is shown in the margin. Locate it above the Ribbon, near the 
upper right part of the document’s window.
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Upon success, the Share pane appears. Upon failure, you see a prompt asking 
you to save the document to OneDrive.

2. Type an email address to invite a collaborator.

If you use Outlook as your computer’s address book, click the Address Book 
icon to the right of the Invite People box to automatically add people.

3. Choose whether the collaborators can edit.

Choose Can View from the menu, and the people you invite can read the 
document. Choose Can Edit, and they can make changes.

4. Type a message in the Include a Message box.

5. Click the Share button.

The invites are sent.

Eventually, the recipients receive the email invite. To access the shared document, 

they click the link in the email address. Their web browser program opens and 

displays the document. If they want to edit the document, they click the Edit in 

Browser link. At that point, their web browser displays the document as it appears 

in Word, complete with a customized version of the Ribbon. Hack away.

Checking updates

To determine whether someone has edited your shared document, open the shared 

document and click the Share button, found near the upper right corner of the 

document window. The Share pane lists all collaborators and whether they’re cur-

rently editing. Collaborators who are currently editing show avatar icons to the 

left of the Share icon atop the document window. If they’re actively editing, you 

see a color-coded insertion pointer appear in the document, showing where the 

collaborator is working.

If collaborators have changed the document, save your copy to view updates: Click 

the Save icon on the Quick Access toolbar, or press Ctrl+S. Any­changed­content­
appears in the document with a colored overlay, similar to how revision marks are 

displayed, as covered earlier in this chapter.

To check to see whether updates are pending, click the File tab, and on the Info 

screen, look for and click the button titled Document Updates Available.
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Chapter 27

Mail Merge Mania

H
ere’s a little quiz: What do these things have in common? Rocket science. 
Quantum mechanics. Brain surgery. Levitation. The answer: They’re all a 
lot easier to accomplish than attempting mail merge in Word.

It’s not that mastering mail merge is impossible. True, it’s an ancient word pro-
cessing­tradition —­something­that­just­about­everyone­toys­with­at­one­time­or­
another. Yet the way Word handles mail merge is frustrating if you’re a normal 
person. That’s why I wrote this chapter.

As you might come to expect by now, the mail merge feature isn’t available in the 
online version of Microsoft Word.

About Mail Merge

The term mail merge is given to the process of opening a single document, stirring 
in a list of names and other information, and then combining (merging) every-
thing. The result is a sheaf of personalized documents. Sounds useful, right? 
Peruse this section before attempting the process on your own.

IN THIS CHAPTER

 » Understanding mail merge

 » Building the main document

 » Conjuring up a recipient list

 » Making a recipient list

 » Inserting fields into the main 
document

 » Previewing the results

 » Merging (the final act)
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Understanding Word’s mail merge jargon

Like me, you probably have your own delightful, descriptive terms for the steps 
required­and­pieces­necessary­to­complete­a­mail­merge.­Word’s­terms­are­differ-
ent. Before taking the mail merge plunge, I recommend that you review the fol-
lowing­jargon:

Main document:­This­document­is­just­like­any­other­document­in­Word,­complete­
with­formatting,­ layout,­and­all­ the­fancy­stuff­that­goes­ into­a­document.­The­
document­also­contains­various­fill-in-the-blanks­items,­which­is­what­makes­it­
the main document.

Recipient list: This list contains the information that creates the customized doc-
uments. It’s a type of database,­with­rows­and­columns­of­information­used­to­fill­
in the form letters.

Field:­Each­of­these­fill-in-the-blanks­items­inside­the­main­document­is­a­place-
holder­that’s­filled­in­by­information­from­the­recipient­list.­Fields­are­what­make­
the mail merge possible.

Persuading these three elements to work together is the essence of mail merge. All 
the commands necessary are located on the Mailings tab. In fact, the Mailings 
tab’s­five­groups­are­organized­from­left­to­right­in­the­order­you­use­them­in­the­
mail merge process. The remainder of this chapter describes the details.

 » The key to mail-merging is the recipient list. If you plan to create a mail merge 

as part of your regular routine, build a recipient list that you can use again 

and again.

 » A mail merge document can have as many fields as it needs. These are the 
parts of the document that change in the output. In fact, any item you want to 

change can be a field: the greeting, a banal pleasantry, gossip — whatever.

 » Fields are also known as merge fields.

 » You can use information from the Outlook program, also a part of Microsoft 

OfÏce, as a recipient list for a mail merge in Word. This trick works best, 
however, when you’re in a workplace environment that features Microsoft 

Exchange Server. Otherwise, making Outlook and Word cooperate is a 
frustrating endeavor.
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Reviewing the mail merge process

The­ typical­mail­merge­ involves­five­ steps.­ These­ steps­ are­ presented­ in­more­
detail throughout this chapter:

I. Build the main document.

Choose the document type — usually, a letter, though other document types 
are listed in the nearby sidebar, “Mail merge document types.” As you create 

the document, you decide which fields are needed. This way, you can build an 
effective recipient list.

II. Create the recipient list — the data for the mail merge.

The recipient list is a table, consisting of rows and columns. Each column is a 

field containing information to go into the fill-in-the-blanks parts of the main 
document. Each row represents data for each different custom document 
created by the mail merge process.

III. Insert fields into the main document.

The fields are placeholders for information that’s eventually supplied from the 
recipient list.

MAIL MERGE DOCUMENT TYPES

In addition to a form letter, the main document in a mail merge can be an email mes-

sage, envelopes, a set of labels, or anything else that can be mass-produced. Here are 

the ofÏcial Word mail merge document types:

Letter: The traditional mail merge document is a letter, a document in Word.

Email messages: Word can produce customized email messages, which are sent elec-

tronically rather than printed.

Envelopes: You can use mail merge to create a batch of customized envelopes, each 
printed with its own address.

Labels: Word lets you print sheets of labels, each of which is customized with specific 
information from the mail merge. See Chapter 28 for specifics.

Directory: A directory is a list of information, such as a catalog or an address book.
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IV. Preview the merge results.

You don’t just merge — first, you must preview how the document looks. This 
step helps you clean up any formatting, check for errors, and make other 

corrections.

V. Merge the information from the recipient list into the main document.

The final mail merge process creates the customized documents. They can 
then be saved, printed, emailed, or dealt with however you like.

Mail merge involves coordination between multiple documents and various Win-
dows technologies. When you open a mail merge document that you’ve already 
created, you may see an alert dialog box. You’re informed that opening the docu-
ment also runs an SLQ command. This command is what links the recipient list to 
the main document. Click Yes to proceed.

Using the Mail Merge Wizard

If­all­this­mail­merge­malarkey­is­just­too­intense­for­you,­consider­an­alternative:­
Word­offers­the­Mail­Merge­Wizard,­which­guides­you­through­the­entire­ordeal,­
one step at a time.

To run the wizard, click the Mailings tab and choose Start Mail Merge ➪   Step-by-Step 
Mail Merge Wizard. You see the Mail Merge pane on the right side of the document’s 
window. Answer the questions, choose options, and click the Next link to proceed.

The rest of this chapter assumes that you’re brave enough to do mail merge the 
macho way.

I. The Main Document
Mail merge begins with the main document. It’s the prototype for all the individu-
alized documents you eventually create, so it contains only common elements.

The­following­sections­discuss­different­types­of­main­documents.­Read­the­sec-
tion that relates to the type of mail merge you’re attempting, and then proceed 
with­the­later­section­“II. The­Recipient­List.”

Creating a mail merge form letter

The most common thing to mail merge is the standard, annoying form letter. 
Here’s­how­you­start­that­journey:
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1. Start a new, blank document.

Press Ctrl+N.

2. Click the Mailings tab.

3. In the Start Mail Merge group, choose Start Mail Merge ➪   Letters.

4. Type the letter.

You type only the common parts of the letter, the text that doesn’t change for 

each copy.

5. Type the fields you need in ALL CAPS.

This step is my idea, not Word’s. For text that changes for each letter, type in 
ALL CAPS — for example, FIRST NAME or HAT SIZE. Use short, descriptive 
terms. Figure 27-1 shows an example.

6. Save the main document.

If you already saved the document as you were writing it, give yourself a treat.

FIGURE 27-1: 
A mail merge 

main document.
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After you create the letter, the next step is to create or use a recipient list. Con-
tinue­with­the­section­“II. The­Recipient­List,”­a­little­later­in­this­chapter.

Creating mail merge email messages

To spew out custom email messages, use Word’s E-Mail option for mail merge. 
This­option­works­only­when­you­configure­ the­Microsoft­Outlook­program­on­
your computer. After doing so, obey these steps to start the main document for 
your email merge:

1. Press Ctrl+N to create a fresh document.

2. On the Mailings tab, choose Start Mail Merge ➪   E-Mail Messages.

Word changes to Web Layout view, used for creating Internet documents in 
Word.

3. Create your mail message.

4. If you anticipate inserting fields in the message, type them in ALL CAPS.

An email mail merge isn’t required to have fields in the document. Instead, 
email addresses are used to send out multiple copies of the message. If you 

plan to add fields, refer to Step 5 in the preceding section.

5. Save the document.

The­primary­field­you­use­when­merging­an­email­document­ is­ the­ recipient’s­
email address. You can’t email-merge without it. Continue your mail merge 
adventure­in­the­later­section­“II. The­Recipient­List.”

Creating mail merge envelopes

To create a stack of mail merge envelopes, which is far classier than using  
peel-and-stick mailing labels, abide by these steps:

1. Start a new document.

2. On the Mailings tab, choose Start Mail Merge ➪   Envelopes.

The Envelope Options dialog box appears. You can set the envelope size and 
font options, if necessary.

3. Click OK.

Word’s window changes to reflect a typical envelope, a size specified in the 
Envelope Options dialog box (from Step 2).
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4. Edit or create the return address.

If you desire a return address and one isn’t added automatically, type it in.

Press Shift+Enter to place a soft return at the end of a line in the return 

address. The soft return keeps the lines in the return address tightly together.

5. Save the envelope.

That’s pretty much it for a mail merge envelope. Not readily visible in the enve-
lope­document­is­a­large­text­box­(lower­center).­This­location­is­where­fields­for­
the recipient’s name are inserted.

Your next task is to use the recipient list to gather the information for your mail-
ing. Keep reading in the next section.

II. The Recipient List

To make mail merge work, you need a list of items to merge, rows and columns, 
as in a database. This information, called the recipient list,­contains­the­field­data­
used to build the individual documents, email messages, envelopes, and other 
items.

Your options include creating a new recipient list, reusing an existing list, and 
pulling­in­information­from­the­Outlook­program.

Building a new recipient list

I don’t mind writing a mail merge main document. I do mind building the recipi-
ent list. It’s time-consuming, data-input drudgery. Still, it beats creating multi-
ple individual documents, which is the point of a mail merge.

Here are the steps involved to build a recipient list:

1. Create the new list.

2. Edit fields.

3. Type in the recipient data.

The­last­step­is­the­most­time-consuming.­If­you’re­an­intern­at­a­major­organiza-
tion, Step 3 is why you were given the mail merge task.
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Create the new recipient list

Before you can create a new recipient list, you must have created and saved the 
main­document.­Specific­steps­are­provided­ in­ the­earlier­ section­“I. The­Main­
Document.”­ Creating­ the­ recipient­ list­works­ the­ same,­ no­matter­which­mail­
merge­document­type­you­created.­Follow­these­steps:

1. Click the Mailings tab.

2. In the Start Mail Merge group, choose the Select Recipients ➪   Type a New 
List command.

You see the New Address List dialog box.

Edit the fields
The­New­Address­List­dialog­box­comes­stocked­with­fields,­which­you­see­march-
ing­atop­the­dialog­box­(Title,­First­Name,­Last­Name,­and­so­on).­If­you­can­use­
these,­great!­Otherwise,­remove­those­you­don’t­need.­Follow­these­steps:

1. Click the Customize Columns button.

The Customize Address List dialog box appears, displaying fields that Word 
assumes you need. Such foolishness cannot be tolerated.

2. Click to select a field that you do not need.

When you’re merging an email message, you need the E-Mail Address field, 
whether it appears in the message body or not. Word uses this field so that it 
knows where to send the message. Don’t delete the E-Mail Address field!

3. Click the Delete button.

4. Click Yes in the confirmation dialog box.

The keyboard shortcut for the Yes button is the Y key.

5. Repeat Steps 2–4 for each field you don’t need.

Yes, it’s tedious, but it makes building the list easier.

After removing the fields you don’t need, add those that you do. The clues to 
which fields you need are found in the main document. Specifically, use the 
ALL CAPS text you added as placeholders. You need a field in the recipient list 
for each of these ALL CAPS items.

Continue editing the fields, by adding those you need.

6. In the Customize Address List dialog box, click the Add button.

The teeny Add Field dialog box pops into view.
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7. Type the field name and click the OK button.

Follow these rules for naming a field:

• No two fields can have the same name, though you can reuse fields in the 
main document.

• Field names can contain spaces but cannot start with a space.

• Field names can be quite long, though shorter is best.

• The following characters are forbidden in a field name: . ! ` [ ].

8. Repeat Steps 6 and 7 for each new field you need in the main document.

The list of fields should match with the list of ALL CAPS text in the main 
document (if you chose to create them). Don’t worry if it doesn’t — you can add 
fields later, though it takes more time.

9. Click OK.

Your customized fields now appear as column headings in the New Address 
List dialog box.

Rather­than­delete­fields­you­don’t­need,­you­can­rename­them:­Select­a­field­and­
click­the­Rename­button.­For­example,­I­renamed­First Name to First; Last Name to 
Last; and so on.

Add recipient data

After­customizing­the­fields,­your­final­job­is­to­fill­in­the­recipient­list.­You­need­
to input records, one for each document you plan to create. Perform these steps in 
the New Address List dialog box:

1. Type the first record’s data.

Type the information that’s appropriate to each field: name, title, evil nickname, 
planet of origin, and so on.

2. Press Tab to move to the next field.

After filling in the last field, you’ll probably want to add another record:

3. To add a new record, press the Tab key after typing in the last field.

When you press the Tab key in the last field in a record, a new record is 
automatically created and added on the next line. Keep filling in data!

4. Review your work when you’re done.

Figure 27-2 shows a completed recipient list.

To edit any field, click to select it.
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If you accidentally add a blank record at the end of the list, click to select it and 

then click the Delete Entry button. You do this because blank records are still 

processed in a mail merge, which results in wasted paper.

5. Click OK.

The Save Address List dialog box pops up, allowing you to save the  

recipient list.

The recipient lists dwell in the folder named My Data Sources, found in the 

Documents or My Documents folder. Word automatically chooses (or creates) 
this folder.

6. Type a name for the address list.

Descriptive names are best. After all, you might use the same recipient list 

again.

7. Click the Save button.

You return to the main document.

The­next­step­in­the­mail­merge­agony­is­to­stir­the­fields­from­the­recipient­list­
into­the­main­document.­Refer­to­the­section­“III. Fold­In­the­Fields,”­later­in­this­
chapter.

FIGURE 27-2: 
Making a 

recipient list.
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Using an already-created recipient list
To use an existing recipient list for your mail merge, follow these steps after cre-
ating the main document:

1. From the Mailings tab, choose Select Recipients ➪   Use an Existing List.

The Select Data Source dialog box appears. It works like the Open dialog box, 

though it’s designed to display recipient lists that Word can use or that you 
previously created and saved.

Look for recipient lists in the My Documents folder, in the My Data Sources 

subfolder.

2. Choose an existing recipient list from the displayed files.

I hope you used a descriptive name when you first saved the recipient list, 
which I recommend in the preceding section.

3. Click the Open button.

That’s it: The recipient list is now associated with the main document.

Refer­ to­ the­ later­ section­“III. Fold­ In­ the­Fields”­ for­ information­on­ inserting­
fields­into­your­document,­which­is­the­next­step­in­the­mail­merge­nightmare.

You can tell when a recipient list is associated with the main document because 
the­Insert­Merge­Field­button­is­available.­Look­on­the­Mailings­tab­in­the­Write­&­
Insert­Fields­group­for­this­button.

Grabbing a recipient list from Outlook

If­you­use­Microsoft­Outlook­and,­further,­you­have­access­to­Exchange­Server,­you­
can follow these steps to create a recipient list:

1. On the Mailings tab, in the Start Mail Merge group, choose Select 

Recipients ➪   Choose from Outlook Contacts.

2. If necessary, select your profile from the Choose Profile dialog box.

3. Click OK.

4. In the Select Contacts dialog box, choose a contact folder.

Contact folders are created in Outlook, not in Word.

5. Click OK.
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6. Use the Mail Merge Recipients dialog box to filter the recipient list.

If the list isn’t too long, remove the check marks by the names of the individu-

als you don’t want in the list. You can also click the Filter link in the dialog box 

to do more advanced filtering, which I’m loath to describe right now.

7. Click OK when you’re done culling the recipient list.

Editing a recipient list

If you were sloppy when you created the recipient list, or new information has 
been acquired, you may need to edit the list. Heed these directions:

1. On the Mailing tab, in the Start Mail Merge group, click the Edit Recipient 

List button.

The button isn’t available unless you’re working on a main document and it has 

been associated with a recipient list: Click the Select Recipients button and 
choose Use an Existing List.

2. Select the data source.

In the lower left corner of the Mail Merge Recipients dialog box, click the data 

source filename.

3. Click the Edit button.

You can now use the Edit Data Source dialog box to edit each record in the 

recipient list, to add or remove fields, and to perform other chaos:

• Click the Delete button to remove the current record.

• Click the Add New button to create a new record.

• Click the Customize Columns button to add or remove fields.

4. Click the OK button when you’re done editing; click Yes if you’re 

prompted to update the list.

5. Click the OK button to dismiss the Mail Merge Recipients dialog box.

This­process­may­not­be­without­its­hiccups.­The­file­may­be­“in­use”­or­unavail-
able to edit. You may be prompted to save the recipient list before editing.
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III. Fold In the Fields

Now that you have the main document and the recipient list ready to go, you must 
replace your silly ALL CAPS placeholders in the document with the actual mail 
merge­fields.­Obey­these­directions:

1. Position the mouse pointer where you want the field to appear in the 
main document.

If you followed my advice from the earlier section “Creating a mail merge form 

letter,” select a placeholder, such as FIRST NAME.

2. On the Mailings tab, click the Insert Merge Field button.

When the Insert Merge Field button isn’t available, a recipient list isn’t associ-
ated with the document. See the earlier section “II. The Recipient List.”

3. Choose the field to add to the main document.

For example, to replace the FIRST NAME placeholder, choose the First Name 

field to stick it into the document.

After the field is inserted, you see its name hugged by angle brackets, like this:

«First_Name»

If the field doesn’t look like this, press Alt+F9 to toggle the field codes from the 
raw format to the angle bracket presentation.

4. Repeat Steps 1–3 to add fields to the document.

When adding fields to an address, press Shift+Enter to end each line.

5. Save the main document.

Always save! Save! Save! Save!

The­next­step­in­your­journey­is­to­preview­the­results­and­fix­any­mistakes.­Keep­
reading and continue with the next section.

IV. Preview the Merged Documents

Rather­than­just­plow­ahead­with­the­merge,­take­advantage­of­the­buttons­in­the­
Mailing tab’s Preview Results group. This way, you can peruse the merged docu-
ments without wasting a lot of paper.
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To preview, click the Mailings tab, and in the Preview Results group, click the 
Preview­Results­button,­shown­in­the­margin.­The­fields­in­the­main­document­
vanish!­They’re­replaced­by­information­from­the­first­record­in­the­recipient­list.­
What­you­ see­on­ the­ screen­ is­how­ the­first­ customized­mail­merge­document­
appears.­I­hope­everything­looks­spiffy.

Use the left and right triangles in the Preview Results group to page through each 
document. As you page, look for these problems:

 » Formatting mistakes, such as text that obviously looks pasted in or not part of 

the surrounding text

 » Punctuation errors and missing commas or periods

 » Missing spaces between or around fields

 » Double fields or unwanted fields, which happen when you believe that you’ve 
deleted a field but haven’t

 » Awkward text layouts, strange line breaks, or margins caused by missing or 

long fields

To­fix­any­boo-boos,­leave­Preview­mode:­Click­the­Preview­Results­button­again.­
Edit the main document to correct the mistakes. Then repeat the preview process.

Once­everything­looks­up­to­par,­you’re­ready­to­perform­the­merge,­covered­in­the­
next section.

V. Mail Merge, Ho!
The­final­step­in­the­mail­merge­ordeal­is­to­create­personalized­documents.­The­
gizmo­that­handles­this­task­is­the­Finish­&­Merge­command­button­(shown­in­the­
margin),­which­is­the­sole­item­in­the­Finish­group­on­the­Mailings­tab.­This­sec-
tion describes how to use this button to complete the mail merge.

Merging to a new set of documents

When you want to save merged documents and print them, follow these steps:

1. Choose Finish & Merge ➪   Edit Individual Documents.

The Merge to New Document dialog box appears.

2. Ensure that the All option is selected.
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3. Click OK.

Word creates a new document — a huge one that contains all merged 
documents, one after the other. Each document copy is separated by a Next 

Page section break. (See Chapter 14 for more information on section breaks.)

4. Save the document.

At this point, you can print the document, close it and edit it later, or do anything 
else you like.

Merging to the printer

The most common destination for merged documents is the printer. Here’s how it 
works:

1. Choose Finish & Merge ➪   Print Documents.

A dialog box appears, from which you can choose records to print.

2. Choose All from the Merge to Printer dialog box to print the entire 
document.

Or, specify which records to print.

3. Click OK.

The traditional Print dialog box appears.

4. Click the OK button to print your documents.

5. Save and close the main document.

See­Chapter 9­for­more­information­on­printing­documents­in­Word.

When merging and printing envelopes, use the printer’s envelope slot or its spe-
cial feeding mechanism to supply it with envelopes. You may have to monitor the 
printer to insert the envelopes, which has to do with how your printer eats 
envelopes.

Merging to email

To send out multiple email messages, abide by these steps:

1. Choose Finish & Merge ➪   Send Email Messages.

The Merge to E-Mail dialog box appears.
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2. Choose the email address field from the To drop-down list.

Your document’s recipient list must include an email address field, though the 
field need not appear within the document. If the recipient list doesn’t contain 
the email address field, go back and edit it to include the email address field.

3. Type a message subject line.

4. Fill in any other fields in the Merge to E-Mail dialog box.

5. Click OK.

It looks like nothing has happened, but the messages have been placed in the 

Outlook outbox.

6. Open Outlook.

After you open Outlook, the queued messages are sent, or they sit ready to be 

sent when you give the command. (Whether the messages are sent right away 
depends on how you configured Outlook.)

Yes,­this­trick­works­only­with­Outlook,­not­with­any­other­email­programs.

Unsolicited email is considered spam. Sending spam may violate the terms of your 
Internet service provider’s or email service agreement, and they can terminate 
your account. Send mass email only to people who have cheerfully agreed to 
receive such things from you.
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Chapter 28

Labels and Envelopes

S
tretching the notion of what a word processor is capable of doing, Word 

features commands that let you print labels and envelopes. After all, a sheet 

of labels or an envelope is simply a document printed on a special type of 

paper.­Rather­than­conjure­a­hack­to­perform­the­task,­Word­offers­ready-made­
label-­and­envelope-creation­and­printing­commands.

Labels Everywhere

Word’s label powers include printing sheets of identical labels or creating individ-
ual labels for a mass mailing. This feat is possible because the labels, at their core, 

are merely cells in a table. The table matches the label printing stock, where each 

cell in the document’s table lines up perfectly with the sticky label. The result is a 

sheet of labels popping out of the printer.

Obviously, to print a sheet of labels requires that you have handy a blank sheet of 

sticky­labels.­These­can­be­found­wherever­ofÏce­supplies­are­sold.­It’s­important­
to­obtain­these­labels­first,­because­to­print­on­the­labels­requires­that­you­inform­
Word of the label manufacturer and paper stock number.

IN THIS CHAPTER

 » Printing a sheet of identical labels

 » Merging an address list onto mail 

labels

 » Printing a single envelope



330      PART 5  The Rest of Word

Printing sheets of identical labels

It­might­seem­impractical­to­print­a­sheet­of­identical­labels,­yet­I­use­such­a­sheet­
for­my­return­address.­This­peel-and-stick­trick­is­convenient­for­other­types­of­
labels as well. Word deftly handles the chore. Follow these steps:

1. Click the Mailings tab.

2. In the Create group, click the Labels button.

The Envelopes and Labels dialog box appears, with the Labels tab ready for 

action, as shown in Figure 28-1.

3. In the Address box, type the text you want printed on the label.

Press the Enter key at the end of each line. The paragraph format is 
single-spaced.

You can apply some simple formatting at this stage: Ctrl+B for bold, Ctrl+I for 

italic, or Ctrl+U for underline, for example. If you right-click in the Address box, 
you can choose Font or Paragraph from the pop-up menu to further format 
the label.

4. Click the Full Page of the Same Label radio button.

5. To choose a new label type, click in the Label area.

The Label Options dialog box appears.

FIGURE 28-1: 
The Labels side of 

the Envelopes 

and Labels 

dialog box.
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6. Choose a label vendor.

For some reason, Microsoft is chosen as the default, which is weird because 
I’ve never seen Microsoft-branded labels in any ofÏce supply store. Instead, 
choose Avery, which is the category leader. Most other label manufacturers 
use Avery’s numbering system anyway.

7. Choose the proper stock number.

For example, Avery US Letter 5960 (refer to Figure 28-1) is the standard 
address sticky label most folks use.

8. Click the New Document button.

By placing the labels in a new document, you can further edit them, if you like. 
Plus, you can save the document for use (and printing) later.

9. Print the labels.

Ensure that the sheet of label paper is loaded into the printer, proper side up. 
Use the Ctrl+P command to print the labels as you do for any document. See 
Chapter 9 for details on printing in Word.

On­my­PC,­I­have­a­folder­full­of­label­documents­I­print­from­time­to­time.­For­
example,­one­document­holds­my­return­address,­one­is­for­the­IRS,­and­another­
has my lawyer’s address. They all come in quite handy.

Printing an address list

To­print­a­sheet­of­different­labels,­such­as­an­address­list,­you­encroach­upon­the­
terrifying­territory­of­mail­merge.­This­topic­is­covered­in­Chapter 27,­so­refer­to­
that­chapter­for­specific­information.­This­section­deals­with­printing­one­or­more­
sheets­of­different­labels.

Before­ getting­ started,­ you­ must­ have­ available­ a­ recipient­ list­ file.­ Refer­ to­
­Chapter 27­for­information­on­creating­a­recipient­list.­If­you’re­fortunate­enough­
to use the Outlook program as your digital address book, you can use it instead.

To print a list of names on a sheet of labels, follow these steps:

1. Start a new document in Word.

2. Click the Mailings tab.

All commands and buttons mentioned in the remaining steps are found on the 
Mailings tab.

3. Click the Start Mail Merge button, and from the menu, choose Labels.

The Label Options dialog box appears.
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4. Choose the label vendor and product number representing the sheet of 

labels on which you’re printing.

For example, to print on a sheet of standard Avery address labels, use Avery 
catalog number 5160.

5. Click OK.

Word builds a table in the document, one with cells perfectly aligned to match 
the labels on the sheet you selected. (The gridlines may be hidden, but the 
table is still there.)

Do not edit or format the table! It’s perfect.

6. Click the Select Recipients button and choose Use an Existing List.

7. Use the Select Data Source dialog box to choose the list.

8. Click Open.

The document is updated with all cells filled in except the first. The remaining 
cells feature the field titled «Next Record». Your job is to create the first record, 
which sets the pattern for all labels.

The mouse pointer should be blinking in the first cell. If not, click that cell.

9. Click the Insert Merge Field button.

10. Choose a field to place into the document.

For example, choose the First Name field to set the placeholder for the label’s 
first name.

11. Repeat Steps 9 and 10 to continue adding fields.

Don’t worry about it looking messy; you can edit the field’s layout later.

12. Format the first label.

Add spaces between the fields to separate them. Press Shift+Enter to create 

multiple lines. Add a comma between the city and state.

When you finish adding fields, the document should look similar to the one 
shown in Figure 28-2.

13. In the Write & Insert Fields group, click the Update Labels button.

Word populates the remaining cells in the table with the same fields and text 
placed into the first cell.

If you make a mistake, press Ctrl+Z to undo. Fix the first cell. Repeat Step 13.

14. Ensure that the proper label sheet is in the printer.

And that you have enough of them.
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15. Click the Finish & Merge button and choose Print Documents.

16. Ensure that the All radio button is chosen in the Merge to Printer 

dialog box.

17. Click the OK button.

The traditional Print dialog box appears. Ensure that you have enough of the 
proper label paper in the printer and that the labels are correctly oriented.

18. Click the OK button in the Print dialog box.

The address labels print.

I­ recommend­saving­ the­document­when­you’re­done.­This­way,­you­can­more­
easily perform the merge again or use the same document again to print a fresh 

batch of labels.

Instant Envelope

Suddenly­you­need­an­envelope!­Don’t­revert­to­using­your­fist­to­scribble­text­on­
that­envelope,­and­please­don’t­dust­off­that­ typewriter.­Yeeks.­ Join­ the­digital­
realm and let Word do the task for you. Obey these steps:

1. Click the Mailings tab.

2. Click the Envelopes button.

The Envelopes and Labels dialog box appears, with the Envelopes tab forward, 

as shown in Figure 28-3.

FIGURE 28-2: 
The first label 
dictates how 

other labels are 

formatted.
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3. Type the recipient’s address in the Delivery Address box.

Press Enter to separate the lines in the address. Word stacks each line atop the 
other, so don’t fret over weird line spacing on the envelope.

If you use Outlook as your computer’s address book, click the Address Book 
button to fetch the delivery address info.

4. Ensure that an envelope is queued in the printer and ready to print.

Most printers prompt you to manually enter envelopes. A guide on the 
printer’s manual feed mechanism describes how to orient and insert the 
envelope.

5. Ensure that the way the envelope feeds into the printer matches the 

Feed item in the Envelopes and Labels dialog box.

Refer to Figure 28-3. Click the Feed button until the orientation matches how 
the printer eats the envelope. The envelope can be oriented in one of six ways, 
including face up and face down.

6. Click the Print button.

You might need to press the printer’s OK button or Ready button to print, 
though some printers may instantly consume the envelope.

If­you­want­to­print­the­envelope­again,­save­it:­Before­Step­5,­click­the­Add­to­
Document­button.­Word­inserts­a­new­first­page­into­the­document,­which­is­the­
formatted­letter.­(The­page­size­is­specific­to­the­type­of­envelope.)­When­that’s­
done, you can save the document so that you can reuse the envelope.

FIGURE 28-3: 
The Envelopes 

side of the 

Envelopes and 

Labels dialog box.
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The­Add­to­Document­button’s­ofÏcial­purpose­is­to­add­an­envelope­to­a­letter.­If­
you­haven’t­written­a­letter­in­Word,­you­don’t­need­the­second­(blank)­page.­To­
delete it, click that page and press the Backspace key. The page is removed, leav-
ing only the envelope.

 » Any text appearing in the return address in the Envelopes and Labels dialog 

box is supplied by Word. If the field is blank, type the return address. Word 
asks whether you want to save it when the Envelopes and Letters dialog box 

closes. Click Yes.

 » If the delivery address is already typed in the document, select it before you 
summon the Envelopes and Labels dialog box. Word automatically grabs the 
selected text and sets it as the delivery address.

 » If you have trouble remembering which way the envelope feeds into the 
printer, draw a picture of the proper way and tape it to the top of the printer 

for reference.

 » In the United States, Size 10 is the common envelope paper size.

 » To change the envelope size, click the Envelope icon in the Preview area of the 
Envelopes and Labels dialog box. (Refer to Figure 28-3.) Use the Envelope 
Options dialog box to choose the proper envelope size.

 » The Envelopes button merely creates a special Word document (or a single 
page). The paper size is set to an envelope. A text box is placed in the center 
of the page, into which you type the delivery address. The return address is 
text typed at the start of the page. You can use various Word commands to 
create such a page, but the Envelopes command saves you the trouble.
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Chapter 29

A More Custom Word

C
ustomization is your tool, and it’s available in just about every computer 

program and mobile app. You can change the way things look, alter pro-

gram­colors,­add­goobers,­and­make­other­fun­modifications.­Many­people­
shy away from such customization, but again it’s your­tool.­If­you­can­fine-tune­
Word­to­make­your­workflow­more­productive,­go­for­it.­This­chapter­offers­many­
suggestions to give you a more custom Word.

A Better Status Bar

Lurking at the bottom of the Word window is an extremely useful gizmo, the sta-

tus­bar.­Chapter 1­introduces­the­status­bar­but­only­hints­at­its­potential.­Now­it’s­
time to reveal all: Right-clicking the status bar produces the helpful Customize 

Status­Bar­menu,­shown­in­Figure 29-1.

The­Customize­Status­Bar­menu­does­two­things:­First,­it­controls­the­info­you­see­
on the status bar (informational tidbits as well as certain controls); second, it lets 

you­turn­on­or­off­certain­Word­features.

IN THIS CHAPTER

 » Configuring the status bar

 » Customizing the Quick Access toolbar

 » Finding special commands for the 
toolbar

 » Adding tabs and groups to the Ribbon
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From­Figure 29-1,­as­well­ as­on­ the­screen,­you­can­see­ the­current­ status­ for­
many optional settings. A check mark indicates that an item is either visible or 

appears­when­necessary.­To­add­a­check­mark,­click­an­item;­clicking­a­check-
marked item removes the check.

 » Choosing an item from the menu doesn’t cause the menu to disappear, which 

is handy. To make the menu go away, click the mouse elsewhere in the 

document window.

 » The topmost items on the menu display document information. To have this 

information displayed on the status bar, choose one or more of these items.

 » The Selection Mode option directs Word to display the text Extend Selection on 

the status bar when you press the F8 key to select text. Refer to Chapter 6 for 
more information on selecting text.

FIGURE 29-1: 
The Customize 

Status Bar menu.
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 » The Overtype item places the Insert/Overtype button on the status bar. You 

can click this button to easily switch between Insert and Overtype modes. 

However, most Word users prefer to use Insert mode all the time.

 » The last three items on the menu control whether the View buttons or Zoom 

shortcuts appear on the status bar.

The Quick Access Toolbar
Back in the old days, you could seriously mess with how the Word window looked. 

You could add toolbars, remove toolbars, modify toolbars, create your own tool-

bars, and generally use the word toolbars over and over again until it loses its 

meaning.­Today,­Word­isn’t­quite­as­flexible­as­it­once­was,­but­you’re­still­allowed­
to customize a toolbar.

The­Quick­Access­toolbar­is­illustrated­in­Figure 29-2.­It’s­found­in­the­upper­left­
corner of the window.

FIGURE 29-2: 
The Quick Access 

toolbar.
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Click­a­wee­icon­on­the­Quick­Access­toolbar­to­activate­a­feature.­You­can­custom-

ize the toolbar by removing icons you don’t use and adding icons you do.

 » When the Quick Access toolbar grows too many custom buttons and begins to 

crowd into the document’s title, place it below the Ribbon: Choose the Show 

Below the Ribbon command from the toolbar menu. (Refer to Figure 29-2.) To 
move the Quick Access toolbar back atop the Ribbon, choose the Show Above 

the Ribbon command.

 » Word is configured to show several buttons on the Quick Access toolbar: 
AutoSave (for documents saved to OneDrive), Open, Save, Undo, and Redo. If 
you have a touchscreen PC, another button appears, Touch/Mouse Mode.

Adding buttons to the Quick Access toolbar
When you enjoy using a Word command so much that you must see its command 

button­icon­on­the­Quick­Access­toolbar,­follow­these­steps:

1. Click the Quick Access toolbar menu button.

Refer to Figure 29-2.

2. Choose a command from the menu to add it to the Quick Access toolbar.

A check mark indicates that the command is already present on the toolbar.

For­other­commands,­those­that­don’t­appear­on­the­Quick­Access­toolbar­menu,­
locate the command’s button on the Ribbon. Right-click the button and choose 

Add­to­Quick­Access­toolbar­from­the­shortcut­menu­that­pops­up.

 » Word remembers the Quick Action toolbar’s commands. They show up again 

the next time you start Word, in every document window.

 » Some commands place buttons on the toolbar, and others place drop-down 
menus or text boxes.

Editing the Quick Access toolbar
If­your­adoration­of­the­Quick­Access­toolbar­turns­into­an­obsession,­you­can­go­
hog-wild­modifying­ the­ thing:­Choose­More­Commands­ from­the­Quick­Access­
toolbar’s­menu.­You­see­the­Word­Options­dialog­box­with­the­Quick­Access­Tool-
bar­area­shown,­as­illustrated­in­Figure 29-3.
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Use­ the­ list­ on­ the­ left­ to­ choose­ a­ new­ command­ to­ add­ to­ the­ Quick­ Access­
toolbar.

The­list­on­the­right­shows­items­currently­on­the­toolbar.­Use­the­up­or­down­
buttons­(refer­ to­Figure 29-3)­ to­move­ items­up­or­down­(left­or­ right)­on­the­
Quick­Access­toolbar.

Click­the­OK­button­when­you­finish­editing.

 » Choose the All Commands item from the Choose Commands From menu 

(refer to Figure 29-3) to view every possible command in Word. Sometimes, a 
missing command that you think could be elsewhere ends up being available 

on the All Commands list — for example, the once popular Save All command 
or the Tabs command, which quickly displays the Tabs dialog box.

FIGURE 29-3: 
Adjusting the 

Quick Access 

toolbar.
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 » When the command list grows long, consider organizing it. Use the 
<Separator> item to help group similar commands. This item appears as a 

vertical bar on the Quick Access toolbar.

 » Yes, some commands lack specific graphics on their buttons; they show up as 
large dots on the toolbar.

 » To return the Quick Access toolbar to the way Word originally had it, choose 

Reset ➪   Reset Only Quick Access toolbar from the Word Options window. 
(Refer to the lower right corner in Figure 29-3.)

Removing items from the  
Quick Access toolbar
To­remove­a­command­from­the­Quick­Access­toolbar,­right-click­its­command­
button­and­choose­Remove­from­Quick­Access­Toolbar.

Likewise,­you­can­choose­a­command­with­a­check­mark­from­the­Customize­Quick­
Access­Toolbar­menu.­Or,­you­can­use­the­Word­Options­dialog­box,­as­described­
in the preceding section, to remove items.

Customize the Ribbon
Though­you­can’t­change­Word’s­core­tabs­and­groups­on­the­Ribbon,­you­can­cre-
ate your own tab on the Ribbon or add a new group on an existing tab.

Figure 29-4­shows­the­Favorites­tab­that­I’ve­added­to­the­Ribbon,­along­with­the­
groups­named­Home,­Insert,­and­Macros.

FIGURE 29-4: 
A custom tab and 

groups on the 

Ribbon.
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I used the Word Options dialog box to create this custom tab. You can too:

1. Right-click a blank part of the Ribbon.

2. Choose Customize the Ribbon.

In the Word Options window, tabs on the Ribbon are listed on the right and 

Word commands are shown on the left. The Ribbon is your oyster.

The­commands­in­the­Word­Options­dialog­box,­in­the­Customize­Ribbon­area,­let­
you­craft­your­own,­unique­tab­as­well­as­mess­with­the­Ribbon­in­other­ways.­For­
full details on the fun and potential hazards available, refer to the book Word 2016 

For Professionals For Dummies (Wiley), which I wrote.

If you mess around to create your own tab and goof things up horridly, click the 

Reset button, found in the lower right corner of the Word Options window, in the 

Customize Ribbon area. Choose the Reset All Customizations command.





6The Part of Tens



IN THIS PART . . .

Obey the ten commandments of Word.

Discover several handy and useful tricks.

Investigate some highly unusual Word features.

Deactivate features that really bug you.
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Chapter 30

The Ten Commandments 
of Word

I 
admit that I look nothing like Charlton Heston. Though I’m only guessing, I 

probably look nothing like Moses, either. Still, I feel compelled to descend from 

Mount Sinai with some basic codes for word processing. I call them my Ten 

Commandments of Word.

IN THIS CHAPTER

 » Thou shalt remember to save 

thy work

 » Thou shalt not use spaces 

unnecessarily

 » Thou shalt not abuse the Enter key

 » Thou shalt not neglect keyboard 

shortcuts

 » Thou shalt not manually number thy 

pages

 » Thou shalt not force a new page

 » Thou shalt not forget thy Undo 

command

 » Honor thy printer

 » Thou shalt have multiple document 

windows before thee

 » Neglecteth not Windows
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Thou Shalt Remember to Save Thy Work

Save!­Save!­Save!­Always­save­your­stuff.­Whenever­your­mind­wanders,­have­your­
fingers­dart­over­to­the­Ctrl+S keyboard shortcut. Savest thy work.

Thou Shalt Not Use Spaces Unnecessarily

Generally­ speaking,­you­should­never­find­more­ than­one­space­anywhere­ in­a­
Word document. The appearance of two or more spaces in a row is a desperate cry 

for a tab. Use single spaces to separate words and sentences. Use tabs to indent or 

to align text on a tab stop. To organize information into neat rows and columns, 

use a table.

 » Refer to Chapter 12 on setting tabs.

 » Refer to Chapter 19 for creating tables.

Thou Shalt Not Abuse the Enter Key

Word wraps text. As you type and your text approaches the right margin, the 

words fall to the next line. Therefore, there’s no need to press the Enter key, 

unless you desire to begin a new paragraph. An exception is a single-line para-

graph, in which case pressing the Enter key at the end of the line is okay.

If you’re pressing the Enter key to add “air” after a paragraph, modify the para-

graph­format­ to­add­padding.­Refer­ to­Chapter  11­ for­ information­on­the­Space­
After format.

When you don’t want to start a new paragraph but you need to start a new line, 

such as when typing a return address, press Shift+Enter, the soft return command.

Thou Shalt Not Neglect  
Keyboard Shortcuts

When­you­type­text­in­a­word­processor,­your­fingers­are­poised­over­the­keyboard.­
As such, it pays to use keyboard shortcuts rather than grope for the mouse.



CHAPTER 30  The Ten Commandments of Word      349

Word is rife with handy and memorable keyboard shortcuts. For example, stab the 

Ctrl+S key combo to quickly save a document. Press Ctrl+P to print or Ctrl+O to 

open a document. You need not know all the keyboard commands, but memoriz-

ing a few helps.

 » See Chapter 31 for information on keyboard accelerators to speed up access 
to the Ribbon.

 » Refer to this book’s online Cheat Sheet for a full-on list of keyboard shortcuts 
mentioned in this book. You can find the Cheat Sheet at www.dummies.com. 
Search for Word Cheat Sheet.

Thou Shalt Not Manually  
Number Thy Pages

Word­has­an­automatic­page-numbering­command.­Refer­to­Chapter 13­for­details­
on how to use it.

Thou Shalt Not Force a New Page

When you need to start text at the top of a new page, you use the manual page-

break command. Its keyboard shortcut is Ctrl+Enter. That’s the best and most 

proper­way­to­start­a­new­page.­Also­see­Chapter 13.

The worst way to start a new page is to brazenly whack the Enter key a couple of 

dozen times. The result may look okay for now, yet this strategy guarantees noth-

ing; as you continue to edit the document, the cluster of empty paragraphs wan-

ders, creating an ugly hole in the text.

Thou Shalt Not Forget Thy Undo Command

Press Ctrl+Z to undo any unwanted change to a document. A shortcut to the Undo 

command is also found roosting on the Quick Access toolbar.

https://www.dummies.com/
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Honor Thy Printer

Before you print anything, verify that the printer is on, healthy, stocked with ink 

and paper, and ready to print before you direct Word to print something.

Using­ the­Print­ command­ a­ second­ time­when­ it­ fails­ the­first­ doesn’t­fix­ the­
problem. Instead, Word now tries to print two copies of the document, despite 

whatever­issue­prevents­the­first­from­printing.

Thou Shalt Have Multiple Document 
Windows Before Thee

In Word, as in most Windows applications, you can work on more than one docu-

ment at a time. In fact, you can have as many document windows open as your 

pitiful PC can stand. Word even lets you view a single document in multiple win-

dows.­Refer­to­Chapter 24­to­see­how­to­conjure­such­alchemy.

 » You need not close one document to open and view another.

 » You don’t have to quit Word to run another program, either. In Windows, you 
can run multiple programs at a time. Don’t quit Word when you plan to start it 
again in just a little while.

Neglecteth Not Windows

Word is a program. Windows is an operating system. Word is designed for produc-

tivity; it’s word processing software. Windows is designed to control a computer 

and­to­drive­human­beings­crazy.­Word­and­Windows­are­two­different­things.

Word­creates­document­files.­Windows­manages­those­files.­If­you­need­to­rename­
a­file,­copy­the­file­to­a­thumb­drive,­move­the­file­to­another­folder,­or­recover­the­
file­from­the­Recycle­Bin,­you­use­Windows,­not­Word.­They­work­together.

Verily I tell ye, know both Word and Windows and ye shall be truly rewarded.
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Chapter 31

Ten Cool Tricks

W
hen it comes down to it, just about everything Word does can be con-

sidered a cool trick. I still marvel at how word-wrap works and how you 

can change margins after a document is written and all the text quickly 

jiggles into place. Everything in this book can be considered a cool trick, but when 

it came down to the wire, I found ten cool tricks barely (or not) mentioned any-

where else and then listed them here.

Side-to-Side Page Movement

In Print Layout view, you can arrange the document window to display pages 

side-to-side,­as­illustrated­in­Figure 31-1.­Workflow­moves­down­the­left­page­and­
then hops up to the top of the right page. This arrangement takes full advantage 

of widescreen computer monitors.

IN THIS CHAPTER

 » Working horizontally

 » Saving automatically

 » Accessing Ribbon commands

 » Exploring old keyboard shortcuts

 » Creating fractions

 » Setting electronic bookmarks

 » Restricting document access

 » Creating a drop cap

 » Seeing the document map

 » Sorting paragraphs
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To enter Side-by-Side view, click the View tab, and in the Page Movement group, 

choose Side-to-Side, shown in the margin. You may need to adjust the Word win-

dow to enlarge the document presentation; the Zoom command is disabled when 

you activate Side-to-Side page movement. So, the wider you can make the docu-

ment window, the better things look.

In the Side-to-Side presentation, the horizontal scroll bar becomes more useful. 

Use­it­to­page­through­the­document.­The­pages­automatically­flip­as­you­edit­and­
create text.

To restore traditional document presentation, click the Vertical button.

The Page Movement command you choose is sticky. The next time you open a 

document, it appears in Vertical or Side-to-Side presentation, whichever you last 

chose.

FIGURE 31-1: 
Working on a 

document 

side-to-side.
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Automatic Save with AutoRecover

Someday, you will sing the praises of Word’s AutoRecover feature. It periodically 

saves the document, even when you neglect to do so. In the event of a computer 

crash or some other type of mishap, Word recovers your document from a super-

secret safety copy it secretly made for you. How nice.

To ensure that AutoRecover is active, heed these directions:

1. Click the File tab.

2. On the File screen, choose Options.

The Word Options dialog box appears.

3. Choose Save.

4. On the right side of the dialog box, ensure that a check mark appears by 

the item Save AutoRecover Information Every 10 Minutes.

You can change the time, though ten minutes seems good.

5. Click OK to close the window.

Whew! You’re safe.

Most of the time, you never notice AutoRecover. On that rare, terrifying occasion 

that something goes awry, you see the Document Recovery pane when you restart 

Word. Information about unsaved documents appears in the Document Recovery 

pane, along with directions on how to recover a document.

 » When a Word document is saved to OneDrive, the AutoSave feature becomes 

active. Your document is continually saved and updated as you work on it. 

Refer to Chapter 8.

 » The best way to avoid accidentally losing stuff is to save now and save often!

Accelerate the Ribbon

Word has always been a mouse based program, even when it ran in Text mode on 

old­DOS­PCs.­Still,­the­keyboard­remains­a­fast­and­effective­way­to­access­com-

mands,­especially­given­that­in­a­word­processor­your­fingers­hover­over­the­key-

board most of the time.



354      PART 6  The Part of Tens

If you’re willing to learn, eschew the mouse and instead use some keyboard accel-

erators to access commands on the Ribbon.

The secret is to use the Alt key: Tap Alt and you see letters in boxes appear on the 

Ribbon, like tiny square freckles. Within each box are one or two letters, which are 

the accelerator keys. Tap a letter, or the two letters in sequence, to “click” a spe-

cific­part­of­the­Ribbon.

For example, to change the page orientation to Landscape mode, you press Alt, P, 

O to display the Orientation menu. Press the down-arrow key to choose Land-

scape. Press Enter to choose that menu item.

 » If you accidentally tap the Alt key, press it again to exit Accelerator mode.

 » You can also press the F10 key to access the Ribbon accelerators.

Ancient Word Keyboard Shortcuts

Before the Ribbon rode into town and freaked out all the townsfolk, Word relied 

upon keyboard commands. These ancient Word keyboard shortcuts still work in 

Word today. They’re handy, though not too memorable.

F4: The F4 key is the Repeat key, very much like Ctrl+Y, the Repeat key.

Shift+F4: Another Repeat key, but this one is the Repeat Find command. It works 

even when the Find dialog box (or Navigation pane) isn’t visible.

Shift+F5: This key combo is the Go Back command, which returns to the spot you 

last­edited.­See­Chapter 3­for­details.

Shift+F8: The Shrink Selection key is the opposite of the Selection key, F8. For 

example, when the entire document is selected, press Shift+F8 to select only the 

current paragraph. Press Shift+F8 again to select only the current sentence. Press 

it again to select only the current word. Press Shift+F8 one more time to deselect 

the­word.­Refer­to­Chapter 6­for­more­text­selection­tricks.

F12: Tap this key to quickly summon the Save As dialog box. I use this key a lot 

because it’s quicker than wading through the Backstage to summon the Save As 

dialog box.
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Ctrl+F12: This key does for the Open dialog box what F12 does for the Save As dia-

log box. It’s not redundant to the Ctrl+O command, which conjures the Backstage. 

Ctrl+F12 always brings up the good ol’ Open dialog box.

Build Your Own Fractions

Word’s AutoCorrect feature builds common fractions for you, replacing your 

clumsy text with beautiful fraction characters. Sadly, Word has only a few of these 

fraction characters. When you need your own, custom fraction, such as 3/64, create 

it this way:

1. Press Ctrl+Shift+= (the equal sign), the keyboard shortcut for the super-

script command.

2. Type the numerator — the top part of the fraction.

For example, type 3 for 3 64 .

3. Press Ctrl+Shift+= again to disable superscript.

4. Type the slash character ( / ).

5. Press Ctrl+= to activate subscript.

6. Type the denominator — the bottom part of the fraction.

For example, type 64 for 3 64 .

7. Press Ctrl+= to turn off subscript.

Behold the fraction.

Electronic Bookmarks

When­you­must­find­your­place­in­a­document,­you­can­write­text­like­WORK HERE, 

or you can take advantage of Word’s Bookmark command. The bookmark is invis-

ible, but Word knows where it is. You can use the bookmark to return to a page for 

editing, to add a cross-reference, or to perform a bunch of other handy tricks 

written about in Word 2016 for Professionals For Dummies, which I wrote (Wiley). For 

this book, set a bookmark by following these steps:

1. Place the insertion pointer where you want to insert the bookmark.

2. Click the Insert tab.
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3. In the Links group, click the Bookmark button.

The Bookmark dialog box appears.

4. Type a name for the bookmark in the Bookmark dialog box.

Try to keep the bookmark name to one word, letters only.

5. Click the Add button.

The bookmark is created.

To hop to bookmarks in the document, use the Go To command: Press Ctrl+G to 

summon the Find and Replace dialog box, with the Go To tab forward. Choose 

Bookmark from the Go to What list.

You can also click the Bookmark button again (refer to Step 3). Select the bookmark 

name from the list and click the Go To button to visit that bookmark’s location.

Lock Your Document

When you really, really don’t want anyone messing with your sweet text, you can 

lock the document. Several levels of protection are available, but you start the 

journey by following these steps:

1. Click the File tab.

2. Choose Info.

3. Click the Protect Document button.

Of the several choices, I recommend these options:

Mark as Final: The document is flagged as final, which means that further 

editing is disabled. Still, you can easily override it by clicking the Edit Anyway 

button that appears.

Encrypt with Password: The document is encrypted and a password applied. To 

open the document in Word, you must enter the password. You cannot 

remove a password after it’s applied.

Restrict Editing: You can limit whether a user can edit a document or whether all 

changes are tracked or restrict that person to make only comments.

4. Choose an option and answer the questions in the dialog boxes that 

appear.

5. Click OK.

The document protection you’ve chosen is applied.
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Locking a document is a serious decision! No one can help you if you forget a 

password or are otherwise unable to remove the restrictions you’ve applied to the 

document.

The Drop Cap

A drop cap­is­the­first­letter­of­a­report,­an­article,­a­chapter,­or­a­story­that­appears­
in­a­larger­and­more­interesting­font­than­the­other­characters.­Figure 31-2­shows­
an example.

To add a drop cap to a document, follow these steps:

1. Select the first character of the first word at the start of the text.

For example, select the I in It was a dark and stormy night. (Refer to Figure 31-2.)

2. Click the Insert tab.

3. In the Text group, click the Drop Cap button.

4. Choose a drop cap style.

The drop cap appears.

It­helps­if­the­drop­cap’s­paragraph­is­left­justified­and­not­indented­with­a­tab­or­
any­of­the­tricky­formatting­operations­discussed­in­Part 3­of­this­book.

To remove the drop cap, choose None in Step 4.

Map Your Document

Whenever I’m writing, I show the Navigation pane on the left side of the docu-

ment window. This pane lets me see the Big Picture, an overview of my document 

based­on­the­heading­styles.­I­can­use­it­to­quickly­hop­to­a­specific­header.­As­a­
bonus, it also shows the handy Search Document text box, as illustrated in 

Figure 31-3.

FIGURE 31-2: 
A drop cap.
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To summon the Navigation pane, follow these steps:

1. Click the View tab.

2. In the Show group, click to put a check mark by the Navigation Pane 

item.

To close the Navigation pane, click its X Close button.

The Navigation pane replaces a popular but long-gone Word feature called the 

document map.

Sort Your Text

Sorting is one of Word’s better tricks, though it’s surprising how few people know 

about it. You can use the Sort command to arrange text alphabetically or numeri-

cally. You can sort paragraphs, table rows and columns, and more.

FIGURE 31-3: 
The Navigation 

pane document  

map.
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Save your document before sorting. It’s just a good idea.

Sorting­isn’t­difÏcult.­First,­arrange­whatever­needs­to­be­sorted­into­several­lines­
of text, such as

Lemon

Banana cream

Apple

Cherry

Rhubarb

Tortilla

After you know what you’re sorting, obey these steps:

1. Select the lines of text (paragraphs or parts of a table) as a block.

2. Click the Home tab.

3. In the Paragraph group, click the Sort button.

The Sort Text dialog box appears. It’s most useful when sorting multicolumn 

items, which is where the Then By parts of the dialog box are most useful.

4. Choose Ascending or Descending to sort the text from A to Z or from Z to 

A, respectively.

5. Click the OK button.

As if by magic, the selected text is sorted.
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Chapter 32

Ten Bizarre Things

I
f­Word­were­only­about­word­processing,­this­book­would­end­at­Chapter 17.­
Fully half the text references things more relevant to the topics of desktop pub-

lishing­or­graphics.­These­tasks­are­done­far­better­by­using­other­software,­but­
Word­ doesn’t­ stop­ there­ with­ its­ unique­ and­ weird­ features.­ Welcome­ to­ the­
Twilight Zone,­Word­edition.

Equations

Microsoft must recognize that a vast majority of Word users hold degrees in astro-

physics­and­quantum­mechanics.­If­you’re­one­of­them,­or­perhaps­you­dabble­in­
rocket­ science­or­brain­surgery,­you’ll­ appreciate­Word’s­Equation­ tools.­These­
tools sate your desire to place a polynomial equation or quantum calculation in 

your­document­without­having­to­endure­the­tedium­of­building­the­thing­yourself.

IN THIS CHAPTER

 » Inserting pretty equations

 » Inserting video

 » Hiding text

 » Beholding the Developer tab

 » Hyphenating text

 » Setting document properties (or not)

 » Reviewing document versions

 » Using collect-and-paste

 » Disabling click-and-type

 » Translating text
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To­place­a­premade­equation­into­your­third­doctoral­thesis­from­MIT,­click­the­
Insert­tab.­In­the­Symbols­group,­click­the­Equation­button­menu­and­choose­a­
preset­mathematical­monster­ from­ the­ list.­ Or­ you­ can­ choose­ the­ Insert­New­
Equation­command­to­share­your­own­brilliance­by­crafting­the­equation­yourself.

 » An equation content control is inserted in a document at the insertion pointer’s 

location. When selected, the Equation Tools Design tab appears on 

the Ribbon.

 » No, Word won’t solve the equation.

Video in Your Document

Seriously?­I’m­guessing­that­Word’s­capability­to­stick­a­video­into­a­document­
doesn’t­translate­well­when­the­page­is­printed.­That’s­just­a­guess —­I­haven’t­
tried­it,­though­I­think­I’m­probably­correct.

When­you’ve­stayed­up­late­and­the­alcohol­in­your­bloodstream­is­flirting­with­
every neuron in your brain, why not follow these steps to shove a video into your 

text:

1. Click the Insert tab.

2. In the Media group, click the Online Videos button, shown in the margin.

3. Type the URL (web page address) for the video you want to shove into 

your text.

It can be a YouTube video or a movie from another service.

After way too much time passes, the video appears as a large graphical goober in 

the­document.­You­can­play­it­right­there­on­the­screen.­Amazing.

Videos­ are­ best­ viewed­when­ a­Word­ document­ is­ presented­ in­ Read­mode —­
which­in­and­of­itself­is­yet­another­bizarre­thing.­To­enter­Read­mode,­click­the­
Read Mode button (shown in the margin) on the status bar; or, on the View tab, 

choose­Read­Mode­from­the­Views­group.



CHAPTER 32  Ten Bizarre Things      363

Hidden Text

One­text­ format­not­covered­ in­Chapter  10­ is­hidden­text.­ I­mean,­why­bother?­
Hidden­text­doesn’t­appear­in­a­document.­It­doesn’t­print.­It’s­just­not­there!

If­you­desire­to­write­hidden­text­so­that­you­can­put­it­on­your­résumé­for­appli-
cation­to­the­CIA,­select­the­text­and­press­Ctrl+Shift+H. The­same­keyboard­short-
cut­deactivates­this­format.­The­following­text­is­hidden:

________________________________________________

The­only­way­you­know­that­hidden­text­exists­in­a­document­is­to­use­the­Show/
Hide­command:­Click­the­Home­tab,­and­in­the­Paragraph­group,­click­the­Show/
Hide­button,­which­looks­like­the­Paragraph­symbol.­The­hidden­text­shows­up­in­
the­document­with­a­dotted­underline.

The Developer Tab

Computer­users­love­secrets,­especially­when­no­one­else­knows­about­them.­One­
such­secret­in­Word­is­the­Developer­tab.­Shhh!

The­Developer­tab­plays­host­to­some­of­Word’s­advanced­and­cryptic­features.­
These­commands­don’t­make­creating­a­document­any­easier,­and­they­open­a­can­
of­worms­that­I­don’t­want­to­cover­in­this­book.­Still,­you’re­reading­this­text,­so­
follow these steps to summon the mysterious Developer tab:

1. Right-click a blank part of the Ribbon.

2. Choose Customize the Ribbon from the pop-up shortcut menu.

The Word Options dialog box appears, with the Customize Ribbon area active.

3. On the right side of the window, below the Customize Ribbon list, place a 

check mark by the Developer item.

4. Click OK.

The­Developer­tab­is­aptly­named;­it’s­best­suited­for­people­who­either­use­Word­
to develop applications, special documents, and online forms or are hellbent on 

customizing Word by using macros.­Scary­stuff,­but­it’s­covered­in­my­book­Word 

2016 For Professionals For Dummies­(Wiley).­Now­you­know­the­secret.
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Hyphenation

Hyphenation is an automatic feature that splits a long word at the end of a line to 

make­ the­ text­ fit­ better­ on­ the­ page.­ Most­ people­ leave­ this­ feature­ disabled­
because­ hyphenated­ words­ tend­ to­ slow­ down­ the­ pace­ at­ which­ people­ read.­
However, if you want to hyphenate a document, click the Layout tab and then the 

Page­Setup­group,­and­choose­Hyphenation­➪  ­­Automatic.

Automatic­hyphenation­works­only­on­paragraphs­formatted­with­full-­justification­
alignment.­If­the­paragraph­is­otherwise­formatted,­the­Hyphenation­command­
button­is­dimmed.­See­Chapter 11­for­information­on­paragraph­alignment.

Document Properties

Word­merrily­tracks­lots­of­details­about­the­documents­you­craft,­stuff­that­you­
normally wouldn’t pay attention to if you didn’t know about the Document Prop-

erties­feature.

To­view­a­document’s­properties,­click­the­File­tab­and­choose­the­Info­item.­The­
properties appear on the right, showing document size, pages, word count, and 

other­trivia.­To­view­or­set­other­options,­click­the­Properties­button­and­choose­
Advanced­Properties.

Document Version History

You­write,­you­save,­you­write,­you­save.­These­different­document­versions­can­
be­recovered­if­you­enable­the­Windows­File­History­feature.­Within­Word,­how-

ever, you can peruse a document’s revision history, providing you’ve saved the 

document­to­OneDrive.

To­check­out­previous­editions­of­a­document,­click­the­document­name,­top­and­
center­of­the­window.­From­the­menu,­choose­Version­History.­The­Version­His-
tory­pane­appears.­ If­you­click­and­don’t­see­a­menu,­ the­document­was­saved­
locally­or­to­cloud­storage­that’s­better­than­OneDrive.

The­Version­History­pane­ lists­all­major­document­revisions­by­date,­ time,­and­
author.­To­see­a­revision,­click­the­Open­Version­link.­The­selected­revision­appears­
in­a­new­window.
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Collect-and-Paste

I­hope­the­word­processing­concept­of­copy-and-paste­is­simple­for­you.­What’s­
not­simple­is­taking­it­to­the­next­level­by­using­Word’s­collect-and-paste­feature.

Collect-and-paste allows you to copy multiple chunks of text and paste them in 

any­order­or­all­at­once.­The­secret­is­found­on­the­Home­tab:­Click­the­dialog­box­
launcher in the lower right corner of the Clipboard group.­ The­Clipboard­pane­
appears­on­the­screen.

With the Clipboard pane visible, you can use the Copy command multiple times in 

a­row­to­collect­text.­To­paste­the­text,­click­the­mouse­on­a­chunk­of­text­in­the­
Clipboard­pane.­Or,­you­can­use­the­Paste­All­button­to­paste­into­the­document­
every­item­you’ve­collected.

Even­more­bizarre:­You­can­actually­select­multiple­separate­chunks­of­text­in­a­
document.­To­do­so,­select­the­first­chunk,­and­then,­while­holding­down­the­Ctrl­
key,­drag­over­additional­text.­As­long­as­the­Ctrl­key­is­held­down,­you­can­drag­
to­select­multiple­chunks­of­text­in­different­locations.­The­various­selected­chunks­
work as a block, which you can cut, copy, or delete or to which you can apply 

formatting.

Click-and-Type

A­feature­introduced­in­Word­2002,­and­one­that­I­don’t­believe­anyone­ever­uses,­
is­ click-and-type.­ In­a­blank­document,­ you­ can­use­ click-and-type to stab the 

mouse­pointer­anywhere­on­the­page­and­type­information­at­that­spot.­Bam!

I­ fail­ to­ see­ any­ value­ in­ click-and-type,­ especially­ when­ it’s­ a­more­ positive­
aspect­of­your­Word­education­to­learn­basic­formatting.­But­click-and-type­may­
bother you when you see any of its specialized mouse pointers displayed; thus:

Those­weird­mouse­pointers­ indicate­ the­ click-and-type­ feature­ in­action.­The­
mouse pointer itself tries to indicate the paragraph format to be applied when you 

click­the­mouse.

See­Chapter 33­for­information­on­disabling­this­feature.
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Translations

Allora, hai il desiderio di scrivere il tuo testo l’italiano? Rather than get bored trying to 

learn­Italian­ in­school­or­waste­precious­ time­vacationing­ in­ Italy,­you­can­use­
Word’s­Translate­feature­to­magically­create­Italian­or­any­other­foreign­language­
text.­The­secret­lies­on­the­Review­tab,­in­the­Language­group.

To­translate­a­chunk­of­text­in­a­document,­follow­these­steps:

1. Write the text you want to translate.

I came. I saw. I conquered.

2. Select the text.

3. On the Review tab, in the Language group, click the Translate button and 

choose Translate Selection.

The Translate command button is shown in the margin.

4. Click the Turn On button if prompted to activate Intelligent Services.

The Translator pane appears on the right side of the document window. The 

pane automatically detects the language selected, which I assume is English for 

this book.

5. Choose a target language from the To menu.

Alas, Latin isn’t one of them, at least as this book goes to press.

6. Review the translation.

If you know a smattering of the selected language, consider fixing it up. For 
example, the Italian sentence at the start of this section was originally trans-

lated with the second person plural instead of second person singular.

7. Click the Insert button to set the translated text into the document.

Bello.

8. Close the Translate pane.

Click the X button to close.

As with all computer translations, what you get is more of an approximation of 

what­a­native­speaker­would­say.­The­text­is­generally­understandable,­but­noth-

ing­truly­substitutes­for­a­knowledge­of­the­language —­or­a­month­in­Italy.
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Chapter 33

Ten Automatic Features 
Worthy of Deactivation

Y
ou need not put up with it. You know what I’m referring to: those annoying 
things that Word does. Those features you might dislike but tolerate simply 
because­no­one­has­told­you­how­to­turn­them­off.­Until­now.

IN THIS CHAPTER

 » Disabling the Start screen

 » Avoiding the Backstage

 » Banishing the mini toolbar

 » Changing how text is selected

 » Turning off click-and-type

 » Setting Paste command formats

 » Disabling automatic bulleted lists

 » Avoiding automatic numbers

 » Stopping automatic borders

 » Disabling list formats
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Bye-Bye, Start Screen
I prefer to see a blank page when I start Word, not a screen full of options. The 
Word Start screen can easily be disabled. Follow these blessed steps:

1. Click the File tab.

2. Choose Options.

The Word Options dialog box appears, with the General category chosen 

for you.

3. Remove the check mark by the item Show the Start Screen When This 

Application Starts.

This item is found in the Start-Up Options section.

4. Click OK.

After you complete these steps, Word starts with a blank document, or whichever 
document you’ve opened.

Restore the Traditional Open  
and Save Dialog Boxes

When you use the Ctrl+O or Ctrl+S commands, you see Word’s way of prompting 
you to open or save. If you prefer instead to use the traditional Open and Save dia-
log boxes, follow these steps:

1. Click the File tab and choose Options to bring up the Word Options 
dialog box.

2. Choose the Save category on the left side of the dialog box.

3. Place a check by the item Don’t Show the Backstage When Opening or 
Saving Files with Keyboard Shortcuts.

This item is found in the Save Documents section.

The Backstage refers to the Open and Save As screens on the File tab.

4. Click OK.

One­benefit­of­the­Backstage­is­that­it­shows­recent­files.­It­also­lets­you­pin­popu-
lar­files­so­that­they’re­easy­to­find.­Refer­to­Chapter 8.
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Turn Off the Mini Toolbar
When you use the mouse to select text, Word displays the mini toolbar, which 
looks­like­Figure 33-1.

You­may­find­its­assortment­of­commands­useful,­or­you­may­just­want­to­set­the­
thing­on­fire.­If­it’s­the­latter,­you­can­disable­the­mini­toolbar­by­following­these­
steps:

1. Click the File tab and choose Options.

The General category is automatically chosen for you.

2. Remove the check mark by the item Show Mini Toolbar on Selection.

This item is located below the heading User Interface Options. It’s right up top.

3. Click OK.

If you would rather not eternally banish the mini toolbar, note that it hides itself 
whenever you move the mouse pointer beyond the selected chunk of text.

Select Text by Letter

When you’re selecting more than a single word, the mouse grabs text a full word 
at a time. If you want Word to select text by characters rather than by words 
(which is what I prefer), follow these steps:

1. Click the File tab and choose Options to display the Word Options 
dialog box.

2. Choose Advanced.

3. Remove the check mark by the item labeled When Selecting, 
Automatically Select Entire Word.

This item is located below the Editing Options heading.

4. Click OK.

FIGURE 33-1: 
The mini toolbar.
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You can still select text a word at a time: Double-click to select a word, but hold 
the mouse button down. As you drag, text is selected one word at a time.

Disable Click-and-Type
Click-and-type is that feature where you can click anywhere in a document and 
start typing. The feature is made evident by an odd-looking mouse pointer and 
strange­ lines­around­ the­ insertion­pointer­ in­ the­ text­ (refer­ to­Chapter 32).­To­
mercifully disable this click-and-type, follow these steps:

1. Click the File tab menu and choose Options.

The Word Options dialog box appears.

2. Choose Advanced.

3. Remove the check mark by Enable Click and Type.

This option is located below the Editing Options heading.

4. Click the OK button.

Seriously: Who uses this feature? For the past few editions of this book, I’ve asked 
readers to send me an email if they use click-and-type. So far, nothing.

Paste Plain Text Only

When you copy and paste text from one part of a document to another, the format 
is retained. Similarly, the format is kept when you copy and paste text from 
another document. If you like, you can direct Word to paste only plain text or 
attempt to paste formatted text. Heed these directions:

1. Click the File tab and choose Options.

2. In the Word Options dialog box, choose Advanced.

Four text pasting options are listed under the Cut, Copy, and Paste heading. 

These options tell you how text is pasted based on its source.

3. Change the paste settings according to how you prefer text to be pasted.

In most cases, keeping the source formatting is what you want. I prefer to 

choose the Keep Text Only option because it doesn’t mess up my document’s 

formatting.

4. Click OK.
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You can use the Paste Special command at any time to override your decision: 
Click the Home tab and, in the Clipboard group, click the Paste button to choose 
whether­to­keep­the­formats.­See­Chapter 6­for­details.

Disable AutoFormat Features (×4)

The­final­four­items­worthy­of­deactivation­fall­under­the­domain­of­the­AutoCor-
rect­ dialog­ box.­ Specifically,­ the­ overeager­ AutoFormat­ feature,­which­ aggres-
sively­interrupts­your­writing­with­jarring­suggestions­you­probably­don’t­want­
to see.

Start your disabling binge by summoning the AutoCorrect dialog box. Follow these 
steps:

1. Click the File tab and choose Options.

2. In the Word Options dialog box, click the Proofing category.

3. Click the AutoCorrect Options button.

The AutoCorrect dialog box shows up.

4. Click the AutoFormat as You Type tab.

You’ve arrived.

Here are four annoying features you can disable:

Automatic Bulleted Lists: This feature assumes that whenever you start a 

paragraph with an asterisk (*), you really want a bulleted list, so it changes the 

format.

Automatic Numbered Lists: This feature works like Automatic Bullet Lists, but 

does the same annoying thing for any paragraph you start numbering.

Border Lines: Type three dashes in a row and you see this feature activated. Use 

the Borders paragraph format instead. See Chapter 18.

Format Beginning of List Item Like the One Before It: This feature assumes that 

just because the first word of the preceding paragraph is in bold or italics that you 
desire all other paragraphs to start that way as well.

Deselect each of these items. Oh, and while you’re at it, look for other items to 
disable in the AutoCorrect dialog box. Some of those features may bother you more 
than they bother me.
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Index

A
absolute margin, 158

accent grave, 272

adding

automatic page numbering, 160–161

buttons to Quick Access toolbar, 340

columns in tables, 235–236

comments, 303–304

cover pages, 173–174

dates, 178, 279–280

document filename field, 277–278
entries to AutoCorrect feature, 78–79

fields, 276–278, 319–320
indexes to documents, 253–254

lists of figures, 254
page number field, 277
page numbers in headers/footers, 177–178

recipient data, 321–322

rows in tables, 235–236

table captions, 238

tables to documents, 227–233

text topics, 296–297

thick lines between paragraphs, 225–226

times, 178, 279–280

total number of pages field, 277
watermarks, 167

word count field, 277
address lists, printing, 331–333

adjusting

appearance of graphics, 267

AutoCorrect settings, 79

column format, 243–244

column size in tables, 236

document view, 15–16

document’s associated templates, 200

fields, 278
gaps between pages in Print Layout view, 28

indents using rulers, 135–137

Normal style, 193–194

orientation, 157

row size in tables, 236

settings for grammar checker, 84

styles, 190–191

tables, 235–238

templates, 202

text case, 121–122

themes, 204–205

Adobe InDesign, 160

Adobe Reader (website), 109

Advanced Find, 53–55

Align Left command button, 12

Align Object button, 268

Align Right command button, 129

aligning

about, 128

graphics, 268–269

text in cells, 234–235

All Borders icon, 222

All Caps text format, 117

All Markup, 305, 310

Alt key, 23

Anchor icon, 264

antonyms, 301

apostrophe, 272

appearance, changing for graphics, 267

applying

all caps, 117

bold, 116

character formatting, 116–117

document themes, 203–204

double-underline, 116

italic, 116

page borders, 224–225

small caps, 117

strikethrough, 116

subscript, 117

superscript, 117

underline, 116

Arrange All button, 284
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arranging

document windows, 284–285, 351–352

graphics, 267–270

assigning shortcut keys to styles, 191–192

AutoCorrect dialog box, 210–211, 371

AutoCorrect feature

about, 77, 272–273

adding new entries, 78–79

adjusting settings, 79

undoing corrections, 77–78

AutoCorrect icon, 1ee

AutoCorrect Lightning Bolt icon, 213

AutoFormat features, 214, 371

Auto-Hide Ribbon, 14

automatic bulleted lists, 371

automatic features, 367–371

automatic formatting, 210–214

automatic numbered lists, 371

automatic page numbering, adding, 160–161

automatic proofing, disabling, 83
AutoRecover feature, 353

AutoSave feature, 93–94

B
back tick, 272

backgrounds, 120–121, 165–167

backing up, 26

Backspace key, 22, 26, 44

Backstage, 91, 368

bar tab, 152

Bar Tab Stop icon, 152

behind text images, 263

blank pages, 102, 165

blocks, 61

blue underlines, 30, 31

boilerplating, 97

bold, applying, 116

Bold command button, 116

bookmarks, electronic, 355–356

border lines, 371

borders

about, 213–214, 219

basics of, 220–222

Borders and Shading dialog box, 222–225

controlling format of, 220

putting around paragraphs, 221

removing, 222

Borders and Shading dialog box, 222–225

Borders button, 220, 222

Both control, 137

boxing text, 224

Breaks button, 171

Browse Next command, 40

Browse Previous command, 40

bullet, 248

bulleted lists, 248, 371

Bullets button, 248

buttons, 340. See also specific buttons

C
canceling print jobs, 107–108

capitalization, 77

Caps Lock key, 77

Caption styles, 184

captions, table, 238

case-sensitive text, finding, 54
cells

aligning text in, 234–235

merging in tables, 236–237

splitting in tables, 237

center alignment, 129, 136

Center command button, 129

center tab stop, 147–148

Center Tab Stop icon, 147

centering pages, 214–216

Change Case command button, 121–122

changes, tracking, 309–310

character formatting

about, 113

applying, 116–117

basic text formats, 114–117

changing text case, 121–122

clearing, 122

coloring text, 119–121

Font dialog box, 123–124

resizing text, 118–119

selecting fonts, 114–116

text-formatting techniques, 113–114

character style, 184

characters
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about, 271–274

date, 280

deleting single, 44

diacritics, 272–273

fields, 275–279
foreign language, 273

PrintDate field, 280
special, 273–274

symbols, 273–274

text boxes, 274–275

time, 280

typing, 272–273

Cheat Sheet (website), 4

Check for Issues tool, 108–109

checking updates, 312

Clear Formatting command button, 122

clearing

character formatting, 122

tab stops, 154

click-and-type feature, 24, 365, 370

Clipboard, viewing, 71–72

Clipboard task pane, 71–72

Close command, 19

Close Header and Footer button, 176

closing

Outline view, 293

Word, 18

closing documents, 18–19

cloud storage, 88, 311

collaboration tools

comments, 303–307

comparing documents, 308–309

highlighting, 307–308

on Internet, 311–312

tracking changes, 309–311

Collapse button, 295

Collapse the Ribbon button, 15

collapsible headers, 29, 296

collapsing topics, 295–296

collating, 106

collect-and-paste, 365

color theme, 204

colored pages, printing, 166

coloring

pages, 165–166

text, 119–121

column breaks, setting, 244–245

columns

about, 239–243

adding in tables, 235–236

changing format of, 243–244

creating 2-column text, 241

creating trifold brochures, 242–243

removing from tables, 235–236

resizing in tables, 236

setting column breaks, 244–245

using multiple, 240

Columns dialog box, 240

Columns menu, 240

commands

Browse Next, 40

Browser Previous, 40

Close, 19

Cover Page, 173–174

Create a Style, 188

Find, 52–53, 54

Go To, 41–42

Horizontal Line, 226

Open, 95–96

for paragraph formatting, 127–128

Paste Special, 371

Print, 102, 350

Redo, 50

Repeat, 50

Replace, 59

Reveal Codes, 30

Show/Hide, 29–30, 49, 164, 253

Undo, 49–50, 69, 265, 349

comments

adding, 303–304

deleting, 306–307

hiding, 305

printing, 306

reading, 305–306

replying to, 304–305

showing, 305
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comparing documents, 285, 308–309

Compatibility Mode, 290

configuring printers, 100
content controls, 279

content lists, 251–254

Continuous section break, 171

Convert button, 290

converting

tab-formatted text into tables, 231

tables, 232

copy and paste, 68, 259

Copy command button, 68

copying text blocks, 68, 70–71

counting words, 301

Cover Page command, 173–174

cover pages, 173–175

Create a Style command, 188

Create New Style from Formatting dialog box, 188–190

creating

bulleted lists, 248

custom headers/footers, 176–178

envelopes, 333–335

fractions, 355

heading styles, 194

indexes, 252–254

mail merge email messages, 318

mail merge envelopes, 318–319

mail merge form letters, 316–318

multilevel numbered lists, 249–250

PDFs, 109

recipient lists, 319–322

right-stop, left-stop lists, 148–149

sections, 171–172

styles, 188

tabbed lists, 144–145

table of contents (TOC), 251–252

tables, 228–232

templates, 201–202

themes, 204–205

titles, 223–224

trifold brochures, 242–243

2-column right-stop lists, 150

2-column text, 241

2-tab paragraphs, 145–147

Crop button, 265

cropping graphics, 265–266

Ctrl +0, 131

Ctrl key, 23

Ctrl+1, 131

Ctrl+2, 131

Ctrl+5, 131

Ctrl+Alt+PgDn, 40

Ctrl+Alt+PgUp, 40

Ctrl+Backspace, 44–45

Ctrl+C, 68

Ctrl+Delete, 44–45

Ctrl+E keys, 129

Ctrl+End keys, 40

Ctrl+F, 52–53

Ctrl+Home keys, 40

Ctrl+I, 114

Ctrl+J, 130

Ctrl+L, 128

Ctrl+N, 88

Ctrl+P, 102

Ctrl+PgDn, 54

Ctrl+PgUp, 54

Ctrl+R, 129

Ctrl+T, 134

Ctrl+V, 68

Ctrl+X, 68

Ctrl+Y, 50

Ctrl+Z, 49, 69

cursor keys, 23

custom dictionary, 82–83

customizing

about, 337

custom dictionary, 82–83

Quick Access toolbar, 339–342

Ribbon, 342–343

status bar, 337–339

Style Gallery, 195

watermarks, 167

Cut command button, 68

D
date

adding current, 279–280

adding in headers/footers, 178

decimal tab, 151–152
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Decimal Tab Stop icon, 151

Decrease Font Size command button, 119

Decrease Indent command button, 134

decreasing font size, 119

Delete button, 307

Delete key, 22, 23, 26, 44

deleting. See also removing

chunks of text, 45–47

comments, 306–307

fields, 278
lines of text, 45

pages, 46–47

paragraphs, 46

sentences, 45–46

single characters, 44

styles, 192–193

tab characters, 154

tables, 232–233

words, 44–45

Demote button, 294

Demote to Body Text button, 296

demoting topics, 294–295

deselecting text blocks, 67

desktop keyboard, 23

Developer tab, 363

diacritics, 272–273

Dialog Box Launcher icon, 14

Dictate button, 30

dictation, 30

dictionary, customizing, 82–83

disabling

AutoFormat features, 371

automatic proofing, 83
click-and-type, 370

mini toolbar, 369

Start screen, 368

Display for Review button, 305

displaying

comments, 305

Paragraph symbol, 126

Ribbon, 14–15

tab characters, 140–141

tab stops, 141

tabs, 14

document filename field, 277–278
Document Map feature, 357–358

Document Properties sheet, 105

document publishing, 160

document windows

arranging, 284–285, 351–352

multiple, 350

viewing documents in multiple, 285–286

documents

adding indexes to, 253–254

adding tables to, 227–233

applying themes, 203–204

arranging windows, 284–285

changing associated templates, 200

changing views of, 15–16

closing, 18–19

comparing, 285, 308–309

content lists, 251–254

defined, 87
exporting, 110

filenames, 92
forgetting to save, 94

formats for, 287–288

hiding proofing errors in, 84–85
large, 298–300

locking, 356–357

marking entire, 66

merging, 326–328

navigating, 35–42

opening, 9–10, 88–89, 94–97, 284, 288–290

placing text boxes into, 274–275

preparing for publishing, 108–109

printing, 101–102, 108–110

proofing, 81–85
properties of, 364

publishing, 99–110

rechecking, 81–82

recipient list, 323

recovering drafts, 98

removing from Recents list, 96

save-errors for, 92

saving, 89–94, 199

scrolling, 35–38

sharing, 311–312
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documents (continued)

slicing into sections, 170–173

split-screen, 286–287

splitting, 299–300

stitching together, 298–299

terminology for, 88

updating, 92–93, 290

version history of, 364

video in, 362

viewing in multiple windows, 285–286

Don’t Save button, 18

double-spacing, 26, 131, 136

double-underline, applying, 116

downward-pointing triangle, 14

Draft view, 16, 28

drafts, recovering, 98

Draw Table button, 237

drawing tables, 228–232

drop cap, 357

E
editing

fields, 320–321
graphics, 264–267

PDF files, 109
Quick Access toolbar, 340–342

recipient lists, 324

text, 43–50

electronic bookmarks, 355–356

electronic publishing, 108–110

Elevator button, 36–37

ellipsis character (. . .), 302
em dashes, 212

email messages

creating for mail merge, 318

merging to, 327–328

en dash, 212

End key, 40

endnotes, 255–256

Enter key, 22, 26, 348

entering Outline view, 292–293

envelopes, creating, 318–319, 333–335

Envelopes and Labels dialog box, 333–334

equations, 361–362

Eraser tool, 237

erasing text, 26

even headers/footers, 179

Even Page section break, 171

Expand button, 296

expanding topics, 295–296

exporting documents, 110

Extend Selection mode, 65–66

F
F1 key, 17

F4 key, 354

F8 key, 65–66

F12 key, 354

Field dialog box, 275–276

fields
about, 275–276

adding, 276–278, 319–320

changing, 278

defined, 314
deleting, 278

editing, 320–321

inserting in mail merge, 325

restoring, 278

updating, 278

viewing raw data from, 278

file format, 287–288
File screen, accessing, 2

File tab, 14

filenames, 93
files, 88
Find and Replace dialog box, 53–54, 58–59

Find command, 52–53, 54

finding
case-sensitive text, 54

formatting, 56–58

special characters, 56

styles, 184–185

text, 51–55

word variations, 55

words, 54

Finish & Merge command button, 326, 333

First Line Indent control, 137

first-page options, headers/footers on, 179–180
fixing misspelled words, 74–75
floating images, 262, 264
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Focus view, 16

folders, 88

follow-me style, 190

Font Color command button, 120

Font dialog box, 123–124

font theme, 205

fonts

resizing, 118–119

selecting, 114–116

footers

creating custom, 176–178

defined, 175
even, 179

on first page, 179–180
multiple, 178–181

odd, 179

removing, 181

sections and, 180–181

using preset, 175–176

footnotes, 175, 255–256

foreign language characters, 273

forgetting to save, 94

form letters, creating for mail merge, 316–318

Format Painter, 209–210

Format Painter command button, 209

Format Text Effects dialog box, 208
formats, for documents, 287–288

formatting

automatic, 210–214

finding, 56–58
pages, 155–167

paragraphs, 125–137, 213–214

style, 183–195

tables, 237–238

tabs, 139–154

templates, 197–205

themes, 197–205

4-way arrow, 268

fractions

building, 355

formatting, 211

full justification, 129–130, 136, 241

G
Galleries, 14

Go To command, 41–42

Gookin, Dan (author)

PCs For Dummies, 3
Word 2016 For Professionals For Dummies, 3, 58, 59, 89, 

113, 125, 216, 233, 249, 254, 260, 279, 343, 363

gradients, 166

grammar checker, 80, 84

graphics

aligning, 268–269

arranging, 267–270

changing appearance of, 267

copying and pasting, 259

cropping, 265–266

editing, 264–267

floating, 264
grouping, 269–270

inserting, 259–260

inserting into shapes, 261

inserting items into shapes, 261

inserting shapes, 260–261

keeping with text, 264

layout, 262–264

layout options, 263

moving, 268

resizing, 265

rotating, 266–267

shufÒing, 269
in text, 257–262

WordArt, 261–262

wrapping text around, 263

Group button, 270

grouping graphics, 269–270

gutter, 241

Gutter settings, 159

H
hanging indents, 134, 136

hard copy, 99

hard page break, 164
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hard returns, 48–49

headers

collapsible, 29

creating custom, 176–178

defined, 175
even, 179

on first page, 179–180
multiple, 178–181

odd, 179

removing, 181

sections and, 180–181

using preset, 175–176

headings, 175, 184, 194

Help system, 17

hidden text, 363

Hide the Ribbon button, 15

hiding

comments, 305

proofing errors, 84–85
Ribbon, 14–15

highlighter, 307–308

Home key, 40

Horizontal Line command, 226

horizontal scroll bar, 37

hyperlinks, 212

hyphenation, 364

I
I-beam, 24

icons

All Borders, 222

Anchor, 264

AutoCorrect, 1ee

AutoCorrect Lightning Bolt, 213

Bar Tab Stop, 152

Center Tab Stop, 147

Decimal Tab Stop, 151

explained, 4

Left Tab Stop, 146

Printer, 107

Pushpin, 91, 96

Immersive Reader view, 16

in front of text images, 263

Increase Font Size command button, 119

increasing font size, 119

Indent command button, 134

indents

adjusting using rulers, 135–137

first lines of paragraphs, 133–134
keyboard shortcuts for, 136

paragraphs, 26, 134–135

indexes, building, 252–254

inline images, 262, 263

input devices

about, 21

mouse pointer, 24

onscreen keyboard, 23–24

PC keyboard, 21–22

Insert Endnote command button, 255

Insert Footnote command button, 255

Insert Index button, 253

inserting

blank pages, 165

cover pages manually, 174–175

fields in mail merge, 325
graphics, 259–260

items into shapes, 261

shapes, 260–261

special characters, 273–274

symbols, 273–274

insertion pointer, 25, 38–40

instant documents, with templates, 197–200

Internet, collaboration tools on, 311–312

Italic command button, 116

italic format, 114, 116

J
joining paragraphs, 47–48

jump list, 96

justification, 128–130
Justify command button, 130

K
keyboard shortcuts

1.5 space lines, 136

1.15 line spacing, 136

accessing Font dialog box, 124

accessing new documents, 88

accessing Open dialog box, 96
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accessing Open screen, 96

accessing Reveal Formatting pane, 186

adding text topics, 296

applying all caps, 117

applying bold, 116

applying italics, 114, 116

applying small caps, 117

applying subscript, 117

applying superscript, 117

assigning to styles, 191–192

centering text, 136

Change Case command, 122

Clear Formatting command, 122

Close command, 19

copy and paste, 68

decreasing font size, 119

deleting words, 44–45

double-space lines, 136

double-underlining text, 116

em dash, 212

en dash, 212

finding text, 51–55
full justification, 136, 241
hanging indents, 134, 136

increasing font size, 119

indenting paragraphs, 135, 136

inserting current date, 280

inserting current time, 280

inserting endnotes, 255

inserting footnotes, 255

inserting symbols, 274

for insertion pointer, 38–40

left alignment, 136

line-spacing, 131, 136

nonbreaking hyphen character, 272

nonbreaking space, 272

pasting, 68, 69

Redo command, 50

Replace command, 59

restoring fields, 278
returning to previous edit, 41

right alignment, 136

searching, 55

selecting text, 64

Show/Hide command, 29–30

single-space lines, 136

splitting pages, 164

starting blank documents, 19

strikethrough, 116

styles, 186

symbols, 273–274

tips for, 354–355

underlining text, 116

Undo command, 49–50, 69, 265

unhanging indents, 136

un-indenting paragraphs, 135, 136

usefulness of, 348–349

word-underlining, 116

keyboards

laptop compared with desktop, 23

onscreen, 23–24

PC, 21–22

selecting text with, 63–64

tips for using, 24–26

L
label printer, 329

labels

about, 329

printing address lists, 331–333

printing sheets of identical, 330–331

Labels button, 330

landscape orientation, 157

laptop keyboard, 23

layout, graphics, 262–264

Layout Options button, 262, 264

leader tab, 153–154

left alignment, 128–129, 136

Left Indent control, 136

left tab stop

about, 144

creating 2-tab paragraphs, 145–147

creating tabbed list, 144–145

Left Tab Stop icon, 146, 149

line art, 260

line spacing

keyboard shortcuts for, 136

options for, 131

setting, 131–132
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Line Spacing command button, 131

lines

about, 213–214

adding between paragraphs, 225–226

defined, 219
numbering on pages, 250–251

linked copy, 71

linked style, 184

list style, 184

lists

creating bulleted, 248

numbered, 213

numbering, 248–249

local storage, 88

locking documents, 356–357

lowercase, 122

M
mail merge

about, 313–314

creating envelopes, 318–319

document types for, 315

Mail Merge Wizard, 316

main document, 316–319

merging documents, 326–328

merging to email, 327–328

merging to printer, 327

previewing merged documents, 325–326

process of, 315–316

recipient list, 319–324

terminology for, 314

Mail Merge Wizard, 316

main document

about, 314, 316

creating mail merge email messages, 318

creating mail merge form letters, 316–318

main screen, 12–13

manipulating text blocks, 67–72

manual line break, 48–49

manual page break command, 349

mapping documents, 357–358

margins, printing, 158

Margins button, 158

Mark Entry button, 252

marking

entire documents, 66

text blocks with F8 key, 65–66

markup area, 305

Master Document feature, 300

math, in tables, 233

Mavis Beacon Teaches Typing program, 25

Merge Cells button, 237

merge fields, 314
merging

cells in tables, 236–237

documents, 326–328

to email, 327–328

to printer, 327

Microsoft OneDrive, 88, 92, 93–94, 311

Microsoft Publisher, 160

mini toolbar, 62–63, 369

Minimize button, 19

misspelled words, 74–75

modifier keys, 23
mouse

copying text blocks with, 70–71

marking text blocks with, 64–65

moving text blocks with, 70–71

Mouse mode, 15

mouse pointer, 24

mouse wheel, scrolling with, 37–38

Move Down button, 294

Move Up button, 294

moving

graphics, 268

insertion pointer, 38–40

text blocks, 68–69

Multilevel List button, 249–250

multilevel numbered lists, creating, 249–250

multiple-page options, 160

N
navigating documents, 35–42

Navigation pane, 52, 358

New Address List dialog box, 320

New Comment button, 304

New Style button, 189

New Window button, 286

Next button, 179

Next Comment button, 305
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Next Footnotes button, 255

Next Page section break, 171

No Markup, 305, 310

nonbreaking hyphens, 271–272

nonbreaking spaces, 271–272

nonprinting characters, 29–30

non-Word documents, opening, 288–290

Normal style, changing, 193–194

nudging text size, 119

numbered lists

about, 213

automatic, 371

multilevel, 249–250

numbering

lines on pages, 250–251

lists, 248–249

pages manually, 349

Numbering command button, 249

numeric keypad, 23

O
Object button, 97

odd headers/footers, 179

Odd Page section break, 172

Online Pictures button, 259

online version, of Ribbon, 15

onscreen keyboard, 23–24

Open command, 95–96

Open dialog box, 96, 368

Open screen, 96

opening

documents, 88–89, 94–97, 284

Navigation pane, 358

non-Word documents, 288–290

PDF files, 109
Reveal Formatting pane, 186

Word documents, 9–10

ordinals, 212

orientation, changing, 157

Orientation button, 157

Original, 305

orphans, 29

outdents, 134

Outline button, 292

Outline view

about, 16

entering, 292–293

exiting, 293

outlines

printing, 297–298

typing topics in, 293–294

Outlook, 314, 323–324

P
page borders, applying, 224–225

Page Break command button, 164

page breaks, 28–29, 349

Page Color button, 165

page formatting

about, 155

adding automatic page numbers, 160–161

adding cover pages, 173–174

adding watermarks, 167

backgrounds, 165–167

changing orientation, 157

coloring pages, 165–166

creating custom headers/footers, 176–178

creating sections, 171–172

first-page, 173–175
footers, 175–181

headers, 175–181

inserting blank pages, 165

inserting cover pages manually, 174–175

multiple-page options, 160

numbering pages, 160–163

numbering with Roman numerals, 163

Page Setup dialog box, 158–160

printing colored pages, 166

removing page numbers, 163

removing section breaks, 173

setting page margins, 158

setting page size, 156

slicing documents into sections, 170–173

starting text on new pages, 164

starting with different page numbers, 162
using preset headers/footers, 175–176

page margins, setting, 158

page number field, adding, 277
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page numbering

about, 160

adding automatic, 160–161

adding in headers/footers, 177–178

removing, 163

with Roman numerals, 163

starting with different, 162
Page Setup dialog box, 158–160, 172–173

page size, setting, 156

pages

centering, 214–216

coloring, 165–166

deleting, 46–47

numbering lines on, 250–251

printing odd and even, 105

printing on both sides of, 104

printing ranges of, 103–104

printing specific, 102–103
splitting, 164

paper documents, 99–108

Paragraph dialog box, 13, 127–128

paragraph formatting

about, 125

alignment, 128–130

commands for, 127–128

hanging indents, 134

indentation, 133–137

indenting first lines, 133–134
indenting paragraphs, 134–135

justification, 128–130
line-spacing, 131

making space between paragraphs, 132

rules for, 126–128

spacing in and around paragraphs, 130–132

tips for, 136

paragraph style, 184

Paragraph symbol (¶), 126

paragraphs

adding thick line between, 225–226

boxing multiple, 221–222

defined, 47, 126
deleting, 46

formatting, 213–214

indenting, 26

joining, 47–48

putting borders around, 221

splitting, 48

Paste button, 300

Paste command button, 68

Paste Options icon, 69–70

Paste Special command, 371

pasting plain text, 370–371

PC keyboard, 21–22

PCs For Dummies (Gookin), 3

PDF files
creating, 109

editing, 109

opening, 109

PgDn key, 40

PgUp key, 40

Pictures button, 259

pilcrow, 30, 126

pinning

templates, 199

Word to taskbar, 9

plain text, pasting, 370–371

Plus (+) button, 236

points, 118

pop-up information bubble, 24

portrait orientation, 157

Preview Results command button, 326

previewing

merged documents, 325–326

before printing, 100–101

Previous button, 179, 311

Previous Comment button, 306

Print command, 102, 350

print jobs, canceling, 107–108

Print Layout view, 15, 28

print preview, 100–101

Print screen, 100

PrintDate field, 280
Printer icon, 107

printers

choosing, 106–107

configuring, 100
merging to, 327

printing

about, 350

address lists, 331–333
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colored pages, 166

comments, 306

documents, 101–102

margins, 158

multiple copies, 106

outlines, 297–298

sheets of identical labels, 330–331

text blocks, 106

printout, 99

program windows

main screen, 12–13

Ribbon, 13–14

Start screen, 10–12

Promote button, 294

Promote to Heading 1 button, 295

promoting topics, 294–295

proofing documents, 81–85
proofing errors, hiding, 84–85
properties, of documents, 364

publishing

documents, 99–110

documents electronically, 108–110

documents on paper, 99–108

pull quote, 274

punctuation, 77

Pushpin icon, 91, 96

Q
Quick Access toolbar, 339–342

Quick Parts button, 275–276

Quick Tables, 232

R
ranges, printing for pages, 103–104

Read Mode, 16

reading comments, 305–306

rearranging topics, 294

Recents list, 96

rechecking documents, 81–82

recipient list, 314, 319–324

recovering drafts, 98

red lines, 31

red zigzag, 30

Redo command, 50

Remember icon, 4

removing. See also deleting

background color, 121

blank pages, 102

borders, 222

column breaks, 245

columns from tables, 235–236

Document Properties sheet, 105

documents from Recents list, 96

drop caps, 357

footers, 181

headers, 181

items from Quick Access toolbar, 342

page borders, 225

page numbers, 163

rows from tables, 235–236

sections breaks, 173

style formatting, 187

text, 43–47

text wrapping, 263

Repeat command, 50

Replace command, 59

replacing text, 58–59

Reply button, 304

replying to comments, 304–305

resizing

graphics, 265

program window, 13

text, 16–17, 118–119

Resolve button, 304

restoring

Open dialog box, 368

Save dialog box, 368

returning to previous edit, 41

returns, 48–49, 132, 302

Reveal Codes command, 30

Reveal Formatting pane, 186

reviewing

changes, 310–311

document proofing errors, 81
revision marks, 310

Ribbon

about, 13–14

customizing, 342–343

hiding, 14–15
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Ribbon (continued)

showing, 14–15

tips for, 353–354

right alignment, 129, 136

Right Indent control, 137

right tab stop

about, 148

creating 2-column right-stop lists, 150

creating right-stop, left-stop lists, 148–149

right-stop, left-stop lists, 148–149

Roman numerals, page numbering with, 163

Rotate command button, 266–267

rotating graphics, 266–267

rows

adding in tables, 235–236

removing from tables, 235–236

resizing in tables, 236

rule, 213, 219

rulers

about, 233

adjusting indents with, 135–137

tab stops and, 142

unhiding, 135

S
Save As screen, 91

Save button, 18, 93

Save dialog box, 368

save-errors, for documents, 92

saving

automatically on OneDrive, 93–94

AutoRecover feature, 353

documents, 89–94, 199

documents for the first time, 90–92
forgetting, 94

importance of, 348

scroll bar

horizontal, 37

vertical, 36–37

scrolling documents, 35–38

search and replace

about, 51

Advanced Find, 53–55

finding text, 51–55
replacing text, 58–59

section breaks, 171–172, 173, 244

sections

about, 169

creating, 171–172

headers/footers and, 180–181

slicing documents into, 170–173

using, 172–173

selecting

bullet styles, 248

fonts, 114–116

index entries, 252–253

printers, 106–107

tables, 234

text, 63–64

text by letter, 369–370

sentences, deleting, 45–46

setting(s)

adjusting for grammar checker, 84

AutoCorrect, 79

column breaks, 244–245

format of pasted text, 69–70

line spacing, 131–132

page margins, 158

page size, 156

tabs with Tabs dialog box, 142–143

text size, 118–119

shading backgrounds, 120–121

Shading command button, 120–121

Shape Styles group, 260–261

shapes, 260–261

Shapes button, 260

Share button, 311

sharing documents, 311–312

Shift +F5, 354

Shift key, 23, 64

Shift+F4, 354

Shift+F5, 41

Shift+F8, 354

Show Gallery button, 14

Show Notes button, 256

Show/Hide command, 29–30, 49, 164, 253

shufÒing graphics, 269
Side-by-Side view, 351–352

Simple Markup, 305, 310

single-spacing, 131, 136
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Size button, 156

slicing documents into sections, 170–173

small caps, applying, 117

smart quotes, 211

soft returns, 48–49, 132, 302

sorting text, 358–359

space, making between paragraphs, 132

Spacebar key

about, 22

using, 25–26

spaces, 348

spam, 328

special characters, 56, 272–273, 273–274

spell check feature

about, 73–74

AutoCorrect feature, 77–79

common misspelled words, 76–77

fixing misspelled words, 74–75
incorrectly flagged words, 75

Split Window button, 286

split-screen, 286–287

splitting

cells in tables, 237

documents, 299–300

pages, 164

paragraphs, 48

square images, 263

Start screen

about, 10–12

disabling, 368

starting

blank documents, 19

File screen, 2

new documents with templates, 198–199

text on new pages, 164

Word, 7–10

status bar

customizing, 337–339

using, 27–28

storage, 88

strikethrough, applying, 116

Strikethrough command button, 116

style formatting

about, 183–184

assigning shortcut keys to styles, 191–192

changing Normal style, 193–194

Create New Style from Formatting dialog box, 188–190

creating heading styles, 194

creating styles, 188

customizing Style Gallery, 195

deleting styles, 192–193

determining current style, 186–187

finding styles, 184–185
follow-me style, 190

modifying styles, 190–191

removing, 187

tips and tricks, 193–195

using styles, 185–186

Style Gallery, customizing, 195

Style Inspector, 186–187

Style Inspector button, 186

styles

assigning keyboard shortcuts to, 191–192

creating, 188

defined, 183
deleting, 192–193

discovering current, 186–187

finding, 184–185
modifying, 190–191

removing formatting from, 187

updating, 200

using, 185–186

Styles Pane Options dialog box, 185

subdocuments, 300

subscript, applying, 117

Subscript command button, 117

subtopics, 293

superscript, applying, 117

Superscript command button, 117

support, for this book (website), 4

Switch Windows button, 284

Symbol dialog box, 273

symbols, inserting, 273–274

synonyms, 300–301

T
tab characters

deleting, 154

displaying, 140–141
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tab formatting

about, 139–140

bar tab, 152

center tab stop, 147–148

clearing tab stops, 154

decimal tab, 151–152

leader tabs, 153–154

left tab stop, 144–147

resetting tab stops, 144

right tab stop, 148–150

ruler, 142

tab characters, 140–141

tab stops, 142, 144

Tabs dialog box, 142–143

Tab key, 22, 23, 26

tab stops

center, 147–148

clearing, 154

default, 144

displaying, 141

left, 144–147

resetting, 144

right, 148–150

tabbed lists, creating, 144–145

Table menu, 228

table of contents (TOC), creating, 251–252

Table of Contents button, 251

table style, 184

tables

adding captions, 238

adding columns/rows, 235–236

adding to documents, 227–233

adjusting column size, 236

adjusting row size, 236

converting, 232

converting tab-formatted text into, 231

creating, 228–232

deleting, 232–233

drawing, 228–232

formatting, 237–238

math in, 233

merging cells in, 236–237

modifying, 235–238

removing columns, 235–236

removing rows, 235–236

selecting, 234

splitting cells, 237

text in, 233–235

typing text in, 233–234

working with in Word, 228

tablets, Word on, 15

tabs

on Ribbon, 13–14

showing, 14

using, 26

Tabs dialog box, 142–143

task pane, copying text chunks to documents  
from, 71–72

taskbar, pinning Word to, 9

Technical Stuff icon, 4
templates

changing associated, 200

creating, 201–202

defined, 11
instant documents with, 197–200

modifying, 202

pinning, 199

starting new documents using, 198–199

text

aligning in cells, 234–235

boxing, 224

case-sensitive, 54

coloring, 119–121

comments on, 303–307

converting into tables, 232

deleting chunks of, 45–47

deleting lines of, 45

double-spacing, 26

editing, 43–50

erasing, 26

finding, 51–55
graphics in, 257–262

hidden, 363

inserting into shapes, 261

keeping images with, 264

removing, 43–47

replacing, 58–59

resizing, 16–17, 118–119

selecting, 63–64

selecting by letter, 369–370

sorting, 358–359
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starting on new pages, 164

in tables, 233–235

typing in tables, 233–234

typing into headers/footers, 177

wrapping around images, 263

zooming, 16–17

text blocks

about, 61–63

copying, 68, 70–71, 71–72

copying to documents from task pane, 71–72

copying with mouse, 70–71

deselecting, 67

manipulating, 67–72

marking entire documents, 66

marking with F8 key, 65–66

marking with mouse, 64–65

moving, 68–69

moving with mouse, 70–71

printing, 106

selecting text, 63–64

setting formatting for, 69–70

text boxes, 274–275

text case, changing, 121–122

Text Direction button, 235

text effects, about, 207–209
Text Effects and Typography button, 207
text formats, 114–117

Text Highlight button, 307

text predictions, 27

text shortcuts, 77

text topics, adding, 296–297

themes

about, 203

applying, 203–204

color, 204

creating, 204–205

elements of, 203

font, 205

modifying, 204–205

Thesaurus, 301

3-column text, 242–243

through images, 263

tick marks, 211, 272

tight images, 263

time

adding current, 279–280

adding in headers/footers, 178

Tip icon, 4

titles, creating, 223–224

toggling

between Mouse and Touch mode, 15

between views, 16

top and bottom images, 263

Top Border, 221

topics

collapsing, 295–296

defined, 293
demoting, 294–295

expanding, 295–296

promoting, 294–295

rearranging, 294

total number of pages field, 277
Touch mode, 15

Track Changes button, 309–310

tracking changes, 309–310

translations, 366

trifold brochures, creating, 242–243

Twain, Mark (author), 73

2-column right-stop lists, creating, 150

2-column text, creating, 241

2-columns lists, creating, 144–145

2-tab paragraphs, creating, 145–147

typeface. See fonts

typing

characters, 272–273

collapsible headers, 29

dictation compared with, 30

input devices, 21–24

keyboard tips, 24–26

nonprinting characters, 29–30

page breaks, 28–29

status bar, 27–28

text in tables, 233–234

text predictions, 27

topics in outlines, 293–294

underlines, 30–31

Typing Instructor Platinum program, 25
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U
underline, 30–31, 116

Underline command button, 116

Undo command, 49–50, 69, 265, 349

Undo Command button, 49–50

undoing

AutoCorrect corrections, 77–78

AutoFormat, 214

unhanging indents, 136

unhiding rulers, 135

unindents, 136

Update Labels button, 332

Update Table button, 252

Update Table of Contents dialog box, 252

updates, checking, 312

updating

documents, 92–93, 290

fields, 278
styles, 200

uppercase, 122

V
version history, of documents, 364

vertical scroll bar, 36–37

video, in documents, 362

View buttons, 16

View Side by Side button, 285

viewing

Clipboard, 71–72

documents in multiple windows, 285–286

raw data from fields, 278
views, toggling between, 16

W
Warning icon, 4

Watermark button, 167

watermarks, adding, 167

Web Layout view, 16

websites

Adobe Reader, 109

Cheat Sheet, 4

support, for this book, 4

Webster, Noah (author), 73

widows, 29

windows. See document windows; program windows

Windows (Microsoft), 350

Word. See also specific topics
pinning to taskbar, 9

quitting, 18

starting, 7–10

Word 2016 For Professionals For Dummies (Gookin), 3, 
58, 59, 89, 113, 125, 216, 233, 249, 254, 260, 279, 
343, 363

Word button, 18–19

word count, 277, 301

Word Count button, 301

word wrap feature, 26

WordArt, 261–262

WordArt button, 261

WordPerfect, 30

words

deleting, 44–45

finding, 54
finding variations of, 55

wrapped images, 262

wrapping text around images, 263

writers, features for, 291–302

Z
zooming text, 16–17
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